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убытки (включая убытки от потери деловой прибыли, перерывов в работе, потери коммерческой информации и 
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следующих или специальных убытков, так что вышеупомянутое ограничение или исключение не может быть при-
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глашения. Вы можете прекратить действие этой Лицензии в любое время,  возвратив программное обеспечение 
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Совершенствуйте свои проекты, редактируя каждый от-
дельный стежок.
Для автоматического создания красивой вышивки по 
отсканированной художественной картинке имеется 
программа AutoDigitizer.
Чтобы превратить картинку в стежки используйте функ-
цию Magic Wand («волшебная палочка»).
Для превращения фотографии ввышивку можно ис-
пользовать программу PhotoSnap.

BERNINA® Embroidery Software – это лучшее программ-
ное обеспечение для создания вышивок в домашних 
условиях. Она создана на основе MSWindows®, что по-
зволяет использовать многие функции, с которыми 
пользователи обычных РС уже знакомы.

BERNINA Embroidery Soft ware интегрировано с ПО CorelDRAW® EssentialsX6 от ком-
пании CorelCorporation, которое является самым популярным пакетом программ век-
торной графики среди домашних пользователей. Это сочетание позволяет создавать 
проекты вышивок наиболее эффективным и удобным образом, объединяя вышиваль-
ные функции BERNINA Embroidery Softwareс графическими функциями CorelDRAW®. 
Оно позволяет пользователям создавать не просто вышивки, но и по-настоящему 
сложные мультимедийные проекты.

Примечание
CorelDRAW® EssentialsX6 и родственный ему программный продукт, CorelPHOTO-
PAINT® EssentialsX6 можно использовать и как отдельные самостоятельные приложе-
ния. Вся информация содержится в электронном Руководстве пользователя, которое 
можно найти в системе Windows в меню Start>Programs (Пуск>Программы). Можно 
найти ее и в системе экранной помощи в графическом режиме.

Начинающим пользователям
Если вы еще незнакомы с ПО BERNINA Embroidery 
Software, Вам понравятся ее гибкие возможности 
оцифровки и простота, скоторой можно создавать 
графические проекты, добавлять и создавать но-
вые  шрифты. Тем не менее, прежде, чем начать 
работу с программой, прочтите Приступая к рабо-
те (GettingStarted). В этой главе мы представляем 
обзор основных концепций работы с ПО BERNINA 
Embroidery Software и даем рекомендации как до-
стичь наилучших результатов.

Опытным пользователям
BERNINA Embroidery Software– это расширенная вер-
сия ранее существовавших программных продуктов 
с многими новыми или расширенными функциями.
Чтобы быстрее ознакомиться с этими новшества-
ми, прочтите пожалуйста сведения о программе 
(Releases-Примечание) в меню экранной помощи 
Help.

Уровни программной продукции
Программный продукт BERNINA Embroidery Soft ware 
имеет два уровня:
• BERNINA EditorPlus
• BERNINA DesignerPlus.
Пользователи ПО BERNINA Embroidery Soft ware мо-
гут получать обновления к программам напрямую 
через Internet. Подробности в разделе Обновления 
и коды доступа (Upgrades&accesscodes).

BERNINA Editor Plus
ПО BERNINA Editor Plus позволяет редактировать 
имеющиеся проекты, добавлять надписи. Вы смо-
жете без проблем сделать красивую вышивку по 
отсканированной картинке. Можно использовать 
мощные инструменты автоматической оцифровки: 
AutoDigitizer, MagicWand и PhotoSnap. 

Глава 1
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Кроме того:
• Можно менять последовательность цветов для
лучшего качества вышивки
• Можно редактировать отдельные стежки для тон-
кого улучшения качества вышивки
• Можно автоматически создавать вышивки по от-
сканированной картинке с помощью программы  
AutoDigitizer
• Можно превратить картинку в стежки с помощью
функции MagicWand («волшебная палочка»)
• Для превращения фотографии в вышивку можно
и спользовать программу PhotoSnap.

BERNINA Designer Plus
ПО BERNINA Designer Plus имеет мощные функции 
для оцифровки и, сочетая как автоматические и  
«ручные» инструменты и методы. 
Система позволяет:
• Оцифровывать сканированные или импортиро-
ванные рисунки прямо на экране
• В дополнении к автоматической оцифровке, ис-
пользовать специальные инструменты и большой 
набор художественных образцов и заполнений
• Создавать аппликации
• Превращать любой из шрифтов Windows TrueType
в новый вышивальный алфавит
• Сохранять понравившиеся настройки как шаблоны.

Примечание
Функции, специфичные для разных моделей, пе-
речислены в списке функций моделей BERNINA 
Embroidery Software Product Feature List.

Ресурсы и поддержка

Информацию о программе BERNINA Embroidery 
Software и о том, как с рей работать, можно получить 
разными способами. Имеются адреса ресурсов, где 
можно скачать готовые образцы вышивок. 

Печатная документация
В зависимости от приобретенного Вами уровня про-
граммного продукта вместе с установочным диском 
DVD Вы получаете следующую печатную докумен-
тацию:

Краткое руководство пользователя BERNINA 
EmbroiderySoftware содержит указания по установ-
ке ПО, а также  общую информацию о программе. 
Имеется раздел с кратким справочником, содер-
жащим все экранные и клавиатурные команды, ис-
пользуемые в программе.

Документация, отображаемая на экране
Документация отображается на экране в двух фор-
матах – HTML Help и Adobe Acrobat. В зависимости 
от уровня программного продукта Вы получите сле-
дующую документацию в полном наборе или только 
часть ее:

Сведения о версии продукта
Сведения о версии продукта входят в комплект 
установочного пакета. Они содержат информацию 
о новых и измененных функциях со ссылками на со-
ответствующие разделы настоящего Руководства.

Руководство по работе с программами
Руководство содержит подробные сведения по 
всем функциям ПО BERNINA Embroidery Software  
‘EmbroideryCanvas’. Приведены пошаговые инструк-
ции действий, образцы, виды экранов. Программ-
ные приложения BERNINA Cross Stitch и BERNINA 
Quilter описаны в отдельных Руководствах.

Примечание
Полное описание инструментария CorelDRAW®, 
входящего в состав ArtworkCanvas, можно най-
ти в электронном Руководствечерез меню Windows 
Start>Programs (Пуск>Программы). Можно найти ее 
и в системе экранной помощи в графическом режиме.

Система экранной помощи
Система Нelp позволяет быстро получить инфор-
мацию о программе и советы, что делать в том или 
ином случае. Доступ к контекстной помощи с помо-
щью клавиши<F1>.

Дополнительные руководства пользователя
В установочный пакет BERNINA Embroidery Soft ware 
входят дополнительные руководства:

• BERNINA CrossStitch: где описаны возможности
программы BERNINA Cross Stitch см. также раздел-
Вышивка крестом. 

Линки к студиям
проектов вышивок 
BERNINA и OESD

Вывод докумен-
тации на экран

Заказ и установ-
ка обновлений
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• BERNINA Quilter: описывает возможности специ-
альной программы BERNINA Quilter. См. также раз-
дел Квилтинг. 

Он-лайновые ресурсы
В сети многие ресурсы предлагают готовые образцы 
вышивок. Программа BERNINA Embroidery Soft ware 
направит Вас к двум богатым ресурсам – студиям 
вышивального дизайна BERNINA и OESD.

Обозначения,  используемые  в Руководстве

В этом Руководстве приняты и используются следу-
ющие обозначения.

Команды
В этом Руководстве команды меню или подменю 
указываются со ссылками на имена меню и коман-
ды. Например, команда ‘ShowAll’ (‘Показать Все’) из 
меню ‘View’ (‘Вид’) указывается как View > ShowAll.

Диалоговые окна
Диалоговые окна показываются в руководстве толь-
ко в том случае, когда в них отображена важная ин-
формация для использования ПО BERNINA. Экранные 
иллюстрации дают лишь примерное представление 
и не являются точными копиями экранных изобра-
жений, воспроизводимых программным обеспече-
нием.

Действия мышью

Указание Действие
Щелчок мышью Щелкнуть левой кнопкой мыши

Щелчок правой кноп-
кой мыши

Щелкнуть правой кнопкой мыши

Двойной щелчок Дважды щелкнуть кнопкой, 
не перемещая мышь

Нажмите кнопку ОК Щелкнуть мышью по кнопке OK диа-
логового окна, или нажать клавишу 
Enter клавиатуры, чтобы завершить 
действие.

Комбинации клавиш

Комбинация Описание
Щелчок мышью Щелкнуть левой кнопкой мыши

Удерживая нажатой клавишу CTRL, 
нажать клавишу (для сохранения про-
екта).

Полный список комбинаций клавиш имеется в разделе,  Комби-
нации клавиш.

Краткое руководство пользователя BERNINA 
Embroidery Software содержит указания по установ-
ке ПО, а также  общую информацию о программе. 
Имеется раздел с кратким справочником, содер-
жащим все экранные и клавиатурные команды, ис-
пользуемые в программе.

Ctrl S+
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Установочный набор BERNINA Embroidery Software 
V7.0 включает ниже перечисленные компоненты 
(или некоторых из них): 

• BERNINA Embroidery Software – установочный
диск DVD
• Заглушка USB
• BERNINA Embroidery Software– краткое руковод-
ство по началу работу

Примечание
На установочном диске BERNINA Embroidery Software 
DVD записано ПО для ВСЕх продуктов,  включая 
BERNINA Designer Plus, BERNINA Editor Plus,  BERNINA 
Portfolio, BERNINA Cross Stitch и BERNINA Quilter.

Требования к системе
Для нормальной работы ПО BERNINA Embroidery 
Software Ваш  компьютер должен удовлетворять сле-
дующим минимальным требованиям:

Спецификации компьютера
Проверьте, удовлетворяет ли Ваш компьютер ни-
жеследующим требованиям к памяти, процессору и 
дисковому пространству.

Позиция Мин. требования
Процессор Intel® Pentium® 4, AMD Athlon™ 64

or AMD Opteron™

OС ‡ Windows® XP SP3 (32-bit)

Браузер I.E. 7.0 or later

Доступ в Интернет Для установки, регистрации,            
получения обновлений.

Память 1 GB (32-bit) or 2 GB (64-bit)

Объем жесткого диска 40 GB

Свободное место на 
диске

† 20 GB

Графическая карта Поддержка Highest Color (32bit)   и 
разрешения 1280 x 1024

Монитор ¥ от 17’ разрешение 1280 x 1024

Сканер, принтер, 
плоттер

Совместимость с Windows.
Любое подсоединение – 
параллельное, или USB 

USB порты Отдельный порт USB для заглушки USB 
dongle

Мышь Мышь USB

Носители данных DVD-ROM для установки ПО

Звуковая карта Нужна для мультимедийных учебных 
программ

Операционные системы ‡
• Допустима ОС Windows XP (32bit), но BERNINA ре-
комендует установить ОС Windows 7 или Windows 8.

Свободное дисковое пространство †
ПО BERNINA Embroidery Soft ware занимает до 1Gb 
на жестком диске в зависимости от конфигурации. 

Разрешение экрана¥
При недостаточном разрешении экрана некоторые 
элементы могут не отображаться. На оптимальное 
разрешение влияет также и размер экрана. Круп-
ные шрифты ухудшают ситуацию. Для оптимизации 
следует настроить и разрешение экрана, и размер 
используемых шрифтов. Приемлемый вариант, на-
пример, размер шрифта 100% или 125% при разре-
шении 1280 x 720.

Глава 2
Установка и настройка программы
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Устройство безопасности
ПО BERNINA Embroidery 
Software защищено с помощью 
так называемой USB - заглуш-
ки, которую следует подклю-
чить к компьютеру. На заглуш-
ке записаны кодовые данные, 
без которых ПО не работает. 
Каждая заглушка имеет свой се-
рийный номер и код.

Все ПО, как новые версии, так и обновления, постав-
ляется вместе с USB- заглушкой.  При обновлении 
ПО Вы получите запрос на выполнение «пересадки 
мозга», со старого устройства на новое. Не отсоеди-
няйте старую заглушку и не подсоединяйте новую, 
пока установочная программа не попросит это сде-
лать. Иначе могут возникнуть проблемы с работой 
защиты ПО.

Предупреждение
Если при работе с ПО BERNINA Embroidery Software 
заглушка была отключена, появятся сообщения об 
ошибках. Закройте сообщения и выйдете из про-
граммы. Все несохраненные в проекте изменения 
будут утеряны. Подключите снова заглушку. Про-
следите за надежностью соединения. Теперь мож-
но продолжить работать с программой BERNINA 
Embroidery Software.

Установочные опции

При установке программы Вы имеете выбор: 

•  Какое ПО и какие образцы Вы желаете установить
•  Какие компоненты будут установлены – дополни-
тельные языки, например, или BERNINA Portfolio
•  Какие файлы с документами будут установлены.

Примечание
Обязательно  надо отметить галочкой чек-
бок с BERNINA Embroidery Software. Чек бокс 
‘ExtraLanguages’ – есть он или нет зависит от версии 
ПО.

Слияние версий ПО
Вы можете выбрать возможность слить новую версию 
ПО с уже установленной. С установленными «нако-
плениями» произойдет следующее:
Образцы
ПО BERNINA Embroidery Software позволяет сохра-
нять образцы  в Ваших собственных папках. В новых 
версиях ПО могут быть изменения в новых версиях 
этих файлов.
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При установке проверяются уже имеющиеся файлы 
на вашем компьютере и сливает их с новыми уста-
новками.

Шаблоны
BERNINA Embroidery Soft ware позволяет также из-
менять уже установленные шаблоны и устанавливать 
новые. В новых версиях ПО могут быть изменения в 
новых версиях этих файлов. Установочная програм-
ма проверяет все шаблоны в системе и сливает их с 
новыми установками. 

Таблицы ниток
Сделанные в таблицах ниток изменения сохраняются.

Ткани и аппликации
Образцы тканей для аппликаций используются как 
программой BERNINA Embroidery Software, так и 
BERNINAQuilter. Вы могли добавить ткани в суще-
ствующей установкеBERNINAQuilter. При установ-
ке новых тканей, программа установки BERNINA 
Embroidery Software проверяет установленные фай-
лы и сливает их с новыми установками.

Примечание
Все изменения, что Вы сделали в библиотеке тканей 
BERNINA Quilter будут учтены в новых установках.

Что не надо делать
•  Не удаляйте ранее установленное ПО BERNINA 
Embroidery Software «вручную», просто удаляя про-
граммные файлы. Этого нельзя делать для любых 
приложений под ОС Windows.
• Не следует удалять существующую версию ПО 
BERNINA Embroidery Software из меню MS Windows 
Start >Programs >BERNINA Embroidery Software 
>Uninstall, а также используя функцию Add/Remove 
Programs (добавить/удалить программы) из панели 
управления  Windows.
Оба этих способа удалят все файлы программы 
BERNINA Embroidery Software и Вы потеряете все ра-
нее сделанные настройки.
• Позвольте установочной программе BERNINA 
Embroidery Software сохранить ранее сделанные на-
стройки в обновленной программе. 
•  При установке ПО программа попросит Вас пере-
загрузит компьютер для завершения установки. До 
перезагрузки не забудьте закрыть все файлы и про-
граммы. 
•  После завершения установки можно удалить уста-
ревшие версии ПО BERNINA Embroidery Software с  
помощью меню Programs > ... >Uninstall или Add/
Remove Programs. При удалении программ некото-
рые файлы могут остаться в установочной папке.

Можно вручную удалить эту папку с помощью про-
граммы Windows Explorer.

USB Port Dongle
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Установка ПО

Процедура установки позволяет выбрать: 
•  Где будет сохранено ПО и образцы проектов - на 
Вашем РС или в сети
•  Какие компоненты будут установлены – например, 
дополнительные языки или BERNINA Portfolio
•  Какие файлы с документами будут установлены. 

Предупреждение
При обновлении ПО не удвляйте старую версию за-
ранее. Установочная программа сделает это за Вас.
См. также раздел Слияние версий ПО.

Перед установкой ПО BERNINA Embroidery 
Software
1   Проверьте, отвечает ли Ваш РС требованиям ПО 
BERNINA Embroidery Software. См. раздел Требова-
ния к системе.
2   Закройте все приложения lMS Windows® , но саму 
ОС Windows не закрывайте

3 Вставьте загрузочный диск DVD-ROM BERNINA  
Embroidery Software
4   Нажмите Next 
5   Выберите продукты для установки и нажмитеNext. 

Установка
Установочная программа будет запущена через 30 
секунд и появится экран приветствия.

Отображается лицензионное соглашение.

Подсказка:
Лицензионное соглашение можно распечатать с по-
мощью кнопки Print.

6   Скажите «да» и нажмите Next.
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Вам будет предложено подключить заглушку. Новая 
версия программы предложит подсоединить и ста-
рую заглушку тоже. 

7   Нажмите Next. 
Появится экран SetupType. Если Вы новичок – вы-
бирайте вариант полной установки (complete 
installation).
8   Нажмите Next.
Появится экран выбора размещения ПО Choose 
Destination Location. Укажите, где разместить ПО  
BERNINA Embroidery Software.
•  Если согласны с выбором по умолчанию - нажми-
те Next.
• Для выбора другого размещения - нажмите  
Browse, выберите существующую уже папку или соз-
дайте новую и нажмите  Next.
Если выбрать папку с установленной ранее прежней 
версией ПО, новая будет установлена поверх старой 
и они автоматически объединятся.
9   Нажмите Next.
Появится экран Sample Location (размещение образ-
цов). Укажите имя папки для сохранения Ваших об-
разцов и проектов.

По умолчантю Вам предложен будет адрес My 
Designs - Embroidery Software 7. Образцы, поставля-
емые вместе с ПО, разместятся именно в этой папке.
•  Если Вы согласны с адресом по умолчанию - на-
жмите  Next 
•  Для изменения папки сохранения, нажмите  Browse 
– выберите существующую уже папку или создайте 
новую и нажмите  Next. 

Примечание
Ваши собственные образцы при установке не пере-
мещаются,  но старые образцы могут быть заменены 
на новые с тем-же именем.



Если на Вашем PC были уже установлены прежние 
версии BERNINA Embroidery Software: 
•  Программа предложит Вам выбрать версию ПО, 
поверх которой установить новую. Какие компонен-
ты будут установлены – например, дополнительные 
языки или BERNINA Portfolio
•  После перезагрузки компьютера данные будут со-
единены.
11  Для продолжения, нажмите Install. 
Появится экран состояния процесса установки Setup 
Status.
Программа CorelDRAW® EssentialsX6 устанавливает-
ся вместе с другим ПО.

12  Нажмите Finish для завершения установки. 
Программа предложит Вам перезагрузить компьютер.
Это можно сделать, через меню «Start>Programms» 
MSWindows®.

Примечание.
При установке обновлений соединение версий мо-
жет потребовать некоторое время. Изменения, что 
Вы могли уже сделать в Вашей прежней програм-
ме BERNINAQuilter (в библиотеке тканей) могут быть 
слиты с новым ПО. Новая установка также забира-
ет все новые образцы и темы, модифицированные 
пользователем. См. раздел Обновление версий ПО.

Обновление действующей программы

Если Вы обновляете уже имеющееся у Вас ПО 
BERNINA® Embroidery Software, или если Вы хоти-
те его удалить, следуйте той-же процедуре, что и 
при установке программы. Запустите ее, и она ав-
томатически определит наличие устаревшего ПО 
BERNINA®Embroidery Software и предложит его об-
новить, починить или удалить. Это предотвратит 
одновременную установке двух или более разных 
версий нашего ПО на Вашем РС.
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Обновление программы
1  Закройте все приложения MS Windows®, но не 
саму ОС Windows. 
2   Вставьте установочный диск BERNINA® Embroidery 
Software DVD-ROM.
Если ПО BERNINA® Embroidery Software уже установ-
лено на Вашем компьютере, Вы увидите следующее 
сообщение на экране:

3 Выберите нужное действие - Modify, Repair, 
Remove - и нажмите  Next.
•  Modify  - обновить – меняет набор установленных 
компонент
•  Repair - ремонтировать – заменяет уже установ-
ленные компоненты на новые
•  Remove - удалить ПО. 
При выборе опции Modify появится экран Select 
Components - выбор компонент.

4   Добавьте или удалите функции и языки.
5   Нажмите Next. Появится экран готовности к уста-
новке Ready to Install.
6  Нажмите Install.
Программа предложит ввести код доступа с Вашей 
карты Bernina Upgrade Card. 
С веб-сайта Вы получите уведомление по электрон-
ной почте.



После успешной установки, при обновлении любых 
дополнительных файлов MSWindows®будет появ-
ляться экран завершения обслуживания Maintenance 
Complete. 

Примечание.
Если при установке Вы выбрали  опцию Repair (по-
чинить), все ранее установленные компоненты будут 
переустановлены. 

7   Нажмите  Finish. 

Обновления и коды доступа

ПО BERNINA Embroidery Software защищено с по-
мощью так называемой USB- заглушки, которую 
следует подключить к компьютеру. На заглушке за-
писаны кодовые данные, без которых ПО не рабо-
тает. Каждая заглушка имеет свой серийный номер 
и может распознать код, записанный в программе. 
7-значный код заглушки (DongleNumber) очень ва-
жен. Он указан на ярлыке заглушки. Кроме номера 
заглушки у каждой из них имеются серийный номер  
(SerialNumber) и код идентичности (IdentityCode), по 
которым их распознает система. Узнать код иден-
тичности можно с помощью программы BERNINA® 
Embroidery Software. Обновлять систему можно не-
посредственно через интернет. 

Идентификация устройства безопасности

Чтобы в корреспонденции идентифицировать Вашу 
систему, Вы должны указать номер заглушки, а так-
же серийный номер и код идентичности. Эту инфор-
мацию можно найти на заглушке или в программе с 
помощью диалога Security Device (устройство без-
опасности).

Для идентификации устройства безопас-
ности
Найдите номер заглушки на ее ярлыке – это уни-
кальный 7-значный код, начинающийся с буквы ‘A’.
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Эта информация есть и в программе в меню настро-
ек (Settings) в диалоге Security Device Options. 

 

Примечание
В поле Serial Number указан внутренний серийный 
номер устройства (перед дефисом).  Этот номер 
считывает программа с заглушки. Он отличается от 
номера, написанного на заглушке. Рекомендуем за-
писать себе это номер для упоминания в переписке 
со службой поддержки. 

Обновление ПО BERNINA® Embroidery 
Software в режиме он-лайн
Пользователи ПО BERNINA Embroidery Software могут 
устанавливать обновления прямо через интернет. На 
сайте Вам предложат выбор обновлений, зависящий 
от уровня ПО. Если уровень соответствует BERNINA 
Editor Plus, обновления для BERNINA Designer Plus  
будут  предложены автоматически. При возникнове-
нии вопросов, обращайтесь к вашему дилеру.

Предупреждение
Если в настройках браузера указан высокий уровень 
безопасности, загрузка ПО может оказаться не воз-
можной. При возникновении этой проблемы попро-
буйте установить средний уровень безопасности.

Для обновления в режиме он-лайн:

1  Проверьте подсоединение к интернету

2  Выберите Help>ActivateUpgrade. Вы подключае-
тесь к веб-сайту.
3  Следуйте подсказкам:
•  Вам будет предложено ввести уникальный код доступа
•  Сайт направит Вам извещение по электронной почте

Заказ и установка
о б н о в л е н и й



4 Получив извещение, нажмите Help> Install  
Upgrade. Откроется диалог Bernina Upgrader. 

5  Нажмите  OK. Коды доступа загружаются на за-
глушку и начинается загрузка обновления.
6 По завершении установки обновления нажмите OK. 
Программа BERNINA® Embroidery Software перезапускается  
с обновлениями.
 
Ввод кода доступа

Если у Вас не получается обновить программу в ре-
жиме он-лайн, попробуйте ввести код доступа вруч-
ную. Этот код можно получить у Вашего дилера. 

Подсказка
Код доступа можно ввести, скопировав его из тек-
стового файла. Этот способ экономит время и по-
зволяет избежать опечаток. Подробнее см. раздел 
Импорт кода доступа.

Ввод кода доступа

1  Выбрать Settings>Security. 
Откроется диалог Set Security Device Options
(Настройка устройства безопасности). 

2  Сличите серийный номер и код идентичности ва-
шей заглушки с теми, что указаны в письме, содер-
жащем код доступа. Они должны совпадать. 
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3  Введите коды в поля формы, переходя от одного 
поля к другому с помощью клавиш Tab или Enter.
 

Подсказка
При вводе кода доступа, программа BERNINA® 
Embroidery Software автоматически добавляет про-
бел после каждых 4 знаков. Вручную вводить про-
белы не надо. 

4  Нажмите  OK. Появится сообщение об успешном 
вводе кода доступа.
5  Перезапустите программу BERNINA® Embroidery 
Software.

Импорт кодов доступа
Код доступа можно ввести, скопировав его из текстово-
го файла, полученного по электронной почте. Этотспо-
собэкономитвремяипозволяетизбежатьопечаток.

Для импорта кодов доступа

1  Получив по почте код доступа (в приложении к 
письму), сохраните текстовый файл на жесткий диск 
– например, на рабочий стол Вашего РС.
2  В меню программы BERNINA® Embroidery  
Software выберите Settings> Security 
(Настройки>безопасность). Откроется диалог Set 
SecurityDevice (настройка устройства безопасности).

3   Сличите серийный номер и код идентичности ва-
шей заглушки с теми, что указаны в письме, содер-
жащем код доступа. Они должны совпадать.
4  Нажмите ImportCodes. Появится диалог Open (от-
крыть).

Для импорта 
кода нажмите



5  Найдите папку, где Вы сохранили файл с кодами 
доступа – например, на рабочем столе Вашего РС. 

6 Выберите файл с новыми кодами доступа и на-
жмите Open. Коды автоматически обновятся.
7 Перезапустите программу BERNINA®Embroidery 
Software.
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Часть I. ОСНОВНыЕ СВЕДЕНИЯ
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Образцы, созданные в ПО BERNINA Embroidery Software состоят из ‘элементов вы-
шивки’. Они называются ‘элементами’, т.к. они являются самостоятельными фрагмен-
тами и могут быть изменены независимо друг от друга. Каждый элемент обладает 
собственными отличительными характеристиками или ‘свойствами’, такими как цвет, 
размер, позиция и т.д. Главное свойство элемента – тип стежка. 

Приступая к работе
ПО BERNINA Embroidery Software дает возможность быстро создавать и редактировать 
образцы вышивки на основе легко меняющихся готовых образцов. Их данного па-
раграфа Вы узнаете основные вещи, которые можно делать при помощи ПО BERNINA 
Embroidery Software, так же здесь есть ссылки на разделы справочного руководства 
для получения более подробной информации. См. Приступая к работе.

Основные процедуры
Эта глава рассказывает о том, как начать работу с ПО BERNINA Embroidery Software и об 
основных его командах и инструментах. Вы познакомитесь с основными процедурами 
для открытия, создания и сохранения образцов. Так же параграф рассказывает о том, 
как активировать пяльцы и энергосеть и как работать со свойствами элементов. См. 
Основные процедуры. 

Просмотр проектов
Эта глава посвящена просмотру образцов ПО BERNINA Embroidery Software и их на-
стройкам. Здесь описано масштабирование, панорамирование и просмотр последо-
вательности швов. Он описывает просмотр фонов образцов и их изменение. Здесь 
также объясняется, как получить информацию о своих образцах. См. Просмотр про-
ектов.

Выбор объектов
Эта глава рассказывает о том, как выбрать элементы при помощи инструментов и кла-
виатуры. Здесь также показано, как выбрать цветовые блоки и отдельные элементы 
при помощи инструмента Color Film (Цветная пленка). См. Выбор объектов.

Варианты пялец
Эта глава описывает выбор и просмотр пялец ПО BERNINA Embroidery Software. Она 
рассказывает как создать и изменить пользовательские пяльцы. Также здесь говорить-
ся о крупных образцах пялец. См. Варианты пялец.

Установка оборудования и ПО
Эта глава описывает установку вышивочной машины, сканеров и калибровку монито-
ра. Также она описывает изменение шага сетки и настройки пялец. Установка основ-
ных настроек, таких как автосохранение, варианты положения курсора и т.д. тоже 
описаны. См. Установка оборудования и ПО.

Часть 1
Основные сведения
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Если Вы впервые пользуетесь ПО 
BERNINA Embroidery Software или са-
мой машиной, Вы, вероятно, спроси-
те  ‘С чего же начать?!’. 

Можно с уверенностью сказать, что 
Вы проведете много часов, изучая как 
выжать максимум из машины и под-
держиваемого ею ПО BERNINA. Они 
работают в тесной связке, и потре-
буется терпение и практика, чтобы 
овладеть созданием и производством 
вышивки.

Но тем ценнее результат. С каждым 
созданным  образцом Вы получаете 
опыт, уверенность и готовность к ре-
шению новых задач. 

Здесь Вы узнаете основные виды использования ПО BERNINA Embroidery Software 
и найдете ссылки на разделы справочного руководства для получения более 
подробной информации.

Начиная работу

Чтобы начать работу с ПО BERNINA Embroidery 
Software, не требуется никакого опыта. Вы можете 
просто открыть образец и послать его на машину 
для вышивки. Лучше всего начать именно здесь. По 
мере работы Вы научитесь ‘читать’ образцы и рас-
познавать, какие из них подходят, а какие могут вы-
звать сложности. 

Примеры образцов и картинок

ПО BERNINA Embroidery Software содержит сотни 
готовых образцов, включая множество прекрасных 
орнаментов, примеров и фонов. Файлы образцов 
(в формате ART) и рисунков (в форматах BMP, JPG, 
и WMF) находятся в папке My Designs - Embroidery 
Software 7 (Мои образцы). Главное при начале ра-
боты – на жалеть времени на изучение образцов и 
понимание того, какие именно имеются в наличии.

Глава 3
Приступая к работе



Примечание.
ПО BERNINA Embroidery Software содержит приложе-
ние BERNINA Portfolio design management (управле-
ние портфолио) для просмотра и управления проек-
тами вышивок. Кроме того, изучить папки проектов 
можно при помощи MS Windows® Explorer. 

Другие источники
Существует множество иных источников, где Вы мо-
жете приобрести готовые образцы, которые можно 
адаптировать и применить. ПО BERNINA Embroidery 
Software автоматически направит Вас к двум из ос-
новных – BERNINA и OESD студии вышивок.

Клипарт
CorelDRAW® Essentials X6 укомплектован набором 
клипартов, которые могут быть доступны в группе 
программ.

Убедитесь, что Вы знаете образцы клипартов. Мно-
гие из них могут быть использованы как с проек-
тами вышивок, так и с фонами или преобразованы 
напрямую.
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Возможно удобнее будет скопировать исходную 
папку CorelDRAW® Essentials X6 Clipart в My Designs 
- Embroidery Software 7 (мои проекты). 

Внимание!
Встроенные клипарты и образцы вышивок предна-
значены только для личного использования – т.е. 
они не могут быть использованы для коммерческих 
целей.

Правила хорошей вышивки

Смотря на проект вышивки (встроенные или соб-
ственный) проверьте:

•    Швы аккуратные, гладкие и ровные 
•    Формы, цвета и баланс 
•  Формы залиты правильной заливкой, наличие 
контурных стежков 
•    Направление швов соответствует формам 
•    Формы прошиты полностью – нет нежелательных 
пробелов 
•    Четко видны все детали
•    Буквы четкие и легко читаются.

Конечная вышивка должна обладать следующими 
характеристиками: 

•    Проект легко вышивается машиной 
•    Ткань не зборит у швов 
•    Нет свободных концов. 

Высокое качество вышивки начинается с хорошего 
проекта. Затем нудна качественная машина для вы-
шивки. Но и этого не достаточно, если Вы использу-
ете правильную ткань, нити,  подкладку, натяжение 
нити и т.д.. Изучите руководство к машине и другие 
вышивки, чтобы не ошибиться.



Работа с вышивкой
Прежде чем начать, давайте посмотрим на алгорит-
мы работы. Обычно необходимо выполнить один 
или все пункты: 

•    Выбрать и вышить готовый проект 
•    Сильно изменить проект 
•    Создать буквенную вышивку 
•    Комбинировать буквы и вышивку 
•    Применить проект, изменив его части 
•     Автоматически создать проект вышивки из картинки 
•    Создать новую вышивку вручную 
•    Использовать специальные функции вышивки 

Давайте рассмотрим их по отдельности.

Выбрать и вышить готовый проект

Во многих случаях достаточно взять готовый про-
ект и вышить его. Многие с этого и начнут. Когда 
Вы выберите проект, нужно будет посмотреть, как 
он будет выглядеть на ткани. Для этого нужно осу-
ществить несколько действий:

Вышить проект
1  Откройте проект в ПО BERNINA Embroidery 
Software. См. Открыть проект.

2    Настройте параметры просмотра по желанию. 
См.  Просмотр вышивки. 
3     Проверьте и измените тип ткани. 
4    Проверьте и изменит  цвет нити. См. Выбор цвета 
нити.
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5  Просмотрите вышивку, чтобы понимать как она 
будет выглядеть на ткани. См. Просмотр последова-
тельности стежков.
6   Вберите пяльцы и расположите на них вышивку. 
См. Выбор пялец.
7   Просмотрите проект и распечатайте его перед 
отправлением на вышивку. См. Распечатать проект.
8   Отправьте проект на машину напрямую или че-
рез цифровой носитель (карту памяти). См. Вышивка 
проекта.

Последующие шаги описаны в документации маши-
ны BERNINA.

Изменить исходный образец

После того, как Вы освоите вышивку клипартов и 
других образцов, можно переходить к их измене-
нию – изменить размер, цвет нити и тип ткани. Это 
простые и схожие операции.

Как изменить исходный образец
1   Откройте нужный проект. См. Открыть проект.

2    Проверьте размеры и поменяйте, если нужно.
Подробносьти в разделе Масштабирование объек-
тов. Например, если Вы вышиваете проект на левую 
часть груди, его размер не должен превышать при-
мерно 4.25 дюйма (108 мм).



3  Выберите желаемый цвет нити. См. Изменение 
цвета нити. 

4  Выберите и измените тип ткани. См. Изменение 
типа ткани. 
5   Выберите пяльцы нужного размера. См. Выбрать 
пяльцы.
6   Визуализируйте вышивку на одежду или изделие. 
См. Визуализация готового изделия.

7   Распечатайте и отправьте на машину. См. Рас-
печатка и Вышивка проекта в Руководстве пользо-
вателя.

Создать простую буквенную вышивку

После того, как Вы освоились с изменением образ-
цов, можно переходить к созданию собственных 
буквенных проектов. Этот процесс не сложнее набо-
ра текста на экране ПО BERNINA Embroidery Software, 
хотя и требует некоторой практики в получении ка-
чественной вышивки.

Как создать простую буквенную вышивку
•    Чаще всего нужно добавить буквы к уже готовому 
проекту.
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•   Быстро и легко добавьте буквы на экран через 
текущие настройки или свойства элемента. См. До-
бавить буквы в образец. 

•   Для этого просто нужно настроить базовые ли-
нии, форматирование, интервалы и цвета. См. Ос-
новы надписи. 

•   Попробуйте вышить проект. Проверьте качество 
стежков. Имейте ввиду, что разные алфавиты лучше 
вышивать разным размером. См. Примеры алфави-
тов. 

Создать более сложную надпись

Набив руку, можно переходить к следующему этапу 
– монограммы, затейливые надписи, Оригинальные 
скрипты, поднятие букв инструментом trapunto и 
эффект ‘эластичные буквы’. Возможности бесконеч-
ны. Вы также приобретете опыт работы с машиной 
BERNINA. 

Монограммы

ПО BERNINA Embroidery Software делает создание 
монограмм достаточно простым с



Монограммы
ПО BERNINA Embroidery Software делает создание 
монограмм достаточно простым с инструментом 
‘все в одном’, выключающим буквы, орнаменты и/
или до 4 концентрических контуров монограммы. 
См. Монограммы.

Необычные шрифты
BERNINA Embroidery Software включает в себя ряд 
модные шрифтов, такие как Creative Cross и Secret
Garden-Caps. Эти шрифты включают множество цве-
тов и миниатюрные конструкции. Смотреть Добав-
ление необычных надписей для деталей.

Оригинальный скрипт – это особый фон, позволяю-
щий добавлять декоративные элементы в конце тек-
ста, имитируя разные почерки. См. Добавить скрип-
ты к буквам. 

Надписи с различными эффектами стежка
Объекты надписи заполнены атласной строчкой 
по умолчанию. Можно использовать и другие типы 
строчки – Шаговая или Причудливая, также как с 
проектами вышивок. См. Применение различных ти-
пов строчек и эффектов Надписи.  

Глава 3. ПРИСТУПАЯ К РАБОТЕ

BERNINA® Embroidery Software: Руководство по работе с программами 16

Эластичные буквы
Примените эффект ‘эластичные буквы’ и сделайте 
надпись выпуклой, округлой, растянутой или сжа-
той. См. Эффект ‘эластичные буквы’ .

Подсказка
Не забудьте изучить примеры образцов, включенных 
в пакет BERNINA Embroidery Software.

Адаптировать проект

Адаптирование проекта – одно из самых распро-
страненных действий. Иногда нужно создать проект 
из картинки, но чаще необходимо переделать су-
ществующий. Мы уже умеем изменять размер, цвет и 
тип ткани. Теперь перейдем к более детальным из-
менениям – изменению формы, перемещению, ком-
бинированию, дублированию, изменению порядка 
элементов, изменению типа стежков, эффектов и т.д.

Граница вышивается 
первой -1,2,3 и т.д.

Орнамент выши-
вается следующим

Текст вышивается 
последним



Комбинирование 
На комбинировании элементов можно хорошо по-
нять, как меняется размер и положение, угол накло-
на, секвентируются элементы и удаляются основные 
швы. См. Комбинирование объектов.

Изменение элементов 
В зависимости от типа проекта ПО BERNINA 
Embroidery Software имеет инструмены дублирова-
ния, вращения и зеркального отражения элементов, 
позволяющие создать эффект калейдоскопа и т.д.. 
См. Зеркальное отражение. 

Изменение формы
Изменять форму можно при любых других операци-
ях от отражения форм до изменения размеров букв. 
В любом случае, размер можно изменить, если до-
ступен инструмент. См. Изменение формы и редак-
тирование элементов.
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художественные эффекты стежка
Не займет много времени пока стандартное напол-
нение и контуры Вам наскучат и захочется попробо-
вать некоторые из множества художественных типов  
стежков и эффектов предоставляемых BERNINA
Embroidery Software. См. также художественные эф-
фекты стежка.    

Подсказка
Не забудьте изучить примеры образцов, включенных 
в пакет BERNINA Embroidery Software.

Создать вышивку автоматически

От работы с готовыми проектами переходим к соз-
данию своих собственных. Самый быстрый спо-
соб – использовать автоматические технологии ПО 
BERNINA Embroidery Software. И хотя этот способ не-
сколько ограничен в своих возможностях, он позво-
ляет создать прототипы проектов просто, и вполне 
достаточен на данном этапе. 



Преобразование вектора картинки

Специальные инструменты ПО BERNINA Embroidery 
Software автоматически конвертируют векторные 
объекты и текст в вышивку или текстовый проект. Их 
уже можно при необходимости изменять. См. Оциф-
ровка векторной графики.

Подсказка
Начните с клипартов CorelDRAW®. Многие из них 
могут быть использованы как вышивка.

Преобразование рисунка с носителя

Инструмент Magic Wand (волшебная палочка) авто-
матически конвертирует рисунок с цифрового но-
сителя. Расширение этой технологии, Auto Digitizer 
(автодигитайзер), распознает формы и определяет 
наиболее подходящий тип стежка. См. Автодигити-
рование Волшебной палочкой (Magic Wand) и Авто-
дигитайзером (Auto Digitizer) в Руководстве пользо-
вателя.
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Конвертирование фотографий
Это делает PhotoSnap. См. Автодигитирование  
PhotoSnap.

Подсказка
Изучите готовые образцы ПО BERNINA Embroidery 
Software. Потренируйтесь на них и попробуйте вышить. 

Создание вышивки с нуля

Вы уже освоили технологию на 90%. Теперь необхо-
димо освоить «черную магию» ручной оцифровки. 
Начнем с простого:

Начните с хорошей картинки
Чтобы вышивка получилась качественной, картинка 
должна соответствовать определенным требовани-
ям. В начале не используйте сложных картинок.

Не цифровое изображение надо отсканировать. Это 
делается при помощи CorelDRAW® , включенного в 
ПО BERNINA Embroidery Software. Возможные источ-
ники:

•   Книги 

•   Клипарт из интернета или с CD  

•   Детский рисунок 

•   Ваш рисунок. 

Помните, что лучше начать с клипартов CorelDRAW®. 
Многие из них могут быть адаптированы под ‘циф-
ровой фон’.

Картинка отсканиро-
вана в формате RGB

Картинка отсканиро-
вана в формате 256 
цветов



Подготовка картинки
Перед оцифровкой надо тщательно продумать 
формы и последовательности швов. Формы должны 
быть четкими, чтобы их было легко вышивать. Про-
стейшие формы схожи по ширине, не имеют острых 
углов и мелких выступающих деталей. См. Оциф-
ровка фонов. 

Оцифровка проекта
ПО BERNINA Embroidery Software строит проект из 
базовых форм или ‘элементов вышивки’. Процесс 
создания элементов вышивки на экране называется 
оцифровкой.

Как и при создании проекта в графических при-
ложениях, оцифровка задействует различные ин-
струменты и методы. Они используются в сочетании 
с типами строчек разных элементов. См. Методы 
оцифровки.

Выбор типа стежка
Для каждой формы выберите тип стежка. ПО BERNINA 
Embroidery Software позволяет менять их на любом 
этапе. См. Стежки заливки и контура.
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Последовательность элементов
Последовательность элементов – порядок, в котором 
они были созданы и, следовательно, будут вышиты. 
Для улучшения вышивки можно менять последова-
тельность, например, чтобы минимизировать изме-
нение цветов, детали вышиваются в последнюю оче-
редь. См. Последовательность элементов вышивки. 

Улучшить качество стежка
Это приходит с опытом. ПО BERNINA Embroidery 
Software автоматизирует многие детали качества, 
например группировку швов, Эффект двукратности 
и стабильность вышивки. Эти важные настройки за-
висят от типа ткани. См. Настройка параметров тка-
ни.

Упростите контур до 
или после оцифровки

1

2

3

меняется 6 цветов

меняется 4 цвета



      Средняя ткань                        Тжелая ткань

После можно поиграть с другими факторами, на-
пример с тиром подкладки. См. Стабилизация под-
кладкой. 

Другая настройка по умолчанию, которая может 
пригодиться – компенсация растяжения ткани.  См. 
Компенсация растяжения ткани.

Специальные функции вышивки

ПО BERNINA Embroidery Software предлагает множе-
ство типов и эффектов строчки. Многие из них Вам 
уже знакомы.

Вышивка от руки
Некоторые типы, такие как Вышивка от руки, не мо-
гут применяться к готовым образцам и должны быть 
оцифрованы с нуля. Эта техника позволит Вам соз-
дать проект, схожий с ручной работой, чего сложно 
добиться при цифровом конвертировании.
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Цель функции в имитации движения руки. Разница 
в том, что ткань в пяльцах закреплена так, что Вы 
можете точно перенести рисунок с экрана на ткань. 
См. Создание вышивки от руки.

Шаблоны, контуры и заливки
Шаблон – готовый элемент – сердечко, листок или 
пограничные шаблоны, которые могут быть быстро 
вставлены в проект. Обычно он состоит из 1 или бо-
лее элементов, и храниться в наборе шаблонов. Ис-
пользуются для шаблонной заливки или шаблонно-
го контура, или как самостоятельные элементы. См. 
Шаблоны, контуры, заливки.

Искусные стежки контуров и заливки
ПО BERNINA Embroidery Software предоставляет ряд 
стежков для имитации традиционных вещей ручной 
работы, включая черно-белую вышивку и «восковую 
гладь», подходящие и для заливки и для контуров. 
См. Искусные стежки и заливки.

Зигзаг подложка

Компенсация 
растяжения

Оцифрованный
контур

Высчитанный-
контур

Гуляющий край-
подкладка



Аппликации
Аппликации – важная часть создания проектов «от 
руки», а функция Аппликация дает возможность вы-
полнить эту работу легко и качественно. Использу-
ется для создания закрытых швов аппликаций. См. 
Оцифровка аппликаций. 

Вышивка крестом
Вышивка крестом удобна при заполнении большого 
объема при малом расходе нити. Также часто ис-
пользуется для границ и контуров. Подходит для 
домашней утвари, столового текстиля и выполнения 
народных мотивов. Иногда комбинируется с аппли-
кацией. Приложение BERNINA Cross Stitch (вышивка 
крестом) позволяет создавать отдельные вышивки 
крестом или добавлять элементы к другим вышив-
кам. См. Дополнение BERNINA Cross Stitch.

Квилтинг
Техника пэтчворк очень популярна при созда-
нии проектов, требующих соединения элементов. 
BERNINA Quilter (Квилтер) поможет создавать про-
екты как по готовым, так и по Вашим образцам. 
BERNINA Quilter дает возможность экспериментиро-
вать с элементами и цветами и создавать прекрасные 
уникальные вещи. См. Дополнение BERNINA Quilter.

Глава 3. ПРИСТУПАЯ К РАБОТЕ
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Пуговичные петли
ПО BERNINA Embroidery Software позволяет делать 
отдельные петли или целые ряды. Можно варьиро-
вать размер и вписывать их в проект. См. Создание 
пуговичных петель.

Мультиузор
При помощи CorelDRAW® ПО BERNINA Embroidery 
Software поддерживает мульти-проекты средних 
размеров. Одна из распространенных техник – со-
четание оцифрованного принта с вышивкой. Такой 
проект включает и принтирование, и вышивку эле-
ментов.

Как правило копировальную бумагу используют для 
обычного цветного принтера. Картинка перево-
диться на ткань, затем проглаживается вместе с из-
делием. Проверьте доступные функции и выберите 
подходящую.



Объемная вышивка
На следуюзем жтапе мы предлагаем «поднять» вы-
шивку за рамки ткани и создать «скульптурную ком-
позицию». ПО BERNINA Embroidery Software распо-
лагает несколькими хорошими методами легкого и 
доступного выполнения такой работы. См. Объем-
ная вышивка. 

Приятной работы!

Приятной работы с машиной BERNINA  и ПО BERNINA 
Embroidery Software. С нашим оборудованием у Вас 
есть все необходимое для создания полностью про-
фессиональной и высококачественной вышивки. 
Единственное, чего Вам теперь не хватает – мощ-
ностей для массового производства!
Помните, Москва не сразу строилась. Нужно полу-
чить некоторый опыт для получения превосходного 
результата во всех имеющихся техниках. Но резуль-
тат превзойдет Ваши ожидания от времени, потра-
ченного на освоение искусства вышивки.
Не забывайте использовать встроенные проекты и 
клипарты. Если сомневаетесь, вернитесь к самому 
началу. А когда захотите усовершенствовать и рас-
ширить свой репертуар, тщательно изучите то, как 
сделаны встроенные образцы.
В качестве последнего напутствия: прежде, чем вы-
шивать проект на изделии, попробуйте его на «чер-
новике». Это выявит проблемные моменты Ваших 
проектов.

Всего наилучшего. Приятной работы!
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Для начала работы с ПО BERNINA 
Embroidery Software необходимо 
знать основные процедуры – за-
пуск, открытие и создание проектов 
и сохранение. При пользовании ПО 
BERNINA Embroidery Software зада-
ния даются через командную строку, 
иконки, диалоговые окна. Команды 
выбираются по тому же принципу, 
что и в приложениях MS Windows®  – 
из меню или строки инструментов.

ПО BERNINA Embroidery Software 
поддерживает ряд файлов формата ART, как и некоторые другие форматы вышив-
ки, получаемые с жесткого диска,  USB карт или CD-ROM. ПО BERNINA Embroidery 
Software дает Вам широкий выбор промышленных пялец. Направляющие помогут 
Вам точно выровнять и измерить элементы вышивки. Самое важное диалоговое 
окно в ПО BERNINA Embroidery Software  - Object Properties (окно Свойства Эле-
мента). Это окно и окно Effects (Эффекты) - ‘не всплывающие’, т.е. они остаются 
на экране столько, сколько они Вам нужны.

Примечание
Данная часть описывает, как запустить ПО BERNINA Embroidery Software и исполь-
зовать имеющиеся команды и инструменты. Она описывает как открыть, создать 
и сохранить проект, объясняет как активировать пяльцы и сети и как пользоваться 
свойствами объектов.

Глава 4
Основные процедуры 

Интерфейс ПО BERNINA Embroidery Software 
ПО BERNINA Embroidery Software интегрировано с 
программой CorelDRAW® Essentials X6 в одно прило-
жение, позволяя пользователям создавать не только 
вышивки, но и настоящие мультимедийные проекты. 
Приложение имеет единое рабочее пространство 
(«окно проекта») но работать с ним можно в раз-
ных режимах: Artwork Canvas («холст для картин») 
и Embroidery Canvas («холст для вышивок»). Третий 
режим, Hoop Canvas, («холст в пяльцах») предна-
значен для больших проектов со сменой пялец.

Начало работы с ПО BERNINA Embroidery 
Software

Программа BERNINA Embroidery Software открывает-
ся с помощью иконки на рабочем столе или через 
мерю MS Windows® Start («Пуск»). По умолчанию от-
крывается режим Embroidery Canvas. В этом режиме 
можно создавать и менять элементы вышивок, ис-
пользуя различные средства оцифровки.

Для начала работы с BERNINA Embroidery Software
• Кликните два раза по иконке BERNINA Embroidery
Software на рабочем столе MS Windows® или найди-
те эту программу в меню Windows Start > Programs. 
BERNINA Embroidery Software открывается в режиме 
Embroidery Canvas с нового, пока пустого проекта. 
Скриншот на следующей странице показывает вид 
экрана со всеми панелями инструментов для про-
граммы BERNINA® Embroidery Designer Plus, запу-
скаемой двойным щелчком мыши. В зависимости от 
уровня Вашего продукта, Вы можете иметь доступ ко 
всем или не ко всем из представленных функций.

Дважды щелкните, чтобы начать работу 
с BERNINA® Embroidery Software.



•    Настройте окно, проявив или скрыв сетку, изме-
нив ее размер, и также проявив или спрятав  панель 
инструментов. См. Вывод сетки на экран. 
•    Закрепите или переместите панель инструментов 
в любом удобном виде. 
Панели инструментов крепятся вверху, внизу, спра-
ва и слева и могут быть перенесены в люьое место в 
окне. Цветовая палитра и панель стежков для удоб-
ства могут быть закреплены вертикально. См. Кра-
ткое руководство ПО BERNINA Embroidery Software.

Закрепление окна
ПО BERNINA Embroidery Software имеет ключевые за-
крепленные окна. холст вышивки имеет окна: Цвет-
ная пленка, Резные штампы, Морфинг эффекты, 
StumpWork, и также  Окно Обзора.
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Все окна крепятся на правой стороне. 

Для увеличения рабочего пространства докеры мо-
гут быть вложениями. В таком случае сбоку появля-
ются кнопки для каждого из них. Все они могут быть 
зафиксированы или свернуты. Если навести мышку 
на вкладку, докер «выпадает» и может быть исполь-
зован. Потом он автоматически сворачивается. Их 
также можно перетаскивать, удерживая мышкой или 
кликнув по ним два раза в рабочее окно. 

Меню заголовка

Цветовая палитра

Рабочее окно

Строка
состоянияния

Строка меню
Инструменты

Панель холста

Панель
инструментов 

Инструменты 
увеличения

Инструменты 
трансформации

Панель
исправления 

стежка

Общая
панель

инструментов

Вложенные докеры



Ниже приведен скан рабочего пространства  Artwork 
Canvas, доступного через панель инструментов Canvas. 
Этот режим позволяет создавать и менять векторную 
графику с помощью нвбора инструментов CorelDRAW® 
Essentials X6, который предлагает множество сложных 
методов обработки форм и контуров на экране.

В дополнение к наборй инструментов CorelDRAW® 
Essentials X6, Artwork Canvas дает возможность кон-
вертировать вектора и векторный текст напрямую в 
элементы вышивки. Векторная графика или текст, 
конвертированные в Artwork Canvas могут быть на-
прямую преобразованы в проект вышивки. Можно 
копировать или вставлять сторонние вектора (напри-
мер, клипарты) через Artwork Canvas и использовать 
их в проектах. Или вставьте, скопируйте или отскань-
те картинку с цифрового носителя, чтобы оцифро-
вать шаблон или фон. 

Примечание
Подробности о CorelDRAW® Essentials X6 в элек-
тронном руководстве пользователя, доступном в 
Windows Start (Пуск) > Programs (Программы). Или 
воспользуйтесь экранным меню Help (помощь) в ре-
жиме Graphics (графика).

Полотно вышивки

Ниже приведен принтскрин рабочего пространства 
Embroidery Canvas (Полотно вышивки), доступного 
через панель инструментов Canvas (холст). Этот ре-
жим позволяет создавать и редактировать вышивку 
объектов с испольхованием инструментов оциф-
ровки. Настройте последовательность и положе-
ние пялец, а также интерфейс BERNINA Embroidery 
Software. См. раздел Заправка в пяльцы крупных 
проектов.

Глава 4. ОСНОВНыЕ ПРОЦЕДУРы

Строка состояния
Строка состояния внизу холста Вышивки окна про-
екта дает непрерывное отображение текущего со-
стояния позиции курсора и инструкции для исполь-
зования выбранных документов.

Отображаемая информация:
•  Подсказка: помогает в работе с выбранными функциями 
•  Размер проекта – ширина и высота 
•  Координаты текущей позиции иглы (X/Y) и длинна (L) и  
угол (A) текущего стежка. См. Измерение расстояния на экране. 
•  Кол-во стежков: общее количество стежков в проекте 
•  Текущая ткань: настройки ткани с учетом типа так-
ни. См. Настройка параметров ткани. 
•  Тип файла: указывает ART формат проекта – ПО 
BERNINA Embroidery Software по умолчанию поддержива-
ет формат ART четырех уровней в зависимости от  того, 
как был создан проект. См. Форматы файлов вышивки. 

Режимы работы

ПО BERNINA Embroidery Software имеет одно рабо-
чее пространство или ‘окно проекта’, но оно может 
работать в разных режимах или «полотнах». Выби-
рается в панели инструментов Canvas (холст).

Режим Artwork Canvas (Полотно холста)
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Датчики положения:X,Y,L и A 

Ширина и высота проектаПодсказка

В режиме Artwork Canvas (Полотно картины), 
нажмите Canvas (холсты)> Show Embroidery 
(показать вышивку), чтобы показать или 
спрятать любые элементы вышивки. 
Исмпользуйте Canvas > Artwork Canvas, что-
бы вставить, изменить или создать вектор-
ный рисунок как фон для цифровой вышивки  
вручную или автоматически.

Canvas > Embroidery Canvas - оцифровка и 
редактирование вышивки. Просмотрите вы-
шивку так же, как картину. Можно просмо-
треть в реалистичном режиме 3D. 

Количество стежков Тип файла

Текущая ткань



Работа с файлами проектов

ПО BERNINA Embroidery Software сохраняет файлы в 
формате ‘ART’ по умолчанию. Данный формат со-
держит информацию и о вышивке и о дальнейших 
изменениях. ПО BERNINA Embroidery Software также 
поддерживает и другие форматы, открываемые с 
жесткого диска, USB носителей или CD-ROM. Файлы 
можно сохранять и в формате ART, и в других фор-
матах. См. Чтение и написание файлов проектов.

Внимание!
Невозможно открыть файл ART, если он создан в 
последующей версии ПО. При попытке это сделать, 
система запросит обновления к текущей версии.

Открыть проект

ПО BERNINA Embroidery Software, помимо формата 
ART, открывает ряд форматов вышивок. Проекты в 
ART делятся на 4 группы в зависимости от способа 
создания файла. См. Запуск ПО BERNINA Embroidery 
Software.

Примечание
Проекты автоматически группируются при открытии 
или вставке новой конструкции по умолчанию. 

Используйте этот режим при необходимости созда-
ния вышивки из оцифрованных фонов. В ПО BERNINA 
Embroidery Software могут быть загружены многие 
типы файлов. См. Оцифровка фонов.
Embroidery Canvas (Полотно вышивки) также предо-
ставляет графическое изображение конечного ре-
зультата вышивки. Show Artistic View (подробный 
предпросмотр) вместе с фоновой тканью дают воз-
можность увидеть как будет выглядеть на выходе. 

холст пялец

Ниже приведен скрин рабочего пространства Hoop 
Canvas, доступный через панель инструментов  
Canvas. Если вышивка слишком большая или отдель-
ные элементы не помешаются на поверхности, раз-
бейте ее на несколько пялец. Что означает возмож-
ность создавать проекты превышающие площадь 
одних пялец. Hoop Canvas позволяет настроить по-
ложение и последовательность каждых пялец.

Canvas (холсты) > Hoop Canvas (холст пялец) 
- просмотр и редактирования мультипялец. 
Если вышивка слишком большая или отдель-
ные элементы не помешаются на поверхно-
сти, разбейте ее на несколько пялец.

General (Основное) > Open (открыть) - 
открыть существующий проект. 
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Как открыть проект
1   Кликните иконку Open (открыть).
Откроется диалоговое окно Open.

2   Выберите папку из списка. Также можно считы-
вать проекты с USB носителей или CD-ROM.
3   Если файл не в формате ART, из списка форматов 
выберите нужный. См. Чтение и написание проектов.
4   Выберите один или несколько проектов.

•   Удерживая кнопку Shift, выделите диапазон фай-
лов. 
•   Чтобы выбрать насколько файлов, удерживайте Ctrl. 
5   Установите флажок Preview (предпросмотр) для 
предварительного просмотра дизайна (для под-
держиваемых форматов файлов). Здесь показаны 
строчки и номера цветов, высота и ширина проекта, 
номер версии ПО.
6   Нажмите Open (открыть).

Примечание
При первом открытии  файла в ПО BERNINA 
Embroidery Software он будет группирован по умол-
чанию. См. Группировка и разгруппировка элементов.

7   Проверьте размеры проекта в Строке состояния. 
См. Строка состояния.
8   Настройте zoom и другие функции. См. Просмотр 
проекта.

Примечание
Также можно читать проекты с памяти машины или 
карты памяти BERNINA. См. Чтение и написание фай-
лов проектов.

Запустить проект

При создании файла, настройки шаблона копируют-
ся в новый проект. Шаблоны содержат предустанов-
ленные стили, по умолчанию, или элементы, чтобы 
сделать оцифровку быстрее и проще. Есть возмож-
ность выбора базовых настроек шаблона и настроек 
ткани. Дополнительно выберите фон образца ткани 
для оптимизации настроек. См. Свойства элемента и 
шаблоны.

Чтобы начать проект
1   Нажмите иконку New. В рабочем окне откроется 
пустой проект с установками по умолчанию.
2   Для использования настроек нажмите File (файл) 
> New (новое) в Шаблоне.

3   Выберите шаблон их списка и кликните OK. См. 
Свойства элемента и шаблоны. При первом запуске 
домтупен только шаблон по умолчанию. 
4   Дополнительно выберите тип ткани из выпадаю-
щего списка. Настройки тканей – это часть настро-
ек шаблона, тонко подобранных доя разных типов 
тканей. Приавтоматическом выборе подходящей 
ткани, свойства объекта автоматически подстраива-
ются под выбранную ткань. См. также Настройки для 
тканей.
5   Дополнительно выберите фон образца ткани для 
оптимизации настроек.
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Проект формата ART 

Выбор шаблон

Выбор ткани

Установить цвет 
фона и образец 
ткани

General (основное) > New (новое) – 
создание нового пустого проекта



Пяльцы, сетки и линейки

Ткань должна быть хорошо натянут на пяльцы до 
запуска работы машины. ПО BERNINA Embroidery 
Software предоставляет большой выбор промыш-
ленных пялец. Линии сетки помогут выровнять и из-
мерить элементы вышивки.

Показать пяльца

При создании каждого нового проекта в рабочем 
окне по умолчанию появляются пяльцы. Положение 
пялец автоматически меняется в Месте с изменени-
ем проекта так, чтобы они всегда находились строго 
вокруг центра проекта. См. Поместить проект в пяль-
цы. 

Для отображения пялец

•   Нажмите иконку Show Hoop (показать пяльцы) – 
откроется экран пялец. 

•   Снова нажмите иконку Show Hoop - экран закроется. 

Показать сетку

Выравнивайте элементы вышивки по линиям сетки. 
Ее можно спрятать или вывести на экран.

Подсказка
Можно выбрать шаг сетки, точку отсчета и вклютьчи/
выключить привязку к сетке в настройках. 

Сохранить проект

Проекты ПО BERNINA Embroidery Software могут быть 
сохранены в чистом формате ART или в других фор-
матах. При сохранении файл получает имя, место и 
формат и обновляется при каждом изменении. Если 
существующий проект сохранить под другим име-
нем, в другом месте или формате, получится его ко-
пия. См. Чтение и написание Файлов проектов. 

Подсказка
Сохраняйте проект как можно чаще. Не ждите окон-
чания работы. Еслы Вы хотите сохранить измене-
ния в проекте и оставить предыдущую его версию, 
нажмите Save As (сохранить как). При нажатии на 
кнопку Save при работе с уже сохраненным проек-
том, он будет обновляться. 

Чтобы сохранить проект
1   Нажатием на иконку Save (сохранить). Если Вы 
сохраняете проект впервые, откроется окно Save As 
(сохранить как). 

2   Выберите папку из списка  Save In (сохранить в). 
3   В строке File name (имя файла) укадите имя. 
4   В списке Save as type (тип файла) выберите фор-
мат. См. Поддерживаемые форматы вышивок. 

Примечание
Проекты также можно записывать на карту памяти 
BERNINA или на машину. Если у Вас установлен Magic 
Box, можно записывать и на другие носители. См. 
Чтение и написание Файлов проектов.
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Папка, содержащая проект

General > Save (сохранить) – сохранение те-
кущего проекта

View (просмотр) > Show Hoop (показать пяль-
цы) – показать или спрятать пяльцы. Кликните 
правой кнопкой мыши для получения настроек. 

Нажмите View > Show Grid (показать сеть) –  сеть 
будет показана или спрятана. Настройки –  клик-
ните правой кнопкой мыши. 

Имя проекта

Список форматов



Вывод линеек и направляющих на экран

•  Нажмите иконку Show Rulers & Guides или  Ctrl+R. 

•  Переустановите точку 0, нажав и потянув квадрат 
в левом верхнем углу. 
•  Чтобы создать направляющую, нажмите либо на 
вертикальную, либо на горизонтальную линейку и 
перетяните ее в нудное место. Можно создать или 
удалить множество направляющих. 
•  Дважды щелкните желтую ручку для более точно-
го размещения направляющей. В окне Guide Position 
(положение направляющей), введите желаемое рас-
стояние от точки 0 и нажмите OK. 

•  Направляющая удаляется при перетягивании жел-
той ручки из окна проекта. 

Вывести сеть на экран
•  Нажмите иконку Show Grid (показать сетку)- вклю-
чение

•   Снова нажмите иконку Show Grid - выключение. 

Показать линейки и направляющие

ПО позволяет включать и выключать линейки для 
более точной оцифровки. Так можно более точно 
выровнять и измерить элементы и весь проект. Еди-
ница измерения - – мм или дюймы – установлены по 
умолчанию в зависимости от региона регистрации 
MS Windows® Control Panel. Но они могут быть из-
менены в самом ПО. См. Установка единицы изме-
рения.
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View > Show Rulers & Guides (показать ли-
нейки и направляющие) – вывести или спря-
тать линейки и направляющие.   
Настройки – правая кнопка мыши.
Чтобы переустановить отсчетную точку ли-
нейки потяните за нее.

Нажать и по-
тянуть для 

переустановки 
нулевой точки

Нажать и пере-
тащить, чтобы 
изменить на-
правляющие

Нажать на 
линейку, чтобы 
создать новую 

направляющую

Перетянуть на-
правляющую с 

линейки, чтобы 
ее убрать 

Введите 
положение 



Подсказка
Длинна и угол также появятся в подсказке, если она 
активирована. 

4   Нажмите Esc - закончить.

Установка единицы измерения
При первом использовании ПО BERNINA Embroidery 
Software настройки по умолчанию будут зависеть 
от операционной системы. ПО BERNINA Embroidery 
Software позволяет менять настройки без смены ОС.

Доступ к функции
Единицы измерения можно поменять через список, 
выпадающий из Общей панели инструментов:

Примечание
При выборе ‘U.S.’ вы получите локальную систему 
измерения – дюймы, футы и ярды.

Эффекты пульсации
При смене систем измерения элементы тоже бу-
дут изменены, например, панель инструментов 
Transform (трансформировать).

Указание единицы измерения «на лету»
Вместо смены всей системы измерений ПО  BERNINA 
Embroidery Software, можно указать их при введе-
нии. Программа автоматически конвертирует вве-
денные значения в нужную систему мер.

Подсказка
Можно включить или выключить Snap to Grid (при-
вязка к сетке) и Snap to Guide (привязка к направля-
ющей)через окно Options (настройки). 

Измерение расстояний на экране
Расстояние между двумя точками измеряется коман-
дой Measure (измерить). Она отражает координаты, 
расстояние и угол между курсором и центром пялец 
в пустом проекте. Данные видны в строке состояния 
или в окне подсказки. 

Подсказка
Перед измерением увеличьте изображение для по-
лучения более точных данных. Увеличение не влияет 
на работу измерения.

Для измерения расстояния на экране
1 Выберите View(просмотр)> Measure (измерить) или 
нажмите M
2  Нажмите начальную точку
3  Передвиньте курсор в конечную точку и остановите курсор.
В строке состоянии появится следующая информация:
•    Координаты конечной точки (X=, Y=). 
•    Длинна линии (L=). 
•    Угол по отношению к горизонтали (A=). 
Измерения показаны в миллиметрах или дюймах, в 
зависимости от настроек.

Глава 4. ОСНОВНыЕ ПРОЦЕДУРы

BERNINA® Embroidery Software: Руководство по работе с программами 30

Выделите
для привязки

к сетке 

Введите
шаг сетки 

Измерения ото-
бражаются в виде 
всплывающей 
подсказки или в 
строке состояния

Единицы измерения

Выбор показанных 
единиц измерения 



Во многих случаях правая кнопка мыши активиру-
ет настройки текущей команды. Например, левая 
кнопка на Lettering (Буквы) – выбор метода ввода, а 
правая -  Object Properties (свойства элемента). 

Примечание
Свойства элемента можно изменить, как выбрав эле-
мент, так и нет. Первое влияет только на выбранные 
элементы. Второе – на текущие настройки. См. При-
менение и управление свойств элемента.

Отмена и повтор команд

Большинство команд можно отменить. А потом пе-
редумать и повторить их. ПО BERNINA Embroidery 
Software последние несколько команд. 

Для отмены и повтора командуы

Отмена – нажмите иконку Undo (отменить). 

•  Если ПО BERNINA Embroidery Software не может 
больше вспомнить команды, иконка  Undo станет 
серой. 
•  Нажмите иконку Redo (повторить) – повтор отме-
ненной команды. 

Инструменты и панели инструментов

ПО BERNINA Embroidery Software имеет закреплен-
ную слева от проекта панель инструментов. Они 
позволяют быстро отдать команду ПО BERNINA 
Embroidery Software. Панели инструментов можно 
закрепить. То есть их можно перемещать в окне.

Передвинуть или закрепить панель инстру-
ментов

•  Нажмите и тяните панель, чтобы ее переместить:
- Панели крепятся справа, слева, внизу и  вверху;
- Их можно переместить в любую точку окна про-
екта

Если Вы пользуетесь метрической системой, высота 
букв указана в миллиметрах. Просто введите ‘3/4д’ 
или ‘3/4 д’ в поле Lettering Height (высотп букв) и 
она автоматически конвертируется в 19.05мм. Под-
держиваемые единицы: 

•    миллиметры, мм 
•    дюймы, д 
•    футы, фт 
•    ярды, яр 
•    сантиметры, см 
•    метры, м 

Подсказка
ПО BERNINA Embroidery Software позволяет вводить 
единицы в текстовом виде, как на английском, так и 
на языке ОС. 

Использование команд и инструментов

В ПО BERNINA Embroidery Software используются ко-
манды или иконки и диалоговые окна для создания 
задания. В ПО BERNINA Embroidery Software все это 
происходит также как в других приложениях MS 
Windows®  – из меню или панели инструментов. Для 
самых распространенных команд также можно ис-
пользовать сочетания клавиш. См. Сочетания кла-
виш.

Выбор команды с панели инструментов
Панель инструментов – простой и быстрый спо-
соб дать команду ПО BERNINA Embroidery Software 
commands. Для активации команды нажмите на со-
ответствующую кнопку панели. Для получения на-
строек нажмите правой кнопкой мыши.

Для выбора команд с панели инструментов
•   Наведите курсор на иконку и увидите ее имя в подсказке. 
•   Нажмите на иконку, чтобы ее активировать. 
•  Кликните правой кнопкой мыши, чтобы увидеть 
настройки или дополнительные команды. 
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Укажите желаемую
единицу  измерения

General (основное) > Undo (отменить) –
отмена последней команды или нескольких 
команд. 
General > Redo (повторить) - повторить 
отмененную команду. 



•  Кликните на любой элемент в окне дважвы или 
щелкните правой кнопкой мыши любой объект в 
окне проекта.

•  Выберите вкладку с нужным свойством. 
•  Используйте поля, выпадающие списки, переклю-
чатели, флажки и ползунок, чтобы ввести или на-
строить параметры. 
•  Нажмите кнопку Effects (эффекты) – доступ к более 
специализированным свойствам, например, к Под-
кладке, Текстурированному краю, градиентной за-
ливке и т.д.. 

Примечание
Также окно имеет кнопку Properties  (свойства), от-
крывающую окно Object Properties (свойства эле-
мента). Это окно можно закрыть на время работы 
окна эффектов. И наоборот.  

- Чтобы вернуть в исходное положение, дважды 
кликните по названию панели.

Доступ к свойствам элемента

Проекты в ПО BERNINA Embroidery Software состоят 
из ‘элементов вышивки’. Они так называются пото-
му, что они самостоятельны и могут быть изменены 
по отдельности. Каждый элемент обладает своими 
характеристиками или свойствами, например, цве-
том, размером, положением и т.д.. Свойства эле-
мента – самое важное окно в ПО BERNINA Embroidery 
Software. 

Чтобы получить доступ к свойствам объекта
•  Откройте окно Object Properties (свойства элемен-
та) следующим образом: 
  - Нажав иконку Object Properties. 
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General (основное)> Object Properties (свой-
ства элемента) – настройка текущих свойств 
или свойств отдельного элемента. 

General > Effects (Эффекты) – эффекты стеж-
ка в элементе вышивки или общие свойства. 

Toolbox ‘digitize’
toolset

Dockable ‘general’
toolbar



Управление проектом BERNINA Portfolio 
BERNINA Portfolio – удобный способ предпросмотра 
и редактирования проекта. Это приложение чита-
ет данные с жесткого диска, флешки или CD-ROM. 
BERNINA Portfolio читает даже WinZip архивы. Оно 
распознает все форматы, имеющиеся в ПО BERNINA 
Embroidery Software. См. BERNINA Portfolio.

Вышивка крестом с приложением BERNINA 
Cross Stitch
Вышивка крестом удобна для заполнения больших 
пространств при малом расходе нити. Также ис-
пользуется для границ и контуров. Подходит для 
домашней утвари, столового текстиля, детской 
одежды и народных мотивов. Может комбиниро-
ваться с аппликацией. Приложение BERNINA Cross 
Stitch позволяет создавать уникальные проекты вы-
шивки крестом или добавлять элементы к другим 
вышивкам. См. Дополнительные приложения.

Квилтинг с приложением BERNINA Quilter
Вы сможете выполнять квмлты по стандартным об-
разцам или по собственным проектам. Экспери-
ментируйте с красками и заплатками с помощью 
программы BERNINA Quilter и создавайте свои соб-
ственные красивые проекты. См. также раздел До-
полнительные приложения.

Подсказка
В окно Object Properties включены графические под-
сказки, демонстрирующие эффект от изменения на-
строек. Они всплывают при наведении курсора на 
элемент управления. Например, если курсор навести 
на элемент Stitch Spacing (длинна стежка) рядом по-
явится графическое изображение.

•  Примените настройки нажав кнопку Apply (приме-
нить) внизу окна или просто нажав Enter.
- Если выделен один или несколько элементов, изме-
нения будут применены только к ним. 
- Если элемент не выделен, изменения применяются 
к текущим настройкам, т.е. распространяются на все 
новые элементы. 
-Если изменены настройки по ряду вкладок, будет 
применено все, что возможно. 
•  Нажмите кнопку Save to Template (сохранить в ша-
блоне) - для сохранения настроек в текущем шаблоне
Теперь это установки по умолчанию для всех файлов, 
создаваемых на основе данного. См. Управление ша-
блоном проекта.
•  Нажмите кнопку Discard (сброс) или Esc -  отмена 
изменений. 
•  Нажмите OK – закрыть окно и применить изменения.

Запуск вспомогательных приложений

Кроме CorelDRAW®, у ПО BERNINA Embroidery Software, 
есть еще ряд приложений, доступных для Embroidery 
Canvas (полотно вышивки). Их можно открыть через 
Application Launcher в панели инструментов General.

Глава 4. ОСНОВНыЕ ПРОЦЕДУРы

BERNINA® Embroidery Software: Руководство по работе с программами 33

General (основное) > Application Launcher 
(запуск приложений) – запуск приложений 
Portfolio, Cross Stitch и Quilter. 

Доступ к дополнительным 
приложениям



Квилтинг с приложением BERNINA Quilter
Вы сможете выполнять квмлты по стандартным об-
разцам или по собственным проектам. Экспери-
ментируйте с красками и заплатками с помощью 
программы BERNINA Quilter и создавайте свои соб-
ственные красивые проекты. См. также раздел До-
полнительные приложения.
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ПО BERNINA Embroidery Software предоставляет множество вариантов предпросмотра,  
делающих работу с проектом значительно проще. Увеличение выделенной области 
для просмотра деталей или просмотр проекта в реальном масштабе. Настройки экра-
на позволят спрятать или показать отдельные элементы вышивки. И предпросмотр 
проекта в разных цветах и для разных тканей.

При работе с проектом необходимо знать последовательность стежков.  В ПО BERNINA 
Embroidery Softwareее можно проверить «пройдя» шов по стежкам. Также можно ими-
тировать вышивку на экране.
ПО BERNINA Embroidery Software также дает информацию о проектах в различных 
форматах и разными способами. И даже до запуска ПО BERNINA Embroidery Software 
или  проекта Вы можете проверить некоторую информацию о файлах формата ART 
через MSWindows® Explorer. В окне Свойства проектов находится информация о швах. 
Также распечатка проекта содержит реальный размер вышивки, ее картинку, после-
довательность цветов и индивидуальные подсказки.
Данная глава описывает различные режимы предпросмотра ПО BERNINA 
EmbroiderySoftware и их настройки. Она рассказывает о панорамировании и масшта-
бировании и о том, как посмотреть последовательность стежков. Также здесь описано 
выведение на экранеычя изменение подкладок. Глава объясняет, как получить инфор-
мацию о проекте. 

Глава 5
Просмотр проектов вышивок

Настройки просмотра вышивки 

Показать или спрятать элементы можно с помощью 
Embroidery Canvas (холст вышивки) с множеством 
Настроек экрана. Показать или спрятать точки про-
никновения иглы и сами стежки. Или показать/спря-
тать выбранные цвета.

Просмотр элементов вышивки

Нажмите Click View > Show Stitches - чтобы 
показать/скрыть швы вышивки

Нажмите View (просмотр) >Show Connectors 
(показать связи) – показать/спрятать связы-
вающие стежки между элементами.

НажмитеView>Show Needle Points (пока-
зать положение иглы) – показать/спрятать 
игольные точки вышивки строчкой.

НажмитеView>ShowArtisticView (реалистич-
ныйпросмотр) -  показать/спрятать имита-
цию выполненной вышивки.
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•  Для имитации вышивки (ArtisticView), переключите 
соответствующую иконку на вкл. 

Просмотр по цветам
Функция Просмотр по цветам View by Color позволя-
ет изолировать элементы при редактировании. Это 
удобно, если нужно изменить элементы определен-
ного цвета.

Примечание
Перед просмотром по цветам проект надо разгруп-
пировать.

Для просмотра по цветам
1   Создайте или откройте проект

2   Выберите View (просмотр)>View by Color (про-
смотр по цветам). Откроется окно View by Color 
(просмотр по цветам). 

3   Выберите нужный цвет. 
•  Удерживайте Shift,чтобы выбрать несколько цветов. 
•  Удерживайте Ctrl, чтобы выбрать разноцветные эле-
менты.

А процессе работы можно спрятать или показать 
швы и контуры элементов. Например, спрятать швы,  
чтобы получить более четкие контуры при измене-
нии формы. 

Примечание
Проверьте экран, чтобы убедиться, что проект в ре-
жиме Artistic View (имитация вышивки) виден кор-
ректно. См. Проверка экрана.

Для просмотра элементов вышивки
•  Нажмите Show Stitches (показать швы) – вкл/выкл 
швов

•  Нажмите Show Connectors (показать связи) – вкл/
выкл связи. 

•  Нажмите Needle Points (положение иглы)  - вкл/выкл 
положения иглы

Швы показаны Швы отключены

Связи показаны

Положение  иглы вкл.



Глава 5. ПРОСМОТР ПРОЕКТОВ ВыШИВОК

BERNINA® Embroidery Software: Руководство по работе с программами 37

2   Для изменения масштаба нажмите кнопку Zoom 
и растяните выделяющую рамку вокруг нужной об-
ласти

3   Для панорамного просмотра проекта поместите 
курсор внутри выделенной рамки (он поменяет вид 
на 4-х стороннюю стрелку). Далее можно его тянуть 
и отпускать.

4   Нажмите OK.
В окне просмотре (OverviewWindow) будут только те 
элементы, которые соответствуют заданным параме-
трам.

5   Просмотр всего проекта - All Colors (все цвета).
6   Нажмите OK.

Подсказка
Функция Color Film (цветной фильм) тоже позволя-
ет  редактировать элементы. См. Просмотр и выбор 
цветовых блоков. 

Масштабирование и панорамирование

Функции Overview Window (окно обзора) и Zoom 
(увеличение) быстро показывают проект под раз-
личными степенями увеличения.

Подсказка
Status Bar (строка состояния) отражает текущее уве-
личение. 
 

Просмотр проекта в обзоре

Overview Window дает возможность рассмотреть 
мелкие детали. Окно обновляется при каждом из-
менении и может использоваться для увеличения 
отдельных элементов или для панорамного обзора 
всего проекта.

Для панорамного просмотра проекта
1   Нажмите иконку Overview Window

Выбрано два цвета

Нажмите General> Overview Window (окно 
обзора) > показать/спрятать докеры. Ис-
пользуется для увеличения и панорамиро-
вания миниатюрных деталей. 

Потяните и отпу-
стите нужную об-
ласть для измене-

ния масштаба

Нажмите, чтобы 
активировать мас-
штабирование окна

Перетащите 
область мас-

штабирования 
для панорами-

рования
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•  Нажмите и перетащите область выделения вокруг 
области масштабирования и отпустите. 

• Чтобы увидеть проект в нужном увеличении, вве-
дите значение в процентах в поле Zoom Factor и  на-
жмите Enter.
Или нажмите клавишу F. Введите значение как соот-
ношение и нажмите OK.

• При помощи полос прокрутки перемещайтесь по 
проекту. Или выберите Pan, или нажмите клавишу P 
и воспользуйтесь инструментом ‘grabbinghand’ (за-
хват). Нажмите и удерживайте окно проекта – пано-
рамный просмотр. 

Увеличение/уменьшение

Увеличивайте или уменьшайте отдельные швы или 
делали, и в окне будут появляться разные области 
проекта. См. Сочетание клавиш.

Примечание
Проверьте экран и убедитесь, что детали показаны-
корректно. См. Проверка экрана.

Для увеличения и уменьшения
•  Нажмите иконку Zoom или клавишу B. Курсор пре-
вратиться в лупу. 
•  Левая кнопка мыши – увеличение, правая - умень-
шение. 

Подсказка
Поле Zoom Factor (увеличение) соответственно об-
новится. 

НажмитеZoom (увеличить)> левойкнопкой 
Zoom – увеличить, правой – уменьшить, или-
перетащите ‘окно увеличения’. 

НажмитеZoom> PantoDrag (панорама или 
перетаскивание) – просмотр проекта на 
большом увеличении. 

Zoom>ZoomFactor (увеличение) – вы-
борстепениввыпадающемокнеилик-
нопку в собственной шкале и нажмите 
Enter. 

Нажмите и перетащите

Введите масштаб

Нажмите и 
удерживайте 
окно проекта
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Для просмотра проекта по частям
•  Убедитесь, что включена функция Show Stitches  
(показатьшвы), а функция Artistic View (художе-
ственный просмотр) отключена. 

•  Нажмите Esc и убедитесь, что Select Object (выбор 
элемента) отключен.
Положение иглы отражается большим белым кре-
стом или маркером положения иглы. Первоначаль-
но она располагается в конце проекта. В Status Bar  
(строка состояния) отражается текущий номер стежка. 

•  Нажмите кнопку Home (домой), чтобы оказаться в 
начале проекта. Белы крест перейдет на первый сте-
жок, а весь проект станет черным. По мере работы 
крест перемещается по шву.

•  Нажмите Ctrl+T – переход к следующему элементу. 
•  Shift+T – переход к предыдущему элементу. 
•  Page Down – переход к следующему цвету.

•  Page Up – переход к предыдущему цвету. 

•  Или выберите View (просмотр) >Zoom (увеличе-
ние) – доступ к большему количеству опций. 

•  Выберите Zoom>Zoom to Fit (размер экрана)  - 
просмотр всего проекта. Или нажмите клавишу 
0 (ноль).
•  Zoom>Zoom 1:1 – просмотр реального размера 
проекта. Или нажмите 1. См.Проверка экрана. 
•  Нажмите Esc, Enter или Spacebar (пробел)  - выход 
из режима Zoom. 

Подсказка
AutoScroll (автопрокрутка)  - прокручивает проект 
автоматически при работе. Это может быть удобнее 
панорамы, увеличения или полос прокрутки. 

Просмотр последовательности стежков

При работе с проектом необходимо понимать по-
следовательность стежков. Это можно выяснить, 
просмотрев стежки, цвета или элементы. Также 
можно имитировать готовую вышивку на экране. ПО 
BERNINA Embroidery Software имитирует вышивку, 
меняя цвет швов с черного на реально заданный.  
См. Просмотр и выбор цветовых блоков.

Просмотр проекта по частям

Исследуйте проект по цветовым блокам или элемен-
там при помощи клавиатуры. Стрелками можно пе-
редвигаться по швам – одно нажатие – один стежок. 
См. Сочетание кавиш.

Нажмите View (просмотр)>ShowArtisticView 
(художественныпросмотр) – показать/спря-
тать имитацию вышивки. 
Нажмите View>Show Stitches (показать швы) – 
показать/спрятать швы.

Дополнительные 
параметры масшта-
бирования

Белый крест - текущее по-
ложение иглы

Белый крест - текущее
положение иглы

Конечная точка

Конечная точка



•  Для перемещения по стежкам используйте клави-
атуру.

- Правая и левая стрелки – перемещение на 1  сте-
жок вперед или назад.
- Стрелки вверх и вниз – перемещение на 10 стеж-
ков вперед или назад.
-  Нажмите +или- - перемещение на 100 стежков.

•  Нажмите End – перемещение в конец проекта.

Подсказка
Нажмите C, если вывышли за пределы видимой зоны, 
и изображение оцентрируется на текущем стежке.

Имитация вышивки

Slow Redraw – важный инструмент ПО BERNINA 
Embroidery Software. Он позволяет имитировать 
проект на экране. Slow Redraw имитирует действия 
машины, и дает Вам возможность оптимизировать 
проект.
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Моделирование вышивки проекта
•  Выберите режим просмотра проекта.
Slow Redraw можно использовать и в Artistic View и в  
стандартном режиме.
•  Выберите View (просмотр)> Slow Redraw или на-
жмите Shift+R. Откроется окно Slow Redraw.

•  В поле Stitch Range (диапазон стежка) укажите на-
чало и конец вышивки, чтобы показать только не-
обходимый элемент.
•  Используйте бегунок для указания скорости пере-
рисовки.
•  Настройка параметров по требованию:
- HideBefore (скрыть до): Скрыть все элементы до те-
кущего положения курсора.
- AutoScroll (автопромотка): При работе с большим 
пространством – область обзора перемещается по 
мере работы.
•  Используйте кнопки управления швом, чтобы он 
шел вперед или назад по проекту.

Подкладки

При оцифровке можно вывести на экран подклад-
ку. Временно скройте или затемните ее при работе 
с проектом. Также можно изменить цвет фона про-
екта, чтобы он совпадал с цветом ткани. 

View (просмотр)>SlowRedraw(медленная пе-
рерисовка) – имитация вышивки как по швам, 
так и художественно. 

Установите
диапазон стежка

Обратно Пауза Вернуться
в начало

Начать Стоп

Отрегулируй-
те параметры 
отображения 
Пауза Стоп 

Для прохож-
дения стежков, 
пользуйтесь 
клавиатурой



Подкладку, цифровой или векторный рисунок мож-
но вывести на экран или временно спрятать при 
оцифровке. Это не удаляет их из проекта. Также 
подкладку можно затемнить, чтобы сделать стежки 
более четкими.

Вывод подкладки на экран
 
•  Нажмите соответствующую иконку, чтобы вклю-
чить/выключить, как цифровую, так и векторную 
подкладку.

•  Нажмите иконку Dim Artwork (затемнить рисунок) 
- затемнение.
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•  Нажмите иконку Show Appliqué Fabric (показать 
ткань аппликации) – вкл./выкл. Такни/цвета аппли-
кации. См. Оцифровка аппликации. 

Настройка цветов фона
ПО BERNINA Embroidery Software может менять цвет 
фона проекта так, чтобы он совпадал с цветом тка-
ни. Или можно выбрать фоновую ткань для более 
реалистичного вида. Фон сохраняется вместе с про-
ектом.

Чтобы задать цвет фона

1 Выберите Design (проект)>Background (фон). От-
кроется окно Background. 

2 Выберите тип фона:

Опция Назначение
Color (цвет) Установка цвета фона окна проекта

Fabric (ткань) Выберите текстуру соответствующую 
ткани

Article (изделие) Выберите картинку, на которой изо-
бражено изделие для вышивки. Это 
также может отображаться в рабочем 
пространстве проекта. 

3 Выберите цвет ткани:

View (просмотр) >Show Appliqué Fabric (по-
казать ткань аппликации) – показать/спря-
тать подкладку/цвет любого элемента ап-
пликации в проекте. 

View> Dim Artwork (затемнить картинку) – 
затемнение подкладки, чтобы швы были бо-
лее четкими при оцифровке.

View> Show Vector Artwork (показать вектор-
ный рисунок) – показать/спрятать имеющий-
ся векторный рисунок, например, клипарт 
CorelDRAW® .

View> Show Bitmap Artwork (показать цифро-
вой рисунок) – показать/спрятать имеющий-
ся цифровой рисунок проекта.

Подкладка Вкл.

Ткань аппликации 
Вкл. 

Исходный рисунок

Подкладка Выкл.

Ткань аппликации 
Выкл.

Выберите цвет 
фона, ткань
или изделие

Затемненный рисунок



3 Выберите цвет ткани:
•  Для выбора цвета фона, выберите цвет из выпа-
дающего списка..

•  Чтобы выбрать ткань, нажмите Browse (загрушить)
и выберите в окне Select Fabric Pattern- выбрать 
образец ткани. 

• Выберите Article (изделие)– выбор картинки, со-
ответствующей проекту. См. Вывод завершенных из-
делий на экран. 
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4 Нажмите ОК:

Подсказка
Рабочее пространство проекта может быть распеча-
тано с фоном или без. См. Печать проекта.

 

Подсказка
Это окно также можно запустить через Design 
Properties (в сойства проекта)> ярлык Thread  Colors 
(цвет нити).  

Вывод завешенных изделий на экран

ПО BERNINA Embroidery Software позволяет задать 
изделие как фон, на котором будет размещена вы-
шивка. Удобно для визуализации положения, разме-
ра и конечного результата. ПО располагает библи-
отекой изделий, включая многоцветные предметы. 
Или Вы можете загрузить свое изображение.

Для визуализации готовых изделий

•  Выберите Design (Проект) >Background (фон).

Коричневый фон Фон джинсовый

Установить цвет(а) 
для выбранного 
изделия

Кликните 
дважды для 
смены фона



Откроется окно Background.

•  Выберите изделие из выпадающего меню Article 
(изделие). 
•  В палитре выберите цвет. При выборе 2 или 
3-цветных изделий, выпадает несколько палитр.

•  Установите размер изделия. Размер задается со-
ответственно размерам одежды – XS, S, M, L, XL, or 
XXL. Практическое правило: L = 100%. Вниз по шка-
ле, примерно до 70% - маленькие размеры.

Подсказка
Измерьте изделие при помощи команды Measure 
(измерить). См. Измерение расстояний на экране. 

• Если Вы используете свое изображение изделия, 
выберите Custom (на заказ), нажмите Browse (загру-
зить), чтобы разместить картинку. 

Подсказка
Рабочее пространство проекта может быть распеча-
тано с фоном или без него. См. Печать проекта. 

Просмотр информации о проекте

ПО BERNINA Embroidery Software предоставляет ин-
формацию в различных форматах и разными спо-
собами. Даже до запуска ПО BERNINA Embroidery 
Software или проекта можно проверить некото-
рые данные файлов формата ART напрямую в MS 
Windows®  Explorer. В окне Design Properties (свой-
ства проекта) указаны параметры швов. Инструмент 
Print Preview  (предпросмотр печати) дает основную 
информацию о проекте – размер, изображение, по-
следовательность цветов и индивидуальные реко-
мендации. 

Просмотр свойств проекта

В окне Design Properties (свойства проекта)  можно 
проверить номер версии ПО и другие данные, на-
пример, швы. Большая часть полей не может быть 
изменена на прямую.

Для просмотра свойств проекта

• Выберите Design (проект) >Design Properties 
(свойства проекта).
Design Properties (свойства проекта) >Design  (про-
ект). Эта вкладка содержит данные о высоте и шири-
не, количестве стежков и их цвете. Данные берутся 
из проекта и не могут быть изменены.
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Выберите 
цвет в 

палитре 



Вкладка Design (проект) также показывает порядок  
формата ART – Файлы ART ПО BERNINA Embroidery 
Software могут быть 4 порядков в зависимости от 
способа создания проекта. См. Форматы проектов 
вышивки.

•  Выберите вкладку Thread Colors (цвет нити) и про-
смотрите и измените цвета, используемые в данном 
проекте. См. Назначение цвета нити. 

•  Выберите вкладку Summary (общее) и введите или 
просмотрите общую информацию о проекте. 

•  Нажмите на поле и наберите любой текст, по ко-
торому Вы потом опознаете проект.

Примечание
Данные из этой вкладки доступны при предпросмо-
тре печати вместе с вкладкой Summary (общее) окна 
Windows Properties (свойства окна). См. Просмотр 
иформации о проекте в Windows Explorer.

Просмотр информации о проекте в 
Windows Explorer
Перед запуском файла ART можно посмотреть эски-
зы и детали проекта через MS Windows® Explorer.  
Окно Properties (свойства) дает картинку проекта и 
информацию о нем – количество швов, количество 
пауз и изменение цветов. Также можно ознакомится 
с информацией о самом файле – размер, даты изме-
нений. См. Доступ к дополнительным приложениям.

Примечание
Тоже окно можно открыть через Open (открыть) в  
ПО BERNINA Embroidery Software. 

Для просмотра информации о проекте в 
Windows Explorer
1  В Windows Explorer вы берите папку в окне появят-
ся картинки проектов Windows Explorer.

2  Правая кнопка мыши - выбрать Properties (свой-
ства) из всплывающего меню. 
Откроется окно Properties (свойства).

3  Проверьте информацию о проекте или нажмите 
на другую вкладку для просмотра других данных.
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Детали проекта 
ART доступны в 
окне Свойства



Подсказка
Вкладка Summary (общее) дублирует некоторые 
данные из Design Properties (свойства проекта)> 
Summary (общее) ПО BERNINA Embroidery Software.  
См. Просмотр свойств проекта. 

4 Нажмите OK.

Предпросмотр проекта

 
Print Preview (просмотр печати) состоит из картинки 
проекта и информации о нем – размер, последова-
тельность цветов и рекомендации. См. Печать проекта.

Посмотреть проект 
1 Нажмите иконку Print Preview (просмотр печати). В 
окне предпросмотра отразиться проект.

2   Отрегулируйте вид:
•  Чтобы изменить положение листа, нажмите 
Landscape (горизонтально) или Portrait (вертикально).
•  Чтобы изменить отображаемую информацию и 
установить настройки печати, нажмите Options (па-
раметры). См. Установка параметров печати вышивки.
•  Нажмите Zoom In (увеличить) – приближенное чте-
ние проекта или информации. Большой проект мо-
жет располагаться над другими окнами.
•  Нажмите Print (печать) - распечатать.
•  Нажмите Close (закрыть) – выйти из режима пред-
просмотра.
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Нажмите General (общее) >Print Preview 
(просмотр печати) – предпросмотр печати на  
экране. 

Нажмите, чтобы 
напечатать проект

Проект

Нажмите, чтобы 
отобразить одну 

или две страницы
Нажмите для 

просмотра пара-
метров печати

Информация о
проекте
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BERNINA Embroidery Software предоставляет массу 
возможностей для выбора объектов, составляющих 
вышивальный проект. Сюда входит метод “point and 
click” (поставь курсор и кликни), рамки, выделяющие 
нужные объекты, возможность выбора нескольких 
объектов сразу. Мождно выбирать отюельные объек-
ты для аккуратной обработки, а можно выбрать сразу 
все. BERNINA Embroidery Software позволяет вбирать 
отдельно контур объекта и наполняющие его стежки. 

Примечание
Перед тем, как выбирать отдельные объекты, их надо 
разгруппировать. См. Раздел Группировка и Разгруппировка объектов. Эта глава рас-
сказывает о том, как выбрать элементы при помощи инструментов и клавиатуры. Здесь 
также показано, как выбрать цветовые блоки и отдельные элементы при помощи ин-
струмента Color Film (Цветная пленка).

Глава 6
Выбор объектов   

Выбор объектов методом point & click

Показать или спрятать элементы можно с помощью 
Embroidery Canvas (холст вышивки) с множеством 
Настроек экрана. См. Графическое изображение Ко-
нечной вышивки. Показать или спрятать точки про-
никновения иглы и сами стежки. Или показать/спря-
тать выбранные цвета.

Простейший способ выбрать обект – установить 
курсор и кликнуть мышью в редиме Select Object. С 
помощью клавиш Shift и Ctrl можно сразу выбрать 
несколько объектов. Можно выбирать как контуры, 
так и заполненные стежками области. Кликнув по 
контуру можно выбрать объект даже тогда, когда он 
спрятан под другим объектом.  Когда в Вашем про-
екте имеются закрытые объекты, Вы можете выби-
рать их контуры или заполнения.

Для выбора объектов методом point & 
click

• Нажмите иконку Select Object

• Кликните по контуру и выделите объект

• Кликните по заполнению для выбора заполненно-
го стежками объекта

Click Transform > Select Object 0 обычно, эти 
опции уже включены по умолчанию – они по-
зволяют выбирать объекты.



•  Выберите заливку, чтобы выбрать объект, даже 
если он лежит в пределах более крупного объекта.

Подсказка
Чтобы выделить объект, спрятанный под другим 
объектом, увеличьте масштаб и кликните по конту-
ру.  Другой способ: поместите курсор поверх объ-
екта, нажмите 2 клавиши и кликайте, пока объект не 
будет выделен. Каждый следующий клик выделяет 
следующий подлежащий объект.
•  Для выбора нескольких объектов , кликните мы-
шью, удерживайте нажатой клавишу Ctrl. 

•  Диапазон объектов можно сразу выбрать, удержи-
вая клавишу Shift и кликая по первому и последнему 
объекту нужного диапазона.   

Выбор объектов рамкой

Если включен инструмент Select Object (выбор объек-
тов), можно выбирать объекты, смещая мышью рамку 
так, чтобы она их окружила. Для выбора несколь-
ких объектов удобно использовать функцию Polygon 
Select (многоугольник).

Shift +
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Выбор объектов рамкой
•  Кликните по иконке Select Object (выбор объектов)
•  Перетащите область выделения вокруг объектов, 
которые требуется выделить.
Расположите рамку выбора вокруг нужных объектов 
и отпустите клавишу мыши.

Подсказка
При отпуске клавиши мыши будут выбраны только 
те объекты, что полностью оказалась внутри рамки 
выбора, если они ранее не были сгруппированы. См. 
раздел Группировка и разгруппировка объектов.

• Можно также выбрать иеонку Polygon Selecti (вы-
деление многоугольником) 
• Отметьте узловые точки вокруг выбираемой груп-
пы объектов. 
• Нажмите Enter, чтобы подтвердить выбор.

Выбор объектов клавишей Tab

Если инструмент Select Object (выбор объектов) ра-
ботает, модно выбрать первый и последний элемент 
в ряду объектов с помощью клавиши Tab. Выбрав 
один объект, Вы также можете выбрать предыдущий 
или следующий за ним в последовательности.  См. 
раздел  Изменение следующего или предыдущего 
объекта.

Ctrl +

 

«Кликните» по объекту

Кликнуть по первому 
объекту

Удерживая  Ctrl кликните 
по другому объекту

Удержать клавишу
Shift> кликнуть по
последнему объекту 

С помощью функций Transform > Polygon 
Select можно выделять многоугольники. 
Кликнуть надо по нескольким контрольным 
точкам.
С помощью функции Transform > Select 
Object можно выделять объекты и смещать 
рамку, их выбирающую.

Нажмите Transform > Select Object и нажми-
те Tab илиr Shift + Tab , чтобы переходить от 
объекта к объекту. 

Расположите рамку выбо-
ра вокруг нужных объек-
тов и отпустите клавишу 

мыши.

Объекты выбраны

Отметьте узловые точки вокруг выбирае-
мой группы объектов 



Отмена выбора и удаление объекта  
•  Отмените выбор любым нижеописанным способом: 
-   Нажмите Esc
-   Выберите другой объект 
-   Кликните и освободите область от фона 
-   Выбрать Edit > Deselect All. 

•  Удалите объект из выбранных удерживая клавишу 
Ctrl и кликая по объекту. . 
•  Выберите объект для удаления и выполните одно 
из следующего: 
-  Нажмите Delete. 
-  Выберите пункт меню Edit > Delete. 
-  Правой клавишей мыши кликните по объекту в ли-
нейке Color Film и выберите Delete в открывающем-
ся меню. Подробнее см. Просмотр и выбор цветных 
блоков. 

Просмотр и выбор цветных блоков

Инструмент Color Film (цветной фильм) отобража-
ет последовательность объектов, сгруппированных 
по цветам. Этот инструмент удобен для  работы с 
“цветными блоками” – последовательностями объ-
ектов одного цвета. Кроме того, Вы можете ото-
бражать, выделять, изменять и выстраивать после-
довательности  отдельных объектов. Инструмент 
Color Film синхронизован с окном проекта. Фильм 
динамически обновляется, ,если модифицировать, 
удалять или создавать новые объекты. См. также 
Выстраивание последовательностей с помощью ин-
струмента Color Film.

Для просмортра и выбора цветных блоков

•  Нажмите иконку Color Film.
Откроется панель инструментов Color Film отобра-
жающая все цветовые блоки проекта в порядке по-
следовательности вышивания sequence.

Выбор объектов клавишей Tab
•  Кликнуть по иконке Select Object (выбор объекта). 
•  Выбрав объект:
1   или нажмите Tab для выбора следующего объекта 
в последовательности вышивки
2   или нажмите Shift+Tab для выбора предыдущего 
объекта в последовательности вышивки

•  Если ни один объект не выбран, то: 
-  Нажмите Tab и выберите первый объект вы после-
довательности вышивки
- Нажмите Shift+Tab и выберите последний объект 
вы последовательности вышивки. 

Подсказка
Удерживая клавишу Ctrl вы можете выбирать разные 
объекты с помощью клавиши Tab.

Выбор всех элементов проекта
•  Все объекты имеет смысл выбрать, чтобы изменить 
все одинаковым образом  См. также раздел. Комби-
нации клавиш.

Для выбора всех элементов проекта:

Войдите в пункт меню Edit(редактировать) > Select 
All (выбрать все) или нажмите Ctrl+A.
Вокруг объектов проекта отобразятся контрольные 
точки.

•  Для отмены выделения -  Edit > Deselect All, На-
жмите X или Esc.

Отмена выбора и удаление объектов
Отмена выделения и удаление объектов – это частые 
операции, к которым быстро привыкаешь.  Модно 
удалить все элемнты проекта, а можно удалить лишь 
отдельные элементы из группы. Для удаления объ-
ектов есть разные способы. См. также раздел Вы-
страивание последовательностей с помощью фуек-
ции Color Film (цветной фильм).
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Shift + Tab Tab

Ничего не выбрано Все выбрано

Кликнуть General > Color Film для просмотра 
с помощью функции Transform >Select Object 
можно выделять объекты и смещать рамку, 
их выбирающую.

Кликнуть General > Color Film для просмотра 
всех цветовых блоков в порядке вышивания



Подсказка
хотите увеличить размер области просмотра – по-
тяните мышкой за угол диалогового окна.

•  Для просмотра отдельных объектов нажмите Show 
Individual Objects.
Все объекты цветового блока отобразятся в после-
довательности вышивания.
•  Кликните по иконке для выбора объекта или цве-
тового блока.
-  Удерживая клавишу Shift Вы можете выбрать сразу 
несколько объектов или блоков. 
-  Удерживая клавишу Ctrl Вы можете избирательно 
выбирать объекты.

•  Управляйте цветовыми блоками, как то Вам нуж-
но См. Раздел Выстраивание последовательностей с 
помощью функции Color Film (цветной фильм).
Откройте выпадающее меню и управляйте нужными 
цветовыми блоками и объектами, используя правую 
клавишу мыши. См. также Комбинирование объек-
тов.
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Выбрать
с помощью  

in Color Film

С помощью вы-
падающего меню 
можно вырезать, 

копировать и 
вставлять объекты 

Перетащите край, 
чтобы увеличить 
миниатюры



Смена пялец

Выберите самые маленькие пяльцы, подходящие 
для Вашего проекта. 

Глава 7. ЗАПРАВКА ПРОЕКТА В ПЯЛьЦы 

BERNINA® Embroidery Software: Руководство по работе с программами 50

Перед выводом вышивки на машину необходимо заправить ткань в пяльцы. ПО 
BERNINA Embroidery Software дает широкий выбор промышленных пялец. Если проект 
содержит одну большую вышивку или несколько маленьких, используйте мульти0пя-
люцы. При использовании пялец, не входящих в список ПО, их можно установить с 
нуля или на основе уде имеющихся. См. Вывод пялец на экран. 

Даная глава описывает выбор и вывод на экран пялец ПО BERNINA Embroidery Software, 
создание и изменение пользовательских пялец и работу с большими проектами.

Глава 7
Заправка проекта в пяльцы 

Выбор пялец

При создании нового проекта в центре окна по 
умолчанию появляются пяльцы. По мере работы по-
ложение пялец меняется автоматически в зависи-
мости от расположения вышивки. Инструмент Show 
Hoop (показать пяльцы) позволяет спрятать или по-
казать пяльцы. Существует множество вариантов 
размеров пялец. Для упрощения оцифровки можно 
менять положение пялец с горизонтального на вер-
тикальное. См. Автоизмерение всего проекта.

Нажмите View (просмотр) > Show Hoop (по-
казать пяльцы) – вкл./выкл. пялец. Кликните 
правой кнопкой мыши для изменения на-
строек. 



Установка центра пялец

ПО BERNINA Embroidery Software по умолчанию цен-
трует вышивку внутри пялец. Но можно оставить 
пяльцы на исходной позиции при помощи функции 
руководство. Что означает, что пяльцы не будут ав-
томатически перемещаться при разработке проекта. 
Но при создании проекта с одними пяльцами, сле-
дует периодически включать автоцентровку, чтобы 
проверить, помещается ли проект в пяльцы, прежде, 
чем отправить его на машину. 

Примечание
Эти функции работают только для ПО, машина все 
равно проект центрует. См. Установка автоматиче-
ских точек старт и стоп.

Установка центра пялец
1 Щелкните правой кнопкой мыши на иконке Show 
Hoop (показать пяльцы) или View (просмотр) > Hoop 
(пяльцы). Откроется окно Options (настройки) > От-
кроется окно Hoop (пяльцы). 

2   В панели Position (позиция), выберите способ 
центрирования.

Это позволяет крепко удерживать ткань во время ра-
боты машины. См. Пяльцы для больших проектов. 

Примечание
При выборе новых пялец, они считаются текущими 
до следующего изменения.

Сменить пяльцы
1 правой кнопкой мыши нажмите Show Hoop (пока-
зать пяльцы) или выберите View (просмотр)> Hoop 
(пяльцы).
Откроется окно Options (настройки)> Hoop (пяльцы).

2   Из списка Hoop (пяльцы) выберите нужные.
3   Если определенный элемент должен быть вышит 
в определенном месте на пяльцах, выберите Manual 
(руководство) и потом Set Hoop Center (установка 
центра пялец).
4   Нажмите OK. 
При выборе Set Hoop Center, в окне проекта нажмите 
на то место, которое должно стать центром.
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Выберите 
размер 
пялец 

Автоматическое 
центрирование

Ручное

Нажмите View (просмотр) > Show Hoop (по-
казать пяльцы). Правая кнопка мыши – изме-
нение настроек. 

Выберите 
метод цен-
трирования 



Руководящие принципы Мульти-пяльцец

Когда BERNINA Embroidery Software вычисляет раз-
личные пяльца, оно пытается разделить целые объ-
екты между последовательными пяльцами. Там, где 
один объект перекрывает другой, перекрывающийся 
объект должен быть нашит перед перекрываемым.

С учетом этого, нужно стремиться к тому, чтобы:

•  Каждая последующая позиция пялец перекрывает 
ранее сшитые положение пялец.

•  Автоматическое центрирование: пяльца движутся 
так, чтобы проект всегда был в центре.

•  Руководство: Пяльцы остаются в исходном поло-
жении. 
Выберите Set Hoop Center (установка центра пялец), 
чтобы его изменить.

3  Нажмите OK. При выборе Set Hoop Center (уста-
новить центр пялец), в окне проекта нажмите на то 
место, где должен быть центр.

Расположения больших проектов на 
пяльцах

При расположении проекта на нескольких пяльцах, 
проект делится на элементы или группы элементов, 
которые могут быть вышиты по-отдельности. Они 
могут быть вышиты последовательно для формиро-
вания конечной конструкции, а могут быть напря-
мую отправлены на машину.
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Проверьте 
последова-
тельность 
объектов 
перед вы-
шиванием 

Нажмите Canvas (полотно) > Hoop Canvas 
(полотно пялец) – просмотр и изменение 
мультипялец. Мультипяльца используются 
при работе на очень больших проектах или 
проектах с большим количеством элементов 
расположенных в разных частях изделия. 

Три пози-
ции пялец, 
но пять 
слоев



Это поможет понять в каком порядке они будут вы-
шиты и, соответственно, в каком порядке следует 
расположить пяльцы. См. Просмотр и выбор цвето-
вых блоков.

Slow Redraw (медленная прорисовка) – еще один 
удобный инструмент. При использовании Slow 
Redraw, можно увидеть какие точки соприкоснове-
ния есть у начала и конца элемента с другими пяль-
цами. Например, если Вы расположили большой 
проект так, что первая его половина находится во 
вторых  пяльцах, возможно, понадобятся еще одни. 
При Медленной прорисовке Вы можете понять, раз-
делены ли все элементы по своим пяльцам (и по рас-
положению элементов и по расположению пялец), а 
также в том, что начало элемента будет в предыду-
щих пяльцах. См. Имитация вышивки. 

Регулировка последовательности
Не смотря на то, что правильная последователь-
ность сокращает количество пялец, иногда после-
довательность элементов может не подходить для 
мульти пялец. Тогда их надо перегруппировать. В 
целом, помните:
•  Проекты для одних пялец уде сгруппированы по 
цвету для сокращения его изменения. Это важно для 
машины с одной нитью. 
•  Увеличение проекта до размеров, требующих 
мультипялец, потребует перегруппировки, чтобы 
сократить количество пялец. 
•  Т.к. вышивка за раз моет осуществляться только на 
одних пяльцах, выбирайте такие, которые вместят 
самые большие элементы проекта. 
•  Чтобы не нарушить последовательность проекта, 
располагайте пяльцы как можно ближе друг к другу. 

Расчет пялец

Т.к. ПО BERNINA Embroidery Software всегда сохра-
няет исходную последовательность вышивки, поло-
жение пялец , и, в зависимости от последовательно-
сти элементов, сокращает расчеты пялец.

•  Для сохранения размера вышивки пяльцы распо-
лагаются как можно ближе друг к другу. Это мини-
мизирует количество необходимых пялец. 

Примечание
‘Положение на Пяльцах’ не одно и тоже с  ‘Положе-
нием пялец’ – положение на пяльцах меняться мо-
жет, а положение пялец - нет. Другими словами, по-
ложение на пяльцах может задействовать несколько 
пялец.

Измерение пялец
При работе с проектами на мультипяльцах важ-
но правильно установить последовательность швов 
так, чтобы лицевые швы были вышиты после изна-
ночных. ПО BERNINA Embroidery Software позволя-
ет установить позицию и порядок каждых пялец. В 
зависимости от своей очереди, пяльцы маркируются 
цветом:

Пяльцы Цвет
1 Темно-зеленый

2 Синий 

3 Красный

4 Коричневый

5 Оранжевый

6 Фиолетовый

7 Бирюзовый

8 Голубой

Если у Вас получилось больше 8 пялец, цвета начнут 
повторяться пока один из первых не будет удален. 

Проверка проекта
При четком построении проекта легко определить 
последовательность пялец. Для этого удобно ис-
пользовать инструмент Color Film (цветной фильм), 
как показано на рисунке вверху. Элементы высвечи-
ваются по мере выбора их из списка.
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Проверьте по-
следовательность 
объектов, кото-
рые пересекают 
перекрывающие-
ся пяльцы.



Создание мульти проекта

1  В Embroidery Canvas (канва вышивки) выберите 
пяльцы. См. Смена пялец. 

Подсказка
Т.к. вышивка может идти только на одних пяльцах 
за раз, выберите те, что покрывают самые крупные 
элементы проекта.

2   Переключите на режим Hoop Canvas (канва пя-
лец). 
В режиме Hoop Canvas выберите элементы полно-
стью помещающиеся в пяльцы – на экране они от-
разятся зеленым цветом. Остальные - черным.

Примечание
Элементы не могут быть выделены или изменены в 
режиме Hoop Canvas.

Время на расчет зависит от количества пялец и эле-
ментов вышивки. Проекты импортированные из EXP, 
PES, HUS, и т.д., в целом, имеют больше элементов, 
чем проекты ПО BERNINA Embroidery Software design. 
Так что они рассчитываются дольше. Но даже обыч-
ный файл ART рассчитывается достаточно долго, 
если он сложен, объемен и содержит множество пя-
лец.

Создание проектов на мультипяльцах

ПО BERNINA Embroidery Software дает различные 
канвы пялец, позволяющие создавать мультипро-
екты. Так Вы можете создавать вышивки, большие 
по размеру, чем одни пяльцы. Hoop Canvas (канва 
пялец) позволяет определить положения пялец. В 
конечном итоге, Вы создаете пяльцы и перемеща-
ете их по проекту так, чтобы свети их количество к 
минимуму. Затем они последовательно вышиваются. 
См. Вывод мультипроекта.

Подсказка
Знание последовательности элементов поможет 
правильно расположить пяльцы. В режиме элемента 
используйте Color Film (цветной фильм). Элементы 
высвечиваются по мере выбора их из списка. Или 
используйте Slow Redraw (медленная перерисовка). 
См. Просмотр и выбор цветовых блоков. См. Имита-
ция вышивки.
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Multi-Hooping (мультипяльцы) > 
Calculate Hoopings (расчет пялец) – рас-
чет текущего проекта. 
Multi-Hooping > Add Hoop Right (до-
бавить пяльцы справа) – добавить пяль-
цы справа от выделенных. Могут идти 
внахлест 10мм.
Multi-Hooping > Add Hoop Up (добавить  
пяльцы вверх) – добавить пяльцы сверху 
от выбранных.

Multi-Hooping > Add 4/8 Hoops Around 
(добавить 4/8 пялец по кругу) – соз-
дание 4/8 пялец вокруг первых. Могут 
идти внахлест 10мм.

Multi-Hooping > Splitting Guide (разде-
ляющее руководство) – разделение эле-
ментов по пяльцам.
Multi-Hooping > Delete Hoop (удалит 
пяльцы) – удалить выделенные пяльцы.
Multi-Hooping > Add Hoop (добавить 
пяльцы) – добавить новые пяльцы.



5   нажмите иконку Delete Hoop (удалить пяльцы) или 
клавишу Delete – удаление выделенных пялец.
При удалении одних пялец, цвета остальных не ме-
няются.

Примечание
При удалении всех пялец и создании новых снова 
активируется автоцентровка.

Подсказка
Чтобы выделить более одних пялец за раз: 
•  Удерживая клавишу Ctrl, кликайте на контур пяль-
цев – убрать или оставить. 
•  Удерживая клавишу Shift, кликайте на пяльцы, 
чтобы выделить их одновременно. 
•  Нажмите и перетащите курсор, чтобы выделить 
все пяльцы в очерченной зоне.

3   Выберете контур пялец и перетащите его, пока 
он не охватыватит самый большой объект в проекте.

4  Инструмент Add Hoop (добавить пяльцы) – доба-
вить пяльцы.
Как только пяльцы передвинуты или соединены 
с другими, автоцентрирование отключается, т.е. 
пяльцы больше не располагаются строго вокруг эле-
ментов.
•  Нажмите иконку Add Hoop (добавить пяльцы)-  
добавить пяльцы по вертикали.
•  Инструмент Add Hoop Right (добавить пяльцы 
справа) – добавить пяльцы справа от выделенных с 
нахлестом 10 мм.

•  Таким же образом используйте инструмент Add 
Hoop Up (добавить пяльцы вверх) – добавить пяльцы 
сверху от выделенных.

Команды Add Four Adjacent Hoops (добавить 4 во-
круг) и Add Eight Hoops Around (добавить 8 вокруг) 
доступны, когда выделены одни пяльцы. Нажатием 
соответствующей иконки добавляются 4 или 8 пялец 
вокруг по часовой стрелке, пока они не покроют са-
мый большой элемент с нахлестом 10мм.
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Если проект 
не помеща-
ется, нужны 
пяльцы боль-
шего размера

 Добавлены новые
пяльцы 

Добавьте четыре соседние пяльца

Добавьте восемь соседние пяльца



6   Переместите и поверните пяльцы так, чтобы они 
покрывали весь проект. См. Повернуть элемент. 

Подсказка
Сдвигайте пяльцы при помощи стрелок на клавиа-
туре.

Примечание
При том, что проект в целом помещен в пяльцы, мо-
гут оставаться некоторые элементы не входящие в 
пяльцы. Инструмент Splitting Guide (разделяющее 
руководство) позволяет отделить элементы, кото-
рые иначе не помещаются в пяльцы. См. Разделение 
элементов по пяльцам.

7   В конце нажмите иконку Calculate Hoopings (рас-
чет пялец) – оценить текущую расстановку пялец.
Исходный файл разделится на число равное количе-
ству пялец, соответственно разделению элементов 
по ним. Теперь можно сохранить проект одним или 
несколькими фалами и/или отправить его на маши-
ну. См. Вывод мультипроекта. 

Подсказка
Чтобы вышить проект в правильном порядке, распе-
чатайте его с обозначением пялец. См. Печать муль-
типроекта. 

Разделение элементов по пяльцам

Инструмент Splitting Guide (руководство разделе-
ния) разделяет элементы, которые сами не могут 
быть сгруппированы по пяльцам. Т.е. он создает ли-
нии раздела прежде, чем отправить проект на ма-
шину или карту памяти. Эти линии видны только в 
режиме Hoop Canvas (канва пялец), но сохраняются 
при переключении на другой режим. Они не влияют 
на целостность проекта и элементы все еще можно 
изменять по форме.

Разделение элементов по пяльцам
1   Выберите Hoop Canvas (канва пялец). Проект по-
казывается с пяльцами и элементами, в них не вхо-
дящими. 
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Перемещение 
центральной 
точки

Все объекты 
выделены

Перемещение 
центральной 
точки

Multi-Hooping (мультипяльцы) > Splitting 
Guide (руководство разделения) - появятся 
несколько направляющих для разделения 
проекта по пяльцам. 



2   Выберите инструмент Splitting Guide (руководство 
разделения). Введите начальную точку в пересече-
ниях пялец. 

3   Разделите элементы открытой кривой – правая 
кнопка мыши – прямые линии, левая - углы.
Все разделенные в рабочем окне элементы отобра-
жаются зеленым цветом.

Объекты, разделенные линиями, но еще не поме-
шенные в пяльцы, будут размещены в конце. Раз-
деление не обязательно пойдет по заданной линии. 
Оно будет сделано максимально неприметно. По-
лученные элементы сохранят первоначальный тип, 
угол шва, параметры и цвет.

4   При необходимости повторите или нажмите 
Enter, чтобы завершить. 

Примечание
Разделительные линии можно менять с помощью 
инструмента Reshape  (изменение формы). См. Из-
менение формы элементов.

Вывод регистрационных знаков

ПО BERNINA Embroidery Software может вывести 
регистрационные знаки, чтобы помочь выровнять 
пяльцы. Это не является частью проекта и не сохра-
няется в нем. Но эти знаки могут быть выведены при 
распечатке производственного листа последова-
тельности пялец. 

Подсказка
Правильное расположение пялец требует некоторой 
практики. Некоторые техники можно увидеть в ин-
тернет-тренингах других компаний. Рекомендуем 
использовать одностороннюю ленту-стабилизатор, 
достаточно крепкую, чтобы знаки рвались. Для вы-
равнивания пялец используйте флажки соседних.
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Открытой кри-
вой разделите 
элементы 

Угловая точка

Выбранная точка

Точка кривой

General (основное) > Options (настройки) – 
вывод дополнительных настроек системы 
предпочтений, сетки, направляющих, мулль-
типялец и др. 



Раздвижные пяльцы – пяльцы с регулировкой диа-
метра. Можно настроить область вышивки соот-
ветственно элементам. Также можно расположить 
пяльцы по требованию. Но проект в целом должен 
помещаться в основные пяльцы.

Примечание
Если Вы работаете со своими пяльцами, можно уста-
новить специальные настройки. См. Установка пя-
лец.

Создание проекта с раздвижными пяльцами

1 В Embroidery Canvas (канва вышивки)выберите 
раздвижные пяльцы. См. Изменение пялец. Контуры 
отобразятся сплошной черной линией.

Примечание
В проекте можно использовать только одни раз-
движные пяльцев, так что придется выбрать те, что с 
ним совпадают. Рабочая область также должна пол-
ностью вмещать самый крупный элемент.

Вывод регистрационных знаков
1   Откройте или создайте большой проект. См. Ор-
ганизация и трансформация элементов. 

2   Нажмите значок Параметры и выберите вкладку 
Multi-гудка.

3   Выберите вкладку Multi-Hooping (мультипяльцы) 
и выберите Add registration marks on output (доба-
вить регистрационные знаки на вывод).

4   Отрегулируйте настройки полей. Чем больше 
значение, тем больше расстояние между знаками и 
тем больше область вышивки. Это облегчит вырав-
нивание, но могут возникать некоторые неточности.

Подсказка
Чтобы проверить активированы ли знаки, выберите 
Print Preview (просмотр печати). См. Вывод мульти-
проекта.

Создание проекта с одними пяльцами
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Выберите, чтобы 
добавить реги-
страционных 
знаков

О
бл
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 в
ыш
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Ширина

Раздвижные пяльцы 

Вы
со

та
 в

се
го

Регистрационные знаки включены

 Multi-Hooping (мультипяльца)> Add Hoop 
(добавить пяльцы) – добавить новые пяльцы.

Multi-Hooping > Delete Hoop (удалить пяль-
цы) – удалить выделенные пяльцы. 



5 Нажимайте и тяните поле, добавляйте еще при не-
обходимости. 

6  Нажмите на контур главных пялец, переместите 
или поверните их. См. Создание мультипроекта.
7   Кликните на контур рабочей области и нажмите 
иконку Delete Hoop (удалить пяльцы) – удаление об-
ласти.

Подсказка
Совет высота рабочей области и главных пялец мо-
гут быть отрегулированы в любой момент так, чтобы 
совпасть с рабочими пяльцами. См. Изменение соб-
ственных пялец.

Создание проекта с трехпозиционны-
ми пяльцами

Трехпозиционные пяльцы позволяют разделить и 
вышить большие проекты без обычных регистра-
ционных проблем. В отличие от раздвижных пялец, 
размеры и положение известны и зафиксированы 
– регистрация элементов значительно упрощена. 
Три области подключены к машине. Так что нет не-
обходимости перезакреплять ткань. На экране они 
отображены тремя прямоугольниками с точечными 
контурами.

2   Переключитесь на режим Hoop Canvas (канва пя-
лец). См. Рабочие режимы. При входе в Hoop Canvas, 
покрытые элементы – те, которые полностью уме-
щаются в рабочем поле – отобразятся зеленым. Не-
покрытые – те, что не помешаются – черным.

Примечание 
В режиме Hoop Canvas, элементы не могут быть вы-
делены или изменены.

3  Нажмите и тяните точечный контур, пока он не 
покроет элемент целиком.
4   Нажмите иконку Add Hoop (добавить пяльцы). Но-
вое положение на поле – показано точечным конту-
ром другого цвета – появится на поле рядом с пер-
вым.

Примечание
Add Hoop Right (добавить пяльцы справа) и Add Hoop 
Up (добавить пяльцы вверху) – не доступны.
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Раздвижные пяльцы

Положение на поле 

Multi-Hooping (мультипяльцы) > Delete Hoop 
(удалить пыльцы) – удаление пялец. 

Multi-Hooping > Add Hoop Right (добавить 
пяльцы справа) – добавление пялец справа 
от выделенных. Нахлест 10мм.

Multi-Hooping > Add Hoop Up (добавить 
пяльцы сверху) – добавление пялец сверху 
от выделенных.

Multi-Hooping > Add Hoop (добавить пяльцы) 
– добавление новых пялец.

Положение на поле 



Не покрытые – выходящие за пределы пялец – чер-
ным. 

Примечание
Элементы не могут быть выделены или изменены в 
режиме Hoop Canvas.
3  Нажмите и тяните контур пялец пока он не покро-
ет самый крупный элемент.

Примечание
В режиме трехпозиционных пялец можно выбрать 
основные пяльцы, но не рабочие области внутри 
них.
4   Add Hoop (добавить пяльцы) – добавить пяльцы. 
См. Создание мультипроекта.

5   Переместите или поверните пяльцы. См. Созда-
ние мультипроекта.

Примечание
Перемещение и вращение влияет на основные пяль-
цы и на рабочие области внутри них.

6   Удалите пяльцы. См. Создание мультипроекта.

Верхний прямоугольник зеленого цвета, средний – 
синего и нижний - красного. 

Примечание
Можно установить собственные трехпозиционные 
пяльцы. См. Установка трехпозиционных пялец.

Создание проекта с трехпозиционными 
пяльцами
1   В Embroidery Canvas выберите трехпозиционные 
пяльцы. См. Смена пялец.
Основной контур показан сплошной черной линией, 
области - точечными.

Примечание
Трехпозиционные пяльцы можно использовать для 
самых крупных проектов. Тем не менее, рабочая об-
ласть должна вмещать самый большой элемент.

2  Переключите на Hoop Canvas (канва пялец). См. 
Рабочие режимы.
При  входе в Hoop Canvas покрытые элементы – пол-
ностью умещающиеся в пяльцах – отражены зеле-
ным.
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Позиция 1
Высота

Позиция 2
Высота

Общая 
высота

Ширина

Позиция 3
Высота



Откроется окно Create.

3  В панели Format (формат), выберите Rectangle 
(прямоугольник). 
4  В панели Dimensions (размеры), введите Height 
(высота) и Width (ширина) пялец.
5  Нажмите кнопку Save Hoop (сохранить пяльцы). 
Откроется окно Save Hoop As (Сохранить как…).
6  Введите название пялец.

7  Нажмите Save (сохранить) и Save Hoop (сохранить 
пяльцы).

Распознавание овальных пялец

Овальные пяльцы обозначены черным точечным 
контуром. Ну овала в соответствии с тем, что Вы ис-
пользуете.

Подсказка
Высоту рабочих областей и размеры основных пялец 
можно изменить в любой момент. См. Изменение 
собственных пялец.

Распознание пользовательских пялец

Если размера пялец, которые Вы используете, нет в 
списке, его можно туда внести и сохранить. Мож-
но создать или изменить тип пялец – прямоуголь-
ник, овал, раздвижные и трехпозиционныеand 
3-position.

Defining rectangle hoops

Прямоугольные пяльцы показаны черным точечным 
контуром. Установите высоту и ширину прямоуголь-
ника в соответствии с тем, что Вы используете.

Распознание прямоугольных пялец
1 Кликните правой кнопкой мыши на иконку Show 
Hoop (показать пяльцы) или выберите View (про-
смотр)> Hoop (пяльцы). 
Откроется окно Options (настройки) > Hoop (пяль-
цы).

2  Нажмите Create (создать).
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Ширина

Ширина

Ведите 
название 
пялец 

Создать 
новые 
пяльцы 

Высота

Высота
прямо-
уголь-

ника

Высота
всего

Нажмите View (просмотр) > Show Hoop (по-
казать пяльцы) – показать/спрятать пяльцы. 
Правая кнопка мыши – изменение настроек. 

Нажмите View (просмотр)> Show Hoop (по-
казать пяльцы) – показать /спрятать пяльцы 
правая кнопка мыши - настройки. 



Раздвижные пяльцы – пяльцы с регулируемой рам-
кой для нестандартных вышивок. Можно установить 
высоту, ширину и рабочую область в соответствии с 
параметрами используемых пялец.

Распознавание раздвижных пялец

1 Правой кнопкой мыши нажмите на иконку Show 
Hoop (показать пяльцы) или View (просмотр) > Hoop 
(пяльцы). Откроется окно Options (настройки) > 
Hoop (пяльцы).

2 Нажмите Create (создать). Откроется окно Create 
Hoop (создать пяльцы).

Распознавание овальных пялец
1  Кликните правой кнопкой мыши на иконку Show 
Hoop (показать пяльцы) или выберите View (просм-
тор) > Hoop (пяльцы).
Откроется окно Options (настройки)> Hoop (пяльцы).

2 Нажмите Create (создать).Откроется окно Create 
Hoop (создать пяльцы).

3  В панели Format (формат)выберите Oval (овал).
4  В панели Dimensions (размеры) введите Rectangle 
Height (высота прямоугольника), Total Height (общая 
высота) и Width (ширина) пялец.
5  Нажмите кнопку Save Hoop (сохранить пяльцы). 
Откроется окно Save Hoop As (сохранить как…).
6   Введите название пялец.

7   Нажмите Save (сохранить) и Save Hoop (сохранить 
пяльцы).

Распознавание раздвигающихся пялец
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Нажмите View (просмотр) > Show Hoop (по-
казать пяльцы) – показать/спрятать пяльцы. 
Правая кнопка мыши - настройки. 

Нажмите 
для созда-
ния новых 
пялец 

Ввод 
названия 
новых 
пялец 

Ширина

Высота
прямо-
уголь-

ника

Высота
всего

Создать 
новые 
пяльцы



Распознавание трехпозиционных пялец

1 Нажмите правой кнопкой мыши на  Show Hoop или 
выберите View > Hoop. Откроется окно Options > 
Hoop. 

2 Нажмите Create. Откроется окно Create Hoop.

3  В панели Format выберите 3-Position (трехпози-
ционные). 
4   В панели Dimensions Велите Total Height (общая 
высота), высота 1, 2 и 3 областей, затем Width (ши-
рина).

3   В панели Format (формат) выберите Sliding (раз-
движные). 
4  В панели Dimensions (размеры) введите Sewing 
Field (рабочая обасть), Total Height (общая высота) и 
Width (ширина). 

 
Примечание
Лучше сначала внести общую высоту. Если рабочая 
область превысит это значение она автоматически 
сократиться до нужной цифры. 

5  Нажмите Save Hoop (сохранить пяльцы). Откроет-
ся окно Save Hoop As (сохранить как…). 
6  Введите название пялец. 

7 Нажмите Save (сохранить) и Save Hoop (сохранить 
пяльцы). 

Распознавание трехпозиционных пялец

Трехпозиционные пяльцы позволяют разделить и 
вышить большие проекты без обычных регистра-
ционных проблем. В отличие от раздвижных пялец, 
размеры и положение известны и зафиксированы – 
регистрация элементов значительно упрощена.
На экране они отображены тремя прямоугольниками 
с точечными контурами. Вы можете определить свои 
собственные 3-позиционные пяльца, в соответствии 
с размерами обруча, который вы используете.
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Введите 
название 
пялец

Позиция 1
Высота

Позиция 2
Высота

Общая 
высота

Ширина

Позиция 3
Высота

Создать 
новые 
пяльцы 

Нажмите View (просмотр)> Show Hoop (по-
казать пяльцы) – показать/спрятать. Правая 
кнопка мыши – настройки. 



Откроется окно Create (создать).

4 Введите новые размеры. 
5 Нажмите Save Hoop. 

Удаление пялец

При удалении типа пялец, они удаляются целиком. 
Удалить можно только пользовательские пяльцы.

Чтбы удалить пяльцы 

1 Нажмите правой кнопкой мыши на иконку Show 
Hoop или выберите View > Hoop. Откроется окно 
Options > Hoop. 
2 Выберите пяльцы. 

3  Нажмите Delete Hoop (удалить пяльцы), за-
тем нажмите OK, чтобы подтвердить. Пяльцы уда-
лены.

Примечание
Лучше сначала ввести общую высоту. Если рабочие 
области окажутся больше заданного значения, их 
размер автоматически подгонится. 

5 нажмите Save Hoop (сохранить пяльцы). Откроется 
окно Save Hoop As (сохранить как…). 
6 Введите название пялец.

7 Нажмите Save (сохранить) и Save Hoop (сохранить 
пяльцы). 

Изменение пользовательских пялец

Пользовательские пяльцы можно редактировать и 
удалять. Изменять можно только пользовательские 
пяльцы. 

Редактирование пялец

Измените ширину и высоту пялец. 

Чтобы отредактировать пяльцы:

1 Нажмите правой кнопкой мыши на иконку Show 
Hoop или выберите View > Hoop. Откроется окно 
Options > Hoop. 

2  Из списка Hoop (пяльцы) выберите одни. 
3 Нажмите Edit (редактировать).
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Нажмите View > Show Hoop – показать/спря-
тать пяльцы. Правая кнопка мыши - настрой-
ки. 

 Нажмите View > Show Hoop – показать/спря-
тать пяльцы. Правая кнопка мыши - настрой-
ки. 

Введите 
название 
пялец 

Нажмите, 
чтобы 
редакти-
ровать 

Нажмите, 
чтобы 
удалить 



Настройки параллельных (LPT) портов
LPT – порты используются для подсоединения прин-
теров и сканеров. Их имена - LPT1, LPT2, и т.д..

Настройки портов USB 
Порт USB (Universal Serial Bus – униыерсальный се-
рийный кабель) необходим ждля подключения 
устройства безопасности (“заглушки”). Эти порты 
можно использовать для подсоединения сканеров и 
принтеров. Увеличить число портов USB можно с по-
мощью разветвителя

Настройка вышивальной машины
Вышивальнцю машину BERNINA  можно подсоеди-
нить через порты COM1, COM2, COM3, COM4 или 
USB. Подробно о подсоединении машин к компью-
теру рассказано в их Руководствах пользователя.

Настройка принтеров
Принтер можно подсоединить через порты USB или 
LPT. Некоторые принтеры можно подсоединять че-
рез разные порты. Программа
BERNINA Embroidery Software будет работать с прин-
тьером, который Вы укажетек в качестве установлен-
ного по умолчанию через меню Принтеры на панели 
управления Windows.

Прочтите инструкцию по установке в Руководстве 
пользователя принтера. Инструкции по настрой-
ке принтера по умолчанию можно найти в системе 
экранной помощи Windows Help (Windows
Start > Help > Index, ввести ‘default printer’).
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Для работы с ПО BERNINA Embroidery Software 
потребуется подключить разные периферийные 
устройства. Это могут быть принтеры, сканеры, 
вышивальные машины. ПО BERNINA Embroidery 
Software позволяет настроить параметры си-
стемы, управляющие отображением проекта на 
экране, отображением информации о проекте, 
видом экрана проекта и др. 

В этой главе рассказывается, как настроить вы-
шивальную машину и периферийные устрой-
ства и как откалибровать монитор. Речь пойдет 
также о параметрах сетки, о свойствах пялец и 
об общих настройках, таких, как автосохране-
ние проекта, отображение курсора и др.

Глава 8
Настройка программы и оборудования 

Настройка оборудования
Разные устройства настирвиваются разными спо-
собами. Некоторые через панель управления 
MS Windows®, другие – с помощью ПО BERNINA 
Embroidery Software. Инструкции по подсоедине-
нию устройств и их настройке через MS Windows® 
имеются в технической документации, сопровожда-
ющей эти устройства, а также в документации MS 
Windows® .

Настойки подсоединения периферийного 
оборудования
Периферийные устройства, например, принтер, 
подсоединяются через “порты”, расположенные на 
передней или на задней панели Вашего компьюте-
ра. Порты бывают ‘серийными’ (СОМ), ‘параллель-
ными’ (IPT) или типа USB. Настройка осуществляется 
через панель управления MS Windows® .

Серийные порты СОМ
COM – порты могут иметь 9 или 25 контактных 
штырьков. Они имеют имена - COM1, COM2, и т.д. 
Возможности подсоединения устройств ограничены 
числом имеющихся портов. Если портов не хвата-
ет, можно установить дополнительные. Программа 
BERNINA Embroidery Software позволяет использо-
вать до 4 СОМ-портов.

Примечание
Нужно знать, где какой порь расположен на Вашем 
компьютере. В случае сомнений, спросите у вашего 
технического специалиста.



Настройка сканеров 
ПО BERNINA Embroidery Software поддерживает 
TWAIN-совместимые сканеры. 
 

Примечание
Не все сканеры могут работать с ПО BERNINA 
Embroidery Software, поскольку для них тпебуется 
собственное программной обеспечение. Если у Вас 
именно такой сканер – работайте с его ПО, сохра-
ните скан в файл, а потом перенесите этот файл в 
программу BERNINA Embroidery Software. 

Для настройки сканера 
1   Подсоедините сканер, как требует его инструкция. 
2   Установите сканер в ОС MS Windows® , используя 
инструкции в документации сканера и/или в доку-
ментации MS Windows® . 
3   Запустите программу BERNINA Embroidery  Software.
4  Выберите в меню настроек Settings > Scanner 
Setup. Откроется диалог Select Source со списком 
имеющихся на вашем РС драйверов.

5  Найдите драйвер, соответствующий Вашему ска-
неру, и нажмите Select  (выбрать)
 

Примечание
Если после перезапуска программы BERNINA 
Embroidery Software сканирование не работает – 
это может быть следствием конфликта ранее уста-
новленных драйверов. Переустановите программу 
BERNINA Embroidery Software и проверьте сканер. 
Если выбранный драйвер не работает вс ПО BERNINA 
Embroidery Software, попробуйте установить другой 
драйвер. Обычно для каждого сканера устанавлива-
ют два драйвера. 

Настройка монитора 
Нужно так откалибровать монитор, чтобы в масшта-
бе 1:1 проект отображался в натуральную величи-
ну.  Это надо сделать при первой-же установке ПО 
BERNINA Embroidery Software, а также при установке 
нового монитора

Для настройки монитора 
1 В меню Settings > Calibrate Screen. 
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Откроется диалог Calibrate Screen (настройка экра-
на).

2 Измерьте ширину и высоту диалогового окна. 
3 Введите измерения в поля Width (ширина) и Height 
(высота). 
4 Нажмите OK. 

Настройка параметров сетки

Отображение сетки можно включать и от ключать. 
Можно устанавливать расстояния между линиями 
сетки и контрольные точки. Можно использовать 
функцию Snap to Grid в диалоге Options.

Можно привязать сетку к определенной точке про-
екта, задав  контрольную точку – например, если 
Вам нужно, чтобы линии сетки пересекали центр 
проекта, или чтобы горизонтальная линия находи-
лась точно под определенным объектом. 
Функция Snap to Grid (привязать к сетке) позволяет 
выровнять объекты по ближайшим линиям сетки. 
Можно выравнивать объеккты по горизонтальным 
(X) и/или вертикальным (Y) линиям. При оцифровке 
новая контрольная точка привяжется к ближайшей 
линии сетки. При перемещении объектов они тоде 
будут привязываться к линиям сетки. 

Для установки параметров сетки 

1 Правый клик по иконке Show Grid (показать сетку) .

Нажмите, 
чтобы ре-

дактировать 

Измерье 
высоту

Измерьте ширину

Параметры рабочего пространства (сетка, 
пяльцы, скроллинг) можно найти через меню 
General > Options. 

Для настройки сетки: правый клик> View  
(вид)> Show Grid t(показщвать сетку).



Откроется диалог Options > Grid.(сетка).

2   Галочка в чекбокс Show grid – отображение сетки
3  Галочка в чекбокс Set reference point – привязка 
сетки к выбранной линии или точке. 
Можно, например, указать контрольную точку в цен-
тре проекта. Это проще и быстрее, чем смещать весь 
проект. 
4   Ввести расстояния между линиями (Grid spacing) 
по осям х и Y.. 
5 Галочка в чекбокс Snap to grid (привязать к сетке). 
 

Подсказка
Если при оцифровке удерживать нажатой клавишу 
Alt, функция Snap to grid будет временно отключена.
 
6   Нажать OK. Если активирована опция Set reference 
point, отметьте контрольную точку на проекте. Го-
ризонтальные и вертикальные линии сетки будут 
пересекаться именно в этой точке. 

Настройка скроллинга 

Для того, чтобы автоматически при оцифровке об-
ходить объекты проекта можно использовать функ-
цию Auto Scroll. Это может быть удобнее, чем ис-
пользовать панаромирование или полосу прокрутки.

Глава 8. ЗАПРАВКА ПРОЕКТА В ПЯЛьЦы 

BERNINA® Embroidery Software: Руководство по работе с программами 67

Для настройки автоматического скроллинга 
1 Нажмите иконку Options и закладку Scrolling.

2 Отметьте галочкой Enable auto scrolling (включить 
автоматический скроллинг)
3 Отметьте галочкой Move pointer after scroll, чтобы 
позиция курсора всякий раз смещалась. 
4 Укажите нужное время реакции в поле Response 
time. Меньшие значения увеличат скорость скрол-
линга.
5 Из списка Move pointer to выберите желаемую по-
зицию курсора после скроллинга из списка: 

Опции Цель
Center (Центр) Центрировать центр окна. Удобно при 

больших помещениях

Midway На полпути от исходного положения 
курсора и центром окна.  Удобно при 
небольших смещениях, например, при 
переходе к увеличенному просмотру 
отдельных фрагментов образца

Corner (Угол окна) Угол окна. Удобно при медленном 
скроллировании

6   Нажмите OK. Эффект этих настроек сказывается, 
когда начнется оцифровка. Окно проекта автомати-
чески следует за положением курсора. 
 

Подсказка
Чтобы на время отключить функцию Auto Scroll, 
удерживайте нажатой клавишу Shift.

Настройка опций для пялец 

Чтобы соответствовать размеру Вашего проекта и 
числу вышивальных машин есть диапазон размеров 
пялец. Выбирайте из них наименьшие, вмещающие 
Ваш проект. Это поможет держать ткань в натянутом 
состоянии при вышивании.

Отобразить сетку 
Привязать к сетке 

Привязать сетку к 
точке 

Расстояния между 
линиями по осям 

х и Y 

Параметры рабочего пространства (сетка, 
пяльцы, скроллинг) можно найти через меню 
General > Options. 

Правый клик> View > Show Hoop (показать пяльцы) 
для изменения настроек пялец. 

Параметры рабочего пространства (сетка, пяльцы, 
скроллинг) можно найти через меню General > Options. 



Чтобы установить пяльца
1  Выбрать в меню Settings > Options  закладку Hoop 
(пяльцы) и правый клик по иконке Show Hoop (по-
казать пяльцы)
2  Выберите пяльцы из списка. 

Чтобы скрыть пяльцы, снимите галочку в чекбоксе 
Show Hoops. 

1   Выбрать в меню Settings > Options  закладку Hoop 
(пяльцы) и правый клик по иконке Show Hoop (по-
казать пяльцы)
2   Выберите пяльцы из списка. 
3  Position - выбор положение пялец. См. раздел 
Центрирование пяляц. 
4   Create – создание новых оптимизированных пя-
лец. См. раздел Настройка пялец. 
5   Edit - настройка существующих пялец. См. раздел  
Настройка пялец
6   Delete – удаление существующих пялец. См. раз-
дел  Удаление пялец. 
7   Нажмите OK. 
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Настройка опций для аппликаций

С помощью функции Appliqué (аппликация) Вы мо-
жете вышивать закрытые объекты аппликаций. Мож-
но определять одиночные или множественные гра-
ницы, а также положения вне рамок через диалог 
Options. См. раздел Создание закрытых объектов 
аппликаций.

Настройка опций для аппликаций

1 Нажмите иконку Options и выберите закладку 
Applique. За ней две панели - Boundaries (границы) 
и Frame-out (за рамками).

2   Выберете нужную опцию:

Опции Цель
Single Удобно при создании одиночного объ-

екта – закрытого объекта аппликации

Multiple Удобно при создании  многообъект-
ных аппликаций. См. раздел Создание 
закрытых объектов аппликаций

3 Выберите требуемый способ Frame-out  
•  Automatic: при этом положение вне рамки фикси-
руется автоматически. 
•  Manual: при этом выборе, положение ане рамки 
остается в процессе оциыровки. 
•  Place under cover stitches: при этом выборе поло-
жение “вне рамки” помещается в точку последнего 
(до начала вышивания объектов за рамкой) прокола 
иглы.
 
Настройка опций удаления перекрыва-
ющихся объектов 

Функция Remove Overlaps поможет удалить под-
лежащие уровни вышивки. При этом сокращается 
число прошиваемых стежков. Там, где их быть не 
должно. См. Также раздел Удаление подлежащих 
стежков.

Параметры рабочего пространства (сетка, 
пяльцы, скроллинг) можно найти через меню 
General > Options. 

Параметры рабочего пространства (сетка, 
пяльцы, скроллинг) можно найти через меню 
General > Options. 



Настройка функции удаления перекрытий 
1 Кликнуть по иконке Options и выбрать закладку 
Remove Overlaps (удалить перекрытия). 
Откроется диалог Options > Remove Overlaps. 

2 Укажите объем перекрытия в поле Cutting overlap 
(отрезка перекрытий).

3 Нажмите ОК.

Настройка общих свойств

ПО BERNINA Embroidery Software позволяет настраи-
вать параметры автосохранения проектов, положе-
ние  курсора на экране и параметры отображения 
ищмерений. 

Настройки автосохранения

С помощью функции Auto Save можно через регу-
лярные промежутки времени автоматически со-
хранять проект, гарантируя от потери изменений в 
случае сбоя аппаратуры. Всякий раз при создании 
проекта создается страховочный файл. Проект со-
храняется в папке BACKUP в инсталляционной папке 
BERNINA Embroidery Software. У страховочного фай-
ла будет то хе самое имя, что и у оригинального, но 
с расширением ‘BAK’.

Предупреждение
Страховочные файлы остаются в папке BACKUP, пока 
Вы их не удалите. Не забывайте регулярно удалять 
нежелательные файлы, чтобы не переполнять жест-
кий диск. 
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Настойка функции автосохранения 
1  Кликнуть по иконке Options и выбрать закладку 
General . 

2  Пометить галочкой  Auto-save design и указать 
частоту автоматических сохранений 
3   Нажмите OK. 

Интерпретация позиций курсора
Значения X и Y указывают расстояния курсора до 
контрольной точки по горизонтали и вертикали  
Значение параметра L  - это длина линии, соединя-
ющей курсор и начальную точку. Величина A – угол 
наклона этой линии к горизонтали.

Отрицательные значения X указывают на то, что вто-
рая точуа была помещена слева от первой, а отри-
цательные значения Y указывают на то, что вторая 
точуа была помещена ниже первой. Отрицательные 
углы соответствуют углам более 180º – например, 
значения -60º и 300º эквивалентны.

Подсказка
Расстояния на экране можно измерять по значениям, 
указанным на панели состояний Status Bar. См. раз-
дел Измерение расстояний на экране.

Отрезкок перекрытия:0,5мм Отрезкок перекрытия:1,5мм

В меню General > Options можно настроить 
опции сетки, пялец и скроллинга. 

Начальная 
точка

Конечная 
точка

длина= 75.4 mm

Строка со-
стояния

Y = -42.7 mm

X = 61.4 mm

X -горизонталь  Y -вертикаль L-длина       A- угол

90º

0º

135º

180º

-135º

45º

-45º

-90º

A = 30º

2

1



Настройка отображения положения курсора

При движении мыши положение курсора указывает-
ся на панели состояния в нижней части экрана. До-
полнительно можно отображать положение курсора 
по отношению к последней оцифрованной точке,  
или как абсолютное значение от первой точки про-
кола иглы на проекте.

Настройка отображения положения курсора
 
1 Кликнуть по иконке Options и выбрать закладку 
General. 

2 Выберите для курсора опции- относительная или 
абсолютная:

Опции Цель
Relative (относитель-
ная): 

Указывает положение курсора по 
отношению к последней оцифрован-
ной точке. Полезно при оцифровке и 
редактировании стежков. 

Absolute (абсолютная) Указывает положение курсора по 
отношению к первой точке прокола 
иглы на проекте. Удобно, если проект 
укладывается в заданные размеры. 

3 Нажмите ОК.

Настройка других общих опций

Закладка Options > General позволяет включить сле-
дующие функции: 
•  При оцифровку включить Closest Join 
•  Отображать измерения при использовании ко-
манды Measure  
•  Скрывать свойства объекта 
•  Группировать объекты при открытии и вставке. 

Глава 8. ЗАПРАВКА ПРОЕКТА В ПЯЛьЦы 

BERNINA® Embroidery Software: Руководство по работе с программами 70

Настройка других общих опций

1 Кликнуть по иконке Options и выбрать закладку 
General.

2 Выберите из следующих возможностей: 
•  Использовать при оцифровку метод Сlosest join 
(кратчайшие соединения): этот метод (по умолча-
нию) автоматически вычисляет кратчайшее соеди-
нение между объектами при оцифровке. Все вновь 
оцифрованные объекты объединяются с помощью 
метода As digitized. См. раздел Оцифровка закры-
тых форм. 
•  Указать размеры: указывать значения измерений 
и углов в разделе tooltip на  экране. См. раздел Из-
мерение расстояний на экране. 

•  Скрыть свойства объекта: При открытии диалога 
Object Properties (свойства объекта) ранее открытый 
диалог Effects (автоматически закрывается, и наобо-
рот. См. раздел Доступ к свойствам объекта. 
•  Группировать объекты при открытии и вставке: 
При выборе проекта он автоматически группируется 
при первом открытии или при вставке в  другой про-
ект. Это позволяет проще переместить его в нужное 
положение без риска случайно удалить объекты. Это 
особенно полезно при работе с проектами, разме-
щаемыми поверх существующих уже элементов. См. 
раздел Работа с файлами проекта для деталей.
3  Нажмите OK.

 В меню General > Options можно настроить 
опции сетки, пялец и скроллинга.  

 В меню General > Options можно настроить 
опции сетки, пялец и скроллинга.  

Установите 
другие общие 

параметры

Указать 
измерения 
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Часть II
Техника оцифровки 

Программа BERNINA Embroidery Software позволяет конструировать проекты из набора 
основных элементов или “объектов вышивки”  Это рисунки, характеризуемые такими 
параметрами или свойствами, как цвет, размер, положение и т.п. Есть и специфиче-
ские именно для вышивок свойства, такие, как тип стежков или плотность стежков. 

Стежки контурные и стежки заполнения 

В этой главе рассказывается о том, как выбирать типы стежков для контуров фигур и 
их заполнения, а также о том, как настраивать их параметры, чтобы получить опти-
мальный результат. Основные контурные стежки, о которых пойдет речь – это стежки 
одиночные и тройные, а также гладьевые (Satin) и обметочные (Blanket). Основные 
стежки заполнения - гладьевые и разреженные (шаговые). См. Контурные стежки и 
стежки заполнения.

Цвета ниток и таблицы цветов 

В этой главе рассказывается о том, как выбирать цвета ниток из палитры, а также о 
том, как выбрать цвет ниток, наиболее близкий к цветовой гамме проекта. Объясняет-
ся, как подобрать таблицу цветов ниток под свой проект. См. Цвета ниток и таблицы 
цветов. 

Методы оцифровки 

В этой главе рассказывается об основных методах оцифровки изображений, а  также 
объясняется, какие настройки могут обеспечить оптимальные результаты оцифровки. 
См. Методы оцифровки. 

Свойства объектов и шаблоны 

В этой главе рассказывается о том, как настроить свойства объекта под Ваш проект. А 
также о том, как создавать и использовать шаблоны в программе BERNINA Embroidery 
Software. См. Свойства объектов и шаблоны.

Как улучшить качество стежков 

В этой главе речь пойдет о настройке параметров под ткани,  об использовании под-
кладок-стабилизаторов и компенсации растяжения ткани. Также  объясняется, как 
сохранить длинные стежки и установить автоматические точки начала и завершения 
стежков. См. Качество стежков. 
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Глава 9
Контурные стежки и стежки заполнения 

Все элементы вышивок в программе BERNINA Embroidery 
Software имеют определенные настройки или “свойства”, из 
которых самым важным является тип стежка. Всякий раз, как 
создается или изменяется проект, генерируются соответству-
ющего типа стежки. Другие настройки, как длина стежка и его 
шаг, можно настроить как до, так и после оцифровки.

Типы стежков разделяются на две основные категории: – ‘кон-
турные’ и ‘заполняющие’. Контурные, как и следует из назва-
ния, используются для создания контуров фигур и небольших 
деталей. Заполняющими стежками заполняют большие обла-
сти проекта. Всякий раз, как создается фигура для вышивки, 
генерируются соответствующего тимпа стежки. Их можно в 
любой момент видоизменить. Программа BERNINA Embroidery 
Software имеет множество средств и инструментов для созда-
ния объектов вышивки. Эти инструменты используют стежки 
разных типов для создания нужных объектов. 

В этой главе рассказывается о том, как выбирать типы стежков для контуров фигур и 
их заполнения, а также о том, как настраивать их параметры, чтобы получить опти-
мальный результат. Основные контурные стежки, о которых пойдет речь – это стежки 
одиночные и тройные, а также гладьевые и обметочные. Основные стежки заполнения 
- гладьевые и рядами. См. также Продвинутое вышивание. 

Выбор и изменение стежков 

Программа BERNINA Embroidery Software содержит 
много типов контурных стежков и стежков заполнения
 разногй формы., включая художественные и декора-
тивные. Всякий раз при создании объекта программа 
выбирает  стежки ранее выбранного типа, но это мож-
но в любой момент поменять. 

Подсказка 
Перед оцифровкой настройте параметры стежков с 
помощью меню Object Properties (свойства объектов). 
См. также  Свойства объектов и шаблоны

Выбор контурных стежков

BERNINA Embroidery Software позволяет использовать 
одиночные, тройные, гладьевые и обметочные стежки 
для создания контуров. 
Можно использовать разные другие типы декоратив-
ных стежков.  Их можно заменять в любой момент.

Для создания тонкого контура в один стежок 
используйте функцию  Stitch > Single Outline. 

Для создания утолщенного контура с по-
мощью утроения числа стежков используйте 
функцию Stitch > Triple Outline
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Для выбора контурного стежка 
1  Возьмите или оцифруйте открытый или закрытый 
объект. См. также  Методы оцифровки. 

2  Выбрать тип стежка Outline (контурный) на панели 
инструментов Stitch (стежки). См. также  Панель ин-
струментов Stitch. Выбранный тип стежка будет ис-
пользован.

Подсказка
Выбрать тип стежка до выбора конкретного объек-
та. Он будет применен автоматически к следующим 
оюъектам.

Выбор стежков заполнения

Программа BERNINA Embroidery Software позволяет 
использовать гладьевые и разреженные (шаговые) 
стежки, а также множество декоративных типов 
стежков.

Выбрать стежок заполнения 

1 Выбрать или оцифровать закрытый объект. См. 
также  Оцифровка закрытых фигур. 

2  Выбрать тип стежка заполнения на панели Stitch 
(стежки). См. также  Панель выбора стежков. 
 

Подсказка
Выбрать тип стежка до выбора конкретного объек-
та. Он будет применен автоматически к следующим 
объектам.

Создание контуров одинарными и трой-
ными стежками 

С помощью функций Single и Triple можно создавать 
контуры из одинарных или тройных стежков. Single 
образует линию одинарных стежков вдоль контура. 
Triple повторяет каждый стежок трижды для утолще-
ния. Это основные способы оконтуривания объектов. 

Примечание
На экране большой разницы между одинарными и 
тройными стежками не заметно, поскольку допол-
нительные стежки перекрываются. Чтобы убедиться, 
что объект оконтурен тройными стежками, пройди-
тесь по последовательности стежков. См. Просмотр 
проекта. 

Создание контуров одинарными и трой-
ными стежками

С помощью функций Single и Triple можно создавать 
контуры из одинарных и тройных стежков. Кликами 
по левой и правой клавишам мыши можно создавать 
контрольные точки по углам проекта и в точках ис-
кривления линий соответственно. 

Для создания контуров одинарными и 
тройными стежками

1  Выбрать Single млм Triple на панели Stitch. См. так-
же  Панель стежков Stitch. 
2  Выбрать инструмент оцифровки и оцифровать 
открытую или закрытую фигуру. См. Методы оциф-
ровки. 

Функция меню Stitch > Satin Fill позволит запол-
нять небольшие объекты плотными стежками.

Функция меню Stitch > Step Fill позволит за-
полнять более крупные объекты менее плот-
ными стежками 

12 34 56

1

2

3

5

6

4

Длина стежка

Оди-
нарные 

Трой-
ные 

Для создания тонкого контура в один стежок 
используйте функцию  Stitch > Single Outline. 

Для создания утолщенного контура с по-
мощью утроения числа стежков используйте 
функцию Stitch > Triple Outline
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Примечание
Контур создается одинарными или тройными стеж-
ками, заданными по умолчанию.  Длину стежка мож-
но настроить как до, так и после оцифровки. См. 
Настройка длины одинарных и тройных стежков. 

Настройка длины стежков 

В диалоге Object Properties можно указать длину 
стежков как до, так и после оцифровки. Укажите 
подходящую длину как для одинарных, так и для 
тройных стежков. Для сильно искривленных линий 
длина стежка должна быть меньше. Для более плав-
ных – больше. Большая длина экономит число стеж-
ков, но ухудшает соответствие с кривой

Настройка длины одинарных и тройных стежков
1  Сделайте двойной клик или клик правой клави-
шей по контуру. Откроется диалог Object Properties 
> Outline Stitch (контурный стежок).  

Подсказка 
Функция Object Properties позволяет настроить па-
раметры стежка как до, так и после оцифровки. Ис-
пользуйте ее в любое время. 
2   Выбрать Single (одинарный) или Triple (тройной) в 
списке типов стежков Stitch Type. 
3   Укажите длину стежка в поле Stitch Length. Для 
сильно искривленных контуров следует брать уко-
роченную длину, например, до 1.8 мм. 
 

Подсказка
Для оживления ручных вышивок можно использо-
вать  стежки типа Single или Triple длиной 4,0 мм. 
См. также  Контура и заполнения художественных 
объектов. 
4 Нажать Apply (Применить). 

Создание контура гладьевыми стежками. 
Гладьевые стежки можно использовать как для кон-
туров, так и для заполнений. Они хорошо подходят 
для утолщенных контуров. Плотность стежков мож-
но настроить вручную, задав значение шага стежка 
(Spacing), или автоматически с помощью функции 
Auto Spacing. 

Создание контура гладью

Функция Stitch > Raised Satin Outline позволяет соз-
давать приподнятые контура с эффектом квилтинга.

Как создать контур гладью
1  Выбрать Satin Outline на панели стежков Stitch. См. 
также  Панель стежков. 
2  Выберите метод оцифровки и оцифруйте откры-
тый или закрытый объект. См. также  Методы оциф-
ровки. Контур будет создан с параметрами, приня-
тыми по умолчанию. Шаг и ширину стежков можно 
настроить как до, так и после оцифровки. См. На-
стройка ширины и шага контурных гладьевых стеж-
ков. 

Подсказка
Приподнятые гладьевые стежки Raised Satin мож-
но использовать для создания каллиграфических 
надписей вместе с функциями Calligraphy и Open 
Freehand. Рекомендуем использовать увеличенную 
ширину  стежка и больше слоев, чем установлено по 
умолчанию. См. Вышивки ручным почерком.

Для настройки параметров стежков войдите 
в меню General > Object Properties (свойства 
объекта). 

Гладьевые стежки (satin stitch) хорошо под-
ходят для утолщенных контуров.

Для создания утолщенных контуров исполь-
зуйте функцию Stitch > Satin Outline.

Длина стежка
Слишком маленькое 
количество стежков

Более частое коли-
чество стежков

Выбрать Single 
или Triple 

Ввести длину 
стежка

Длина стежка



2 Выбрать Manual для настройки параметров вруч-
ную. Активируется поле указания шага стежка Stitch 
Spacing.

Примечание
Если выбрать опцию Automatic поле установки шага 
стежка Stitch Spacing будет отключено. См. Автома-
тическая установка шага стежка для гладьевых кон-
туров. 
3  В поле Stitch Spacing укажите величину шага стежка. 
•  Уменьшение шага увеличивает плотность стежков. 
•  Увеличение шага уменьшает плотность стежков.

4  Укажите ширину стежка в поле Satin Width. 
5  Нажмите Apply (применить). 

Автоматическая установка шага стежка 
для гладьевых контуров

Для узких контуров стежки короче. Если они очень 
коротки, следует увеличить шаг стежка, чтобы ча-
стые проколы не повредили ткань. Функция автома-
тической настройки шага стежка Automatic Spacing 
настраивает шаг стежка в соответствии с шириной 
контура. Для контуров с меняющейся шириной эта 
вункция автоматически выбирает оптимальный шаг 
стежка. См. также Настройка ширины и шага кон-
турных гладьевых стежков. 

Применение функции automatic spacing  
1 Двойным кликом или кликом правой клавишей 
мыши выделите нужный контур. Откроется диалог 
Object Properties > Outline Stitch > Satin.

 

2  Выбрать опцию Automatic. 
3  Нажмите Apply  (применить). 

Глава 9. КОНТУРНыЕ СТЕжКИ И СТЕжКИ ЗАПОЛНЕНИЯ

BERNINA® Embroidery Software: Руководство по работе с программами 75

Настройка ширины и шага контурных 
гладьевых стежков

Ширина стежка – это расстояние  ы миллиметрах 
между двумя соседними проколами иглы с одной 
стороны шва. Уменьшение шага увеличивает плот-
ность стежков. И наоборот. См. также  Автоматиче-
ская установка шага стежка для гладьевых контуров.

Для настройки ширины и шага контур-
ных  гладьевых стежков:
1 Двойным кликом или кликом правой клавишей 
мыши выделите нужный контур. Откроется диалог 
Object Properties > Outline Stitch > Satin.

Подсказка
С помощью функции Object Properties можно в лю-
бое время  настроить шаг стежка, в том числе и до 
оцифровки.

Для настройки параметров стежка откройте 
диалог General > Object Properties. 

Открыть диалог General (Общие)> Object 
Properties (свойства объекта). 

Толстые-тонкие 
каллиграфические
строчки

Ширина стежка

Авто Расстояние ВКЛ. Авто Расстояние ВыКЛ.

Шаг стежка 0.6 мм                       Шаг стежка 1.0 мм   

Выбрать Manual 
для изменения 

шага стежка 

Изменение 
отступов и 

ширины

Расстояние между-
стежками

Выбрать 
Automatic 



Создание контуров обметочными стежками

Используйте Blanket Outline для длинных, узких 
контуров с эффектом ‘comb’.

Создание контура обметочными стежками 
1 Выбрать функцию Blanket Outline на панели стеж-
ков Stitch toolbar. См. также  Панель стежков. 
2 Выберите метод оцифровки и оцифруйте откры-
тый или закрытый объект. См. также  Методы оциф-
ровки.
Контур будет создан с параметрами, принятыми по 
умолчанию. Шаг и ширину стежков можно настроить 
как до, так и после оцифровки. См. Настройки ши-
рины и шага обметочных стежков.

Подсказка
Когда открытый объекь оцифровывается  слева на-
право, обметочные стежки ориентированы сверху 
вниз. Когда справа на лево – то снизу вверх.

Настройка ширины и шага обметочных 
стежков 

Можно настроить шарину и шаг стежков.

Настройка ширины и шага обметочных стежков

1  Двойным кликом или кликом правой клавишей 
мыши выделите нужный контур. Откроется диалог 
Object Properties > Outline Stitch > Blanket  

Подсказка
Для широких контуров максимальная ширина стежка 
может превышать возможности некоторых моделей 
швейных машин. Функция Special Satin в програм-
ме BERNINA Embroidery Software разбивает слишком 
длинные стежки на более короткие. См. также  Раз-
биение длинных стежков для заполнений гладью. 

Смещение гладьевых контурных стежков

По умолчанию стежки позиционируются вокруг се-
редины оцифрованной линии. Но итх можно сме-
стить по одну сторону от этой линии.

Смещение гладьевых контурных стежков
1 Двойным кликом или кликом правой клавишей 
мыши выделите нужный контур. Откроется диалог 
Object Properties > Outline Stitch > Satin. 

2  Выбрать опцию – Center (по середине) 
или Offset (со смещением).

Подсказка
Увидеть смещение можно, выделив объект и ис-
пользуя функцию Reshape Object (изменение формы 
объекта). 
3 Нажмите Apply (применить).

Создание контуров обметочными стежками
Обметочные (Blanket) стежки для длинных, узких 
контуров с эффектом ‘comb’. Их часто используют 
для вышивки границ вокруг аппликаций. Игла про-
калывает ткань с двух сторон от линии контура, а 
затем еще раз вторично с одной из сторон. В ре-
хультате образуется сплошной шов с этой стороны. 
Эти стежки обычно более открытые, чем гладьевые 
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Открыть диалог General (Общие)>Object Properties 
(свойства объекта). 

Рекомендуем использовать функцию Stitch>Blanket 
Outline для длинных,  узких контуров с эффектом ‘comb’ 

Выбрать 
center или 

offset 

Контроль-
ные точкиСтежки центро-

ваны
Стежки со смеще-

нием 

Шаг обметочного стежка 

Ширина 
обметочного 
стежка 

Для настройки параметров стежка откройте диа-
лог General > Object Properties.



Подсказка
Смотрите смещение, выбрав объект, затем нажав на 
инструмент Object Reshape.

3 Нажмите Apply (применить). 

Заполнение гладью 

Заполнение гладью хорошо подходит для неболь-
ших или узких фигур. Гладьевые стежки почти па-
раллельны, но каждый второй немного отклонен.  
Проколы иглы приходятся на границу объекта и 
практически отсутствуют внутри заполнения, в ре-
зультате чего заполнение выглядит блестящим и 
очень качественным. 

Подсказка
Для слишком широких объектов гладьевые стежки 
могут боказаться длинными, ослабленными и  не 
покрывающими ткань должным образом. Если нуж-
но увеличить размер проекта, воспользуйтесб функ-
цией Special Satin. Она автоматически пересчитает 
длину стежка под новый масштаб.

Создание заполнения гладью

Гладьевое заполнение (Satin Fill) рекомендуется для 
небольших или узких фигур. Приподнятое гладье-
вое заполнение (Raised Satin Fill) для создания выпу-
клых вышивок с многими слоями гладьевых стежков. 
См. также  Вышивки с эффектом квилтинга.

Создание заполнения гладью 

1 Выбрать Satin Fill на панели стежков Stitch. См. 
также  Панель стежков. 
2 Выбрать инструмент оцифровки и оцифровать за-
крытую фигуру. См. Методы оцифровки. 

Подсказка
С помощью функции Object Properties можно в лю-
бое время  настроить шаг стежка, в том числе и до 
оцифровки. 

2   В поле Stitch Spacing укажите шаг стежка. 
Шаг стежка – это расстояние в миллиметрах между 
соседними вертикальными линиями на стежке.

3   В поле Blanket Width укажите ширину обметочных 
стежков.

4 Нажмите Apply (применить). 

Смещение обметочных стежков 

По умолчанию стежки позиционируются вокруг се-
редины оцифрованной линии. Но их можно сме-
стить по одну сторону от этой линии. 

Для выбор смещения обметочных стежков 
1 Двойным кликом или кликом правой клавишей 
мыши выделите нужный контур. Откроется диалог 
Object Properties > Outline Stitch.

2  Выбрать опцию:

•  Center  (центровать)
•  Offset  (со смещением)
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Для настройки параметров стежка откройте диалог 
General > Object Properties. 

Функция Stitch > Raised Satin Fill позволяет создавать 
приподнятые поверхности, что применимо для надпи-
сей. И создания эффектов квилтинга.
Функция Stitch > Satin Fill рекомендуется для заполнения 
небольших или узких объектов

Указать шаг
и ширину

 Шаг: 1.0 мм                 Шаг: 2.0 мм                Шаг: 3.5 мм 

            Ширина: 2.5 мм                          Ширина: 5 мм 

Центрованные стежки                           Смещенные стежки 

Выбрать 
Center или 

Offset 

Контроль-
ные точки



3 Увазать значение шага в поле Stitch Spacing. 
•  Уменьшение шага увеличивает плотность стежков. 
•  Увеличение шага уменьшает плотность стежков.

4 Нажмите Apply (применить). 

Автоматический выбор шага заполнения 
гладью

Функция автоматической настройки шага стежка 
Automatic Spacing настраивает шаг стежка в соот-
ветствии с шириной объекта. Для объектов с меняю-
щейся шириной эта функция автоматически выбира-
ет оптимальный шаг стежка. См. также  Сохранение 
длинных стежков. 

Как включить автоматический выбор шага:
1 Двойным кликом или кликом правой клавишей 
мыши выделите нужный контур. Откроется диалог 
Object Properties > Fill Stitch > Satin. 

2  Выбрать опцию Automatic. 

3 Нажмите Apply (применить).

Разбиение длинных стежков при заполне-
нии гладью 
Для широких контуров максимальная ширина стежка 
может превышать возможности некоторых моделей 
швейных машин. Функция Special Satin в програм-
ме BERNINA Embroidery Software разбивает слишком 
длинные стежки на более короткие. Эта функция 
также случайным образом разбрасывает точки про-
колов ткани в поле заполнения, чтобы они не обра-
зовали нежелательные линии.

Примечание
Параметры заполнения заданы по-умолчанию. Шаг 
стежков заполнения можно задать как до, так и по-
сле оцифровки. См. Настройка шага заполнения 
гладью. 

Настройка шага заполнения гладью

Шаг стежка – это расстояние в миллиметрах между 
двумя соседними проколами с одной стороны фи-
гуры.  Для узких объектов стежки тугие и их для за-
полнения нужно меньше. Для очень узких объектов 
рекомендуется уменьшить плотность стежков, чтобы 
слишком близкие проколы не повредили ткань. См. 
также  Сохранение длинных стежков.

Поменять плотность можно в любой момент. Чем 
больше шаг, тем ниже плотность, и наоборот. 

Настройка шага заполнения глалью 

1 Двойным кликом или кликом правой клавишей 
мыши выделите нужный контур. Откроется диалог 
Object Properties > Fill Stitch > Satin. 

Подсказка
С помощью функции Object Properties можно в лю-
бое время  настроить параметры стежка, в том числе 
и до оцифровки.

2 Выбрать опцию  Manual. 
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Для настройки параметров стежка откройте диалог 
General > Object Properties. 

Для настройки параметров стежка откройте диалог 
General > Object Properties. 

Выбрать manual 

Автоматический выбор шага       Выбор шага “вручную” 

       Шаг меняется                 Шаг постоянен  

Шаг стежка

Ширина стежка

           Шаг стежка 1.0 мм                 Шаг стежка 1.8 мм

Выбрать 
Automatic 



Заполнение рядами состоит из рядов прямых стеж-
ков и предназначено для заполнения больших бес-
форменных фигур. Стежки укладываются рядами , 
пересекающими образец от края до края. Стежки 
могут быть универсальными или  особыми. Мож-
но выбирать из нескольких имеющихся вариантов. 
Можно также варьировать шаг и длину стежка. 
 

Примечание
При заполнении рядами стежков можно  Выбрать 
образцы, формируемые точками прокола иглой. По 
умолчанию применяется образец заполнения ряда-
ми No. 1, разработанный для создания максимально 
гладкой и плоской текстуры, подобной матрасной 
ткани.  См. также  Применение образцов заполнения 
рядами. 

Создание заполнения рядами 

При этом используйте тип стежка рядами (Step fill). 

Для заполнения рядами

1 Выбрать Step Fill на панели стежков Stitch toolbar. 
См. также  Панель стежков. 
2 Выбрать инструмент оцифровки и оцифровать за-
крытый объект. См. Методы оцифровки. 

Примечание
Заполняемый объект создается с настройками ша-
гового заполнения, принятыми по умолчанию. Шаг 
и ширину стежков заполнения можно задать как до, 
так и после оцифровки. См. Настройка параметров 
стежков заполнения шагами.

Настройка параметров стежков запол-
нения рядами.

Функция Special Satin обычно используется для со-
кращения длины стежков, заполняющих большие 
фигуры. Ее можно использовать также  как альтер-
нативу шагового заполнения. Заполнение Special 
Satin больше похоже на гладь и хорошо работает 
с поворачивающимися стежками и искривленными 
объектами. Для сравнения, шаговое заполнение вы-
глядит более плоским и хуже работает в случае не-
больших и сильно искривленных объектов. См. так-
же  Сохранение длинных стежков. 

Разбиение длинных стежков при заполне-
нии гладью 
1 Двойным кликом или кликом правой клавишей 
мыши выделите нужный контур. Откроется диалог 
Object Properties > Fill Stitch > Satin.

2 Выбрать опцию Special Satin.

3 Нажмите Apply (применить). 

Заполнения стежков рядами 

Разным объектам подходят разные типы стежков. 
Программа BERNINA Embroidery Software предлагает 
стандартные стедки заполнения гладью и рядами, 
а также разные художественные типы заполнений. 
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Для создания заполнений больших и бехформенных 
объектов – используйте фугкцию Stitch > Step Fill . 

Опция Special Satin включена   Опция Special Satin отключена

Выбрать 
Special Satin 

Для настройки параметров стежка откройте диалог 
General > Object Properties



3  В поле Stitch Length введите нужную длину 
стежка.

4  Нажмите Apply (применить). 
 
Использование образцов заполнения 
рядами

В редиме заполнения рядами можно выбирать об-
разцы, формируемые по точкам прокола. Образец 
по умолчанию (No. 1) разработан так, чтобы созда-
вать однородно плоскую текстуру, подобную той, 
что применяется на матрасной ткани. См. также  
Creating fancy fills.

Есть и другие образцы. Экспериментируйте с ними. 
Попробуйте найти самый подходящий в Вашем слу-
чае. См. Образцы заполнения рядами.

Применение образцов заполнения рядами 

1 Двойным кликом или кликом правой клавишей 
мыши выделите нужный контур. Откроется диалог 
Object Properties > Fill Stitch > Step.

2  Выбрать образец.

При заполнении рядами, плотность стежков опре-
деляется расстоянием между рядами стежков. Вели-
чина шага – расстояние между передними рядами 
стежков.

Можно также  задать длину стежка. Она  может не-
много отличаться, чтобы не допустить того, чтобы на 
краях небольшие стежки не создавались бы. 

Настройка шага и длины стежка рядами 
1 Двойным кликом или кликом правой клавишей 
мыши выделите нужный контур. Откроется диалог 
Object Properties > Fill Stitch > Step. 

Подсказка
С помощью функции Object Properties можно в лю-
бое время  настроить параметры стежка, в том числе 
и до оцифровки. 

2 В поле Stitch Spacing введите требуемую вели-
чину шага. Оно соответствует расстоянию между 
передними строчками стежков в рядах.
•  Уменьшение шага увеличивает плотность стежков. 
•  Увеличение шага уменьшает плотность стежков. 
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Шаг: 1.2 мм              Шаг: 0.7 мм 

Длина стежка: 5.0 мм             Длина стежка: 2.0 мм

 Шаг стежка 

Длина
стежка 

Стежки вперед
назад

Выбрать шаг и 
длину стежка 

Для настройки параметров стежка откройте диалог 
General > Object Properties. 

Выбрать об-
разец для 

заполнения 
рядами 



На экране отобразится образец.

3 Нажать Apply (Применить).
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Глава 10
Методы дизайна 

В ПО BERNINA Embroidery Software проекты создают-
ся на основе базовых форм или «элементов вышивки». 
Процесс создания элементов называется оцифровкой. 
Как и в графических приложениях, здесь задействуются 
различные инструменты и методы оцифровки. При соз-
дании элементов вышивки они сочетаются с типом шва. 
Инструменты ПО BERNINA Embroidery Software иден-
тичны рисованию, только в конечном итоге Вы полу-
чаете вышивку, а не картинку. 
Как и инструменты рисования, инструменты оцифров-
ки обладают определенными характеристиками, т.е. 
свойствами: цвет, размер, положение и т.д. Также есть 
уникальные свойства: тип шва и плотность. Самым важ-
ным свойством является тип шва. Разные формы выши-
ваются разными швами. См. Стежки контура и заливки. 
Свойства устанавливаются при оцифровке, но могут 
быть изменены в любой момент. При оцифровке эле-
мента можно принять свойства заданные по умолчанию 
или настроить новые. Свойства по умолчанию заданы в шаблоне проекта. Также мож-
но настроить текущие свойства для всех элементов конкретного проекта. См. Свой-
ства элемента и шаблоны. 
Данная глава описывает основные методы оцифровки форм и оптимальную настройку 
свойств. 

Инструменты оцифровки и их выбор

Различные методы оцифровки или «инструменты» 
подходят для создания различных форм или эле-
менты дизайна. Методы Оцифровки можно разде-
лить на две категории - контур и заполивка.

Подсказка
Нарисованные объекты могут быть преобразованы в 
объекты вышивки с использованием «волшебной па-
лочки». См. Авто-оцифровки с помощью «волшеб-
ной палочки».

Digitize (оцифровка) > Open Object (открытый элемент) 
-  оцифровка открытого элемента.

Digitize > Closed Object (закрытый элемент) -  оцифровка 
закрытого элемента.

Digitize > Ellipse (эллипс) – оцифровка круглого или 
овального элемента. 

Digitize > Rectangle (прямоугольник) – оцифровка пря-
моугольного или квадратного элемента. Нажмите <Ctrl> 
для сжатия. 

Digitize > Block (блок) – оцифровка колонок с поворотом 
стежка.



не могут быть удалены – например, отметка началь-
ной точки. См. Изменение размера и редактирова-
ние элемента.

Методы присоединения

Установка Closest Join (ближайшее соединение) 
автоматически вычисляет ближайшее соединение 
элементов, и Вам не нужно думать о начальных и 
конечных точках. При активации (по умолчанию), 
соединяются все новые элементы. При отключении, 
элементы можно соединить по методу As Digitized 
(по оцифровке). Т.е. конечная точка предыдущего 
элемента соединяется с начальной следующего. При 
отключенном Closest Join можно самостоятельно 
определять начальные и конечные точки. См. Общие 
настройки.

Оцифровка открытой формы

Инструмент Open Object – оцифровка открытой фор-
мы с одной/тройной перспективой, атлас, одеяло, с 
рисунком или ремесленное шитье. Open Object раз-
мешает ряд стежков вдоль линии. Этот инструмент 
часто используется для добавления в проект границ.

Глава 10. МЕТОДы ДИЗАйНА 

BERNINA® Embroidery Software: Руководство по работе с программами 83

 Digitize (оцифровка) > Open Object (открытый элемент) – 
оцифровка открытой формы. 

ПО BERNINA Embroidery Software включает в себя 
различные инструменты оцифровки форм – Open 
Object (открытый объект), Closed Object (закрыты 
объект), Block Digitizing (оцифровка блока), Ellipse 
(эллипс) и Rectangle (прямоугольник). Инструмент 
Open Object нужен для создания контуров. Инстру-
мент Block Digitizing  - для создания колонн разных 
швов и наклонов. Инструменты Closed Object, Ellipse 
и Rectangle – для создания заполненных или конту-
рированных форм.

Ориентиры и узлы изменения формы

После выбора инструменты оцифровки, установите 
ориентиры вдоль контура:

•  Нажатием для ввода точки. 
•  Правая кнопка мыши для введения кривой. 

В общем точка отмечается, где: 
•  Кривая меняет направление 
•  Находится угол контура 
•  Контур меняется с прямой на кривую. 

Точки отмечаются там, где должны быть узлы из-
менения формы. Другие точки на элементе нужны 
для того, чтобы его трансформировать (повернуть, 
наклонить, и т.д.), измерить (изменить размер), на-
строить расстояние между буквами и изменить на-
чальную и конечную точки.

Узлы отмечены цветом, углы обозначены желтыми 
квадратами, точки изгиба – бирюзовыми кружками, 
а сгибы шва – оранжевыми квадратами. Начальная 
точка обозначена зеленым ромбом, конечная – крас-
ным крестом. Начальная и конечная точки всего 
проекта обозначены маленьким зеленым кружком и 
маленьким кранным крестом соответственно.

Примечание
Большая часть узлов может быть добавлена, удале-
на, перемещена или превращена в точки изгиба и 
углы. Некоторые узлы выполняют особые функции и

Ближайшее 
соединение 

ВКЛ.

Ближайшее 
соединение 

ВыКЛ.



Оцифровка закрытых элементов

Оцифровывайте закрытые элементы инструментом Closed 
Object (закрытый элемент). Создайте элемент, нажимая на 
контуры правой или левой кнопкой мыши.

Оцифровка закрытого элемента
1   Выберите тип шва контура или заливки. См. Выбор и из-
менение типа шва. 
2   Выберите инструмент Closed Object (закрытый элемент) 
и оцифруйте расставляя точки по контуру: 
•  Нажмите и проставьте точки. 
•  Правая кнопка мыши – обозначение кривой. 

 

Подсказка
Следуйте подсказкам в Строке состояния. Если Вы оши-
блись, нажмите Backspace (отмена) – удаление последней 
точки, или Esc  - удаление всех точек. 

3   Закройте форму. 
•  Нажмите Enter, чтобы закрыть форму идентичную пре-
дыдущей. 
•  Чтобы закрыть разные формы, выберите начальную и 
конечную точки и нажмите Enter. 

4  Повторите при необходимости. 
 

Примечание
Метод Closest Join (ближайшее соединение) закрывает 
формы автоматически. Если он не активирован, все новые 
элементы соединяются методом As Digitized (по оцифров-
ке). 
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Digitize (оцифровка) > Closed Object (закрытый элемент) 
– оцифровка закрытого элемента. 

Оцифровка открытой формы

1  Выберите тип шва контура. См. Выбор шва контура. 
2  Нажмите иконку Open Object (открытый элемент).
3  Оцифруйте, проставив точки вдоль контура
•  Нажмите и проставьте точки. 
•  Правая кнопка мыши – обозначение кривой. 

Подсказка
Следуйте подсказкам в Строке состояния. Если Вы оши-
блись, нажмите Backspace (отмена) – удаление последней 
точки, или Esc  - удаление всех точек. 

4  Нажмите Enter – завершение формы. 
 

Примечание
Если Вы хотите закрыть элемент выберите Edit (редактиро-
вать) > Close Curve (закрыть кривую) ... возможно закрыть 
прямой или кривой линией.

Открытый элемент                       Закрытый элемент

Автоматически закрытые элементы

Закрытый элемент с контуром      Закрытый элемент с заливкой 

1

2

3

4
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6

1

2

3

4
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Подсказка
Парные узды не обязательно должны быть одного типа. 
Например, одни может быть угловым, а второй – обозна-
чением кривой.

Подсказка
Если Вы ошиблись, нажмите Backspace (отмена) – удаление 
последней точки.

4  Нажмите Enter - завершение. 
5  При необходимости повторите. Метод Closest Join (бли-
жайшее соединение) закрывает формы автоматически. 
Если он не активирован, все новые элементы Соединяются 
методом As Digitized (по оцифровке). Т.е. Вам необходимо 
определить начальную и конечную точки, следую подсказ-
кам в Строке состояния. См. Установка общих параметров. 
См. Регулировка начальных и конечных точек. 
 

Подсказка
При использовании метода As Digitized (по оцифровке) 
можно пропустить или осуществить последний стежок. 
Например, пропустите или осуществите последний сте-
жок, чтобы конечная и начальная точки оказались ближе 
друг к другу. 
•  Нажмите Enter - осуществить последний стежок и по-
местите конечную точку в отмеченное место.

Глава 10. МЕТОДы ДИЗАйНА 

BERNINA® Embroidery Software: Руководство по работе с программами 85

Т.е. Вам необходимо определить начальную и конечную 
точки, следую подсказкам в Строке состояния. См. Уста-
новка общих параметров, а также См. Регулировка началь-
ных и конечных точек.

5   Нажмите Esc – деактивировать инструмент. 

Оцифровка колонн разной ширины

Инструмент Block Digitizing (оцифровка колонн) – оциф-
ровка колонн разной ширины и углом шва. Отправные 
точки определяют контур, а линии, их соединяющие – угол 
шва. 

Оцифровка колонн разной ширины:

1 Выберите тип шва Заливки. См. Выбор заливки
2 Нажмите иконку Block Digitizing (оцифровка блока).
3 Оцифруйте, проставив точки на противоположных сто-
ронах колонны. 
•  Нажмите и проставьте точки. 
•  Правая кнопка мыши – обозначение кривой. Отметьте 2 
точки, где должен меняться контур и/или угол шва. 

По оцифровке                   Ближайшее соединение

Швы изменяют свой 
угол постепенно

Начало Начало

Конец

Mixed curve and corner control points within
the same pair

Швы остаются параллельны-
ми между параллельными 

углами стежка

 Digitize (оцифровка) > Block (блок) – оцифровка колонн. 



•  Для создания овала нажмите на круг и отметьте 
вторую точку радиуса и нажмите Enter.

Оцифровка квадратов и прямоугольников

Оцифруйте в несколько кликов. Можно использовать 
любой тип шва заливки и контура.

Оцифровка квадрата или прямоугольника 

1 Выберите тип шва Контура или заливки.  См. Выбор 
шва контура или изменение стежка.
2 Нажмите иконку Rectangle (прямоугольник). 
3 Оцифруйте. 
•  Нажмите и отметьте один из углов. 
•  Двигайте курсор пока форма не достигнет нуж-
ного размера. 
•  Еще раз нажмите и обозначьте противоположный 
угол прямоугольника/квадрата. 

•  Если при движении курсора удерживать Ctrl, по-
лучится квадрат.
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•  Нажмите Spacebar (пробел) - пропустить послед-
ний стежок и поместить конечную точку напротив 
последней опорной точки.

6 Нажмите Esc – деактивация инструмента. 

Оцифровка стандартных форм

ПО BERNINA Embroidery Software включает в себя ин-
струменты для создания стандартных форм: кругов, 
квадратов, овалов и прямоугольников. 

Оцифровка овалов и кругов

Оцифруйте в несколько кликов. Можно использовать 
любой тип шва заливки и контура.

Оцифровка круга или овала 

1   Выберите тип шва Контура или заливки.  См. Вы-
бор шва контура или изменение стежка. 
2   Нажмите иконку Ellipse (эллипс). 
3   Оцифруйте. 
•  Нажмите на центра круга или овала. У курсора 
появится кружок. 
•  Двигайте курсор пока форма не достигнет нуж-
ного размера, затем нажмите, чтобы зафиксировать 
радиус. 
•  Нажмите Enter - завершить. 

Digitize (оцифровка) > Ellipse (эллипс) – оцифровка
эллипсов и кругов. 

Digitize (оцифровка) > Rectangle (прямоугольник) – 
оцифровка прямоугольников и квадратов. Нажмите 
<Ctrl> - удержание. 

Начало

Одинарный                  Атласный                     Обметка

Одинарный                       Атласный                      Обметка

Шаговый шаблон           Pattern Run                Необычный 

Шаговый шаблон                Pattern Run                  Необычный  

Конец Начало 1

2

1

2

3

Центр Центр

Нжмите 
Enter

Нжмите 
Enter

1

2
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Глава 11
Цвета нити и схемы

При оцифровке в рабочем окне из палитры выбирается 
цвет нити для каждого нового элемента. Палитра содер-
жит цвета с учетом проекта. Она отражает цвета, в ко-
торых и будет вышит проект. Также можно использовать 
коммерческие палитры других производителей. Для эко-
номии времени при выборе цветов, можно создать соб-
ственную палитру из часто используемых цветов. В ПО 
BERNINA Embroidery Software можно задать поиск нити по 
определенным критериям. И даже автоматически сопоста-
вить цвета с проектом.
Данная глава рассказывает о том, как выбирать цвета из 
палитры и устанавливать их для нити проекта, как изме-
нить и создать собственную палитру.

Изменение цвета выделенного элемента

• Отмените все выделения. На панели инструментов
будет показан текущий цвет (по умолчанию).

• Выберите цвет из Палитры. Теперь этот цвет уста-
новлен по умолчанию.

Изменение цвета нити

ПО BERNINA Embroidery Software содержит различ-
ные техники выбора и смены цвета локально или для 
всего проекта. 

Примечание
Палитры – только примерно отражают цвета, т.к. 
существует разница мониторов и видео карт. Нить 
всегда следует соотносить с конкретным цветом в 
палитре.

Изменение цвета выделенного элемента

Новые элементы будут заданного цвета. Цвет мож-
но изменить в любой момент. При создании нового 
элемента, он автоматически принимает текущий за-
данный цвет.

Color Palette (палитра) > Color Picker (выбор цвета) – вы-
брать и применить цвет.

Color Palette > Apply Current  Color (применить текущий 
цвет) – применить выбранный цвет в элементах.

Color Palette – выбор цвета.

Текущий цвет
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Изменение цветовой схемы

•  Инструмент Cycle Used Colors (цикл используемых 
цветов) – различные комбинации имеющихся нитей. 

•  Или выберите Color Wheel (цветовое колесо) из 
палитры. 
Так можно получить больше цветов и гамм, включая 
Аналог, Дополнительно, Гармония, и .т.д. 

•  Нажмите и передвигайте узел цвета, чтобы про-
смотреть комбинации в последовательности. 

•  Выделите элемент/ы

•  Выберите цвет из цветовой палитры. Выбранные 
объекты меняют цвет соответственно.

•  Выберите уже используемый в других элементах 
цвет при помощи Color Picker (выбор цвета) и пере-
несите его на нужные элементы при помощи Apply 
Current Color (применить текущий цвет).

Изменение цветовой схемы

Color Wheel (колесо цветов) позволяет проверять и 
менять всю схему. Главная цель – быстро и легко 
менять последовательность цветов, чтобы обновить 
старый проект или перенести его на другую ткань.

Color Palette (палитра) > Color Wheel (колесо цветов) – 
просмотр оттенков. 

Color Palette > Cycle Used Colors (цикл используемых 
цветов) – просмотр используемых цветов.

Выберите цвет 
из Палитры

Выберите цветовую схему

Регулируемая цветовое колесо для цветовых 
сочетаний

Нажмите и перетащите узелок для
регулировки цвета



Примечание
Основной цвет, как правило, соответствует ткани. 
•  Нажмите и передвигайте указатель, чтобы уста-
новить цвет. 
•  Для настройки оттенка используйте контроль яр-
кости. 

•  Отрегулируйте яркость проекта, выберите основ-
ной цвет и отрегулируйте его яркость. 
•  Нажмите OK - завершение. 
Проект обновится и примет изменения. 

Примечание
Если нужные цвета уже есть в палитре, они будут со-
поставлены автоматически. 
•  Если нужно сопоставить и установить цвет нити, 
это можно сделать вручную или функцией Match & 
Assign All (сопоставить и принять все). См. Сопо-
ставление и установка нити. 

Установка цвета нити

В ПО BERNINA Embroidery Software можно задать кри-
терии  поиска нити вручную и Применить к проекту. 
Сопоставление цвета нити позволяет найти и уста-
новить цвет, наиболее близкий к нужному. Функция 
Color Wheel (колесо цветов) позволяет менять цвет в 
проекте и автоматически его сопоставлять.
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Подсказка
Thread Chart (палитра нити)> Print (печать) – позво-
ляет распечатать выбранные цвета вместе с пали-
трой для дальнейших покупок. См. Печать палитры 
нити. 

Поиск и установка нити

Нить можно искать по коду или описанию и при-
менять к выбранному слоту. ы палитрах указаны 
поставщики нитей, применимых для машин с ПО 
BERNINA Embroidery Software. Каждая палитра имеет 
свой ряд цветов. Код, марка и описание нити выво-
дится на экран, так что будет легко найти ее в запасе 
или в магазине. Цвета можно выбирать по оттенку 
или по номеру. Выбирайте палитру по марке нити, 
которая у Вас есть или просто по понравившимся 
цветам. 
 

Примечание
Также возможно создать свою палитру с нитями раз-
ных марок. См. Создать пользовательскую палитру 
нити. 

Поиск и установка нити 

1 Нажмите иконку Thread Colors (цвет нити).
Откроется окно Design Properties (свойства проекта) 
> Thread Colors (цвета нити). 

Color Palette (палитра) > Thread Colors (цвет нити) - 
поиск и сопоставление нити в разных палитрах.

Локальная регулировка             Контроль яркости

Смена цвета фона 

Выбор палитры 

Код или описание 

Введите строку 
поиска 



Подсказка
Измерите фон кнопкой BKG вверху панели Threads 
in design (нить проекта). См.  Настройка цвета фона. 

2   Выберите палитру в списке Thread Chart (палитра 
нити). 
3   Выбор критерия поиска – Code (код) или 
Description (описание). Код – идентификационный 
номер цвета по марке 
4   В поле Search (поиск) введите первые несколь-
ко символов кода или описания. Система найдет все 
похожие и выведет список. 
5    Выберите цвет в панели Threads in design (нить 
проекта) и нажмите Assign (принять) или дважды 
кликните на нить. 
6   Нажмите Apply (применить) – предпросмотр из-
менений в окне проекта. 
7   Нажмите OK - заверщить. 
 

Примечание
Настройки цветов применяются только к текущему 
проекту и являются его свойствами. Таким образом 
они сохраняются вместе с проектом. 

Сопоставление и установка нити

Команда Match (сопоставить) – сопоставление выде-
ленного цвета в проекте с цветом в палитре. Также 
опция Match & Assign All (сопоставить и принять все) 
сопоставляет все цвета проекта с ближайшими к ним 
нитями и автоматически их заменяет. 
 

Подсказка
Это также можно использовать для изменения всех 
элементов одного цвета. Например, заменить все 
темно-зеленые элементы на светло-зеленые.

Сопоставление и установка нити

1 Нажмите иконку Thread Colors (цвет нити).
Откроется окно Design Properties (свойства проек-
та)> Thread Colors (цвета нити). В панели Threads in 
design (нити проекта) отражены все используемые 
цвета.
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2  Из списка Threads in design выберите цвет проекта. 
3  Из списка Thread Chart выберите палитру. Кнопка 
Match (сопоставить) доступна.

4   Нажмите Match. Вверху списка Thread Color по-
явится ближайший цвет. 
5  Нажмите кнопку Assign (принять) или дважды 
кликните по нити. Выбранный цвет будет заменен 
ближайшей нитью. 
6   Повторяйте пока цвета полностью не совпадут. 

Подсказка 
Или просто кликните на кнопку Match & Assign All 
(сопоставить и принять все). Автоматически будет 
найдена ближайшая нити и цвет будет заменен. 

7   Нажмите Apply (применить) – предпросмотр из-
менений в окне проекта. 
8   Нажмите OK - завершение.

Color Palette (палитра) > Thread Colors (цвет нити) – поиск 
и сопоставление нити в разных палитрах. 

Исходный цвет
проекта

желтый заменен 
на оранжевый

Назначен другой 
оттенок зеленого

Выберите цвет для 
сопоставления 

Выберите палитру 
нити 

Выбор сопоставляе-
мой нити 

Сопоставить цвет с 
нитью 



Изменение палитры нити 

Измените палитру, изменив настройки нити или 
удалив несколько. Также палитры можно переиме-
новывать или удалять. 
 

Примечание
Палитры ПО BERNINA Embroidery Software отража-
ют множество цветов и марок. К сожалению, они не 
всегда полностью точны, т.к. производители нити 
часто меняют, снимают с производства или добав-
ляют новые цвета. В таком случае Вы можете создать 
свою палитру обновлений.

Изменение настроек нити
Измените код, марку или описание существующей 
нити. 

Изменение настроек нити

1 Выберите Design (проект) > Thread Colors (цвет 
нити) или нажмите на ссылку в окне Color Palette 
(палитра). 
Откроется окно Design Properties (свойства проекта) 
> Thread Colors (цвет нити). 

2 Нажмите Create/Modify (созжать/изменить). От-
кроется окно Modify Thread Chart (изменить пали-
тру).

3 В списке Name (название) выберите палитру.
4 В списке Threads (нити) выберите нить.
5 Нажмите Edit (редактировать). 
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Откроется окно Edit Thread (редактировать нить).

6   Измените код, марку и описание нити 
Код - идентификационный номер цвета по марке. 
7   Нажмите на выпадающее меню Color (цвет) – выбор 
экранного цвета нити. См. Смешивание цветов нити. 
8   Нажмите OK. Отредактированный цвет появится в 
списке Threads (нити). 

Смешивание цветов
Можно изменять цвет конкретной нити или при по-
мощи окна Color (цвет) создавать новые. 

Смешивание цветов 

1   В окне Add Thread (добавить нить) или Edit Thread 
(редактировать нить) нажмите More Colors (больше 
цветов) в выпадающем меню Color (цвет). 
•  См. Изменение свойств нити. 
•  См. Добавление цветов в палитру нити. Откроется 
окно Colors – цвета могут незначительно отличаться 
в зависимости от используемого ПО.

2 Выберите стандартный (предустановленный) цвет 
или смешайте свой.

 Изменить палитру 

Нажмите, чтобы 
выбрать или пере-
мещать цвета 

Выберите палитру 

Выберите нить                      Нажмите для редактирования цвета 



Для переименование палитры нити:
1   Откройте окно Modify Thread Chart (изменение 
палитры нити). См. Изменение свойств нити. 

2 Из списка Name (название) выберите палитру. 
3 Нажмите Rename (переименовать). 
Откроется окно Rename Thread Chart (переимено-
вать палитру нити). 

4   Введите новое название и нажмите OK. 

Удаление палитры нити

Удалите устаревшие палитры из окна Modify Thread 
Chart (изменение палитры нити). 
 

Примечание
Будьте внимательны при удалении палитры. Если 
удалите не ту, придется переустанавливать ПО 
BERNINA Embroidery Software, чтобы ее восстановить. 

Удаление палитры нити

1   Откройте окно Modify Thread Chart. См. Измене-
ние свойств нити. 

2 Из списка Name выберите палитру. 
3 Нажмите Delete (удалить). Подтвердите удаление. 
4 Нажмите Yes (да). 

Создание пользовательской палитры нити

3   Для уточнения выбора цвета перетащите крестик 
по цветовой гамме. 
4   Передвиньте стрелку ползунка для редактирова-
ния яркости. 
5   Или уточните значения HLS или RGB. 
6   Нажмите OK. В окне предпросмотра появится но-
вый цвет. 

Удаление нити из палитры

 

При помощи окна Modify Charts (изменение пали-
тры) легко удаляются устаревшие нити. 

Удаление нити из палитры
1  Откройте окно Modify Thread Chart (изменение 
палитры нитей). См. Изменение нити. 

2   Из списка Name (название) выберите палитру. 
3   Из списка Threads (нити) выберите нить/и для удаления: 
•  Удерживайте клавишу Shift, чтобы выделить по-
следовательность объектов. 
•  Удерживайте клавишу Ctrl, чтобы выделить не-
сколько объектов. 
4   Нажмите Remove - удаление. 
 

Подсказка
Чтобы удалить все, нажмите Clear All (очистить все). 

Переименование палитры

Переименуйте палитру в окне Modify Thread Chart 
(изменение палитры нити).

Подсказка
Названия выбирайте такие, которые помогут Вам 
ориентироваться или те, которые оказываются ввер-
ху списка.
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 Color Palette (палитра цвета) > Thread Colors (цвет нити) 
– поиск и применение таких же нитей в других палитрах. 

Color Palette (цветовая палитра) > Thread Colors 
(цвета нитей) – переименовать палитру. 

Color Palette (палитра цветов) > Thread Colors 
(цвета нити) – удалить палитру. 

Color Palette > Thread Colors – создать новую палитру

Нажмите для уда-
ления выбранного 
цвета 

Переименовать 
палитру нити 

             Выберите палитру                              Удалить палитру 

Выбрать палитру        Переименовать палитру 

Нажмите для 
удаления ВСЕх 
цветов



Палитра нити- список заранее определенных цве-
тов. Они могут быть основаны на коммерческих спи-
сках нитей или созданы Вами. 
 

Подсказка 
Опция Thread Chart (палитра нити) > Print (печать) 
позволяет распечатать палитру в виде закупочного 
списка. См. Печать палитры нити. 

Создание новой палитры
Создание палитры – создание запаса необходимых 
Вам цветов. Например, можно создать палитру ни-
тей, которые у Вас уже есть. Она может включать в 
себя множество нитей и марок. Такая палитра по-
зволит легче сопоставлять и менять цвета проекта. 

Для создания новой палитры нити
1  Выберите Design (проект) > Thread Colors (цве-
та нити) или нажмите на ссылку в окне Color Palette 
(палитра цветов). 
Откроется окно Design Properties (свойства проекта) 
> Thread Colors (цвета нити). 

2  Нажмите Create/Modify (создать/изменить). От-
кроется окно Modify Thread Chart (изменение пали-
тры нити).

3  Нажмите кнопку Создать (Create). 
Открывает Create Thread Chart (Создание палитры 
нити).

4   Введите название и нажмите OK.

Примечание
При наименовании новой или переименовании ста-
рой палитры, не используйте специальные символы 
и знаки препинания, например, запятые. 
Вы вернетесь в окно Modify Thread Chart (изменение 
палитры нити). Новая палитра готова, можете до-
бавлять в нее цвета. 

5 Нажмите Add (добавить) – откроется окно  Add 
Thread (добавить нить). См. Добавить свой цвет в 
палитру. 
6 Нажмите Copy From (копировать из) – добавить 
цвет из другой палитры. См. Копирование цветов 
между палитрами. 
7 Нажмите Close (закрыть). Новая палитра готова к 
использованию. 

Копирование цветов между палитрами
Чтобы создать палитру из цветов других палитр, их 
можно копировать. 

Копирование цветов между палитрами
1  Откройте окно Modify Thread Chart (изменение 
палитры нити). См. Создание новой палитры нити. 

2  Из списка Thread Chart (палитра нити )> Name 
(название) выберите палитру.  
3   Нажмите Copy (копировать). 
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Нажмите, чтобы 
создать палитру 
нити 

Нажмите Create(Создать)

Введите 
название 
палитры 

Новая
палитра
создана 

Выберите палитру 

Нажмите, 
чтобы ско-
пировать



Откроется окно Copy Thread Chart (копировать па-
литру нити). В списке Threads (нити) появится новый 
цвет. 

4  Из списка Name (название) выберите нужную палитру. 
5  Выберите цвет: 
•  Удерживайте клавишу Shift, чтобы выбрать после-
довательность цветов. 
• Удерживайте клавишу Ctrl, чтобы выбрать не-
сколько цветов. 
6  Нажмите OK. Цвета скопированы и появятся в кон-
це списка.

Добавление собственных цветов
В палитру можно добавлять цвета из других палитр 
или полученные самостоятельно.

Для добавление собственных цветов:
1 Откройте окно Modify Thread Chart (изменение па-
литры нити). См. Создание пользовательской пали-
тры нити. 
2 Нажмите Add (добавить) – добавить свой цвет. От-
кроется окно Add Thread (добавить нить). 

3  Нажмите на выпадающее меню Color (цвет) – вы-
бор визуализации цвета. См. Смешивание собствен-
ных цветов нити.
4  Введите код, марку и описание нового цвета. Код 
– идентификационный номер цвета нити для марки.
5   Нажмите OK.
Новый цвет появится в списке Threads.
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Выберите палитру из которой
 будем копировать

Выберите 
цвета нитей

Нажмите, чтобы 
выбрать или 
смешивать цвета

Нажмите, чтобы 
выбрать или 
смешивать цвета

1234

My Brand
Purple
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Глава 12
Свойства объекта и шаблоны 

Свойства объекта вышивки определяют такие характеристики как 
размер, положение, тип и плотность шва. Конкретные параметры 
стежка определяют, как он будет изменяться при смене формы, 
размера или других трансформаций объекта. 

При создании  объекта можно принять свойства по умолчанию 
или настроить свои, в зависимости от метода создания. Также 
можно применить текущие настройки для всех новых объектов 
проекта. 

Данная глава описывает настройку свойств объекта,  создание, 
применение и сохранение шаблонов в ПО  BERNINA Embroidery 
Software. 

В общем, их следует менять, чтобы сэкономить вре-
мя при оцифровке. Например, можно заранее уста-
новить шаг стежка, чтобы получить определенную 
плотность всех последующих объектов. 

Примечание
Изменения касаются только новых объектов, а не 
всего шаблона в целом. Чтобы изменения распро-
странились на все шаблоны, необходимо изменить 
настройки по умолчанию, а не текущие. 

Свойства существующих объектов
Это свойства каждого отдельного объекта проекта. 

Установка текущих свойств объекта

При изменении текущих свойств, они автоматически 
применяются ко всем новым объектам проекта.

Управление и применение свойств 
объекта

ПО BERNINA Embroidery Software предлагает 3 ком-
плекта свойств: по умолчанию, текущие и существу-
ющие. 

Примечание
Некоторые свойства можно изменить  с экрана,  на-
пример, размер путем масштабирования объекта 
маркерами. Другие свойства (например, расстояние 
между стежками или их длинна) изменяются в окне 
Object Properties (свойства объекта).

Свойства по умолчанию 
Такие свойства сохранены в шаблоне и являются на-
чальными при создании проекта на основе готового 
шаблона. 

Текущие свойства
Текущие свойства – используемые для создания но-
вых объектов. Они будут заданы по умолчанию, пока 
не будут изменены. 

 General (основное) > Object Properties (свойства объекта) 
– установка текущих свойств. 
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Установка текущих свойств объекта 

1 Нажмите иконку Object Properties (свойства объ-
екта), на выделяя никаких объектов.
Откроется окно Object Properties (свойства объекта).

Вверху окна отображены закладки. Они дают доступ 
ко всем свойствам объекта. 

2 Выберите закладку, просмотрите настройки и из-
мените их. 
3 Нажмите Apply (принять). 

Изменение свойств выделенных объектов

Можно менять свойства выделенного объекта/ов. 
Например, при изменении размера проекта может 
понадобиться вышить заливку  некоторых объектов 
пошагово, а не атласным стежком, чтобы получить 
более четкий рисунок. Если выделить более одно-
го объекта, в окне отобразятся вкладки, касающиеся 
только их.

Если одно и тоже свойство для разных объектов бу-
дет иметь разные значения, поле будет пустым. Но-
вое значение будет применено ко всем объектам. 
 

Примечание
Изменение не влияет ни на текущие  свойства, ни на 
свойства невыделенных объектов. 

Для изменение свойств выделенных объ-
ектов
1 Выделите объект/ы. 
2 Щелкните по ним дважды или один раз правой 
кнопкой мыши. Откроется окно Object Properties 
(свойства объекта). 
3 Выберите вкладку с нужными свойствами. 
4 Нажмите Apply (принять). 

Изменение свойств по умолчанию

Свойства по умолчанию можно изменить в любой 
момент, сохранением текущих свойств. Сохранят-
ся только настройки, касающиеся текущего объекта. 
Other properties retain their current settings. Напри-
мер, если для текущего объекта установить атласную 
заливку, то художественная заливка по умолчанию 
изменена не будет. При сохранении свойств можно 
задать будут ли они применены только к буквенным 
объектам, всем остальными или и тем и другим.

Примечание
Изменения коснуться всех новых проектов, соз-
данных при помощи данного шаблона. Если изме-
нения должны касаться только текущего проекта, 
они должны быть сделаны для текущих свойств. См. 
Установка текущих свойств объекта.

Для изменение свойств по умолчанию для 
выделенного объекта:

1 Выделите объект/ы. 
2 Щелкните по ним дважды или один раз правой 
кнопкой мыши.

Выбрать 
закладку 

Настроить 
свойства 

Default Satin Spacing 
values applied  

New Satin Spacing 
values applied

 General (основное) > Object Properties (свойства объекта) 
– установка текущих свойств. 

 General (основное) > Object Properties (свойства объекта) 
– установка текущих свойств. 
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Откроется окно Object Properties (свойства объекта).

3  Выберите вкладку с нужными свойствами. 
4  Нажмите Save To Template (сохранить в шаблон). 
Откроется окно Save To Template (сохранить в шаблон). 

5 Выберите опцию: 
•  Буквы: изменения будут применены только к бук-
венным объектам. 
•  Другое: ко всем объектам, кроме буквенных. 
•  Все: ко всем объектам.
Появится запрос подтверждения. 

6  Нажмите OK – обновить шаблон. Изменения со-
хранены и свойства применяются ко всем новым 
объектам вышивки. 

 
Примечание
Используя такие настройки как настройки по умол-
чанию, можно создать новый шаблон. См. Управле-
ние шаблонами проекта. 

Управление шаблонами проекта
Шаблон – файл, в котором хранятся настройки по 
умолчанию. Шаблоны нужны, чтобы не менять на-
стройки и свойства каждый раз при создании нового 
проекта, а использовать готовые часто используе-
мые наборы и комбинации. В шаблоне можно просто 
сохранить настройки шва, буквенный фон и размер, 
цвета и текущие свойства. Или можно задать особую 
плотность, Or it may have special density, компенса-
цию натяжения или настройки подкладки для раз-
ных тканей.

Обычный шаблон – шаблон ПО BERNINA Embroidery 
Software. Он содержит текущие свойства. При необ-
ходимости изменения могут быть отменены и ша-
блон вернется в обычным настройкам. См. Возвра-
щение к обычному шаблону.

Создание шаблонов
Шаблон создается из объектов проекта и их свойств. 
Просто сохраните проект или его элементы кА ша-
блон. Файлы шаблонов выглядят также как файлы 
проектов, но имеют расширение AMT. Убедитесь, 
что Вы задали название шаблона до внесения в него 
изменений. Если изменения сделаны в настройках 
Object Properties (свойства объекта), а затем нажата 
кнопка Save To Template (сохранить в шаблон) – из-
менения будут сохранены в текущем шаблоне. См. 
Изменение свойств по умолчанию. 

Примечание
Вы не можете перезаписать шаблоны случайно. Каж-
дый раз, когда вы создаете новый проект из ша-
блона, BERNINA Embroidery Software открывает ду-
бликат. При сохранении конструкции в первый раз, 
диалоговое окно Сохранить как (Save As) открыва-
ется, так что вы можете сохранить шаблон под 
Новым именем.

Для создание шаблона:
1 Откройте новый или уже существующий проект. 
2 Настройте свойства. 
3 Добавьте все необходимые объекты. НапримерFor 
instance, надписи на разных уровнях. Просто заме-
ните текст в шаблоне.

Изменение свойств       Сохранить для всех выделенных

В шаблоне можно 
сохранить часто 
используемый цвет 
фона 
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См. Установка линий буквенных объектов. 

4   Выберите File (файл) > Save As (сохранить как). 
Откроется окно Save As.

5 Выберите шаблоны ПО BERNINA Embroidery 
Software. Из списка Save as Type (сохранить как тип). 
ПО BERNINA Embroidery Software автоматически от-
рывает папку ..\Program Files\BERNINA\Embroidery 
Software 7\template. Если шаблон не сохранить 
здесь, он не будет виден в списке при создании но-
вого проекта. 
6  В поле File Name (название файла) велите назва-
ние шаблона.
7  Нажмите Save (сохранить). 

Изменение шаблона
Шаблон можно менять также как проект. Изменения 
применяются к будующим использованиям шаблона. 
Они не влияют на проекты использующие шаблон. 
 

Примечание
Шаблон удаляется точно также как любой другой 
файл MS Windows® Explorer. Они хранятся в пап-
ке ..\Program Files\BERNINA\Embroidery Software 7\
template. 

Для изменения шаблона:
1 Выберите File (файл) > Open (открыть). 
Откроется окно Open (открыть). 

2 Найдите папку ..\Program Files\BERNINA\
Embroidery Software 7\template. 
3 Выберите Шаблоны ПО BERNINA Embroidery 
Software из списка Files of Type (тип файла). Появятся 
доступные шаблоны. 
4   Выберите шаблон и нажмите Open (открыть). 

5 Измените свойства, стиль и другие настройки.

6  Выберите File (файл) > Save As (сохранить как). 
Откроется окно Save As. 
7 Выберите папку ..\Program Files\BERNINA\
Embroidery Software 7\template. 
8  Из списка Save as Type (сохранить как тип) вы-
берите Шаблоны ПО BERNINA Embroidery Software. 
9  Выберите файл шаблона и нажмите Save (сохра-
нить). Появится запрос подтверждения. 
 

Подсказка
Чтобы из готового шаблона сделать новый, введите 
новое название и нажмите Save. 

10  Нажмите Yes (да), чтобы подтвердить. Новый 
шаблон готов к использованию.

Сохранение текущих свойств в шаблон
Текущие свойства объекта можно легко сохранить в 
шаблон. См. Управление и применение свойств объ-
екта. 

Введите имя 
шаблона

Выберите ша-
блоны Bernina

         Проект 1                                               Проект 2 
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Сохранение текущих свойств в шаблон

1  Откройте окно Object Properties (свойства объекта).

•  Для активации текущих свойств отмерите все вы-
деления и нажмите иконку Object Properties (свой-
ства объекта). 
•  Чтобы применить свойства к определенному объ-
екту, выделите его и нажмите на него два раза или 
один раз правой кнопкой мыши. 

2  Измените свойства объекта. 
3  Нажмите Save To Template (сохранить в шаблон). 
Появится запрос подтверждения.

 

Примечание 
В шаблон можно сохранить только текущие на-
стройки. 
4   Нажмите OK – обновить шаблон. 
5   Нажмите Close (закрыть) – возврат в окно проекта. 
Настройки сохранены в шаблон и готовы к исполь-
зованию. 

Возврат к обычному шаблону
Если был изменен обычный шаблон ПО BERNINA 
Embroidery Software, можно вернуться к первона-
чальному виду. Оригинальная копия не удаляется, 
так что она всегда может быть восстановлена. 

Возврат к обычному шаблону
1  Закройте ПО BERNINA Embroidery Software. 
2 Нажмите кнопку MS Windows® Start и выберите про-
граммную папку ПО BERNINA Embroidery Software. 
3 Выберите папку Tools (инструменты) и нажмите 
иконку Revert (возврат). Откроется окно Revert to 
Factory Template (возврат к шаблону производите-
ля).

Примечание
Окно может открываться  1 - 2 минуты

4  Выберите флажок Templates (шаблоны) и нажмите OK. 
Оригинальная версия восстановлена. 

Выберите 
шаблоны
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Глава 13
Качество стежков 

ПО BERNINA Embroidery Software располагает множеством 
возможностей для улучшения качества и эффективности 
вышивки. Настройки ткани позволяют учитывать тип ткани 
при работе машины. Автоматические настройки подкладки 
позволяют стабилизировать ткань и избавится от затяжек 
из-за растяжения ткани. Отрегулируйте количество повто-
рений шва, чтобы компенсировать натяжение ткани. Это 
очень удобно при работе с тянущимися тканями.

Применив Auto Jump (авто прыжок) можно превратить 
длинный стежок в серию. Стежки-связки автоматически 
включаются в начало объекта, чтобы избежать запутывания 
нити. Эти стежки можно контролировать по всему проекту 
или по отдельным объектам. Авто начало и конец помо-
гают установить положение первого и последнего стежка 
проекта. Все это – свойства объекта и они могут быть при-
менены, удалены или изменены в любой  момент. 

Глава рассказывает о том, как установить настройки ткани и подкладки, и как ком-
пенсировать растяжение ткани, а также о том, как сохранить длинные стежки, на-
строить стежки-связки и установить автоматические точки начала и конца. 

Настройка параметров ткани

ПО BERNINA Embroidery Software дает возможность 
менять параметры ткани так, чтобы машина учиты-
вала ее особенности. Например, тип ткани опре-
деляет компенсацию растяжения при вышивке. Это 
предохраняет вышивку от непредвиденных пробе-
лов. См. Компенсация растяжения ткани. 



Глава 13. СВОйСТВА ОБъЕКТА И ШАБЛОНы 

BERNINA® Embroidery Software: Руководство по работе с программами 101

Примечание
Изменения по умолчанию применяются ко всем но-
вым объектам вышивки, кроме буквенных. См. Ком-
пенсация растяжения ткани. 

Для настройки параметров ткани:
1 Выберите Edit (редактировать) > Select All (выде-
лить все). Выделен весь проект. 
2 Выберите Design (проект) > Fabric Settings (пара-
метры ткани). Откроется окно Fabric Settings.

3 Из списка Fabric type (тип ткани) выберите нужное.

4   Нажмите OK. Настройки применены к проекту.

В таблице ниже приведены виды шва для разных типов ткани.  

Вес Ткань 
Комп. Раст. 

(мм)

Расстояния (мм)

Сатин (уч.) Сатин
(авто) Шаг

Зигзаг
подкладки

Шаг
подкладки

По умолчанию N/A 0.200 0.4 0.01 0.45 3.0 3.0 

Легкий три-
котаж Футболки 0.250 0.37 0.02 0.40 3.0 2.5 

Средний три-
котаж 

Поло /ребри-
стая ткань 0.250 0.37 0.02 0.40 3.0 2.5 

Тяжелый три-
котаж 

Флис / Свит-
шоты 0.350 0.36 -0.02 0.38 2.5 2.5 

Средняя мах-
ровая ткань Полотенца 0.250 0.36 0.02 0.38 1.5 1.8 

Тяжелая мах-
ровая ткань

Полотенца / 
халаты 0.250 0.36 -0.02 0.38 1.5 1.8 

Легкая шерсть Батист / хло-
пок / Сатин 0.200 0.38 0.03 0.40 3.0 2.8 

Тяжелая 
шерсть

хлопок / 
Легкая по-

лотняная ткань 
/ Полиэстер 

0.200 0.38 0.0 0.40 2.5 2.5 

Средняя 
шерсть

Деним / холст 
/ Твил 0.200 0.38 -0.01 0.40 2.5 2.5 

Стабилизация с подкладкой

Для улучшения качества необходимо использовать 
подкладку. Она помогает стабилизировать ткань и 
избегать затяжек. Также она дает «буфер» верхним 
стежкам, не позволяя им проваливаться в ткань. Без 
подкладки вышивка будет плоской, а сама ткань бу-
дет просвечивать. Может возникнуть соблазн увели-
чить плотность стежка, но использовать подкладку 
гораздо эффективнее. 

Применение подкладки

Инструмент Auto Underlay (автоподкладка) автома-
тически подгоняет имеющиеся объекты под условия 
использования подкладки. Можно устанавливать 
параметры для каждого нового объекта или задать 
одну подкладку для всех по умолчанию.

Направление нити ткани  Направление нити ткани
             Средний вес                     Тяжелый вес   

General (основное)>Effects (эффекты)– применение эф-
фектов к выделенным объектам или ко сем объектам 
сразу. 

Stitch (стежок) > Auto Underlay (автоподкладка) – усиле-
ние и стабилизация объектов при помощи подкладки.



Все типы подкладки 1 доступны и для подкладки 2.

•  Для большей устойчивости, примените подкладку 2. 
Подкладки могут свободно комбинироваться.

• Чтобы сохранить настройки, нажмите Save to 
Template (сохранить в шаблон). См. Сохранить теку-
щие настройки в шаблон. 

Настройка подкладки по центру и по краю

Подкладка Center Walk (по центру) – ряд стежков 
вдоль центра колонны. Используется для узких ко-
лонн –2-3 мм шириной. Edge Walk (по краю) – стеж-
ки по контуру объекта. Используется для больших 
форм вместе с зигзагами и шагами.

Примечание
Выбор настроек шва подкладки отделен от выбора 
шва вышивки и никак на него не влияет.

Применение подкладки

•  Нажмите иконку Auto Underlay (автоподкладка) – 
доступ к настройкам. 

Подсказка
Для сохранения настроек подкладки нажмите икон-
ку Effects (эффекты) -  откроется окно Effects > 
Underlay (подкладка).  

•  Создайте круг или квадрат. См. Методы оциф-
ровки. Объект будет создан с текущими свойствами. 

•  Выделите объект и нажмите на иконку Auto 
Underlay (автоподкладка) правой кнопкой мыши, 
чтобы изменить настройки. Откроется окно Effects 
(эффекты) > Underlay (подкладка). Можно менять 
одну или 2 последовательных подкладки.

•  Выберите Apply Underlay 1(применить подклад-
ку1) и выберите ее тип из списка. 
Тип определяется целями использования. 

•  Отрегулируйте длину стежка и настройки края.
Подробности ниже.
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Выберите 1-ую 
подкладку и 

тип шва 

Выберите 2nd 
Подкладку и 

тип шва 

Подкладка 
по краю 

Подкладка 
по краю 

Шаговая 
подкладка

Подкладка по центру и 
по краю вместе 

Зигзаговая
подкладка 

Шаговая 
подкладка 

Двойной
зигзаг

Подкладка 
по краю 

Зигзаговая
подкладка 

Правая кнопка мыши -  Stitch Effects (эффекты шва) > 
Auto Underlay (автоподкладка) – усиление и стабилиза-
ция объектов при помощи подкладки. 



Регулировка положения зигзага
1  Настройки могут быть текущими или применяться 
для выделенных объектов: 
•  Нажмите Esc – все выделения отменены. 
•  Или выделите объект\ы для которых устанавли-
ваете настройки. 
2  Нажмите правой кнопкой мыши на икону Auto 
Underlay (автоподкладка). Откроется окно Effects 
(эффекты) > Underlay (подкладка). 

3   Выберите флажки первой и второй подкладки и 
нажмите Zigzag (зигзаг) или Double Zigzag (двойной 
зигзаг).
4   Введите длину стежка.

5   Нажмите Apply. Настройки применены к выде-
ленным объектам.

Установка поля подкладки

Поле подкладки – расстояние между контуром вы-
шивки и краем подкладки. Увеличьте это значение, 
чтобы подкладка не выходила за пределы вышивки. 

1  Настройки могут быть текущими или применяться 
для выделенных объектов: 
•  Нажмите Esc – все выделения отменены. 
•  Или выделите объект\ы для которых устанавли-
ваете настройки. 
2  Нажмите правой кнопкой мыши на икону Auto 
Underlay (автоподкладка). Откроется окно Effects 
(эффекты) > Underlay (подкладка). 

3  Выберите флажки первой и второй подкладки и 
нажмите Center Walk (по центру) и/или Edge Walk (по 
краю). 
4   Настройте длину стежка так, чтобы она совпадала 
с кривой контура и не была видна на конечной вы-
шивке. 

5 Отрегулируйте поле подкладки так, чтобы ее 
стежки не выходили за пределы вышивки. См. На-
стройка поля подкладки. 
6  Нажмите Apply (применить).  Изменения будут 
применены к новым или выделенным объектам. 

Регулировка амплитуды зигзага

Для широких колонн используйте одинарный и 
двойной зигзаг. Возможно установить длину стежка. 
Двойной зигзаг применим только для сатиновой за-
ливки или букв. Настройки можно применить и до и 
после оцифровки. 
 

Примечание
Зигзагообразные стежки подкладки задаются от-
дельно от аналогичных стежков вышивки и никак на 
нее не влияют. 
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Выберите 1ую 
подкладку и 

тип шва 

Длинна стежка по краю: 1.5мм           Длинна стежка по краю: 3.5мм Зигзаг длинна стежка: 2.5 мм          Зигзаг длинна стежка: 5 мм 

Двойной зигзаг длина стежка: 7 мм     Двойной зигзаг длина стежка: 3.5 мм 

Stitch (стежок) > Auto Underlay (автоподкладка) – 
изменение настроек автоподкладки. 

Stitch (стежок) > Auto Underlay (автоподкладка) – 
изменение настроек автоподкладки. 

Одинарный 
или двойной 

зигзаг 

Поле 
подкладки



Настройки можно установить как до, так и после 
оцифровки.

Конкретный коэффициент зависит от ткани. Прежде 
чем вышивать, проверьте, подходит ли заданное 
значение для имеющейся ткани.
Таблица подсказок:

Ткань Компенсация (мм)
Фактурный хлопок 0.1 

Футболка 0.2 

Флис, трикотаж 0.25 - 0.3 

Буквы 0.2 - 0.3 

Также настройки можно установить через Settings 
(настройки) > Fabric Settings (настройки ткани). См. 
Установка настроек ткани. 
 

Подсказка
Растяжения также уменьшится при использовании 
подкладок и уплотнении верхнего слоя. См. Стаби-
лизации при помощи подкладки.

Применение автоматической компенсации растяжения:
1  Настройки могут быть текущими или применяться 
для выделенных объектов: 
•  Нажмите Esc – все выделения отменены. 
Или выделите объект\ы для которых устанавливаете 
настройки. 
2  Нажмите иконку Object Properties (свойства объекта). 
Откроется окно Object Properties (свойства объекта. 
3  Нажмите кнопку Effects (эффекты) и выберите 
вкладку Others (другое). 
4   Выберите флажок Pull Compensation(компенсация 
растяжения).

5  Нажмите Apply (применить).

Установка поля подкладки
1  Настройки могут быть текущими или применяться 
для выделенных объектов: 
•  Нажмите Esc – все выделения отменены. 
•  Или выделите объект\ы для которых устанавли-
ваете настройки. 
2  Нажмите правой кнопкой мыши на ико-
ну Auto Underlay (автоподкладка). Откроется окно 
Effects (эффекты) > Underlay (подкладка).

3   Из списка выберите тип поля

4  Нажмите Apply (применить). Настройки примене-
ны для новых или выделенных объектов. 

Компенсация растяжения ткани

Вышивка стягивает ткань внутрь в местах проник-
новения иглы. Из-за этого ткань может начать мор-
щить и могут появиться пробелы в вышивке. В ко-
нечной вышивке формы несколько уже и длиннее, 
чем на экране. Эффект компенсации растяжения до-
стигается путем добавления стежков в местах про-
никновения нити.
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General (общее)> Object Properties (свойства объ-
екта) – настройка компенсации растяжения. 

Нормальное 

Среднее 

Широкое 

Выберите
тип поля 

Компенсация

Оцифрованный контур       Высчитанный контур 

Выберите 
компенсацию 

растяжения 



Чтобы создать узкую колонну с большим буфером, 
чем для обычной глади, примените Auto Jump вме-
сте с подкладкой с длинной стежка, например, 6 мм. 
Если длинна стежка не большая этот эффект дела-
ет их более свободными и, следовательно, больше 
поднимает их над тканью. См. Стабилизация под-
кладкой. 

Auto Jump также может быть применен для объек-
тов, оцифрованных вручную. Также его можно ис-
пользовать для создания стежки, например, на бо-
лее плотной глади. Auto Jump – свойство объекта по 
умолчанию. Его можно менять в любой момент как 
текущую настройку или для выделенного объекта. 
Auto Jump может применяться для заливки, контура 
и обметки. 

Чтобы применить Auto Jump 
1  Настройки могут быть текущими или применяться 
для выделенных объектов: 
•  Нажмите Esc – все выделения отменены. 
Или выделите объект\ы для которых устанавливаете 
настройки. 
2  Нажмите иконку Object Properties (свойства объек-
та). Откроется окно Object Properties (свойства объ-
екта. 
3  Нажмите кнопку Effects (эффекты) и выберите 
вкладку Others (другое). 

4   Выберите Auto Jump, если он еще не выбран и на-
жмите Apply (применить).

5 В поле Maximum Stitch введите максимальную 
длину стежка.

Настройки применены для новых или выделенных 
объектов.

Подсказка
По умолчанию компенсация установлена на 
0.2 мм. Это подходит для большинства проектов. 
Тем не менее, для автооцифровки рекомендуется 
использовать 0.4 мм. 

6  Введите припуск верхнего слоя (в мм). 

7  Нажмите Apply (применить). Настройки примене-
ны для новых или выделенных объектов. 
 

Подсказка
Нажмите Save to Template (сохранить в шаблон) 
перед тем, как закрыть окно, чтобы сохранить на-
стройки. Они будут применены ко всем новым объ-
ектам текущего шаблона. См. Свойства объекта и 
шаблоны. 

Сохранение длинны стежка

Машина имеет технические ограничения по длине 
стежка. Если длинна превышает возможную, она бу-
дет разбита на меньшие стежки. Это может повлиять 
на внешний вид вышивки, особенно при вышивке 
гладью. Применив Auto Jump, можно этого избежать.
См. также Splitting long stitches in Satin fills (разде-
ление длинных стежков).
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General (общее) > Object Properties (свойства объ-
екта) – установить настройки Auto Jump. 

Компенсация растяжения ВКЛ.          Компенсация растяжения ВыКЛ. 

            Компенсация: 0.2 мм                       Компенсация: 0.5 мм 

Максимальная стежок

Длинные стежки разбиваются на 
более мелкие

Выберите 
Auto Jump 

Выберите 
максималь-
ную длину 
и прыжок 

стежка 

Long jump
stitches

No jumps



Если соединение не закрыто, потом нить нужно об-
резать.

Стежки соединения создаются по автоматически, но 
можно изменить объекты так, чтобы свести тримме-
ры к минимуму. Можно даже поменять точки начала 
и конца, но настройка Closest Join  (ближайшее со-
единение) (по умолчанию) автоматически высчиты-
вает ближайшие точки соприкосновения при оциф-
ровке. См. Установка других основных настроек. 

Пробег
Пробег добавляется автоматически, когда игла дви-
жется между сегментами одного объекта. Он всегда 
закрыт другими швами, но иногда просвечивает. 

Пробег минимален при сведении точки входа и 
выхода объектов. Методом As Digitized (по проек-
ту) можно задать эти точки вручную, но настройка 
Closest Join  (ближайшее соединение) (по умолча-
нию) автоматически высчитывает ближайшие точки 
соприкосновения при оцифровке. См. Установка 
других основных настроек.

К стежкам, превышающим это значение будет при-
менен Auto Jump.

Подсказка
Длину установите больше, чем длинна глади, иначе 
стежки глади разобьются на 2 и более.

6  В поле Jump Length (длинна прыжка) введите дли-
ну каждого прыжка.

Подсказка
Маленькие прыжки увеличивают время вышивки, но 
делают движении рамы более плавным.

7   Нажмите Apply (применить). Настройки примене-
ны для новых или выделенных объектов. 
 

Подсказка
Нажмите Save To Template (сохранить в шаблон) 
перед тем, как закрыть окно, чтобы сохранить на-
стройки. Они будут применены ко всем новым объ-
ектам текущего шаблона. См. Свойства объекта и 
шаблоны.

Соединение объектов вышивки

Коннекторы соединяют объекты вышивки. Они при-
нимают форму «пробега» или «прыжка» и видны в 
режиме просмотра шва, но скрыты в режиме Artistic 
View (художественный просмотр). В идеале проект 
должен быть спланирован так, чтобы стежки соеди-
нения потом были закрыты другими объектам. 
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Максимальная длина стежка:           Максимальная длина стежка: 
                   10 мм                                                    12.1мм

           Длинна прыжка: 7 мм               Длинна прыжка: 4 мм 

художественный режим 

Пробег Пробег виден-
художествен-
ный режим

Точка начала 
не изменилась 
- пробега нет



Они также автоматически делаются перед коннекто-
рами и сменой цветов.

Подсказка
Tip Travel through the design by one stitch to check
for tie-ins and tie-offs. See Traveling through designs
for details.

Регулировка закрепляющих стежков 

По умолчанию, крепежные стежки вставляются в 
начале объектов для предотвращения распускания 
стежков. Есть случаи, однако, когда целые конструк-
ции могут не включать закрепления или где выбран-
ные объекты, такие как надписи, могут не включать 
их. BERNINA Embroidery Software дает вам контроль 
над настройками закрепляющих стежков.
Это необходимо для особых случаев, таких как «об-
ратная вышивка», предполагающая использование 
толсто нити. Здесь может и не быть закрепления в 
конце. Они могут быть использованы в проектах с 
особыми нитями. В таких случаях можно отключить 
связки и закреплять нить, обрезав и пропустив ее че-
рез ткань. См. Установка точек начала и конца.

Настройка свойств закрепления

1   Это можно сделать одним из следующих способов: 
•  Для настройки текущих свойств объекта нажми-
те иконку Object Properties (свойства объекта) или 
выберите Settings (настройки) > Object Properties 
(свойства объекта) – откроется окно Object Properties 
(свойства объекта). 
•  Для регулировки одного или нескольких объектов 
кликните на них дважды или правой кнопкой мыши. 
Откроется окно Object Properties. 

2   Выберите вкладку Tie-in/off (закрепления). 

Прыжки
Прыжки передвигают раму из одной точки проекта 
в другую без движения иглы. Как правило, связую-
щую нить нужно обрезать. В просмотре шва прыжки 
отображаются сплошной или пунктирной линией. 
Сплошная – для малых прыжков, пунктирная – для 
длинных (более 12.1 мм). Штрихпунктирная линия – 
изменение цвета.

Длинные прыжки – до 7 мм. Это как правило замед-
ляет машину, т.к. нужно переместить пяльцы к сле-
дующей точке проникновения иглы. 
 

Примечание
Длинна прыжка по умолчанию равна длине Auto Jump. 

Закрепляющие стежки

Закрепляющие стежки – дополнительные стежки до 
и после прыжка и смены цвета, необходимые для 
того, чтобы швы можно было обрезать без узлов.

Стежок закрепления вначале объекта делается авто-
матически после прыжка более чем 2 мм или смены 
цвета. При вышивке гладью – это второй стежок по-
сле начала объекта. 
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Малые прыжки-сплошная линия

Стежок за-
крепления

в начале 
объекта

Стежок закре-
пления в начале 

объекта

Стежок за-
крепления
в конце
объекта

Длинные прыжки-пунктирная линия

Изменение цвета- штрихпунктирная линия

Use General > Object Properties to adjust tie-in/off
settings(Свойства объекта для регулировки закре-
пляющих стежков).



Настройки автоматических точек нача-
ла и конца

Некоторые машины требуют установить иглу ровно 
над местом первого проникновения перед началом 
работы. При помощи Auto Start & End (авто старт и 
авто конец) установите положения первого и по-
следнего стежков проекта. 

Настройки автоматических точек начала и 
конца
1 Выберите Design (проект) > Auto Start & End (авто 
старт и авто конец). 
Откроется окно Auto Start & End.

2   Выберите метод позиционирования иглы на старте: 

•  Первый стежок проекта: начало проекта в первом 
стежке. 
•  Авто старт: точка начала расположена в опреде-
ленном месте. Выберите из возможного: 
 

Во вкладке есть 2 панели – Tie in before object (за-
крепление перед объектом) и Tie off after object (за-
крепление после объекта) – включение/выключение 
нужной функции.

Примечание
Проекты, созданные в предыдущих версиях ПО 
BERNINA Embroidery Software или других приложениях 
могут иметь коннекторы более 2 мм по умолчанию. 
3   Настройте Tie in before object  (закрепление пе-
ред объектом): 
•  Если функция отключена, ни внешних, ни вну-
тренних закреплений не будет. 
•  Если функция включена, закрепление будет сде-
лано при коннекторе более 2 мм. 

4   Настройте Tie off after object (закрепление после 
объекта): 
•  Если функция отключена, ни внешних, ни вну-
тренних закреплений не будет. 
•  Если функция включена, закрепление будет сде-
лано при коннекторе более 2 мм. 

5   Выбор метода закрепления: 
•  Первый– закрепляющий стежок вместе с последним. 
•  Второй – закрепляющий стежок между последни-
ми двумя. Второе лучше для букв, первое – для всего 
остального.

6   Нажмите Apply (применить).  Изменения приме-
нены к выбранным объектам или к текущим свой-
ствам.
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Закрепление
двумя стежками 

Выберите метод 
позиционирования 
иглы на старте

Выберите метод 
позиционирования 
иглы в конце

Выбрать метод 
закрепления 

Выбрать начальное 
положение иглы 



•  Оцифровка начального положения иглы: Ее мож-
но отметить вручную.

3   Выберите метод позиционирования иглы в конце: 
•  Последний стежок проекта: Конечная точка в по-
следнем стежке проекта. 
•  Авто конец: точка начала расположена в опреде-
ленном месте. 
•  Оцифровка конечной точки: точка начала распо-
ложена в определенном месте. 
4  Выберите флажок Maintain Automatically (под-
держивать автоматически) (по умолчанию) – автома-
тически поддерживать начальную и/или конечную 
точки положения иглы. 
5   Нажмите OK. Связующие стежки будут располо-
жены перед первым и после последнего стежка про-
екта. 
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Начальная точка: первый сте-
жок конечной точки: послед-

ний стежок проекта

Начальная точка: Авто старт 
конечной точки Авто Конец, 

Центр дизайна
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Часть III
Оцифровка изображений 

Есть две основные категории файлов с изображениями и обе они могут использовать-
ся в программе BERNINA Embroidery Software в качестве оригиналов для последующей 
оцифровки. Это побитовые рисунки и векторная графика. Как основу для качествен-
ной вышивки надо сначала подготовить качественный рисунок в любом разрешенном 
формате.

Оцифровка с оригиналом

В этом разделе описывается, как подбирать подходящие рисунки для оцифровки, а 
также, как загрузить их в ПО BERNINA Embroidery Software. Кроме того, поясняется, как 
оцифровывать рисунки, используя оригинал-трафарет, и как отображать их на экране 
и скрывать во время оцифровывания. См. главу Оцифровка с оригиналом.

Обработка изображений для автоматической оцифровки

В этой главе рассказывается, как подготовить рисунок для автоматической оцифров-
ки.  Поясняется, как готовить оконтуренные и не оконтуренные изображения. См. гла-
ву Обработка изображений. 

Автоматическая оцифровка

В этой главе рассказано, как с помощью имеющихся программных средств автомати-
чески преобразовать рисунок, векторной или побитовый, в вышивку. Также рассказа-
но, как создавать вышивки на основе фотографий. См. главу Автоматическая оциф-
ровка.
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Глава 14
Оцифровка с оригиналом 

Электронный рисунок в побитовом или векторном 
формате может быть загружен, скопирован или от-
сканирован в BERNINA Embroidery Software для ис-
пользования в качестве оцифровываемого ориги-
нала или трафарета. Можно также импортировать 
также текстурированный фон, чтобы увидеть, как 
будет выглядеть вышивка на реальной ткани. Может 
быть использован почти любой рисунок – фотогра-
фия, журнальные иллюстрации, графические файлы 
и даже образцы ткани.

Из ПО BERNINA Embroidery Software вы можете от-
крыть изображения в графических программах MS 
Paint, Corel PHOTO-PAINT® Essential 4 или Paint 
Shop Pro™. Обновленные таким образом изображе-
ния автоматически реимпортируются в ПО BERNINA 
Embroidery Software.

В этом разделе описывается, как подбирать подходящие рисунки для оцифровки, а 
также, как загрузить их в ПО BERNINA Embroidery Software. Кроме того, поясняется, как 
оцифровывать рисунки, используя оригинал-трафарет, и как отображать их на экране 
и скрывать во время оцифровывания.

Вы выбираете изображение и Auto Digitizer автома-
тически определяет контуры и стежки, требуемые 
для оцифровки проекта. Подробнее см. в разделе 
Оцифровка функцией Auto Digitizer.

• Оцифровка фотографий производится функци-
ей PhotoSnap. Вы снова выбираете изображение и 
PhotoSnap автоматически определяет контуры и 
стежки, требуемые для оцифровывания проекта. 
Подробнее см. в разделе Оцифровка с помощью 
PhotoSnap. 
художественный оригинал может быть импортиро-
ван в BERNINA Embroidery Software как в векторных, 
так и в побитовых форматах: 
• Векторныая графика: Рисунки состоят из конту-
ров, которые могут быть цветными и могут иметь 
цветное заполнение. Векторные контуры остаются 
тонкими и чистыми даже при большом коэффици-
енте увеличения, их можно оцифровать достаточно 
точно. 
• Побитовые рисунки: Они состоят из цветных то-
чек, или пикселей. При увеличении на малой площа-
ди контуры становятся разорванными и отобража-
ются как серий цветных квадратиков, или пикселей.

Использование оригиналов-трафа-
ретов

Оригиналы могут быть использованы в качестве тра-
фарета при ручном оцифровывании. Альтернативно 
функции полуавтоматического и автоматического 
оцифровывания BERNINA Embroidery Software могут 
конвертировать побитовые рисунки в проекты вы-
шивки. В общем случае оригиналы-трафареты по-
могают вам:

• Оцифровывать объекты вручную.
Калькировать контуры и линии по трафарету, ис-
пользуя подходящий инструмент оцифровки. Под-
робнее см. в разделе Методы оцифровки.
• Автоматическая оцифровывка контуров произво-
дится функцией Magic Wand (Волшебная палочка).  
Вы выбираете контур и Magic Wand автоматически 
определяет требуемые стежки.
• Автоматическое оцифровывание сложных рисун-
ков производится функцией Auto Digitizer. 
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Поддерживаемые графические форматы
Программа BERNINA Embroidery Software поддержи-
вает значительное количество графических форма-
тов, как векторных, так и побитовых:

Примечание
Полное перечисление графических форматов мож-
но найти в разделе руководства пользователя 
CorelDRAW® Essentials 4 User Guide,  которое мож-
но найти в разделе меню Windows Start > Programs 
Также можно использовать экранную систему помо-
щи Help в графическом режиме Graphics. 

Автоматическая оцифоровка 
Функции автоматической оцифровки BERNINA 
Embroidery Software -- Auto Digitizer и Magic Wand 
– обеспечивают наилучшие результаты с изображе-
ниями, которые можно найти в библиотеке графи-
ческих файлов или которые создаются по эскизам 
в пакете графических программ. Подробнее см. в 
разделах Автоматическая оцифровывка функцией 
Magic Wand и Оцифровывка функцией Auto Digitizer.
Функции автоматической оцифровки могут работать 
с изображениями из других источников, но они тре-
буют большей или меньшей подготовки. Это объяс-
няется тем, что наиболее доступные изображения не 
выполнены в чистых цветах. Сканирование вызывает 
шумы (помехи), в то время как графические про-
граммы выполняют «сглаживание», чтобы улучшить 
качество печати изображения.
Автоматическая оцифровка менее эффективна с 
фотографическими изображениями, которые мо-
гут содержать много размытых цветов и сложных 
форм. Однако на фотографиях вы можете обрабо-
тать формы, которые вы хотите вышить, удалив не-
нужные детали. Альтернативно можно использовать 
PhotoSnap для создания проектов вышивки из отска-
нированных фотографий. 

Отсканированные 
изображения
Изображения, отскани-
рованные с бумажных 
оригиналов или су-
ществующих вышивок 
обычно содержат мно-
жество «шумовых» по-
мех. 

Для создания высококачественной вышивки вам 
нужно подобрать подходящий рисунок.  В BERNINA 
Embroidery Software вы можете назначит общие 
свойства, такие как размер и положение. Вы може-
те также расположить и трансформировать рисунок 
таким же образом, как проекты вышивки. 
 

Предупреждение
Поставляемые с программой образцы рисунков и 
вышивок можео использовать только для личных 
нужд. Их нельзя продавать или как-либо исполь-
зовать в коммерческих целях. Изменение формата 
образца – например, преобразование аппликации в 
вышивку – авторских прав на рисунок не отменяют. 

Векторная графика 
Векторные рисунки загружаются в BERNINA 
Embroidery Software для использования в качестве 
оцифровываемых трафаретов. Они автоматически 
конвертируются в побитовые изображения. 

Побитовые изображения 
Побитовые изображения могут быть загружены или 
отсканированы в BERNINA Embroidery Software для 
использования в качестве оцифровываемых трафа-
ретов. Как для ручной, так и для автоматической 
оцифровывки лучше всего подходят «чистые» ри-
сунки, иногда рассматриваемые как карикатуры или 
шаржи. Такие рисунки имеют ограниченное количе-
ство чистых цветов, которые в свою очередь имеют 
четко очерченные контуры. Идеальными являются 
рисунки:
•  Четко определенные, когда каждая фигура выполнена 
пикселями одного и того же цвета.
• Четко разделенные на блоки, когда каждая фигура 
имеет «вышиваемый» размер, по меньшей мере 1 кв. мм.
•  Сохраненные с насыщенностью цвета по мень-
шей мере 256 цветов (8 бит) или предпочтительно 
миллионами цветов (16 бит). (При загрузке изобра-
жений в BERNINA Embroidery Software насыщенность 
цвета автоматически сокращается до 256 цветов или 
меньше.): 

Подсказка: 
После загрузки в BERNINA Embroidery Software вы 
можете изменять размеры и трансформировать по-
битовые изображения. Однако, если нужно изменить 
размеры или повернуть изображение, то лучше де-
лать это во время сканирования. Последующее из-
менение размера может разрушить изображение. 

                       Рисование                         Рисунок оцифрован                                       
                                                              с по мощью Magic Wand

Выбрать начальное 
положение иглы 
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Подготовка оригинала для сканирования 
Для создания проекта вышивки, в большей или 
меньшей степени, вам не требуется каждая деталь 
изображения. Вы используете «структуру» изобра-
жения в большей мере, чем тонкие детали текстуры 
и цвета. 
Для упрощения оригинала вы можете накрыть его 
калькой и перенести на нее только наиболее суще-
ственные контуры и линии, которые будут заполне-
ны стежками. При сканировании наложите на кальку 
с эскизом лист белой бумаги. 

Блестящие поверхности, такие как глянцевые фото-
графии, не могут быть хорошо отсканированы. Их 
следует накрывать чертежной калькой. Если ориги-
нал имеет очень светлые цвета, обведите контуры 
тонким черным фломастером. 

Разрешение при сканировании

Для большинства сканеров требуется вводить ин-
формацию о требуемом разрешении сканирования. 
Величина разрешения определяет количество точек 
на дюйм (dpi), используемых для создания отскани-
рованного изображения.  Чем выше разрешение, тем 
чище изображение, но тем больше файл. Для оциф-
ровывания используйте изображения, отсканиро-
ванные с разрешением не выше 300 dpi. Разрешения 
72 dpi (разрешение экрана) обычно вполне доста-
точно. В общем случае, чем меньше оригинал и/или 
чем больше в нем деталей, тем выше должно быть 
разрешение. Для ориентировки можно использовать 
данные следующей таблицы. 

В то время как они могут быть использованы для 
автоматической оцифровки. Лучшие результаты по-
лучаются при использовании относительно чистых 
изображений, содержащих блоки с чистыми цвета-
ми. Как правило это логотипы и простые рисунки, 
отсканированные с визитных карточек, шапок фир-
менных бланков, книг, журналов и т.п.  Загрязнен-
ные изображения обычно требуют подготовки, за-
ключающейся в уменьшении количества цветов и 
повышении резкости контуров. См. Обработка изображений.

Изображения со сглаженными цветовыми 
переходами
Сглаживание цветовых переходов – это программ-
ная техника, комбинирующая существующие цвета 
шахматным расположением пикселей. Она обычно 
используется для имитации цветов, смешиваемых из 
изображаемой гаммы. 

Наподобие «загрязненных» 
изображений, изображения со сглаженными цвето-
выми переходами требуют уменьшения количества 
цветов. Имейте в виду, что  программа отлично ра-
ботает по обработке сглаженных цветовых пере-
ходов с четко определенными контурами, но мало 
подходит для работы с изображениями, не имею-
щими четких контуров. См. Обработка изображений.
 
Изображения со сглаженными контурами
Сглаживание контуров – это программная техника, 
подобная сглаживанию цветовых переходов, которая 
используется для смягчения жест-
ких контуров, если цветовые блоки 
пересекаются.. 
Она создает сглаженные контуры 
путем «размывания». Если техника 
размывания сознательно использу-
ется для размывания контуров, то 
перед автоматической оцифровкой 
следует увеличить их резкость. См. 
Обработка изображений. 

Сканирование художественных изо-
бражений 

Если у вас имеется готовое изображение, вы можете 
отсканировать его сканером, совместимым с про-
токолом TWAIN, используя сканирующие функции 
BERNINA Embroidery Software. Важно правильно от-
сканировать ваше изображение, если вы намерены 
использовать одну из функций автоматического 
оцифровывания; качество отсканированного изо-
бражения повлияет на качество окончательного 
проекта вышивки.

Блоки со сглаженными 
цветовыми переходами

хорошее  качество изо-
бражения – хорошее 
качество вышивки

Плохое  качество изобра-
жения – плохое качество 

вышивки 

Изображение со сгла-
женными контурами

Оригинал .                     Калькированы наиболее суще-
ственнве контуры   
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Черно-белый режим создает файлы наименьшего 
размера. Цветные фотографии и режим градации 
серой шкалы создают ‘изображения с 256 цветами, 
сохраняемые в файлах подобного размера. Режимы 
‘RGB’, ‘True Color’ (‘Истинный цвет’) или  ‘миллион 
цветов’ создают изображения с 16,7 млн цветов, со-
храняемые в файлах наибольшего размера. Поль-
зуйтесь приводимой ниже таблицей, чтобы опре-
делить, какой из режимов вам нужен для вашего 
оригинала.

Примечание
Обратите внимание, что в вашем сканере могут ис-
пользоваться другие обозначения режимов.

Вы не сможете заметить различия на экране. В дей-
ствительности, изображение в 256 цветов может вы-
глядеть лучше изображения RGB.. 
•  Однако BERNINA Embroidery Software конверти-
рует все изображения в 256 или меньше цветов при 
загрузке. Программа использует дополнительную 
информацию для создания лучшего изображения, 
чем если бы оригинал был отсканирован в режиме 
256 цветов.

Вид оригинала Пример Описание Рекомендуемый цвето-
вой режим *

Количество цветов в 
отсканированном изо-

бражении

Штриховой рисунок
   

Два цвета – обычно 
черный и белый

Черно/белый рисунок
Штриховой рисунок

2 
2

Эскиз/Набросок Рисунок или эскиз с 
градацией серого

Градация серого
Штриховой рисунок

256 
2

Черно-белая фото-
графия Градация серого Черно/белое фото

Градация серого
256 
256

Цветная фотография Много цветов Цвет RGB 
Цветное фот

16 миллионов
256

Цветной рисунок Два цвета или больше
Цвет RGB 

Миллионы цветов
Цветной рисунок

16 миллионов
16 миллионов
2 - 256

* Различные ПО сканеров используют различные обозначения для одних и тех же режимов.

Тип изображения Разрешение 
Визитки, шапки бланков 150 - 300 dpi

Рисунки от-руки 150 - 300 dpi 

Фотографии, изображения 150 - 300 dpi 

Реклама, штриховые рисунки 72 - 150 dpi 

Цветовой режим 
Для большинства сканеров требуется вводить ин-
формацию о требуемом цветовом режиме. Вначале 
определите, с каким изображением вы имеете дело 
– со штриховым рисунком (черно-белым), эскизом, 
цветным рисунком, черно-белой или цветной фото-
графией, - а затем выберите подходящий режим

Советы по сканированию   
•  Не сканируйте штриховые рисунки в режиме гра-
дации серого; в таком режиме получаются размытые 
кромки.
•  Цветные иллюстрации лучше сканировать в режи-
ме RGB (миллион цветов), чем в режиме 256 цветов. 
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Предупреждение
Иимеющиеся в программе рисунки,  графические 
вставки и образцы вышивок могут быть использова-
ны только в личных целях. Продажа или какое-ли-
бо их коммерческое использование не допускается. 
Изменение формата образца – например, преобра-
зование аппликации в вышивку – авторских прав на 
рисунок не отменяют.

Сканирование рисунка 

BERNINA Embroidery Software для использования в 
качестве оцифровываемых трафаретов. Сканирую-
щие функции BERNINA Embroidery Software позво-
ляют вам использовать большинство совместимых с 
протоколом TWAIN сканеров. Вы можете использо-
вать любое ПО сканера, если оно способно сохра-
нять изображения в одном из совместимых форма-
тов. 
 

Подсказка
Можно сканировать в ваш собственный текстури-
рованный фон, чтобы увидеть, как будет выглядеть 
вышивка на реальной ткани. Ткани могут быть от-
сканированы, чтобы получить полный отцентрован-
ный фон вашего проекта или фон в виде небольших 
образцов, расположенных, как плиточная кладка, 
заполняющая экран. См. Изменение фона. 

Как сканировать рисунок 
1 Настройте сканер. См. Настройка сканеров
2 Подготовьте рисунок. См. Подготовка рисунка к 
сканированию. 
3 Перейти в режим Artwork Canvas. 
4 Нажмите кнопку Scan Bitmap 
5 Выбрать режим и разрешение сканирования. См. 
Разрешение сканирования и Цветовой режим. 

•  Не сканируйте цветные изображения в режиме 
CMYK, поскольку этот режим используется для изо-
бражений, которые должны быть распечатаны и в 
которых имеются цвета, отличающиеся от палитры 
RGB. 
•  Если надо изменить размер изображения, то де-
лайте это во время сканирования. После него изме-
нение размера может разрушить зображение. 
 
Повышение четкости 

Некоторые программы сканирования позволяют 
применять функцию повышения четкости отскани-
рованного изображения. Эта функция компенсирует 
легкое размывание отсканированного изображения, 
обусловленное различиями между цветами ориги-
нала. Функция повышения четкости выделяет эти 
различия, которые делают края изображения более 
определенными. При этом количество деталей изо-
бражения не увеличивается, они лишь становятся 
более различимыми. В общем случае используйте 
функцию повышения четкости для изображений с 
хорошо выделенными контурами. Не используйте ее 
для изображений, не имеющих контуров. 

Импорт рисунков 

Побитовые рисунки и векторные графики разных 
форматах могут быть отсканированы  или «загруже-
ны»  в BERNINA Embroidery Software для использова-
ния в качестве оцифровываемых трафаретов. После 
загрузки в BERNINA Embroidery Software вы можете 
изменять их  размеры и трансформировать. Однако, 
если нужно изменить размеры или повернуть изо-
бражение, то лучше делать это во время сканирова-
ния. Последующее изменение размера может раз-
рушить изображение.

Отсканировано в режиме 
256 цветов Отсканировано в режиме 

рисунок

Отсканировано с повы-
шением четкости

 Отсканировано без повы-
шениея четкости

Отсканировано в режиме 
RGB (миллионы оттенков) Автоматически  оцифро-

ванный рисунок

Use Canvas > Artwork Canvas. .Для загрузки, редактиро-
вания и сохранения рисунков в качестве фона для вы-
шивок, используйте режим Art Canvas.

Используйте функцию Artwork > Scan Bitmap для скани-
рования изображений в программу BERNINA



3  Выберите файл и нажмите Open (открыть).
•  Используйте рисунок как основу для оцифровки. 
См. Методы оцифровки. 
•  Преобразуйте рисунок в вышивку. См. Автомати-
ческая оцифровка. 
 

Примечание
Если вы не можете просмотреть загруженный рису-
нок, проверьте, активна ли иконка Show Picture. См. 
Отображение или скрытие оригинала. 

Загрузка векторной графики 

Можно загружать векторные рисунки различных 
форматов как оригиналы для последующей оциф-
ровки “вручную” или автоматически.

Как загрузить векторный рисунок:

1  Перейти в режим Artwork Canvas и нажать кнопку 
Load Artwork.

2  Выберите папку и тип файла из списка Files of 
Type (например, CDR).

Подсказка
Если вы сканируете ткань для фона, установите ска-
нирование на 256 цветов, 100 % и 72 dpi. Такие на-
стройки позволят получить файл небольшого разме-
ра, который будет хорошо отображаться на экране, 
не занимая много места на жестком диске или в па-
мяти компьютера. 
6  Просмотрите изображение в программе сканирования.
7   Выберите зону сканирования и отсканируйте изо-
бражение.
8   Сохраните рисунок в совместимом графическом 
формате в папке My Designs. См. Оцифровка с ори-
гиналом.
 

Примечание
Отсканированные оригиналы являются побитовыми 
изображениями и должны сохраняться отдельно от 
файлов проектов или они будут удалены при закры-
тии проекта. См. Сохранение оригиналов в отдель-
ных файлах.

Загрузка побитовых рисунков 

Можно загружать побитовые рисунки различных 
форматов как оригиналы для последующей оциф-
ровки “вручную” или автоматически.

Как загрузить рисунок 
1 Перейти в режим Embroidery Canvas и нажать 
кнопку Insert Artwork. 

2  Выберите папку и тип файла из списка Files of 
Type (например, BMP).. 
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Выберите нужный формат

Используйте  Canvas > Embroidery Canvas для оциф-
ровки, правки и сохранения рисунков. Просматривайте 
проекты и рисунки в реалистическом 3D – режиме. 

С помощью функции General > Insert можно вставлять 
рисунки в проект как трафареты для оцифровки “вруч-
ную” или автоматически. 

Используйте View > Show Bitmap Artwork для просмотра 
рисунков

Используйте Canvas > Artwork Canvas для загрузки, соз-
дания и правки векторной графики для последующей 
оцифровки. 

Используйте функцию Artwork > Load Artwork для прав-
ки изображений в графическом режиме.

Используйте View > Show Vector Artwork для просмотра 
или скрытия векторных рисунков например графиче-
ских вставок CorelDRAW® 



2 Откройте папку Content и в ней Clipart.

3 Найдите в папке желаемый рисунок.

Примечание
открыть графическую вставку в программе BERNINA 
Embroidery Software можно через функцию Artwork 
Canvas. См. Загрузка векторной графики 
 

Подсказка
Возможно, удобнее будет скопировать всю пап-
ку CorelDRAW® Clipart В раздел меню My Designs - 
Embroidery Software 7. 

Правка загруженных рисунков
Как при ручной, так и при автоматической оцифров-
ке вам может потребоваться кадрировать изображе-
ние перед оцифровкой. Вы можете сделать это в ПО 
Embroidery Software  или же с использованием дру-
гих графических программ. Иногда вам может по-
требоваться сохранить оригиналы в виде отдельных 
файлов после сканирования или кадрирования. 
 

Подсказка
Как для ручного, так и для автоматического оциф-
ровывания лучше всего подходят «чистые» рисун-
ки, иногда рассматриваемые как карикатуры или 
шаржи. Сканирование вызывает шумы (помехи), 
в то время как графические программы выполня-
ют «сглаживание», чтобы улучшить качество печати 
изображения. См. также Подготовка изображений 
для автоматического оцифровывания. 

Кадрирование изображений для оцифровки
BERNINA Embroidery Software позволяет вам выде-
лить кадр из изображения перед использованием. 
Перед оцифровкой побитового рисунка обрежьте 
его, чтобы удалить ненужные детали и сэкономить 
время, требуемое для обработки.

Для кадрирование изображений для оцифровки
1   Отсканируйте или загрузите изображение, См. 
Загрузка  изображений.

3  Выбрать файл и нажать Import (загрузить). 
4  Поместите курсор в окно проекта и нажмите Enter 
(ввод)
5  Выберите технику оцифровки: 
•  Преобразуйте рисунок в вышивку. См. Оцифровка 
векторной графики. 
•  В режиме Embroidery Canvas можно использовать 
рисунок как основу для оцифровки. См. Методы 
оцифровки. 
 

Примечание
Если загруженный рисунок не отображается, про-
верьте, включена ли функция Show Vector Artwork. 
См. Отображение оригиналов
 
 

Подсказка
Блокировка рисунков – оригиналов удерживает их 
на месте в процессе оцифровки, правки или изме-
нении формы объектов вышивки. Блокированные 
объекты можно в любой момент разблокировать. См. 
Блокировка и разблокировка 

Просмотр графических вставок 
Программа CorelDRAW® Essentials 4 поставляется с 
набором графических вставок и рисунков, которые 
можно использовать в качестве фона для оцифровки 
вышивок или прямо преобразовать в вышивки. См. 
раздел Преобразование векторных рисунков в вы-
шивки. 

Для просмотра графических вставок
1   Войдите в папку  CorelDRAW® Essentials 4 с по-
мощью меню Windows Start > Programs. 
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Выберите нужный формат



2  Выберите изображение и  инструмент кадрирова-
ния в разделе меню Artwork > Crop.

•  Оцифруйте точки для создания кнужной формф 
кадра вокруг нужной его части и нажмите Enter (ввод)

Изменение формы кадра

 
  

После обрезки изображения вы можете изменить 
форму и трансформировать контуры кадрирования 
таким же образом, как вы изменяете форму и транс-
формируете текстовые объекты. Вы можете также ис-
пользовать этот инструмент для перемещения конту-
ров кадра.

Для изменения формы кадра 
1   Выделите кадр нужной формы. См. Кадрирование 
побитовых рисунков для оцифровки. 

2  Нажмите кнопку Reshape Object.

3  Поправьте узловые точки для изменения вида 
объекта и нажмите Enter (ввод). Отобразится линия 
выделения кадра с узловыми точками.

4   Нажмите Esc . 

Правка рисунков графическими про-
граммами 

Из BERNINA Embroidery Software вы можете открыть 
изображение в другой графической программе, 
которое поможет улучшить отсканированное вами 
изображение. Можно удалить фон, залить цветом 
определенные зоны или контуры, заполнить про-
белы, добавить или усилить контуры. Обновленные 
таким образом изображения автоматически импор-
тируются в BERNINA Embroidery Software. 
Имеется много графических программ, которые по-
могут вам улучшить отсканированное изображение. 
Наиболее простой из них является программа Paint. 
Она входит в пакет приложений ОС Windows и мо-
жет работать со многими форматами или цветовыми 
преобразованиями. Наиболее сложными являются 
профессиональные программы, такие как програм-
ма Corel Photo Paint Essential X6. 

Для правки рисунков в графических про-
граммах 
1  Отсканируйте или загрузите изображение. См.  
Загрузка изображений.
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Выберите инструмент 
кадрирования

Прямоугольник                                 Сердечко

10-конечная звезда                                Кривая линия 

Нажмите Reshape Object (Изменить форму объекта) 
на панели Edit, чтобы сделать кадр произвольной 
формы

С помощью Artwork > Touch Up Bitmap можно пра-
вить рисунки графическими программами.

Используйте Canvas > Artwork Canvas для загрузки, 
создания и правки векторной графики для после-
дующей оцифровки.



2   Оставаясь в режиме Artwork Canvas, выберите изо-
бражение.

3   Нажмите Touch Up Bitmap. Картинка откроется в 
программе Corel PHOTO-PAINT® Essentials X6. 
4   Поправьте изображение как нужно. 

5  Выберите пункт меню File > Update Design.
Изображение отобразится в BERNINA Embroidery 
Software на заштрихованном фоне. Это означает, что 
оно все еще открыто в графической программе.

6  Выберите пункт меню File > Exit & Return 
<Filename>, чтобы выйти из графической програм-
мы и увидеть обновленное изображение в BERNINA 
Embroidery Software. Заштрихованный фон исчезнет.
 

Подсказка
Если вы хотите сохранить графическую программу 
открытой, выберите File > Close после завершения 
обновления изображения. 

Сохранение оригиналов изображений в 
отдельных файлах

Все изображения, показываемые в окне Design 
Window при сканировании, вставке из буфера или 
загрузке с жесткого диска, сохраняются совместно с 
вышивальным проектом в файлах формата .ART. По-
сле правки в BERNINA Embroidery Software или других 
графических программах вы сможете сохранить изо-
бражение в отдельном файле. 

Для сохранения оригиналов изображений в 
отдельных файлах
1  Отсканируйте или загрузите ихображение. См. За-
грузка изображений. 
2  Оставаясь в режиме Artwork Canvas, выберите изо-
бражение. 

3 Нажать Save Artwork. Откроеься диалоговое окно 
Export.

4  В поле Save In (Сохранить в) выберите папку, затем 
выберите формат из списка Save as Type. 
5  Введите новое имя файла и нажмите Export. При 
сохранении проекта ссылка обновляется, чтобы мож-
но было использовать новый файл с изображением.
 

Примечание
Этот файл не относится к файлам формата .ART. Лю-
бые дальнейшие изменения в нем не отображаются 
во встроенном изображении.
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 Изображение в кадре 

Удален фон

Добавлены линии 

Выбрать папку

Введите имя файла        Выберите нужный формат

Изображение все еще 
открыто в графической 
программе 

Используйте пункт меню Artwork > Save Artwork 
для сохранения оригинальных изображений в от-
дельных файлах. 

Используйте Canvas > Artwork Canvas для загрузки, 
создания и правки векторной графики для после-
дующей оцифровки.

Используя графиче-
скую программу, 
выделите часть ри-
сунка, которую надо 
вышить
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Глава 15
Обработка изображений 

BERNINA Embroidery Software поддерживает автоматиче-
ское и полуавтоматическое оцифровывание побитовых 
изображений. Качество результирующего проекта в зна-
чительной мере зависит от типа и качества оригинально-
го изображения. Чтобы сделать побитовые изображения 
более пригодными для автоматического оцифровывания, 
BERNINA Embroidery Software также обладает возможно-
стями обработки изображений и связи с графическими 
программами. 
В этой главе рассказывается, как подготовить рисунок для 
автоматической оцифровки.  Почсняется, как готовить 
оконтуренные и не оконтуренные изображения. См. главу 
Обработка изображений. 

Очистка изображения
На практике очистка отсканированных изображений 
может выполняться одним или комбинацией из не-
скольких технических средств: 
• сокращением количества цветов
• добавлением или акцентированием  контуров
• удалением «шума», сглаживанием  цветовых пе-
реходов или контуров
• удалением ненужных деталей
• кадрированием секций
• удалением фона:

Сокращение колличества цветов 
Иногда изображение выглядит достаточно четким, 
но во время сканирования или в графической про-
грамме к нему добавляются дополнительные цвета. 
Снижение цветности означает уменьшение фактиче-
ского количества цветов изображения для устране-
ния ненужных деталей и приведения каждого бло-
ка к единому цвету. Снижение цветности вызывает 
также очистку изображения с удалением шума (не-
желательных крапинок) и сглаживанием переходов 
между пикселями, если это необходимо. Это, в свою 
очередь, сводит к минимуму число обрезок и изме-
нений цветов, требуемых в окончательном проекте 
вышивки. Снижение цветности в не оконтуренных 
и  изображениях выполняется инструментом Bitmap 
Artwork Preparation. 

Подготовка рисунков к автоматиче-
ской оцифровке 

Перед применением автоматического оцифровы-
вания вам часто требуется улучшить или «очистить» 
оригинал. Для эффективной работы инструментов 
Auto Digitizer и Magic Wand требуются изображения 
с чистыми цветами. Вы можете улучшить изображе-
ние как инструментами редактирования побитовых 
образом в графических программах, так и инстру-
ментами обработки изображений, входящими в 
BERNINA Embroidery Software. В действительности 
программное обеспечение не позволит применить 
Auto Digitizer, пока изображение не будет должным 
образом обработано.

Оконтуренные и не оконтуренные изобра-
жения
Перед подготовкой изображения нужно узнать, с 
каким типом изображения вы имеете дело.  Для ав-
томатической оцифровки изображения делятся на 
две категории – оконтуренные и не оконтуренные. 
Оконтуренные изображения в идеале имеют сплош-
ной черный контур вокруг каждой цветной зоны.. 
Не оконтуренные изображения в идеале состоят из 
сплошных цветовых зон. Оконтуренные и не окон-
туренные изображения требуют различных методов 
подготовки.

Оконтуренный рисунок                        Не оконтуренный рисунок  
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Снижение цветности следует применять лишь в том 
случае, если потеря детали не приведет к искаже-
нию форм изображения. Перед снижением цветно-
сти цветовые зоны изображения (см. рисунок внизу) 
содержат много цветов. После снижения цветности 
каждая зона окрашена единым цветом. Детали со-
храняются.

Если у вас отсканированные изображения, убеди-
тесь, что они отсканированы правильно. Подробнее 
см.  Сканирование изображения.

Повышение четкости контура 
Повышение четкости контура означает более четкое 
определение контуров, ограничивающих опреде-
ленные цветовые блоки или формы оригинала. Эти 
контуры могут быть расплывчатыми уже в оригинале 
или сделаться нечеткими в процессе сканирования. 
Повышение четкости контуров важно для автома-
тического оцифровывания, поскольку программе 
становится легче идентифицировать определен-
ные зоны, которые становятся объектами вышивки в 
окончательном проекте.

Примечание
Функция повышения четкости контуров работает 
только в том случае, если в изображении имеются 
черные или темные контуры.

Некоторые изображения имеют сплошные конту-
ры, но они могут быть расплывчатыми или незавер-
шенными. Такие контуры должны быть выправлены 
инструментами подготовки изображений BERNINA 
Embroidery Software или графическими програм-
мами. См. Правка изображений в графических про-
граммах.
 
Фильтрация шума 
Фильтрация шума означает восстановление сплош-
ных цветовых блоков оригинала в отсканированном 
изображении. Это достигается слиянием различных 
цветовых оттенков в сплошной цвет. Фильтрация 
шума важна для автоматического оцифровывания, 
поскольку программе становится легче идентифи-
цировать определенные цветовые зоны, которые 
становятся объектами вышивки в окончательном 
проекте. Эта функция очищает также размытые или 
пестрые цветовые зоны.

Обзор способов подготовки изображений
Даже если изображение загружено в программу и 
выглядит готовым к вышиванию  перед оцифровкой 
его надо еще обработать. Программа не позволит 
автоматически оцифровать изображение без пред-
варительной подготовки. 
 

До сокращения цветности              После сокращения цветности 
 До повышения четкости              После повышения четкости

Отсканировано в 
режиме RGB 

Отсканировано в 
режиме 256 цветов 

До удаления шума                          После удаления шума
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Подготовка не оконтуренных изображений

Инструмент Embroidery Canvas имеет функцию 
Bitmap Artwork Preparation для подготовки не окон-
туренных рисунков к автоматической оцифровке. 
Инструмент автоматически уменьшает число цвет-
ных блоков в побитовых изображениях, удаляя за-
зубрины в кривых линиях и шум. Вы можете позво-
лить программе самостоятельно уменьшить число 
цветов или задать заранее их желаемое количество. 
Последнее полезно в том случае, если вы хотите со-
гласовать цвета проекта с имеющимися у вас цвет-
ными нитками.

Подсказка
В зависимости от качества отсканированного изо-
бражения вам может потребоваться выправить их 
вручную перед обработкой в BERNINA Embroidery 
Software. Вы можете сделать это, чтобы удалить фон, 
залить цветом определенные зоны или контуры, за-
полнить пробелы, добавить или усилить контуры. 
См. Правка изображений в графических програм-
мах.

Для подготовки не оконтуренных изображе-
ний

1  Отсканируйте или загрузите изображение, См. За-
грузка изображений. 
2  В режиме Artwork Canvas выберите изображение, 
при необходимости кадрируйте или подправьте. 
См. Правка загруженных изображений
3  Перейти в режим Embroidery Canvas и выбрать ри-
сунок.

4 Выбрать функцию Artwork > Bitmap Artwork 
Preparation.

Действие Оконтуренное изображение Не оконтуренное изображение Фотография

Сканирование
оригинала

• Сканирование в режиме RGB 
• Повышение четкости 

• Сканирование в режиме RGB 
• Без повышения четкости Сканирование в режиме RGB

Сканирование
штриховых 
рисунков

Сканирование в режиме двух 
цветов - -

Отделка изобра-
жения в графиче-
ской программе

• Обрезка
• Добавление или правка кон-
туров
• Правка цветности
• Удаление шума

• Обрезка
• Правка форм изображения
• Правка цветности
• Удаление шума

• Обрезка
• Конвертирование в шкалу 
серого
• Удаление фона
• Осветление или затемнение
• Регулировка контраста

Использование 
инструмента 

Image Preparation 
в BERNINA 
Embroidery 

Software

Позволяет отрегулировать свет-
лость или темноту контуров.  
Автоматически: 
• усредняет цветность каждого 
оконтуренного блока в единый 
цвет
• удаляет зазубрины в кривых 
линиях, шум и размывы цвета
• повышает четкость 
   контуров

Позволяет снизить цветность 
до назначенного числа цветов: 
Автоматически:
• сокращает каждый блок до 
единого цвета
• удаляет зазубрины в кривых 
линиях, шум и размывы цвета
• удаляет цвета 
   меньшие, чем 
   назначенная область

-

Оцифровывание
• Вручную
• Инструментом Magic Wand
• Инструментом Auto Digitizer

• Вручную
• Инструментом Magic Wand
• Инструментом Auto Digitizer

В программе PhotoSnap

Используйте функцию Canvas > Embroidery Canvas 
для оцифровки вышивальных проектов. . Просма-
тривайте и исходные картинки и объекты вышивки 
в режиме 3D. 
Используйте режим General > Insert Artwork для 
загрузки рисунков в Ваш проект для последующей 
оцифровки. 

Подготовленный рисунок                    Оцифрованный рисунок 



Откроется диалог Bitmap Artwork Preparation.

5  Проверьте число имеющихся оттенков (Available). 
Если их слишком много, изображение может ока-
заться “загрязненным”. См. Подготовка рисунков к 
автоматической оцифровке.

6 Введи достаточное число оттенков. Можете 
оставить то, что предложит программа BERNINA 
Embroidery Software или ввести другое.

7   Чтобы сохранить изменения, нажмите OK. Рмсу-
нок голтов для вытоматической оцифровки. См. Ав-
томатическая оцифровка.

Подготовка оконтуренных изображе-
ний

В режиме Embroidery Canvas есть опция Bitmap 
Artwork Preparation,  предназначенная для подго-
товки оконтуренных изображений к автоматической 
оцифровке. 

Этот инструмент автоматически повышает четкость 
контуров и уменьшает шум. Зоны, входящие в чер-
ный контур, окрашиваются в единый цвет. Повыше-
ние четкости контура облегчает программе распоз-
навать определенные зоны изображения. Эти зоны 
становятся объектами вышивки в окончательном 
проекте. Используйте этот инструмент в тех случаях, 
когда контуры являются смазанными, зазубренными, 
расплывчатыми или неопределенными.

Подсказка
В зависимости от качества отсканированного изо-
бражения может потребоваться выправить их 
вручную перед обработкой в BERNINA Embroidery 
Software. Можно кадрировать изображение, удалить 
фон, залить цветом определенные зоны, заполнить 
пробелы, добавить или усилить контуры. См. 
Редактирование  загруженных изображений.

Для подготовки оконтуренных изображений
1  Отсканируйте или загрузите изображение, См. За-
грузка изображений. 
2  В режиме Artwork Canvas выберите изображение, 
при необходимости кадрируйте или подправьте. 
См. Правка загруженных изображений
3  Перейти в режим Embroidery Canvas и выбрать ри-
сунок. 

4  Выбрать Artwork > Bitmap Artwork Preparation.
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Ввести нужное 
число оттенков 

Рисунок с про-
стой сплошной 

цветностью

Оцифрован-
ное изобра-

жение 

Осталось 3 оттенка                  Осталось 2 оттенка

Используйте функцию Canvas > Embroidery Canvas 
для оцифровки вышивальных проектов. Просма-
тривайте и исходные картинки и объекты вышивки 
в режиме 3D. 
Используйте режим General > Insert Artwork для 
загрузки рисунков в Ваш проект для последующей 
оцифровки. 



Откроется диалог Bitmap Artwork Preparation .

Изображение отобразится в окне просмотра. В поле 
Available указано имеющееся количество оттенков.

5   Установите степень резкости контура, перемещая 
ползунок. Отобразятся контурные линии в черно-
белом формате.

Подсказка
Для начала установите ползунок в крайнее правое 
положение. Контур будет “очень черным”. Затем 
медленно перемещайте ползунок влево до дости-
жения нужной Вам плотности контура. 

6  Для сохранения изменений нажмите OK . Изобра-
жение готово к автоматической оцифровке. См. Ав-
томатическая оцифровка. 
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Указать вид 
контура 
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Глава 16
Автоматическая оцифровка 

Интеграция программ CorelDRAW® и BERNINA Embroidery 
Software обеспечивает возможность взаимо-преобразова-
ния векторной графики и объектов вышивки. Инструмент 
Convert Vectors to Embroidery можно применять как для 
векторных графических изображений, так и для текстов. 

BERNINA Embroidery Software предлагает инструмент 
Magic Wand (Волшебная палочка) Он полезен для создания 
объектов вышивки из отсканированных изображений, ко-
торые не требуют особых художественных эффектов или 
специфичных знаний в области вышивания. Это поможет 
вам сохранить больше времени на обработку в действи-
тельности сложных зон вашего проекта. 

Инструмент Auto Digitizer автоматически преобразует рисунок в практически готовый 
вышивальный проект с минимальными поправками.  С эти инструментом даже нович-
ки в вышивании смогут создавать несложные проекты легко и быстро.  Инструмент 
PhotoSnap позволяет создавать вышивки на основе фотографий и других картинок.

В этой главе рассказано, как с помощью имеющихся программных средств автомати-
чески преобразовать рисунок, векторной или побитовый, в вышивку. Также рассказа-
но, как создавать вышивки на основе фотографий.

Предупреждение
Рисунки, поставляемые вместе с программой, и об-
разцы вышивки могут использоваться только для 
личных целей – т.е. они ни коим образом не могут 
использоваться в коммерческих целях. Изменение 
формата – превращение рисунка в образец вышивки 
или обратно – никоим образом не отменяет защиту 
авторских прав.

Ограничения возможности преобразова-
ния
Есть определенные ограничения на возможность 
преобразования векторных рисунков из формата 
CorelDRAW® в образцы вышивок. Некоторые специ-
альные изобразительные эффекты, такие как пада-
ющие тени, оконтуривание или полупрозрачность, в 
образцы вышивки преобразуются плохо, поскольку 
при вышивке воспроизвести такие эффекты сложно.
Тем не менее, программа BERNINA Embroidery 
Software будет стараться преобразовать векторный 
рисунок, даже если он имеет заполнение или окон-
туривание. 

Оцифровка векторной графики

В программе BERNINA Embroidery Software имеются 
специальные функции для преобразования объектов 
векторной графики в объекты вышивки или тексто-
вой вышивки. Фактически, можно легко преобразо-
вать весь векторный графический объект в объект 
вышивки. При этом преобразовании, программа 
определяет оптимальные объекты и типы стежков 
для тех или иных форм, причем все это можно на-
страивать. Можно осуществлять и обратные преоб-
разования – из вышивок в графику. 



Если эффект на вышивке воспроизведен быть не мо-
жет, программа преобразует рисунок в вышивку, со-
храняя только точные цвета. Встроенный текст пре-
образуется скорее в объект рисунка вышивки, а не в 
текстовую вышивку. 

Преобразование векторной графики в 
вышивку 

Инструмент Convert Vectors to Embroidery (Преоб-
разование векторной графики в образцы вышивки) 
преобразует заполнения и контуры отдельных век-
торных рисунков для заполнения или оконтурива-
ния соответствующих стежков. Эту функцию можно 
использовать и для текстов. См. также Преобразова-
ние текста в вышивку. 
 

Примечание
Побитовые изображения не могут быть преобразо-
ваны в образцы вышивок с помощью инструмента 
Convert to Embroidery. Такие рисунки надо предва-
рительно переработать. См.  Обработка изображе-
ний. 

Преобразование векторной графики в об-
разцы вышивки 
1 Перейдите в режим Art Canvas.
2 Отсканируйте, загрузите или создайте рисунок и/
или текст, который вы хотите использовать. См. За-
грузка рисунков.

3 Откройте инструмент преобразования рисунка в 
образец вышивки Convert to Embroidery.
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Программа BERNINA Embroidery Software автомати-
чески переходит в режим Embroidery Canvas. Ис-
ходные объекты удаляются с экрана проекта.

Преобразование вышивки в векторный ри-
сунок

Инструмент Convert Embroidery to Artwork преобра-
зует выбранный объект вышивки в векторный рисунок. 

Для преобразования вышивки в векторный 
рисунок 
1 Войдите в режим Embroidery Canvas

2 Выберите один или более объект вышивки и/
или текста и нажмите кнопку Convert Embroidery to 
Artwork. BERNINA Embroidery Software автоматически 
переходит в режим Artwork Canvas.

Тень не возможно 
преобразовать

Функция Canvas> Convert Artwork to Embroidery 
преобразует векторный или побитовый рису-
нок в контурные и заполняющие стежки

Функция Canvas > Convert Embroidery to 
Artwork преобразует выбранный объект вы-
шивки в векторный рисунок. 
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Автоматическая оцифровка с 
помощью инструмента Magic Wand

Инструмент Magic Wand дает все возможности для 
автоматической оцифровки отдельных форм поби-
товых изображений.

Для автоматической оцифровки фигур 
1  Отсканировать или загрузить изображение. См. 
Загрузка рисунков. Если загруженное изображение 
не отображается на экране, убедитесь в том, что 
функция Show Bitmap Artwork включена. См. также 
Отображение оригинала.  
2  Перейти в режим Embroidery Canvas и выбрать 
инструмент Magic Wand. Он доступен, если хотя-бы 
один побитовый рисунок присутствует в окне про-
екта.

3   Щелкните мышью в области рисунка. Программа 
проверит, обрабатывался ли этот рисунок ранее, и 
при необходимости отобразит диалог подготовки 
рисунка Bitmap Artwork Preparation. См. Подготовка 
изображений. 
4   Выберите цвет ниток и тип стежков. См. Подбор 
цветов ниток. 

5  Щелкните мышью в области рисунка.

6  Другие зоны вышивки заполняются и оцифровы-
ваются таким же образом. Можно поменять цвета 
ниток и типы стежков. См. Подбор и замена стежков. 
7   Проверьте результат в режиме Artistic View. 

Подсказка
Если вы хотите оцифровать как заполнение, так и 
контур объекта, щелкните левой клавишей мыши по 
заполнению или правой – по контуру. Можно также 
использовать функцию Outline Design для автома-
тического создания контура. См. Создание границ 
и контуров.

Обработанное 
изображение 

Все области
оцифрованы

Нажмите в области                Область заполнена стежками

Законченный проект             Оцифрованы только линии контура 

Используйте Canvas > Artwork Canvas для загруз-
ки, создания, правки и оцифровки векторных и 
побитовых рисунков.

Функция Canvas > Embroidery Canvas позволяет 
оцифровывать и править вышивки,  просматри-
вать вышивки и рисунки, просматривать проекты 
в режиме 3D.

Функция Auto-Digitize > Magic Wand позволяет ав-
томатически оцифровать заполнения в векторных 
или побитовых рисунках.

Функция View > Show Bitmap Artwork позволяет 
показывать и скрывать побитовые рисунки.



По существу, создание проекта вышивки функци-
ей Auto Digitizer заключается в том, что вам нужно 
выделить изображение, которое вы хотите преоб-
разовать, и щелкнуть по нему инструментом Auto 
Digitizer. Однако имеются некоторые настройки, ко-
торые вы можете изменить, чтобы оптимизировать 
процесс преобразования для конкретных проектов.
В одно и то же время можно выделить только одно 
изображение. Команда отменяется, если в выделен-
ной зоне находится больше одного изображения 
 

Подсказка
При использовании Auto Digitizer выберите компен-
сацию стягивания (Pull Compensation), установлен-
ную на 0,4 мм  

Для оцифровки всего изображения 
1 Отсканировать или загрузить изображение. См. 
Загрузка рисунков. 

Подсказка
Если загруженное изображение не отображается на 
экране, убедитесь, что функция Show Bitmap Artwork 
включена. См. Отображение и скрытие изображений.

2  Перейти в режим Embroidery Canvas и выбрать 
Auto Digitizer. Инструмент работает, если хотя-бы 
один побитовый рисунок присутствует в окне про-
екта.
3   Щелкните мышью в области рисунка. Программа 
проверит, обрабатывался ли этот рисунок ранее, и 
при необходимости отобразит диалог подготовки 
рисунка. См. Подготовка изображений. 
4   Еще раз щелкните мышью в области рисунка. От-
кроется диалоговое окно Auto Digitizer. В верхней 
части окна появляется информация об изображении, 
включая размеры по высоте и ширине и количество 
оттенков в изображения.
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Стежки создаются в соответствии с текущими на-
стройками. Возможно появление перескоков, если 
длина стежка превышает установленные стандарт-
ные настройки.

Оцифровка инструментом AutoDigitizer 

Этот инструмент развивает технологию Magic Wand, 
Auto Digitizer распознает отдельные формы на ри-
сунке и принимает решение по выбору оптимального 
типа стежков. Он также определяет последователь-
ность вышивания, ориентируясь на взаиморасполо-
жение объектов. Рисунок эффективно дробится на 
отдельные объекты вышивки, составляющие проект.
 
Auto Digitizer позволяет до известной смтепени 
управлять процессом преобразования. Можно ука-
зать цвета, которых следует избегать. Можно ука-
зать тип стежков. После оцифровки сохраняется 
возможность редактировать проект с помощью дру-
гих инструментов. См. Методы оцифровки. Незабы-
вайте применять подкладки, или придется менять 
некоторые формы. См. Стабилизация с помощью 
подкладок. 

Примечание
Даже если рисунок выглядит готовым к вышиванию, 
программа не позволит выполнить его автоматиче-
скую оцифровку без некоторой предварительной 
обработки. См. Обработка изображений. 

Автоматическая оцифровка всего проекта 

Ширина атласных строчек: 
2.5 mm есть перескоки

Ширина атласных строчек: 
1 mm есть перескоки

Используйте Canvas > Artwork Canvas для загруз-
ки, создания, правки и оцифровки векторных и 
побитовых рисунков.

Функция Canvas > Embroidery Canvas позволяет 
оцифровывать и править вышивки,  просматри-
вать вышивки и рисунки, просматривать проекты 
в режиме 3D.

Функция Auto-Digitize > Auto Digitizer позволяет  
автоматически оцифровать подготовленное по-
битовое изображение. 

Функция View > Show Bitmap Artwork позволяет 
показывать и скрывать побитовые рисунки.

Обработанное 
изображение
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Настройка параметров стежков 
Auto Digitizer позволяет выбирать настройки запол-
няющих стежков.

Для настройки параметров стежков

1  Отсканируйте или загрузите изображение. Запу-
стите программу Auto Digitizer для автоматической 
оцифровки всего проекта. См. Автоматическое соз-
дание проектов вышивки. 
2   Щелкните клавишей мыши по изображению. От-
кроется диалоговое окно Auto Digitizer.

•  Выбрать стиль стежков.

Стиль Описание 

Aвто Программа саса выберет лучший вариант. 

Шаг Подходит в большинстве случаев. 

Гладь Используйте для небольших или узких 
форм. 

5   Выберите типы стежков для заполнения и окон-
туривания. См. Настройка заполняющих стежков  и 
Автоматическое оцифровка всего изображения.
6   Нажмите кнопку Omitted Colors (Пропустить от-
тенки). В диалоговом окне отобразится список от-
тенков. Вы можете выбрать исключаемые из процес-
са обработки:
•  Для выбора нескольких оттенков удерживайте на-
жатой клавишу Ctrl. 
•  Для выбора нескольких идущих подряд 
оттенков удерживайте нажатой клавишу Shift

7   Установите требуемые опции для контуров.  См.  
Автоматическое создание контуров и границ.
8   Нажмите кнопку ОК. Auto Digitizer преобразует 
изображение в объекты вышивки и генерирует стежки.

9  Нажмите кнопку Show Artistic View на общей па-
нели инструментов или нажмите клавишу быстро-
го вызова этой команды ‘T’. Программа подбирает 
цвета из существующей палитры. Если вам кажется, 
что в проекте конвертированные цвета на экране 
отображаются неправильно, проверьте, установлен 
ли ваш монитор на 16-битовую насыщенность цве-
та, и убедитесь в том, что вы выбрали подходящую 
таблицу ниток.

Размер 
проекта
Количество 
цветов 
нитей 
Выберите 
параметры 
вышивания

Выберите
цвет

Выберите Выбрать 
тип стежка 
для запол-
нения 

Выбрать 
тип стежка 
для дета-
лей 

          Пропущен белый фон           Пропущены некоторые цвета



Для автоматического создания контуров и границ
1 Отсканируйте ищи загрузите рисунок, который 
хотите использовать. См. Importing artwork(Импорт 
рисунков).

Подсказка
Если загруженный рисунок не отображается, про-
верьте, включена ли кнопка Show Bitmap Artwork См. 
Отображение оригинала.

2  Выйти из Embroidery Canvas и выбрать Auto 
Digitizer. Инструмент работает, если хоть одна по-
битовая картинка имеется в окне просмотра проекта.
3   Кликните по изображению. 
Программа проверит, обрабатывался ли этот рисунок 
ранее, и при необходимости отобразит диалог под-
готовки рисунка Bitmap Artwork Preparation См. Под-
готовка изображений. 
4   Еще раз кликните по изображению.. 
Откроется диалог Auto Digitizer. 

5   Проверить параметры Add Outlines (добавить кон-
тур) и/или Add Border (добавить границу).
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Примечание
Не используйте гладьевые стежки там, где их длина 
должна превышать 7 мм. См. Сохранение длинных 
стежков. 

•  Выбрать из списка стиль стежков для деталей 
(Details). 

Стиль Описание 

Гладь Для толстых линий и маленьких объектов 
небольшой ширины

Два прохода Подходит для тонких линий

Линия гладью хорошо для использования с более широ-
кими линиями 

•   Нажать OK. 
Auto Digitizer преобразует рисунки в вышивки и ге-
нерирует стежки.

Автоматическое создание границ и конту-
ров

Инструмент Auto Digitizer позволяет автоматически 
генерировать контуры во время преобразования ри-
сунка. Это могут быть как контуры, отделяющие объ-
екты, так и границы вокруг всего образца вышивки.  
Автоматическое оконтуривание можно использовать 
для создания заполненного фона для вышивок на 
проблемных тканях, имитации тени и т.п.. Можно 
выбрать цвет контура при преобразовании рисунка. 
Цвета и детали генерируемого объекта можно в лю-
бой момент изменить.

Установите 
параметры пре-
образования в 
соответствии с 
требованиями

Добавить кон-
туры и границы
 Указать цвета

Гладь использовать не надо.                 Перескакивают стежки 

            Контур гладью                       Контур в два прохода 

Функция Auto-Digitize > Auto Digitizer позволяет  
автоматически оцифровать подготовленное по-
битовое изображение. 

Функция View > Show Bitmap Artwork позволяет 
показывать и скрывать побитовые рисунки.



Функция PhotoSnap создает вышивки на основе фо-
тографий и других картинок. Используйте изображе-
ния цветные или в градации серого. Изображения в 
градациях серого создаются из разных оттенков се-
рых пикселей. Цветные изображения можно автома-
тически преобразовать в серые с помощью PhotoSnap.

Проекты PhotoSnap состоят из рядов гладьевых 
стежков с изменяющимся шагом. Эффект напомина-
ет печать на принтере.

Подсказка
Для получения лучших результатов используйте 
изображения с хорошо выделенными формами или 
постоянно изменяющимися оттенками.

Для оцифровки с помощью PhotoSnap 
1  Отсканируйте или загрузите изображение. См. За-
грузка изображений. 

Подсказка
Проверьте, включена  ли функция Show Bitmap 
Artwork icon. См. Отображение оригинала.

2  В режиме Embroidery Canvas нажмите кнопку 
PhotoSnap и кликните по изображению.
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•  Генерируемая линия контура использует бегущие 
стежки, которые оконтуривают формы одного цвета 
на рисунке.
•  Генерируемые границы и контуры выполняются 
гладью с текущими настройками пео ширине и дру-
гим параметрам. Граница ориентируется по часовой 
стрелке чтобы вышивание объектов происходило 
регулярным образом (например, аппликаций). 

Примечание
Если изображение уже содержит контурные линии, 
использовать функцию Add Outlines не рекоменду-
ется – Вы получите двойные линии контура. См. Соз-
дание границ и контуров. 

6   Из выпадающего списка выберите цвета ниток 
для контуров и нажмите OK. Auto Digitizer преобра-
зует изображение в объекты вышивки и генерирует 
стежки.

Подсказка
Если хотите, вы можете пропустить выбор всех цве-
тов рисунка и ограничиться только внешними конту-
рами и/или границами.

Автоматическая оцифровка инстру-
ментом PhotoSnap

Добавлена гра-
ница и надпись 

        Добавлены линии контура              Добавлена граница        

              Заполнения удалены                        Заполнения удалены.  
                                                                           Границы  добавлены

Используйте Canvas > Artwork Canvas для загруз-
ки, создания, правки и оцифровки векторных и 
побитовых рисунков.

Функция Canvas > Embroidery Canvas позволяет 
оцифровывать и править вышивки,  просматри-
вать вышивки и рисунки, просматривать проекты 
в режиме 3D.

Функция Auto-Digitize > PhotoSnap позволяет пре-
образовать картинки и фотографии в вышивки. 

Функция View > Show Bitmap Artwork позволяет 
показывать и скрывать побитовые рисунки.



6 На панели Fill Angle (угол заполнения) настрой-
те угол заполнения стежками (если надо) и нажмите 
Apply (Применить).

7  Выбрать закладку Fill Stitch и указать параметры 
гладьевых стежков PhotoSatin.

•  Stitch Spacing (Шаг стежка): определяет плотность 
стежков – для увеличения плотности введите мень-
шее значение.
•  Skew Angle (Угол перекоса): определяет угол на-
клона стежков по отношению к углу стежков запол-
нения.

8 Для применения изменений нажмите Apply (при-
менить) и затем OK, чтобы закрыть окно.
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ПО BERNINA Embroidery Software начинает генери-
ровать стежки, что может занять некоторое время.
3   Кликнуть два раза линюю правой кнопкой мыши 
по проекту PhotoSnap. Откроется диалог Object 
Properties > PhotoSnap.

4   На панели опций “разрешение” (Resolution) вы-
берите вариант – Coarse (грубое), Medium (среднее), 
или Fine (тонкое) – и нажмите Apply (применить).

5   На панели Background Fabric выбрать опцию фона 
– Light or Dark – и нажать Apply (применить).

Подсказка
Обычно выбираемая вами опция зависит от того, яв-
ляется ли ткань светлой или темной.

Выберите разрешение

Указать 
параметры 
стежков 

Угол Заполнения 45 ° 
Угол наклона: 0 °

Угол Заполнения 45 ° 
Угол наклона: 45  °

                 Грубо                                      Точно

Угол заполнения 0°                     Угол заполнения 45° 

Светлый фон                           Темный фон 
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Часть IV 
Изменение проекта

Когда проект готов, его можно изменить целиком, отредактировать отдельные объ-
екты или стежки.

Комбинирование и изменение последовательности объектов
В этом разделе описывается, каким образом можно комбинировать объекты и проекты 
путем копирования и вставки, дублирования и вставки целых проектов и их элемен-
тов. Здесь же объясняется, как группировать и разгруппировать объекты, а также на-
значать последовательность объектов различными способами, включая функцию Color 
Film. Рассматривается также функция автоматического установление последователь-
ности всего проекта. См. Комбинирование и изменение последовательности объектов.

Расположение и трансформация объектов
В этом разделе описывается, как позиционировать и выравнивать объекты как инте-
рактивными, так и цифровыми способами. Также рассматриваются способы измене-
ния размеров, вращения и перекоса объектов. Кроме того, описываются различные 
способы перевода объектов в зеркальное отображение. См. Расположение и транс-
формация объектов.

Изменение формы и правка объектов
В этом разделе объясняется, как изменять форму объектов контрольными точками, из-
менять форму окружностей, устанавливать угол наклона стежков – включая сложные 
углы наклона – и изменять точки входа и выхода. См. Изменение формы и правка 
объектов.

Редактирование стежков.
В этом разделе объясняется, как выбирать и редактировать стежки. См. Редактирова-
ние стежков.
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Глава 17
Комбинирование и изменение последовательности объектов

ПО BERNINA Embroidery Software позволяет легко созда-
вать комбинации проектов и элементов проекта путем 
вставки содержания одного файла в другой. Вы можете 
также быстро добавлять к проектам существующие объ-
екты путем их копирования или дублирования. Объеди-
нение в группу выделенных объектов или целых проектов 
используется для совместного перемещения, изменения 
размеров или трансформирования. 
Первоначально объекты вышиваются в том порядке, в ко-
тором они были созданы. Однако имеется много спосо-
бов изменения последовательности вышивания. Напри-
мер, можно изменить положение выделенного объекта, вырезав его и вставив в другое 
место последовательности. Имеются также возможности выбора последовательности 
объектов способом «As Selected» («Последовательность в порядке выделения») или как 
«Color Blocks» («Цветные блоки»). Вы можете также изменить последовательность объ-
ектов, используя инструмент Color Film.
Функция Stitch Sequence (Последовательность вышивания) улучшает качество и эф-
фективность вышивания, сводя к минимуму количество перезаправки пялец, замены 
цветных ниток и обрезки ниток.  Все существующие перекрытия сохраняются при этой 
операции.
В этом разделе описывается, каким образом можно комбинировать объекты и проекты 
путем копирования и вставки, дублирования и вставки целых проектов и их элемен-
тов. Здесь же объясняется, как группировать и разгруппировать объекты, а также на-
значать последовательность объектов различными способами, включая функцию Color 
Film. Рассматривается также функция автоматического установление последователь-
ности всего проекта.

Комбинирование объектов
Проект или объекты проекта можно копировать или 
вырезать изменив 1 или несколько цветов перед тем 
как загрузить его на буфер MS Windows® для вре-
менного хранения. Содержимое буфера обмена мо-
жет быть вставлено любое число раз в один и тот же 
или в другой проект, до тех пор. Кроме того, объ-
екты можно клонировать или дублировать без копи-
рования в буфер обмена. См. также Выбор объектов. 

Вставка объектов

ПО BERNINA Embroidery Software позволяет скопиро-
вать один проект в другой. « и более проекта могут 
быть сохранены как комбинированный. При вставке 
одного проекта в другой, их палитры соединяются 
в одну. Цвета с одинаковыми значениями RGB авто-
матически признаются одной нитью. Если Вы хотите 
оставить их как две разные нити,

General (общее) > Insert Embroidery (вставить вы-
шивку) – вставить проект в действующий проект.



Вы можете копировать объекты, чтобы создавать 
многократно воспроизводимые идентичные объек-
ты или вставлять объекты из других проектов. См. 
также Установление последовательности объектов 
функцией Color Film.
 

Примечание
Вы можете также удалять объекты из проекта, поль-
зуясь командой Cut (Вырезать), и вставлять их об-
ратно. Команды Cut и Paste изменяют последова-
тельность вышивания в проекте. Подробнее см. в 
разделе Изменение последовательности вышивания 
объектов командами Cut и Paste. 

Как копировать и вставлять объекты
1   Выделите объект (или объекты) для копирования.
2  Нажмите кнопку Copy (Копировать). Выделенный 
объект будет скопирован в буфер обмена.
3  Перейдите к позиции в последовательности вы-
шивания, в которую вы хотите вставить объект. Под-
робнее см. в разделе Обход по стежкам. Вы можете 
вставить объект между другими объектами в после-
довательности вышивания.
4   Нажмите кнопку Paste (Вставить).

Примечание
Объект будет вставлен точно в верхнюю часть ори-
гинального объекта. Щелкните мышью и перетащи-
те объект перед отменой выделения. Объект будет 
оставаться в буфере обмена и может быть неодно-
кратно вставлен до тех пор, пока не последует сле-
дующая команда Copy (Копировать) или Cut (Вырезать). 

Осторожно!
Убедитесь в том, что имеется только одна копия объекта 
в одной и той же позиции. Если объект вставлен дважды 
в одну и ту же позицию, то он будет вышит дважды.
 
Дублирование объектов
Предпочтительнее дублировать объекты, чем копи-
ровать. При дублировании объекта он не копируется 
в буфер обмена.
Этим вы сохраняете буфер обмена для вырезки или 
копирования других объектов. См. также Установ-
ление последовательности объектов функцией Color 
Film.

Осторожно!
При комбинировании проектов лучше всего исполь-
зовать файлы формата Art Grade A или Grade B. Фор-
маты Art Grade C и D могут оказаться плохого каче-
ства при изменении размеров. См. Форматы проекта.

Как вставить проекты
1  Откройте базовый проект. Объекты сгруппирова-
ны по умолчанию. См. Группировка и разгруппиров-
ка объектов. 
2 Нажмите Insert Embroidery (вставить вышивку). От-
кроется окно Insert Embroidery. 
3   Выберите файл с нужным вам проектом и нажми-
те Open.  Проект будет вставлен в текущую позицию 
иглы. Он также будет сгруппирован по умолчанию. 
4 Переместите второй проект в нужное вам поло-
жение так, чтобы детали выгивались в последнюю 
очередь. См. Группирование объектов. 
5 Измените размер проекта. См. Масштабирование 
объектов. 

6   Переместите на нужное место. См. Позициониро-
вание объектов. 
7 Удалите нижние стежки. См. Удаление нижних 
стежков. 
8   Сохраните проект под новым именем. 

Копирование и вставка объектов
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Нажмите кнопку Copy (панель General), чтобы ко-
пировать выделенные объекты в буфер обмена.

Нажмите кнопку Paste (панель General), чтобы 
вставить скопированные объекты в проект.

Лепестки 
скопированы 
и вставлены



Подсказка
Для точного позиционирования удерживайте на-
жатой клавишу Ctrl для перетаскивании вдоль оси 
X или Y.
3  Отпустите кнопку мыши. В этой точке будет соз-
дан дубликат объекта/ов.
4 Нажмите Ctrl+D, чтобы повторить. Новый объект 
появится на таком же расстоянии, что и клонирован-
ный. 

Подсказка
Клонируйте этим же способом объекты в другом 
окне. Идентичная копия выделения создается в тех 
же координатах, что и в первом окне, независимо 
от того, в каком месте вы отпустите кнопку мыши.
method. 

Группировка и разгруппировка объектов 
Вы можете объединить в группу выбранные объекты 
или весь проект, чтобы сохранять связи между объ-
ектами во время перемещения, изменения разме-
ров и трансформации. BERNINA Embroidery Software 
различает понятия «разгруппирование» объектов и 
«разбивка» объектов. В общем случае объекты, кото-
рые были вами объединены в группу, для оцифров-
ки должны быть «разгруппированы», чтобы получить 
доступ к компонентам объектов. Если вам нужно по-
лучить доступ к объектам, которые были сгруппи-
рованы во время системных операций, - например, 
при генерировании объекта открытой аппликации, 
- вам потребуется разбить объекты.
 
 

Примечание
По умолчанию проекты автоматически группируются 
при открытии или вставке в другой проект. Подроб-
нее см. в разделе Настройка других общих опций.

Как дублировать объекты
1  Перейдите к позиции в последовательности вы-
шивания, в которую вы хотите поместить объект. 
Подробнее см. в разделе Обход по стежкам. Вы мо-
жете поместить объект между другими объектами в 
последовательности вышивания.
2  Выделите объект (или объекты) для дублирования.
3  Выберите Edit > Duplicate. Дублированный объект 
помещен непосредственно в верхней части ориги-
нального объекта в назначенной позиции последо-
вательности вышивания. Не забудьте щелкнуть мы-
шью и перетащить объект перед отменой выделения.
 
Клонирование объектов

Функция Quick Clone позволяет быстро дублировать 
выбранные объекты  перетаскиванием в новое по-
ложение нажатой правой кнопкой мыши. 
 

Подсказка
Объекты можно дублировать с автоматическим сме-
щением. Что означает возможность копирования с 
повторением шага. 

Как клонировать объекты
1  Выделите объект/ы.
2  Удерживая нажатой правую кнопку мыши пере-
тащите объект/ы в новое положение.
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Transform (трансформировать> Select Object (вы-
брать объект) – выбрать и клонировать объекты.

Щелкните 
правой кнопкой 

мыши по объекту

Перетащите и 
отпустите

Нажмите Ctrl + D для созда-
ния дубликата и сместите

Клонирование 
объекта

Исходник



Заблокируйте объекты, чтобы случайно их не пере-
местить или не изменить. Например, блокиров-
ка фонового рисунка удерживает его на мест при 
оцифровке, трансформации или изменении размера 
объектов рядом с ним. Его можно разблокировать в 
любой момент. 

Блокировка и разблокировка
•  Выберите объект и нажмите иконку Lock или на-
жмите K. Маркировка объекта исчезнет, и его нельзя 
будет выбрать или изменить. 
•  Чтобы разблокировать нажмите иконку Unlock All 
(разблокировать). Все объекты разблокированы. 

Выбор объекта в группе

ПО BERNINA® Embroidery Software предлагает ме-
тод выбора объекта в группе. Кнопкой Alt можно 
временно приостановить группировку. Это удобно, 
если Вы хотите что-то изменить «по ходу дела», не 
разгруппировывая объекты. 

Выбор объекта в группе
•  Нажмите иконку Select Object (выбрать объект) или 0. 

•  Alt + Click – выбор одного объекта. 
•  Сложные объекты или их последовательность выби-
рается стандартными методами в сочетании с кнопкой 
Alt как в окне проекта, так и в режиме Color Film. Это 
включает: 
     •  Выбор одного объекта/цвета: Alt + Click. 
    •  Добавление/удаление одного объекта/цвета: Alt 
+ Ctrl + Click. 

Группировка и разгруппировка объектов

Вы можете объединить в группу выбранные объекты 
или весь проект, чтобы сохранять связи между объ-
ектами во время перемещения, изменения размеров 
и трансформации. Объединение в группу выделен-
ных объектов или целых проектов используется для 
совместного перемещения, изменения размеров или 
трансформирования. После внесения изменений в 
группу, ее можно расформировать и работать с объ-
ектами по отдельности. 
 

Примечание
При открытии проект сгруппирован по умолчанию. 

Группировка и разгруппировка объектов
•  Выберите объекты для объединения в группу.
Нажмите кнопку Group (Объединить в группу) или 
нажмите Ctrl + G.

Выбранные объекты объединяются в группу. Груп-
па может быть выделена, перемещена, изменена по 
размеру как единый объект. См. также разделы Рас-
положение и трансформация объектов и Изменение 
формы и правка объектов. 
•  Выберите объект и нажмите Ungroup или Ctrl+U. 
Объекты будут разгруппированы, и входившие в 
группу объекты можно будет выделять индивиду-
ально. См. Выделение объектов в группе.

Блокировка и разблокировка объектов
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Щелкните по значку Group (панель Arrange), чтобы 
сгруппировать выделенные объекты.

Нажмите Arrange (организовать) > Ungroup  (раз-
группировать) -  разгруппировать. 

НажмитеTransform (трансформировать) > Select 
Object (выбрать объект) – выбрать один или не-
сколько/группу объектов. 

Нажмите Arrange > Lock (блокировать) – заблоки-
ровать все/включить защиту.

Нажмите Arrange (упорядочить) > Unlock All (раз-
блокировать все) – разблокировать все/убрать за-
щиту. 

Выделение, переме-
щение или 
трансформирова-
ние сгруппирован-
ных объектов как 
единого объекта  

Разгруппированные 
объекты можно выде-
лять индивидуально

Сгруппирован
весь проект 



Команда Break Apart активирована.

2   Щелкните по значку Break Apart. Объект будет разбит 
на исходные (первичные) компоненты вместо сгенери-
рованного (вторичного) объекта.

Эта операция разгруппирует открытый объект аппли-
кации в группы компонентов – исходные (первичные) 
объекты, из которых были сгенерированы (вторичные) 
объекты. Она также создает объект авто-аппликации 
из каждого куска ткани в проекте. Это нельзя вышить. 
См. Оцифровка аппликации.

Эта операция разгруппирует объекты монограммы 
на составные группы компонентов – текстовый объ-
ект, орнаменты (каждый орнамент остается сгруп-
пированным) и бордюры (также сгруппированные). 
См. также раздел Создание монограмм. 
 

Подсказка
Для модификации индивидуальных объектов, - на-
пример изменения последовательности вышивания 
бордюров монограммы, - используйте инструмент 
Color Film, чтобы разгруппировать объекты и изме-
нить последовательность. 

    •  Выбор последовательности объектов/цветов: Alt 
+ Shift + Click.

Подсказка
Вы также можете использовать область выделения 
или инструмент Polygon Select в сочетании с кнопкой 
Alt. См. Выбор объектов. 

•  Выбрав объект/ы, отредактируйте их свойства, 
швы и т.д. 

Разбивка объектов на компоненты 

Инструмент Break Apart позволяет разбить объекты 
Advanced Applique на отдельные компоненты. Эта 
команда может быть также использована для моно-
грамм, аппликаций, текстов и элементов «черной 
вышивки». Воздействие на эти объекты аналогично 
операции разгруппировки. 
 

Примечание
При сохранении в предыдущей версии ПО моно-
граммы, аппликации, текстовых объектов, объек-
тов «черной вышивки» они могут быть подвергнуты 
процедуре Break Apart по умолчанию.

Как разделять объекты на компоненты
1   Выберите объект, который вы хотите разделить - 
объект открытой аппликации, автоаппликации или 
текст. 
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Используйте инструмент Break Apart (панель Edit ), что-
бы разделить монограммы, аппликации, тексты и эле-
менты «черной вышивки» на отдельные компоненты. 

Выбраны от-
дельные объ-
екты 



3 Перейдите к точке в последовательности выши-
вания, в которую вы хотите поместить объект. Под-
робнее см. в разделе Обход по стежкам.  Вы можете 
вставить объект между другими объектами в последо-
вательности или «вмонтировать» вырезанный объект 
внутри другого объекта. 
Если текущее положение маркера иглы находится в 
конце проекта, объект будет вставлен в конце после-
довательности. 
4   Нажмите кнопку Paste (Вставить).

Объект будет вставлен в конец проекта.

Примечание
Объект будет оставаться в буфере обмена и может быть 
неоднократно вставлен до тех пор, пока не последует 
следующая команда Copy(копир.) или Cut (вырезать).

Изменение последовательности объектов 
инструментом Color Film

Проекты создаются из индивидуальных вышивальных 
«объектов», сгруппированных функцией «color block». 
Они указываются в порядке вышивания в списке Color 
Film. Используйте эту возможность для оптимиза-
ции своего проекта путем вырезания, копирования, 
вставки, дублирования, удаления и изменения после-
довательности выбранных цветных блоков. В общем 
случае вы должны стремится к сохранению блоков с 
одним и тем же цветом а общей последовательности, 
чтобы свести к минимуму количество изменений цве-
та, обрезки ниток и перемещения пялец. После оп-
тимизации цветовой последовательности вы сможете 
оптимизировать свой проект, проверив последова-
тельность вышивания отдельных объектов. См. также 
раздел Просмотр и выделение цветных блоков.

Примечание
Возможны случаи, при которых может потребоваться 
разбивать цвета, в особенности, если один из объ-
ектов находится около контура, поскольку контуры 
требуется вышивать поверх заполнения.

Как изменить последовательность объектов ин-
струментом Color Film 

•  Нажмите кнопку Color Film на основной панели ин-
струментов.

Изменение последовательности вы-
шивания объектов
Первоначально объекты вышиваются в том поряд-
ке, в котором они создаются.. Перед началом ра-
боты надо потренироваться в планировании про-
екта, форм и последовательности вышивки. Лучшие 
формы имеют постоянную ширину, никаких острых 
углов, выступающих мелких деталей и ровные края. 
Детали вышиваются после. См. также Установление 
последовательности объектов функцией Color Film.

Примечание
При работе с проектом нужно понимать последова-
тельность вышивки. Это можно сделать, пойдя про-
ект по стежкам или перерисовав его на экране. См. 
Просмотр последовательности вышивки. 

Изменение последовательности объек-
тов вырезкой и вставкой

Вы можете изменить последовательность объектов 
путем вырезания объекта из проекта и вставить его 
в другое место последовательности. Это не внесет 
изменений в физическое расположение объекта.

Как изменять последовательность объектов вы-
резкой и вставкой
1  Выделите объект (или объекты) для изменения по-
следовательности.
2  Нажмите кнопку Cut (Вырезать).  Выделенный объ-
ект будет удален из проекта и помещен в буфер об-
мена.
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Нажмите Cut (панель General), чтобы вырезать объект 
или объекты с помещение в буфер обмена.

Нажмите Paste (панель General), чтобы вставить скопи-
рованные объекты в проект.

Щелкните по кнопке Color Film (панель General), чтобы  
изменить последовательность объектов путем измене-
ния их положения в окне Color  Film
Щелкните по кнопке Show Individual  Objects (панель 
General), чтобы просмотреть индивидуальные объек-
ты в порядке последовательности вышивания.  Пере-
таскивайте значки объектов для изменения последо-
вательности. 

Неправильная последовательность    Выбрать и вырезать объект, чтобы из-
                                                                                                                    менить

1

2

3

      Перейдите к концу проекта                       Вставьте объект



См. Перегруппировка вышивки копированием и 
вставкой.

•  Используйте кнопку команды Sequence для из-
менения положения выбранных цветных блоков 
или индивидуальных объектов в последователь-
ности вышивания. См. также раздел. Sequencing 
objects&color blocks для подробностей.

Последовательность объектов по цвету

Перегруппировка по цвету минимально меняет про-
ект. См. Перегруппировка с Color Film.

Как изменить последовательность объек-
тов по цвету 
1  Выберите объекты для изменения последовательности.
2  Выберите Sequence by Color (перегруппировать по 
цвету) в панели Color Film. 

•  Перетащите цветные блоки, чтобы изменить их 
положение в последовательности вышивания.

Примечание
Функция Color Film синхронизирована с окном про-
екта. Она динамически обновляется в то время, ког-
да вы выбираете, изменяете или удаляете объекты 
или создаете новый объект. 

• Щелкните по переключающей кнопке Show 
Individual Objects (Показать индивидуальные объ-
екты), чтобы просмотреть индивидуальные объекты. 
Все объекты в пределах каждого цветного блока по-
казываются в последовательности.

•  При необходимости используйте список для пе-
ретаскивания значков объектов и изменения после-
довательности.
      • Для выделения нескольких идущих подряд 
объектов удерживайте нажатой клавишу Shift. 
         • Для выделения нескольких объектов удержи-
вайте нажатой клавишу Ctrl.
•  Щелкните правой кнопкой мыши по списку, что-
бы вызвать всплывающее меню. Используйте его при 
необходимости для вырезания, копирования или 
вставки объектов. 
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General (основное) > Color Film – открыть окно Color 
Film. Перегруппируйте, перемещая объекты в списке

Color Film > Sequence by Color (последовательность 
по цвету) – перегруппировка по цвету. 

Перетащите 
цветовой блок

Отпустите цвет-
ной блок в но-
вом положении

Используйте всплы-
вающее меню, чтобы 

вырезать, копиро-
вать, вставлять объ-
екты в соответствии 

с требованиями

Последователь-
ные объекты од-
ного цвета об-
разуют единый 
цветной блок

Все объекты, 
входящие в 

цветные блоки, 
показываются 

в последо-
вательности 
вышивания



Примечание
Выбирайте каждый объект в том порядке, в котором 
вы хотите их вышивать. 
3   Когда объекты еще остаются выделенными, вы-
берите команду Sequence by Selects на панели Color 
Film.  Или выберите Arrange > Sequence by Selects.

Теперь последовательность объектов будет соответ-
ствующей порядку их выделения справа от первого 
выделенного объекта. См. также Установление по-
следовательности объектов функцией Color Film.

Перегруппировка объектов и цветовых блоков

Панель Color Film обладает удобными средствами 
перегpуппировки объектов и цветовых блоков.

Или выберите Arrange(Упорядочить) > Sequence by 
Color(Последовательность по цвету).

Откроется окно Sequence by Color (группировать по 
цвету) с цветами проекта.

3  Выберите цвет и нажмите Move Up (вверх) или 
Move Down (вниз) – изменение последовательности. 
4  Нажмите OK.

Изменение последовательности выде-
ленных объектов

Группировать можно и по порядку вышивки. 

Для изменения последовательности выделен-
ных объектов
1   Выделите первый объект в диапазоне объектов, 
последовательность которых вы хотите изменить.
2   Удерживая нажатой клавишу Ctrl, последователь-
но выберите объекты в порядке изменения последо-
вательности. 
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General (основное) > Color Film – открыть окно Color 
Film. Перегруппируйте, перемещая объекты в списке

Выберите команду Sequence As Selected (меню Color 
film), чтобы изменить последовательность выделен-
ных объектов.

General (основное) > Color Film – открыть окно Color 
Film. Перегруппируйте, перемещая объекты в списке

Color Film > Back 1 Object (1 объект назад) – на 1 объ-
ект назад. 
Color Film > Forward 1 Object (1 объект вперед)–на 1 
объект вперед. 

Color Film > Back 1 Color (1 цвет назад) – на 2 цвет 
назад. 
Color Film > Forward 1 Color (1 цвет вперед) -  на 1 
цвет вперед. 

Color Film > Move to Start (на старт) – в начало по-
следовательности.
Color Film > Move to End (в конец) – в конец последо-
вательности вышивки.

Выбрать группи-
ровку по цвету 

                Сначала черный                       Черный последний                      Неправильная и правильная последовательность 

Выбрать 
группи-
ровку по 
цвету 



Тоже самое можно сделать через меню Arrange (упо-
рядочить) > Sequence (последовательность).

Автоматическая последовательность 
вышивания всего проекта 

Функция Stitch Sequence (Последовательность вы-
шивания) улучшает качество и эффективность выши-
вания, сводя к минимуму количество перезаправки 
пялец, замены цветных ниток и обрезки ниток.  При 
этой операции сохраняются все существующие пе-
рекрытия. Система анализирует проект и пересчи-
тывает: 
•  перезаправки пялец (если требуется больше од-
ного раза)
•  замену цветных ниток (общее число в текущем 
окне проекта) и
•  объекты, которые вышли за контуры пялец (если 
таковые имеются). 
Объединенные в группу объекты при операции Stitch 
Sequence не разгруппируются, но объектам разного 
цвета назначается оптимальная последовательности 
независимо от группировки. Однако монограммы и 
объекты открытой аппликации обрабатываются как 
отдельные объекты. Другими словами, их внутрен-
няя последовательность не изменяется до тех пор, 
пока командой Break Apart они не будут разбиты. 
См. также Разбивка объектов на компоненты. 

Как назначить автоматическую последователь-
ность всему проекту:
1   Откройте или создайте проект

2   Выберите Design > Stitch Sequence.
Система анализирует все выбранные объекты и рас-
считывает оптимальное число перезаправок пялец, 
замен цветов и обрезок ниток.

Примечание
Если ваш проект не размещается в текущих пяльцах, 
вы будете об этом предупреждены.  Вы сможете вы-
брать более крупные пяльцы или  использовать пе-
резаправку. См. также Закрепление в пяльцах круп-
ных проектов.

3   Подтвердите последовательность.
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Последовательность вы-
бранных объектов с помо-
щью панели инструментов 
или меню Упорядочить

Меняются 
6 цветов

Меняется 
4 цвета



Примечание
Командой Undo можно отменить изменение после-
довательности вышивания.
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Позиционирование объектов
Наиболее простым способом перемещения объекта 
в вашем проекте является перетаскивание его мы-
шью. Используйте клавиши со стрелками для «под-
талкивания» объекта к нужной позиции.

Подсказка
Если нет выбранного объект, используйте стрелки.

Для позиционирования объектов:
• Выберите объекты для перемещения, нажмите и
перетащитев новое положение. См. Выбор объектов.

• Для более точного позиционирования, исполь-
зуйте клавиши со стрелками, чтобы ‘подтолкнуть’ 
объект в нужное положение.
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Глава 18
Расположение и  трансформация объектов

ПО BERNINA Embroidery Software позволяет располагать и 
трансформировать объекты различными способами, как 
интерактивной, так и цифровой техникой. Позициониро-
вать объекты можно перетаскиванием мышью, клавишами 
со стрелками или изменением свойств объекта. Для вы-
равнивания объектов относительно друг друга имеются 
различные специальные инструменты.

Изменять размеры объектов можно непосредственно на 
экране или заданием точных размеров или процентно-
го изменения. Поворот, изменение наклона и зеркальное 
отображение объектов производится такими же сред-
ствами.

Специальные инструменты позволяют дублировать и трансформировать вышивальные 
объекты, а также переводить их в зеркальное отображение и поворачивать по цен-
тральным осям. 

В этом разделе описывается, как позиционировать и выравнивать объекты как инте-
рактивными, так и цифровыми способами. Также рассматриваются способы измене-
ния размеров, вращения и перекоса объектов. Кроме того, описываются различные 
способы перевода объектов в зеркальное отображение. 

Расположение объектов

Вы можете позиционировать объекты в окне про-
екта различными стандартными методами , в том 
числе перетаскиванием мышью, а также клавишами 
со стрелками для «подталкивания» в требуемое по-
ложение. Вы можете также задавать точные коорди-
наты объекта, используя свойства объекта. Или ПО 
BERNINA Embroidery Software имеет инструменты, 
которые помогут выровнять объекты и равномерно 
распределить их по проекту.

Use cross-hair cursor
to center object (Ис-
пользуйте курсор-пе-
рекрестие)



3  Щелкните по одному из значков выравнивания на 
панели Arrange (Расположение).

Оцифровка объектов

Можно автоматически распределять и по горизон-
тали и по вертикали, задав одинаковое расстояние 
между объектами. 

Распределение объектов
1 Выберите объекты. См. Выбор объектов. 
2 Нажмите инструмент распределения или выберите 
Arrange > Space Evenly > ... 

Изменение размеров объектов

Вы можете изменять размеры объектов непосред-
ственно на экране или заданием точных размеров 
или процентного изменения. При изменении разме-
ров объекта изменяется количество стежков для со-
хранения интервала между стежками.

Примечание
Возможность изменения размера и качество вышив-
ки  в конечном счете зависит от формата

•  Для еще более точного позиционирования введи-
те координаты X:Y.
В панели Transform (трансформировать) объект по-
явится вокруг заданных координат. 

Подсказка
Увеличьте масштаб, чтобы отредактировать детали. 
Расстояние между объектами зависит от увеличения. 
Чем больше увеличение, тем меньше расстояние. 

Выравнивание объектов

ПО BERNINA Embroidery Software позволяет вырав-
нивать объекты, чтобы позиционировать их по от-
ношению друг к другу. Вы можете выравнивать вы-
бранный объект по левому, правому, верхнему или 
нижнему краю или по центру. 

Как выравнивать объекты 
1   Выберите объекты, которые вы хотите выровнять.
2  Выберите объекты, которые вы хотите выровнять 
совместно. 
 

Примечание
Объекты выравниваются с последним выбранным 
объектом. Если мы выделяем все объекты проекта 
клавишами Ctrl+A или командой «Выделить все», 
объекты выравниваются по последнему объекту по-
следовательности.
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Выровнять центры

          Выровнять снизу                   Выровнять слева

Выберите объекты.

Значки на панели Arrange:
Align Left  выравнивает объекты по их левым сторонам. 

Align Centers выравнмвает объекты по их средним линиям. 

Align Right выравнмвает объекты по их средним линиям

Align Top выравнмвает объекты по их верхним сторонам. 

Align Horizontal выравнмвает объекты по их средним линиям

Align Bottom выравнмвает объекты по их нижним сторонам. 

Align Centers выравнивает объекты по их центрам

Arrange>Space Evenly Across (равномерно наиско-
сок)–равномерно распределить 3 и более объектов 
по горизонтали. 

Arrange > Space Evenly Down (равномерно вниз) – 
равномерное распределение 3 и более объектов по 
вертикали.

Проверьте положение 
выделенной области



•   Для пропорционального изменения высоты и ши-
рины используйте угловые маркеры.

Подсказка
По умолчанию размеры объектов изменяются про-
порционально.

•   Для изменения размера только по вертикали или 
горизонтально удерживайте при перетаскивании 
клавишу Ctrl.
•   Для изменения высоты используйте верхний 
средний или нижний средний маркеры.

      •   Для изменения ширины используйте средние 
боковые маркеры.

•  Для изменения размеров относительно центра во 
время перетаскивания маркера удерживайте нажа-
той клавишу Shift.

Изменение размеров объектов с ис-
пользованием свойств объекта

первоисточника – ART Grade A, ART Grade B, ART 
Grade C или ART Grade D. Только проекты в «род-
ном» формате ART Grade A содержат полный набор 
информации, требуемой для 100%-ного совершен-
ства масштабирования и трансформации. Подроб-
нее см. в разделе Форматы проектов вышивки. 

Проверка размеров
При изменении размеров надо следить за текущими 
измерениями. Чаще всего приходится менять раз-
мер проекта для разных изделий. например, если 
вшивка располагается на левой стороне груди, ее 
размер будет примерно 4.25» или 108 мм. 
 

Внимание!
Если увеличить строчки или проект более чем на 5%, 
это может повлиять на качество вышивки. См. Фор-
маты файлов вышивки. 

Для проверки размеров
1  Включите направляющую и/или линейку. См. Вы-
вод направляющих и линеек на экран. 
2  Выберите проект или объект. См. Выбор объекта 
указанием и нажатием. 
3  Проверьте размеры в строке состояния. См. Стро-
ка состояния. 
4  Проверьте размеры на панели Transform (транс-
формировать). См. Измерение расстояния на экране. 

5   Задайте размеры. См. Ввод размеров. 

Изменение размеров объектов перета-
скиванием мышью
Вы можете изменить высоту и ширину объекта или 
пропорционально изменять размеры объекта, ис-
пользуя маркеры – манипуляторы выделения. Из-
меняйте объекты индивидуально или выберите не-
сколько объектов для одновременного изменения. 

Как изменять размеры объектов перетаскива-
нием мышью
•     Выберите объект/ы для изменения размеров. См. 
Проверка размеров. 
•   Перетащите мышью манипулятор, чтобы изме-
нить размер объекта. 
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Transform > Scale Up (увеличить) – увеличить коли-
чество шагов на 20%.

Transform (трансформировать) > Scale Down (умень-
шить) – уменьшить количество шагов на 20%.

Проверьте размеры 
выделенной области

Тянуть-
Пропорциональное 

изменение размеров 

Тянуть-
по вертикали

Тянуть-
по горизонтали

Shift+тянуть в обе 
стороны по вертикали

Shift+тянуть в 
обе стороны по 

горизонтали 

Shift+Тянуть-
Пропорциональное 

изменение размеров 



Как поворачивать объекты перетаскиванием 
мышью
1   Выберите проект или объект.

2   Еще раз нажмите на объект.  На углах объекта 
появятся маркеры вращения, а в его центре отобра-
зится местоположение анкера. 
3   При необходимости перетащите анкер вращения 
в другое положение.
4   Щелкните по маркеру вращения и перетащите 
его по часовой стрелке или против часовой стрелки. 
Во время поворота появляется контур и перекрестие. 

Вращение объектов с использованием 
свойств объекта

Инструментами можно повернуть объект на уста-
новленный угол.

Как вращать объекты с использованием свойств 
объекта
•   Выберите проект или объект. 
•   Можно использовать функцию Rotate Right/Left 
(повернуть вправо/влево)
•   Можно использовать иконку Skew (перекос) для 
ввода точного угла перекоса. Нажмите Enter

Вы можете изменять высоту и ширину выбранных 
объектов или всего проекта, используя свойства 
объекта.

Как изменять размеры объектов с использо-
ванием свойств объекта 
•   Выберите объекты. См. Проверка размеров. 
•  Для быстрого изменения используйте иконки Scale  
Up / Down (увеличить/уменьшить). 
•   Для более точного изменения введите размеры 
в панели Transform и нажмите Enter. См. измерение 
расстояний на экране. 

•   Также можно уточнять параметры на ходу. См. 
Уточнение параметров измерения на ходу. 
•   Используйте переключатель соотношения сторон, 
чтобы разделить настройки ширины и высоты 
•   Нажмите Apply (применить)

Вращение объектов

Вы можете поворачивать объекты непосредственно 
на экране или назначив угол поворота.

Вращение объектов перетаскиванием мы-
шью
При выделении объекта на его крайних точках по-
являются метки – манипуляторы выделения. Если вы 
щелкните по объекту еще раз, то эти метки преоб-
разуются в маркеры вращения.
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Щелчком  Transform > Rotate Right можно повернуть 
выделенный объект на 45 градусов вправо

Щелчком Transform > Rotate Left можно повернуть 
выделенный объект на 45 градусов влево.

   Объекты можно поворачивать на определенный  
    угол по и против часовой стрелки. 

Установить ширину 
и / или высоту

Изменение масшта-
ба в процентах

Опорная точка

Поворотный
маркер

Первым щелч-
ком отобража-
ются маркеры 
выделения 

Перетащите 
угол, чтобы вра-
щаться вокруг 
точки привязки

Перетащите 
угол, чтобы вра-
щаться вокруг 
точки привязки

Перетащите 
опорную точку

После второго 
щелчка появля-
ются маркеры 
вращения

Блокирвка/разбло-
кировка пропорции

Маркер перекоса



•   Можно использовать иконку Skew (перекос) для 
ввода точного угла перекоса. Нажмите Enter

Перевод объектов в зеркальное ото-
бражение

Вы можете зеркально отображать объекты, перево-
рачивая их по горизонтали или по вертикали, ис-
пользуя Object Properties (Свойства объекта). Спе-
циальные инструменты позволяют дублировать и 
трансформировать вышивальные объекты, а также 
переводить их в зеркальное отображение и повора-
чивать по центральным осям. 

Перевод объектов в зеркальное отображе-
ние с использованием инструментов Mirror 
Horizontal или Mirror Vertical.

Вы можете зеркально переворачивать объекты на го-
ризонтальной или вертикальной оси, используя ин-
струмент Mirror Horizontal или Mirror Vertical.

•   Можно использовать функцию Rotate Right/Left 
(повернуть вправо/влево)

•   Или в поле Rotate By (Повернуть на), введите тре-
буемое вам значение угла поворота - плюс или ми-
нус – и нажмите Enter.

Перекос объектов

Вы можете придавать объектам нужный угол пере-
коса непосредственно на экране или путем ввода 
угла перекоса. 

Перекос объектов
•   Выберите проект  или объект

•   Нажмите еще раз.
Вокруг объекта появятся маркеры поворота и пере-
коса. Маркеры перекоса имеют форму ромба и по-
являются в средних точках верхнего и нижнего края 
объекта.
•   Перетащите маркер перекоса влево или вправо.
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   Вы можете перекосить объект относительно гори   
   зонтальной линии, щелкнув по маркеру перекоса  
   и перетащим его на требуемый угол. 

Опорная точка

Поворотный
маркер

Маркер перекоса

Первым щелч-
ком отобража-
ются маркеры 
выделения 

После второго 
щелчка появля-
ются маркеры 
вращения

Перетащите 
маркер пере-
коса влево или 
вправо.

Щелкните по кнопке Mirror Horizontal (панель 
Transxform), чтобы перевернуть объект на горизон-
тальной оси. 

Щелкните по кнопке Mirror Vertical (панель 
Transform), чтобы перевернуть объект на вертикаль-
ной оси.



Примечание
Убедитесь в том, что исходный объект/ы разгруппи-
рованы, в противном случае при операции зеркаль-
ного отображения с дублированием последователь-
ность цветов не будет изменена. 

2   Выберите инструмент Mirror-Merge:
•  Mirror-Merge Horizontal 
•  Mirror-Merge Vertical 
•  Mirror-Merge Horizontal/ Vertical Технологии одинаковы. 

3   Передвиньте линию на место, в котором Вы хоти-
те отобразить объекты

4  Нажмите, чтобы появилось отображенное изобра-
жение.  Отображения сохраняют цвета оригинала

Примечание
Если зеркальное изображение перекрывает ориги-
нал, Вам будет предложено объединить их.

Как переводить объекты в зеркальное ото-
бражение с использованием инструментов 
Mirror Horizontal или Mirror Vertical

1   Выберите объект/ы

2    Щелкните по значку Mirror Horizontal, чтобы пе-
ревернуть объект по горизонтали, или Mirror Vertical,  
чтобы перевернуть объект по вертикали. 

Зеркальное переворачивание с дубли-
рованием объектов

Инструменты Mirror-Merge (Зеркальное перевора-
чивание-Дублирование) позволяют дублировать и 
преобразовывать объекты в вертикальной и гори-
хонтальной плоскостях. Цвета также отображают-
ся автоматически. Также пересекающиеся объекты 
можно объединить в один.
 
Как зеркально переворачивать и дублировать 
объекты
1   Выберите объекты
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Оригинальный
объект

Отражение по 
вертикали (Y)

Объекты в 
последовательности 

цветовых блоков

Перекрывающиеся 
объекты сливаются

Отражение по 
горизонтали (X)

Отражение по 
горизонтали (X) 
и вертикали (Y)

Используйте инструмент Mirror Merge Horizontal 
(панель Mirror-Merge) для дублирования объекта по 
горизонтали.

Используйте инструмент Mirror Merge Vertical (па-
нель Mirror-Merge) для дублирования объекта по 
вертикали.

Используйте инструмент Mirror Merge Horizontal/
Vertical (панель Mirror-Merge) для дублирования 
объекта как по горизонтали, так и по вертикали. 



4   Нажмите кнопку Kaleidoscope, если это необхо-
димо. 
5 Переместите базисную линию к центру венка и 
щелкните, чтобы наметить местоположение анкера.

Подсказка
Удерживайте нажатой клавишу Ctrl, чтобы линия 
проходила под углом 45°.

Примечание
Если перевернутая копия перекрывает оригиналь-
ный объект, то появится вопрос, хотите ли вы объ-
единить объекты.

Создание дубликатов («Венков»)

Инструмент Wreath (Венок) многократно дублирует 
объекты вокруг центральной точки. Инструментом 
Kaleidoscope (Калейдоскоп) работают совместно с 
инструментом Wreath для расположения зеркаль-
но перевернутых объектов вокруг центральной 
оси.  Поскольку объект зеркально переворачивается, 
функция Kaleidoscope действует только с четным ко-
личеством объектов.

Подсказка
Используйте инструмент (Wreath) Венок для абукв и 
цифр, чтобы создавать забавные проекты.

Создание венков
1   Выберите объект/ы. Убедитесь, что оригинал раз-
группирован, иначе цвета отобразятся некорректно. 
2   Нажмите Wreath.

3   Введите число точек венка. 
Для активирования функции Kaleidoscope вводите 
четные числа. 
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Шести-точечный венок 
с  отключенным инстру-

ментом Калейдоскоп
Шести-точечный венок с  
включенным инструмен-

том Калейдоскоп

Открывает Допол-
нительную панель 
инструментов 
настроек Wreath 
(венок)

Калейдоскоп до-
ступен

       Нечетное                     Четное

Mirror-Merge>Mirror-Merge Wreath - многократ-
но дублировать и отобразить объекты вокруг цен-
тральной оси. Настройте дубликаты на панели 
Mirror-Merge Settings toolbar.

Mirror-Merge > Kaleidoscope – дублировать и ото-
бразить объекты вокруг центральной оси. Настройте 
дубликаты на панели Mirror-Merge Settings toolbar.

Переместите 
указатель мыши 
для установления 
центральной точки

8-точечный венок с цен-
тром, намеченным выше 
оригинального объекта 

8-точечный венок с цен-
тром, намеченным ниже 
оригинального объекта 
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Вокруг формы появятся контрольные точки

• Нажмите, чтобы выбрать одну точку.

• Удерживая Ctrl, нажмите на контрольную точку,
чтобы изменить форму

Глава 19
Изменение формы и правка объектов

Изменение формы объектов

Вы можете изменять форму объекта, выбрав его ин-
струментом Reshape Object (Изменение формы объ-
екта) и перемещая, добавляя или удаляя контроль-
ные точки на контуре. Для некоторых объектов вы 
можете также заменять угловые контрольные точки 
на контрольные точки кривых.
Инструмент Reshape дает возможность изменять 
формы, не оказывая влияния на угол стежков.

Примечание
Стежки всех объектов при изменении формы реге-
нерируются. 

Просмотр и выбор контрольных точек 

Узлы изменения формы могут быть выбраны инди-
видуально или совместно для изменения положения 
или модификации.

Просмотр и выбор контрольных точек

• Выберите объект и нажмите Reshape Object (из-
менить форму)

BERNINA Embroidery Software позволяет изменять форму объ-
екта, угла стежков точки входа и выхода с помощью контроль-
ных точек. Линии наклона стежков маркеры входа и выхода 
появляются вокруг выбранных объектов. Контрольные точки 
слегка различаются в зависимости от типа объекта.

Рекомендуется перед началом изменения любого проекта со-
хранить его копию под новым именем и хранить оригинал 
для случая, если вы захотите отказаться от всех изменений и 
начать снова.

В этом разделе объясняется, как изменять форму объектов 
контрольными точками, изменять форму окружностей, уста-
навливать угол наклона стежков – включая сложные углы наклона – и изменять точки 
входа и выхода. См. также раздел Правка вышиваемых текстов. 

Используйте инструмент Reshape Object (панель 
Transform) для просмортра контрольных точек вы-
бранных объектов.

Конечная точка

Начальная точка

Точка изменения 
формы 

Точка изменения 
формы 
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4  Выберите требуемые узлы изменения формы. 
Подробнее см. в разделе Просмотр и выбор узлов 
изменения формы.
5   Определите новое положение выбранных узлов 
изменения формы, перетащите их вдоль контура и 
нажмите клавишу Enter.

Подсказка
Используйте клавиши со стрелками для «подталки-
вания» выбранных узлов изменения формы. 

6   Нажмите Delete для удаления нежелательных уз-
лов изменения формы и нажмите Enter.

7   Нажимайте клавишу пробела, чтобы переходить 
от выбранных угловых точек к точкам кривой и за-
тем клавишу Enter. 
 

Подсказка
Если вы сделали ошибку, нажмите Esc, чтобы отме-
нить изменения, нажмите Esc еще раз, чтобы деак-
тивировать инструмент Reshape Object. 

•  Удерживая Shift, нажмите, чтобы выбрать несколь-
ко точек для изменения формы.

Подсказка
Нажатие правой или левой кнопки мыши в закрытой 
форме меняет направление отбора. 

•  Чтобы выделить группу точек, нажмите и тяните 
значок вокруг нее. 

Изменение формы объектов с использо-
ванием контрольных точек

Вы можете изменять форму объекта, выбрав его ин-
струментом Reshape Object (Изменение формы объ-
екта) и перемещая, добавляя или удаляя контрольные 
точки на контуре. Для некоторых объектов вы можете 
также заменять угловые контрольные точки на кон-
трольные точки кривых. 

Как изменять формы объектов с использованием 
контрольных точек 

1   Выделите объект.
2   Нажмите кнопку Reshape Object (Изменение фор-
мы объекта). Вокруг объекта появятся контрольные 
точки.
3   Для создания дополнительных контрольных точек 
изменения формы на контуре: 
•  щелкните левой кнопкой (Left-click), чтобы доба-
вить угловую точку,
•  щелкните правой кнопкой (Right-click), чтобы до-
бавить точку кривой.

Используйте инструмент Reshape Object (панель 
Transform) для изменения формы объекта

Щелкните правой 
кнопкой мыши

Щелкните левой 
кнопкой мыши

Перетащите и 
нажмите Enter

Выберите, удалить, 
и нажмите Enter

Выберите, нажмите 
пробел и нажмите 

Enter
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Чтобы сгладить кривые линии 

1  Выберите объект (или объекты), для которых нуж-
но выполнить сглаживание. 
 

Примечание
Сглаживание применимо только к разгруппирован-
ным и выбранным объектам. Выбрать можно сразу 
несколько объектов. 

2  Нажмите кнопку  Reshape Object.
На контуре объекта появятся узлы изменения формы.

3   Выберите Edit > Smooth Curves.
Откроется диалог сглаживания кривых линий 
Smooth Curves. 

4  В поле Precision (точность) укажите уровень точ-
ности сглаживания. От его значения зависит, на-
сколько близко сглаженный контур будет повторять 
исходный образец. Чем выше уровень точности – 
тем меньше будет узлов изменения формы.

5  Нажмите OK. 

Изменение формы объектов окружности 

Для объектов, создан-
ных инструментом Circle 
(Окружность), измене-
ние формы производит-
ся только контрольными 
точками. В таких объектах 
вы не можете добавлять, 
изменять или удалять контрольные точки. Объекты 
окружности можно преобразовывать из окружности в 
овал инструментом Reshape Object. Объекты окруж-
ности имеют две контрольные точки изменения фор-
мы (используемые для изменения радиуса и ориента-
ции объекта), центральную точку (используемую для 
изменения положения) и точку входа стежка.

Примечание
Вы можете также настроить по своему желанию угол 
наклона стежков, как и изменять точки входа и вы-
хода. Подробнее см. в разделах Подгонка углов на-
клона стежков и Изменение точек входа и выхода. 

8   Нажмите Esc для завершения. 

Изменение формы следующего или 
предыдущего объекта 
При правке объекта в режиме Reshape используй-
те клавишу табуляции (Tab) для быстрого перехода 
между объектами. См. также раздел Отмена выделе-
ния объектов.

Как изменять форму следующего или предыду-
щего объекта 
•  Нажмите клавишу Tab для принятия всех измене-
ний и перехода к следующему в последовательности 
вышивания объекту.

•  Сочетание Shift+Tab сохраняет изменения и вы-
полняет переход к предыдущему объекту.

Сглаживание кривых линий

Векторные объекты и объекты вышивки имеют узлы 
изменения формы на контуре. На объектах, которые 
можно плавно вращать, программа может вставить 
сотни  узлов изменения формы, что затрудняет ра-
боту с объектом. Команда Smooth Curves (сгладить 
кривые) позволяет применить к объектам вышивки 
функцию сглаживания кривых линий.

Используйте функцию Reshape Object вместе с ко-
мандой Edit > Smooth Curves, чтобы удалить лиш-
ние узлы изменения формы объектов вышивки. 

Используйте инструмент Reshape Object(панель 
Transform) для изменения формы объектов окружности. 

Изменение формы

Изменение формы

Shift + Tab Tab

90°

Угол шва

Точка входа
Центральная точка



Форма цепочки узоров изменяется инструментом 
Reshape (Изменение формы) таким же образом, как 
вы изменяете форму текстовых объектов.
Вы можете сделать цепочку узоров выше или уже, 
поворачивать цепочку узоров, перемещать инди-
видуальные узоры по базовой линии или изменять 
форму базовой линии. Вы можете поворачивать, на-
клонять и переводить в зеркальное отображение це-
почку узоров таким же образом, как и другие объекты. 

Как изменять форму цепочки узоров 
1  Выберите цепочку узоров и щелкните по значку 
Reshape. Вокруг объекта появятся узлы изменения формы. 
2  Перетащите контрольные точки изменения фор-
мы, чтобы изменить внешний вид цепочки узоров. 

3   Нажмите Esc для завершения.

Подгонка углов наклона стежков 

Настройка угла наклона стежков зависит от типа объ-
екта, с которым вы работаете. Для заполняемых объ-
ектов вы можете назначить угол наклона стежка для 
всего объекта. Альтернативно вы можете добавить 
сложные углы наклона стежков инструментом Stitch 
Angles. Вы можете также установить угол наклона 
стежка, используйте инструмент Reshape Object. 

Примечание: Вы можете изменить угол наклона 
стежков объекта окружности, перемещая точку вво-
да стежков.
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Как изменять форму объектов окружности
 
1  Выберите объект окружности и нажмите кнопку 
Reshape Object (Изменение формы объекта). Вокруг 
объекта появятся контрольные точки. 
2  Для перемещения окружности щелкните по кон-
трольной точке в центре окружности и перетащите 
ее в новое положение. 
3  Щелкните по контрольной точке на контуре 
окружности и перетащите ее для изменения формы   
контура. 
•  Для изменения формы без изменения ориентации 
используйте контрольную точку на вершине объекта. 

•  Для изменения формы и вращения объекта вокруг 
центральной точки используйте боковую контроль-
ную точку.

4 Нажмите Enter, чтобы принять изменения и клави-
шу Esc для окончания.

Подсказка
Для изменения размера окружности без превра-
щения ее в овал выберите ее инструментом Select 
Object (Выбор объекта) и используйте угловые мар-
керы выделения, чтобы изменить размер.

Изменение формы цепочки узоров

Используйте инструмент Reshape Object(панель 
Transform) для изменения формы объектов окружности. 

Изменение размера с 
использованием 
угловых маркеров 
выделения 

Перетащите для 
перемещения от-
дельных моделей

Передвиньте, чтобы 
отрегулировать высоту

            Исходное       Изменение ширины

Перемещены 
отдельные 
образцы

Пропорциональ-
ное увеличение

размера
Увеличение 

высоты

Длина базовой 
линии и ориента-
ция изменились

Пропорциональные 
изменения 

Изменения масштаба 
по горизонтали

Изменение длинны и 
направления базовой 
линии



Откроется диалог свойств объекта Object Properties.

4  Выберите закладку Stitch Angle(Угол наклона стежка). 
5  В поле Angle (Угол) введите требуемый угол на-
клона стежка. 

6 Нажмите Apply. 

Добавление и удаление углов наклона 
стежков 

Углы наклона стежков объектов с заполнением все 
модифицируются тем же способом. Сложные углы 
наклона стежков могут быть добавлены инструмен-
том Stitch Angles.

В программе BERNINA Embroidery Software, функция 
добавления углов наклона стежков Add Stitch Angles 
может применяться к замкнутым объектам, имеющим:
•  Поворачивающиеся углы наклона стежков
•  Один общий угол наклона стежков, с отверстиями или без. 

Подсказка
Инструментом Reshape (Изменить форму) вы може-
те добавить индивидуальные контрольные точки без 
воздействия на углы наклона стежков. Подробнее 
см. в разделе Изменение формы объектов.
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Подгонка углов наклона стежков

Вы можете изменить угол наклона стежка заполняе-
мых объектов, используя свойства объекта.

Примечание: 
Функция Remove Stitch Angles применяется к вы-
бранным объектам с поворачивающимися стежками.  
В результате остаются стежки с одним номинальным 
углом наклона.

Как подогнать углы наклона стежков с исполь-
зованием свойств объекта 
1 Выберите замкнутый объект с поворачивающимися  
стежками или без них. 

2 При необходимости, воспользуйтесь функцией 
Remove Stitch Angles , чтобы привести углы поворота 
стежков к номинальному.

3   Дважды нажмите или щелкните правой клавишей 
мыши по кнопке Add Stitch Angles.

Используйте Edit > Add Stitch Angles для установки тре-
буемых углов наклона стежков для замкнутых объектов с 
отверстиями или без. 

Используйте Edit > Remove Stitch Angles для удаления 
углов наклона стежков для замкнутых объектов с  пово-
рачивающимися стежками.

Используйте Edit > Add Stitch Angles для установки тре-
буемых углов наклона стежков для замкнутых объектов с 
отверстиями или без. 

Используйте Edit > Remove Stitch Angles для удаления 
углов наклона стежков для замкнутых объектов с  пово-
рачивающимися стежками.

Ввести нужный 
угол шитья

Угол: 0°                                          Угол: 90° 

С поворачиваю-
щимися стежками

Номинальный 
угол: 45 °

Одинаковый угол 
наклона стежков

Сложные углы 
наклона стежков



5   Вводите точки угла столько раз, сколько требу-
ется для создания эффекта «переворачивания» за-
полнения.
6   Нажмите Enter, чтобы принять изменения и  кла-
вишу Esc для окончания.

Подсказка
Вы можете использовать функцию Reshape Object 
для настройки узлов изменения формы. См. раздел 
Подгонка углов наклона стежков.

Подгонка углов наклона стежков

Вы можете изменить угол наклона стежка объек-
тов, используя функцию Reshape Object (Изменение 
формы объекта).

Как подогнать углы наклона стежков 

1   Выберите объект с заполнением.
2   Нажмите кнопку Reshape Object (Изменение фор-
мы объекта). 
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Для добавления  или удаления углов на-
клона стежков
1   Выберите замкнутый объект с поворачивающими-
ся стежками или без них.

Примечание
Если функция Stitch Angles применяется к объекту 
с эффектами заполнения типа Star Fill (заполнение 
звездами) или Wave Fill (заполнение волнами), эти 
эффекты будут удалены.

2 При необходимости воспользуйтесь функци-
ей удаления углов наклона стежков (Remove Stitch 
Angles), чтобы вернуться к текущему номинальному 
значению угла наклона.
3   Нажмите Add Stitch Angles.  Вам будет предло-
жено ввести углы наклона стежков.

Подсказка
Если нажать кнопку Enter после включения функции 
Add StitchAngles, но линии наклона стежков не вво-
дить, то они будут сгенерированы автоматически. 
Чтобы принять линии наклона – еще раз нажмите 
Enter . Чтобы отказаться от автоматически выбран-
ных линий наклона нажмите пробел. Тогда будет 
использован один общий угол наклона.
4   Назначьте такие углы наклона – точки 1 и 2 , что-
бы стежки пересекали две стороны объекта. Убеди-
тесь в том, что они не пересекают друг друга.

Внимание: Новые линии стежков не должны пере-
секать существующие линии стежков, в противном 
случае появится сообщение об ошибке. Нажмите 
клавишу пробела Backspace для удаления.

Используйте инструмент Reshape Object (панель 
Tansform) для установки угла наклона стежков выбран-
ных объектов. 



Как изменять точки входа и выхода
1   Выделите объект.
2   Нажмите кнопку Reshape Object (Изменение 
формы объекта). Появятся контрольные точки, 
включая точки входа и выхода.

Примечание:
В объектах окружности появляется точка входа. 
3   Выберите точку входа или выхода, как вам 
нужно, и перетащите ее в другое положение на 
контуре объекта.
4   Нажмите Enter, чтобы принять изменения и 
клавишу Esc для окончания. 

Примечание:
В объектах окружности угол наклона стежков пер-
пендикулярен линии, соединяющей точку входа с 
центром окружности. Таким образом, при измене-
нии точки входа стежка в объекте окружности из-
меняется угол наклона стежка.
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3  Выберите узлы наклона стежков и нажмите Delete 
для удаления углов наклона. 
 

Подсказка
При перемещении указателя мыши над точкой угла 
наклона на экране появляется всплывающая под-
сказка с углом наклона стежков выбранного объекта. 
4  Захватите кнопкой мыши узел и передвиньте так, 
как требуется. 

5   Нажмите Enter, чтобы принять изменения и кла-
вишу Esc для окончания. Объект будет вышит по-
вторно с новыми углами.

Подсказка
Для установки точного угла наклона стежков ис-
пользуйте свойства объекта. Подробнее см. в раз-
деле Подгонка углоа наклона стежка. 

Подгонка точек входа и выхода

По умолчанию функция Closest Join (Самое корот-
кое соединение) автоматически рассчитывает крат-
чайшее соединение между объектами, экономя ваше 
время, требуемое для нахождения точек входа и вы-
хода. Вкладка Settings > Options > General позво-
ляет при необходимости деактивировать эту функ-
цию. Если эта функция деактивирована, все вновь 
оцифровываемые объекты соединяются методом As 
Digitized (По мере оцифровки). Это означает, что во 
время оцифровки вам будет предлагаться выбирать 
точки входа и выхода. Вы сможете изменять их в лю-
бое время инструментом Reshape Object. См. также 
Настройка других общих опций.
    

Используйте инструмент Reshape Object (панель 
Transform) для подгонки точек входа и выхода вы-
бранных объектов.

Точка входа

Travel runs 
входа

Точка выхода

Точка входа

Точка выхода
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The needle point and stitch colors change and the
needle position marker moves to the selected
stitch. All stitches after the needle position marker
in the stitching sequence appear in black.

• Для выбора диапазона стежков удерживайте на-
жатой клавишу Shift.
• Для выбора нескольких стежков удерживайте на-
жатой клавишу Ctrl.

Выбор стежков ограничивающим пря-
моугольником

Глава 20
Редактирование стежков

Выбор стежков

Функция Stitch Edit (Редактирование стежков) по-
зволяет выбирать отдельные стежки или диапазон 
стежков путем выбора их точек укола иглой или 
оконтуривающим прямоугольником. Выбранные 
стежки выделяются другим цветом.

Выбор стежков по точке прокола

Вы можете выбрать индивидуальные стежки в режи-
ме Stitch Edit (Редактирование стежка) путем выбора 
их точек укола иглой.

Как выбирать стежки по точке прокола
1  Выберите Edit > Stitch Edit.  или E на клавиатуре, 
чтобы перейти в режим Stitch Edit.

Подсказка
Выбирать точки проще при увеличенном масштабе. 
См. Увеличение и уменьшение объектов. 

2  Щелкните по точке укола иглой.

BERNINA Embroidery Software автоматически генерирует стежки в соответствии с кон-
туром проекта и его свойствами. Это означает, что вы можете преобразовывать про-
екты BERNINA Embroidery Software и изменять их формы без изменения плотности или 
качества стежков.

Но BERNINA Embroidery Software позволяет также редактировать индивидуальные 
стежки. Вам просто нужно выбрать стежок, как и любой другой объект, и переместить 
по своему желанию точку укола иглой. Например, вы можете вставлять стежки в объ-
ект, чтобы заполнить пробелы. Вы можете переместить или удалить индивидуальные 
стежки или группы выбранных стежков.

В частности, это может потребоваться при работе с файлами стежков, которые не со-
держат данных о контуре проекта. Однако, если это возможно, редактируйте свойства 
объекта раньше, чем индивидуальные стежки. См. также Форматы проектов вышивки. 

В этом разделе объясняется, как выбирать и редактировать стежки.

Используйте команду Stitch Edit (меню Edit), чтобы вы-
брать индивидуальные стежки для редактирования.

Удерживайте Shift, чтобы 
выбрать диапазон стежковВыбранная точка

Используйте команду Stitch Edit (меню Edit), чтобы вы-
брать стежки ограничивающим прямоугольником.
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3  Переместите указатель мыши в то место, куда вы 
хотите вставить стежок, и щелкните правой кнопкой 
мыши.

4   Переместите мышь в то место, куда вы хотите 
вставить стежок, и щелкните правой кнопкой мыши.

5   Продолжайте щелкать правой кнопкой мыши по 
мере необходимости.

Перемещение стежков
 

Вы можете перемещать индивидуальные стежки или 
группы стежков. 
 

Внимание: 
Если стежки объекта по любой причине регенери-
руются, все функции редактирования стежков те-
ряются. Если это возможно, лучше изменять форму 
объекта, чем перемещать индивидуальные стежки. 
Подробнее см. в разделе Изменение формы и прав-
ка объектов. 

Как перемещать стежки 
1 Выберите Edit > Stitch Edit. или E на клавиатуре, 
чтобы перейти в режим Stitch Edit. 
 

Подсказка
Выбирать точки проще при увеличенном масштабе. 
См. Увеличение и уменьшение объектов. 
2   Выберите стежки и перетащите их мышью в новое 
положение. 

Можно быстро выбрать группу стежков, растянув во-
круг них выделяющую рамку.

Как выбирать стежки выделяющей рамкой 
1  Выберите Edit > Stitch Edit. или E на клавиатуре, 
чтобы перейти в режим Stitch Edit.

Подсказка
Выбирать точки проще при увеличенном масштабе. 
См. Увеличение и уменьшение объектов.  

2  Очертите указателем мыши ограничивающий пря-
моугольник вокруг выделяемых стежков. 
Стежки будут выделены, как только вы отпустите 
кнопку мыши.

Вставка стежков
 

Вы можете вставлять стежки в объект, чтобы запол-
нить пробелы. Вставленные стежки являются обо-
снованной частью объекта (в большей мере, чем 
независимые объекты). Однако они могут быть уда-
лены, если происходит регенерация стежков. Если 
это возможно, лучше редактируйте свойства объ-
екта, чем индивидуальные стежки. Например, чтобы 
увеличить плотность стежков, лучше уменьшить ин-
тервал между стежками. чем вставлять стежки. 

Как вставлять стежки 
1 Выберите Edit > Stitch Edit или E на клавиатуре, 
чтобы перейти в режим Stitch Edit.. 
 

Подсказка
Выбирать точки прозе при увеличенном масштабе. 
См. Увеличение и уменьшение объектов.
 
2   Выберите точку укола иглой

Цвет стежка изменится, а маркер положения иглы 
переместится на выбранный стежок. Все стежки за 
маркером положения иглы в последовательности 
вышивания будут отображены черным цветом.

Ограничивающий прямоугольник        Стежки выделены 

Щелкните правой кнопкой мыши, чтобы вставить новый стежок 

 Новый стежок вставлен и выделен

Правый щелчок – новый стежок вставлен

Новый стежок вставлен и выбран
Используйте команду Stitch Edit (меню Edit), чтобы 
вставить стежки в объект. 

Используйте команду Stitch Edit (меню Edit), чтобы 
выбрать индивидуальные стежки для перемещения. 
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Новое положение будет отображено теневым кон-
туром.

Удаление стежков

Вы можете удалить отдельные выделенные группы 
стежков.

Внимание:
Если стежки объекта по любой причине регенериру-
ются, все функции редактирования стежков теряют-
ся. Если это возможно, лучше редактируйте свойства 
объекта, чем индивидуальные стежки. Подробнее 
см. в разделах Регулировка шага гладьевого запол-
няющего стежка и Сохранение длинных стежков. 

Для удаления стежков
1 Выберите Edit > Stitch Edit. или E на клавиатуре, 
чтобы перейти в режим Stitch Edit.  
 

Подсказка
Выбирать точки проще при увеличенном масштабе. 
См. Увеличение и уменьшение объектов.  

2  Выберите стежок или стежки 
3  Нажмите Delete. 

Используйте команду Stitch Edit (меню Edit), чтобы 
выбрать индивидуальные стежки для удаления.

Перетащите стежок 
в новое положение

Теневой контур

Выделенные стежки

           Стежки выделены                            Стежки удалены
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Часть V
Продвинутая оцифровка 

ПО BERNINA Embroidery Software предоставляет специальные возможности повышения 
продуктивности, эффекты вышивки и методы оцифровки. 

Специальная техника оцифровывания
В этом разделе рассматривается создание „ручных“ вышивок и возможности упрочне-
ния контуров в технике Double Run и Blackwork Run. Кроме того, описывается техника 
вырезания отверстий и удаления перекрывающих стежков, а также заполнения отвер-
стий в объектах. Описаны также простые и быстрые способы выметывания пуговичных 
петель. См. Специальная техника оцифровывания.

Эффекты художественного вышивания
В этом разделе описывается, как применять эти типы художественных стежков и эф-
фекты к проектам вышивания и как настраивать эти функции для получения желаемых 
результатов. См. Эффекты художественного вышивания.

Узорные штампы. Оконтуривание и заполнение узорами
В этом разделе описывается, как вставлять узоры в проект и как подгонять их настрой-
ки, чтобы получать наилучшие результаты. Также объясняется, как создавать собствен-
ные узоры и комплекты узоров, а также то, как создавать образцы стежков с резными 
штампами. См. Узорные штампы. Оконтуривание и заполнение узорами.

Оконтуривание и заполнение  рукодельными стежками
В этом разделе поясняется, как выбирать типы рукодельных стежков, а также изменять 
настройки стежков для получения наилучших результатов. См. Оконтуривание и за-
полнение  рукодельными стежками.

Оцифровка аппликаций
В этом разделе описывается создание закрытых, частично открытых и открытых ап-
пликаций. См. Оцифровка аппликаций.
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Глава 21
Специальная техника оцифровывания

BERNINA Embroidery Software предлагает спе-
циальные способы оцифровывания для полу-
чения специальных эффектов при вышивании, 
а также для экономии времени при подготовке 
проектов. Существуют инструменты для соз-
дания вышивок, выглядящих так, как-будто 
они сделаны вручную.  При обычных методах 
оцифровки рисунка добиться такого эффекта 
не просто. 

Имеются инструменты для упрочнения контуров, вырезки отверстий в объектах, уда-
ления подстилающих стежков, а также заполнения отверстий. Можно быстро про-
строчить контуры вокруг выбранных объектов или вокруг всего рисунка, с помощью 
простых, тройных или гладьевых линий. Имеются также специальные инструменты 
для простого и быстрого создания пуговичных петель. 

В этом разделе рассматривается создание „ручных“ вышивок и возможности упрочне-
ния контуров в технике Double Run и Blackwork Run. Кроме того, описывается техника 
вырезания отверстий и удаления перекрывающих стежков, а также заполнения отвер-
стий в объектах. Описаны также простые и быстрые способы выметывания пуговичных 
петель.

Создание “ручных”вышивок

Функция Freehand Draw Embroidery (создание “руч-
ных” вышивок) работает аналогично тому, как ра-
ботают функции Freehand и Polyline в программе 
CorelDRAW®. Функция Freehand Draw Embroidery 
предоставляет множество преимуществ. Она позво-
ляет легко и быстро создавать рисунки, выглядящие 
так, как-будто они сделаны вручную, При обычных 
методах оцифровки рисунка добиться такого эф-
фекта не просто.  Цель состоит в иммитации движе-
ний ручной вышивки на вышивальной машине, когда 
ткань зафиксирована в пяльцах. Для этого игла как-
бы “рисует” на поверхности ткани.  
Другие техники позволяют вышивать поверх фото-
графических изображений или детально прорисо-
вывать линии.



Например, можно использовать этот инструмент, 
чтобы вручную набросать цветной рисунок фото-вы-
шивки. Эта техника требует аккуратности, особенно 
в прорисовке углов, подобно функции CorelDRAW® 
Polyline.

В других случаях, рисунки, похожие на наброски ка-
рандашом или углем, могут быть оцифрованы очень 
быстро. Эту функцию можно использовать для соз-
дания эффектов типа ‘doodle’ (“каракули”) без под-
робной проработки деталей. Например, можно до-
бавить к  основному рисунку графический фрагмент, 
декоративный текст и т.п

Создание линий “ручных” стежков

Функция “ручной” вышивки представлена на пане-
ли инструментов оцифровки (Digitize toolbar) в двух 
вариантах:  Open Object (вышивка незамкнутых объ-
ектов) и Closed Object (вышивка замкнутых объек-
тов). Подобно другим инструментам оцифровки, эти 
функции можно использовать в сочетании с любыми 
имеющимися на данный момент типами стежков. С 
помощью этих функций можно рисовать объекты не-
посредственно на экране. При рисовании наброска 
вышивки, можно смотреть, как это будет выглядеть 
в стежках, непосредственно в процессе рисования. 
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Таким образом достигается возможность создания 
художественных эффектов, подобных машинным 
вышивкам в режиме свободного движения или «ри-
сования нитками».  Эту функцию можно использо-
вать и для того, чтобы просмотреть, как будет вы-
глядеть реальная ручная вышивки, перед тем, как 
начинать ее вышивать. В конце концов, создав рису-
нок на экране, его можно вышить и автоматически.

Примечание
С функциями “ручной” вышивки Freehand Embroidery 
можно работать как с помощью компьютерной 
мыши, так и компьютерного пера WACOM.

Как создать линии “ручных”  стежков 
• Создайте форму при помощи инструмента 
Freehand.  
•   В палитре выберите цвет и тип шва.
Для инструмента Closed Freehand доступны все виды 
швов и заливок. 
•   Выберите стиль, настройте коэффициент сглажи-
вания и плотность шва. См. Регулировка гладкости 
линии в ручную. 

•   Нажмите и тяните для создания формы. Чтобы 
завершить, отпустите. 
ПО BERNINA Embroidery Software выводит стежки на 
экран в процессе рисования. 

•   Для создания закрытой формы используйте ин-
струмент Closed Freehand. 
      •  Если выбран режим Outline, в палитре Color 
Palette ПО BERNINA Embroidery Software стежки вы-
водятся по клику или движению мышки.

Чтобы наметить контуры (набросок) вышивки не-
посредственно на экране, используйте пункт меню 
Digitize > Freehand Draw Embroidery ->Open Object . 
Можно смотреть, как это будет выглядеть в стежках, 
непосредственно в процессе рисования. 

Для прорисовки на экране объектов вышивки с за-
полняющими “ручными” стежками, используйте 
функцию Use Digitize > Freehand Draw Embroidery 
-Closed Object.

Установите гладкость      Выберите стиль



•   Если выбран режим заполнения стежками (Fill), 
после каждого щелчка или при перетаскивании 
пойнтера мыши отображается каркасный набросок.

•  Отпустите кнопку мыши. ПО BERNINA Embroidery 
Software аккуратно закроет форму. 

Подсказка
Инструмент  Open Freehand может создавать кал-
лиграфию настройками Calligraphy в сочетании с 
швами Raised Satin. Для лучшего результата могут 
понадобится дополнительные подкладки и большая 
плотность шва. См. Создание гладких контуров. 

Сглаживание линий “ручных” стежков

Функции Freehand Draw Embroidery имеют специ-
альный курсор. Он разработан для того, чтобы  
контролировать зазоры и промежутки. Число кру-
гов и промежутки между концентрическими кру-
гами управляется с помощью панели инструментов 
сглаживания “ручных” линий Freehand Embroidery 
Smoothing. Эту панель инструментов можно рас-
положить на экране фиксировано, или сделать ее 
“плавующей”.
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Как настроить сглаживание линий “ручных” 
стежков
•  Создайте образец “ручного” рисунка с использо-
ванием контурных (набросочных) объектов и/или  
замкнутых заполненных объектов. Подробнее см. 
раздел Создание линий “ручных” стежков.

•  Можно настроить степень “сглаживания” линий 
“ручных” стежков с помощью регулятора Smoothing.
Регулятор Smoothing располагается на панели ин-
струментов и позволяет указать в процентах на-
сколько точно сглаженная линия должна соответ-
ствовать оригиналу. Изменяя степень сглаживания 
вы меняете количество контрольных точек, которые 
программа BERNINA Embroidery Software использует 
при вычислении контура вышивки.

•  Отрегулируйте гладкость:

Tool Note
Show Guide – переключение курсора 
оцифровки – больший контроль за ри-
сованием и точками по умолчанию. 

Контроль Guide Inner Circle Radius 
– установка размера центра круга 
оцифровки от руки. 

Контроль Number of Guide Circles – 
установка количества кругов курсора 
– если радиус внутреннего круга 2 мм, 
каждый следующий круг сдвигается 
на 2 мм. 

Чтобы наметить контуры (набросок) вышивки не-
посредственно на экране, используйте пункт меню 
Digitize > Open Freehand. Можно смотреть, как это 
будет выглядеть в стежках, непосредственно в про-
цессе рисования. 

Для прорисовки на экране объектов вышивки с за-
полняющими “ручными” стежками, используйте 
функцию Digitize > Closed Freehand.

«Толстый-
тон»кий» кал-
лиграфический 
эффект

Без сглаживания

Со сглаживанием



•  В режиме Reshape можно просматривать и редак-
тировать контрольные точки, созданные инструмен-
том Freehand Embroidery.

•  Чтобы удалить часть линии, нажмите и удержи-
вайте Shift при обратном движении мышки по ли-
нии. Как только кнопку Shift отпустить, точка начала 
и конца отрезка соединятся прямой линией. Или на-
жмите Backspace. Удалится последняя точка.

•  Или нажмите Backspace. Удалится последняя точка.
•  Для завершения отпустите мышку или нажмите Esc.

Примечание
Объекты, созданные с помощью функции Freehand 
Embroidery можно редактировать и перерисовывать 
тем же способом, что и объекты созданные обычным 
образом. Надо выбрать объект и нажать на кнопку 
Reshape Object на панели Transform.

Упрочнение контуров 
Используйте инструмент Double Run (панель Design) 
для упрочнения контура. Используйте инструмент 
Blackwork Run для соединения выделенных конту-
ров, чтобы образовать единый сгруппированный 
контур с оптимальной последовательностью выши-
вания. 

Упрочнение контуров функцией Double 
Run
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Используйте функцию Double Run 
(Двойной обход) для упрочнения 
контура. При этом контур обшивает-
ся в противоположном направлении. 
Обычно это свойство используется для 
утолщения строчки контура без обра-
зования нежелательных соединитель-
ных стежков. Также может применяться к заполнен-
ным объектам.

Как упрочнять контуры инструментом Double 
Run 
1 Выберите объекты, контуры которых требуют 
упрочнения.
2  Щелкните по значку Double Run или нажмите  Ctrl+В.
Объект будет дублирован реверсными стежками и 
помещен сверху оригинала. Цвет остается тем же, 
что и у оригинала, и помещен после него в после-
довательности вышивания.

3   Проверьте, дублирован ли объект, используя 
один из следующих способов:  
•   Проверьте количество стежков в статусной строке
• Просмотрите объекты функцией Color Film. См. 
Просмотр и выбор цветовых блоков. 
•  Обойдите объект по стежкам. Подробнее см. в 
разделе Просмотр последовательности вышивания. 
•  Используйте команду Slow Redraw (Медленное 
перерисовывание). Подробнее см. в разделе Замед-
ленный просмотр последовательности вышивания. 

Упрочнение контуров инструментом 
Blackwork Run

Используйте инструмент Blackwork Run для соеди-
нения выделенных контуров, чтобы образовать еди-
ный сгруппированный контур с оптимальной после-
довательностью вышивания.

Используйте инструмент Double Run (панель Edit) 
для упрочнения контура путем обшивания его в об-
ратном направлении. 

Используйте инструмент Blackwork Run (панель Edit) 
для автоматического назначения последовательно-
сти выделенных объектов вышивки. 

Без сглаживания

Со сглаживанием

Удерживая 
клавишу Shift, 
и перетащите 

назад



Образующийся объект Blackwork Run всегда сле-
дует цвету первого объекта в последова-тельности 
вышивания. См. также раздел Создание контуров 
стежками назад («бэкстич»).

Функция Blackwork Run работает с вышивальными 
контурами, состоящими из одного объекта или из 
комбинации объектов типа открытого объекта, зам-
кнутого объекта, окружность/овал или прямоуголь-
ник. Могут быть использованы все оконтуривающие 
стежки, кроме Pattern Run, Blackwork Border или 
Candlewicking Border. См. Стежки заливки и контура.

Примечание:
Команда Ungroup (Разгруппировать) не действует, 
если выбран объект Blackwork Run. Если вы хотите 
получить доступ к компонентам объекта, используй-
те инструмент Break Apart. Подробнее см. в разделе 
Разбивка объектов на компоненты.

Как упрочнять контуры функцией Blackwork Run

1   Выделите объекты.

Примечание
Эта функция применима только в том случае, если вы-
брано больше одного объекта подходящего типа.
Любой объект, для которого не может быть установлена 
автоматическая последовательность, исключается из 
операции. 
2  Нажмите на значок Blackwork Run. 
3  Оцифруйте точку входа или нажмите Enter, чтобы 
принять стандартные настройки.
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Компоненты объекта сгруппированы и принимают 
цвет первого объекта.

Подсказка  
Обойдите объект автоматической последователь-
ности для проверки. Подробнее см. в разделе Про-
смотр последовательности вышивания. 

4  Измените при необходимости цвет нитки все-
го объекта в последовательности. Подробнее см. в 
разделе Изменение цвета ниток. 
5   Измените при необходимости форму объекта в 
последовательности.
Объекты в последовательности могут изменены по 
форме в целом. Имеется только одна точка входа 
и одна точка выхода, но все компоненты объектов 
имеют индивидуальные точки изменения формы. 
Подробнее см. в разделе Изменение формы объек-
тов с использованием узлов изменения формы. 
 

Примечание:
Вы можете не заметить на экране большого различия 
после применения Blackwork Run, если укреплен-
ные контуры перекрывают друг друга. Для провер-
ки оконтуривания объекта функцией Blackwork Run 
обойдите объект по стежкам. Подробнее см. в раз-
деле Обход по стежкам.

Удаление подстилающих стежков

Используйте инструмент Remove Overlaps для удале-
ния подстилающих слоев вышивки. Благодаря этому 
сокращается количество стежков и предотвращается 
скопление ненужных стежков.  Вырезание перекры-
тий сохраняется между «вырезкой» объектов и «вы-
резанными объектами», чтобы избежать пробелов. 
Это можно подгонять для различных типов ткани.

Используйте инструмент Remove Overlaps (панель 
Edit) для удаления слоев подстилающих стежков в                 
перекрывающихся объектах.

Длинные соедини-
тельные стежки 

между отдельными 
объектами 



Вырезаемые объекты
Различные объекты вышивки могут быть использо-
ваны в качестве вырезаемых объектов если они не 
слишком малы или если зазоры между стежками не 
менее 1 мм. Например, это могут быть:
• Объекты с заполнением стежками Satin, Step или 
Fancy Fill
• Контуры, выполненные гладьевым валиком
• Объекты автоаппликации с покрытием гладьевыми 
стежками
• Текстовые объекты.

«Вырезаемые» объекты:
К «вырезаемым» объектам относятся:
• Заполненные объекты
• Объекты автоаппликации
• Оконтуренные объекты. 

Инструмент Remove Overlaps не создает букв и пу-
говичных петель, но они могут быть резаками. См. 
Создание пуговичных петель. 
Подстилающие стежки, просвечивающие через за-
полнение, не удаляются. Это относится к заполне-
ниям такими стежками, как Pattern Fill, Blackwork 
Fill, Candlewicking Fill, Lacework Fill, Gradient Fill, 
или стежками с шагом 1,00 мм и больше. А также 
не удаляются любые стежки, подстилающие узкие 
фрагменты объектов. 
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Перекрытия 
удалены



Добавление и удаление отверстий:
1 Выберите объект. 

2   Щелкните по значку Add Holes (Добавить отвер-
стие). Вокруг контура объекта появятся базисные   
точки. 
3   Оцифруйте дополнительные контуры для объек-
та. Нажимайте Enter после каждого контура. 

4   Нажмите Enter.

Примечание
Чтобы удалить границы закрытого объекта, нажмите 
Remove Holes.

Заполнение отверстий в объектах

Инструмент Fill Holes заполняет отверстия в оди-
ночных замкнутых объектах или прямоугольниках, 
содержащих отверстия. Они могут быть полностью 
удалены или заполнены новыми объектами. 

Примечание:
Можно одновременно выбрать несколько резцов как 
часть единой операции вырезания.

В показанном примере заметьте, что:
•  Объект «небо» разделен на две части.
• Для «двери» и «дорожки» были удалены стежки 
дома и холма.
• Ствол дерева и небо, подстилающее листья, 
оставлены, поскольку под объектами узорного за-
полнения (Pattern Fill) подстилающие стежки не вы-
резаются
• Участок неба, перекрываемый оранжевой луной, 
остается без изменений, поскольку луна не была вы-
брана в начале операции. 

Добавление и удаление отверстий

BERNINA Embroidery Software позволяет вырезать от-
верстия в выбранных объектах замкнутой кривой с 
единообразным углом наклона стежков, используя 
инструмент Add Holes (Добавить отверстия).. При-
менимо только к объектам, созданным инструмен-
том Closed Object. Аналогичный инструмент Remove 
Holes позволяет удалять отверстия в закрытых объ-
ектах.
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Используйте инструмент Add Holes (панель Edit) для 
вырезания отверстий в объектах. 

Use Edit > Remove Holes – удаление отверстии в 
объектах.

Используйте инструмент Fill Holes (панель Edit) для 
заполнения отверстий в одиночных объектах.



Создание контуров и границ

Функция Outline Design позволяет быстро созда-
вать контуры отдельных объектов или всего рисун-
ка с помощью  одинарных, тройных или гладьевых 
линий. См. также раздел Автоматическое создание 
контуров и границ.

Для заполнения отверстий в объектах:
1   Выберите исходный объект

2   Щелкните по значку Fill Holes. 
Откроется диалоговое окно Fill Holes.

3   Выберите величину Underlap (Недокрытие).

• Для точного перекрытия отверстий примите стан-
дартное значение 0.00.
• Для перекрытия с нахлестом отверстий и ориги-
нального объекта выберите положительное смеще-
ние, например 1.00. Перекрытие с нахлестом позво-
ляет избежать пробелов.
• Для перекрытия с пробелом отверстий и ориги-
нального объекта выберите отрицательное смеще-
ние, например -1,00. 

4   Нажмите OK. 
Все вновь создаваемые объекты заполняются с те-
кущими настройками заполняющих стежков, углом 
наклона стежков и цвета нитки.  Каждый новый объ-
ект является независимым объектом и размещается 
непосредственно перед исходным объектом в по-
следовательности вышивания.
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Для вышивки контуров объектов  одинарными, 
тройными или гладьевыми линиями, используется 
функция  Edit > Outline Design. Выберите 

величину 

Недокрытие: -1.00



Создание пуговичных петель 
BERNINA Embroidery Software позволит вам встав-
лять заданные заранее пуговичные петли, назна-
чать размеры петель и соединять петлю с проектом. 
Пуговичные петли выполняются обычно стежками 
гладьевого валика, обрамляющего прорезь, длина 
которой примерно соответствует диаметру пугови-
цы. Стежки гладьевого валика защищают прорезь от 
осыпания. Пуговичная петля состоит из двух гладье-
вых валиков с закрепками на концах. 

Добавление пуговичных петель

Добавьте пуговичные петли к проекту.

Для создания контуров и границ

1   Выберите объект(ы) или весь рисунок. 

2  Нажмите кнопку Outline Design. Откроется диа-
логовое окно функции Outline Design.

3   Настройте параметры в соответствии с требова-
ниями:

Поле Описание

Offset (отступ)
Устанавливает отступ контура в мм. 
Значение отступа может быть и от-
рицательным.

Outline (Число кон-
туров)

Можно указать число линий контура – 
до 99 – для создания художественного 
эффекта.

Outline holes (Контур 
отверстия)

Эта функция позволяет включать или 
исключать “отверстия” из обработки.

Outline type (Тип 
контура)

Можно выбрать тип линии контура: 
Одинарная, тройная, гладьевая

4   Чтобы применить выбранные настройки, нажмите OK. 
Контуры рисунка будут вышиты нитками текущего 
цвета с текущими настройками. Контур будет вышит 
в последнюю очередь, если для обработки выбран 
весь рисунок. В случае, если выбранная часть ри-
сунка отделена от остальной его части “пробелом”, 
контур вышивается после выбранной части.

BERNINA® Embroidery Software: Руководство по работе с программами 170

Глава 21. СПЕЦИАЛьНАЯ ТЕхНИКА ОЦИФРОВыВАНИЯ

Установить 
количество 
контуров

Бортик 

Закрепка
верхняя

Пуговичное 
отверстие

Закрепка
нижняя

Digitize > Buttonhole – оцифровка пуговичной петли. 



Как добавлять пуговичные петли 
1  Откройте или создайте петлю, требуемую для ва-
шего проекта
2  Выберите команду Buttonhole. Текущий контур 
петли появляется в привязке с указателем мыши.

3   Щелкните в том месте, куда вы хотите поместить петлю.
4  Повторяйте эту операцию, если нужно добавить 
несколько петель.
5   Нажмите Esc для завершения.
Рекомендуется удалять зону вышивания, которая 
подстилает объект петли. Подробнее см. в разделе 
Удаление подстилающих стежков.

Подсказка
Если петля помещена сверху другого объекта, не-
которые из расположенных ниже стежков могут рас-
пуститься после прорезания петли. Чтобы предот-
вратить это, находящийся под петлей объект может 
быть изменен по форме, так что оконтуривающая 
линия будет проходить вдоль прорези петли. Под-
робнее см. в разделе Изменение формы и правка 
объектов. 

Создание линии петель 

С помощью команды Add Buttonholes (добавить пет-
ли) можно добавить к вашему проекту цепочку рав-
номерно расположенных пуговичных петель.

Для создания линии петель

1  Откройте или создайте проект, требующий петель
2   Выберите инструмент Buttonholes (петля). Откро-
ется диалоговое окно Buttonholes Settings (Параме-
тры Бутоньерки).

3  Введите число петель, необходимых для вашего 
проекта, и нажмите OK.
4   Щелкните мышью в той точке проекта, где долж-
на  располагаться первая петля.
5  Протяните линию до точки, где должна распола-
гаться последняя петля.

6  Используйте окно измерительного указателя. Для 
завершения работы щелкните клавишей мыши.

Выбор типов петель

Выбирайте тип петли до или после оцифровывания. 
Если вы используете петли без выбора типа петли, то 
будет применена стандартная петля.
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 Digitize > Buttonholes – оцифровка ряда петель

Используйте функцию Object Properties (панель 
General) для изменения типа петли 

Подстилаю-
щие стежки 
удалены 

Введите 
необходи-
мое число 
петель

Подсказка

Протянуть 
линию 
петель



3   В поле Bead Stitch Spacing (Шаг стежка бока петли) 
введите новое значение.

4    Нажмите Apply.
 
Настройка ориентации петли 
Вы можете поворачивать объекты петли, как и лю-
бые другие вышивальные объекты, путем манипули-
рования контрольными точками на экране или через 
свойства объекта. Применим любой из перечислен-
ных ниже способов:
• Инструментом Select Object для вращения одной 
или нескольких петель.  Подробнее см. в разделе 
Вращение объектов.

• Инструментом Reshape Object для вращения оди-
ночных петель. Подробнее см. в разделе 
Изменение формы объектов.

• Инструментом Rotate 45° CCW/CW для вращения 
одной или нескольких петель.  Подробнее см. в раз-
деле Вращение объектов.
• Инструментами Mirror Vertical и Mirror Horizontal. 
Подробнее см. в разделе Перевод объектов в зер-
кальное отображение.
• Через диалоговое окно Object Properties для ин-
дивидуального вращения одной или нескольких пе-
тель. Подробнее см. в разделе Вращение объектов с 
использованием свойств объекта. 

Чтобы изменить тип петли:
1  Выберите Object Properties (Свойства объекта) и 
щелкните по закладке Buttonhole (Петля).

2    Выберите тип петли.
3    Нажмите Apply.

Подсказка
Дважды щелкните или щелкните правой кнопкой 
мышки по объекту, чтобы изменить тип петли только 
для этого объекта. 

Настройка длины и плотности петли 

Для изменения длины петли измените длину прорези. 
Используйте диалоговое окно Object Properties для ввода 
точной длины или используйте инструмент Reshape Object.

Подсказка
Вы можете также отрегулировать длину петли, используй-
те инструмент Reshape Object (Изменение формы объекта).
Увеличивайте или уменьшайте плотность гладье-
вых или краеобметочных стежков боков петли путем 
уменьшения или увеличения Bead Stitch Spacing (Шаг 
стежка бока петли).
 
Как настроить длину и плотность петли 
1   Выберите Object Properties (Свойства объекта) и 
щелкните по закладке Buttonhole (Петля). 

Подсказка
Дважды щелкните или щелкните правой кнопкой 
мышки по объекту, чтобы изменить характеристики 
стежка только для этого объекта.

2   В поле Slit Length (Длина прорези)  введите новую 
длину прорези.
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Используйте функцию Object Properties (панель 
General) для изменения типа петли 

Выберите 
кнопку типа 

петли

Шаг           0,3 мм                      0,4 мм                        1,0 мм
стежка

Введите 
характери-
стики петли 

Длина 
прорези

20 мм

Длина 
прорези
15 мм Длина 

прорези
10 мм

Повернуто 
несколько 
петель 

етля повернута 
с изменением 
размера 
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Глава 22
Эффекты художественного вышивания

BERNINA Embroidery Software предлагает большое количество 
художественных эффектов и типов стежков для создания тек-
стурированных и узорных форм заполнения объектов. 
Контурные стежки дают возможность шить в любом направле-
нии с фиксированным числом линий и переменными зазорами, 
в зависимости от очертаний объекта.
Орнаментное заполнение Fancy fill подобно заполнению про-
стегивающими стежками, но при этом стежки располагаются 
в виде регулярно повторяющихся узоров.  Заполнение пере-
крестными стежками (Сross fill) напоминает  орнаментное 
заполнение,  но оно формируется иначе и использует про-
стегивание под и вдоль перекрестных стежков. Используйте 
функцию Textured Edge (Текстурированный край) для получения шероховатых краев, созда-
ния теневых эффектов или имитации меха или других пушистых текстур в вашем проекте.
Эффект волнистости (Wave Effect) позволяет направлять строчки заполняющих стежков по 
оцифрованной направляющей линии. Стежки располагаются по линии, но сохраняют одно-
родную плотность и порядок проколов иглой материала. Заполнение звездочками (Star Fill) 
представляет из себя стежки, поворачиваемые в радиальном направлении, что можно реали-
зовать при разных типах стежков, таких, как гладьевые стежки и стежки типа татами. 
Функция Gradient Fill (Заполнение с плавным тоновым переходом) изменяет плотность рядов 
строчек заполнения от весьма плотного до весьма редкого, создавая теневые эффекты, ко-
торые трудно было бы получить вручную. Используйте эффект Travel on Edges (Перемещение 
по краям), чтобы подстилающие стежки сместились к краям объекта и не были заметны через 
открытую часть вышивки. Эффект Color Blending (Смешивание цветов) создает различные те-
невые, перспективные и трехмерные эффекты путем смешивания двух цветных слоев в од-
ном объекте вышивки. Заполнение звездочками (Star Fill) представляет из себя стежки, пово-
рачиваемые в радиальном направлении, что можно реализовать при разных типах стежков, 
таких, как гладьевые стежки и стежки типа татами
В этом разделе описывается, как применять эти типы художественных стежков и эффекты к 
проектам вышивания и как настраивать эти функции для получения желаемых результатов. 

Создание контурного заполнения

Контурные стежки обеспечивают простегиавание 
вперед и назад с фиксированным числом линий, но 
с переменными промежутками междк ними, завися-
щими от контуров объекта.  Этот тип стежков можно 
применять только для блокировки оцифровываемых 
объектов, включая круглые (Circle objects). 
Замкнутые объекты, модифицированные с помощью 
инструмента добавления углов шитья стежков Add 
Stitch Angles, с контурными стежками использовать-
ся не могут. См. также раздел Создание спиральных 
заполнений.

Перед тем, как начать оцифровку, используйте 
функцию Contour Fill (панель Stitch), чтобы выбрать  
тип заполняющего стежка. 
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• Настройте длину стежка (Stitch Length), чтобы сде-
лать кривые швы более или менее резкими.

• Изменение отступов стежка для более плотной и 
более свободной строчкой.

5   С помощью кнопки Apply можно просмотреть, как 
будет выглядеть вышивка, а с помощью клавиши OK 
закончить работу.Выбранные настройки будут при-
менены к объекту.

Создание заполнения орнаментными 
стежками

Орнаментное заполнение Fancy Fill подобно запол-
нению простегивающими стежками, но при этом 
стежки располагаются в виде регулярно повторя-
ющихся узоров. Эффект Fancy Fill используется для 
художественного заполнения широких и крупных 
зон с сохранением внешнего вида сплошного за-
полнения. Вы можете выбрать узор или изменить 
компоновку как до, так и после оцифровки. См. 
также раздел Применение узоров простегивающих 
стежков.

Контурные стежки можно выбрать из меню панели 
стежков и цветов ниток (Stitch and Color Bar), а также 
на закладке свойств объекта заполнения стежками 
(Fill Stitch object properties tab). 

Для создания контурного заполнения
1  Нажмите Contour Fill. Тип шва будет применен к 
новым или выбранным объектам. 
2  Создайте объект оцифровки и выберите его См. 
также Методы оцифровки. К объекту будут приме-
нены текущие установки функции контурных стеж-
ков Contour.

Примечание
Угол направления стежка на вид образца не влияет.
 
3  Для изменения параметров, щелкните по объ-
екту дважды, либо воспользуйтесь правой клави-
шей мыши. Откроется диалог Object Properties > Fill 
Stitch.

4  Настройте параметры контурных стежков как 
надо (Stitch Values):

Используйте функцию Fancy Fill (панель Stitch and 
Color) для выбора типа заполняющего стежка до 
или после оцифровки

Регулировка 
настроек 
контура 

Длина стежка больше    Длина стежка меньше

         Плотность больше                   Плотность меньше
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Откроется закладка Fill Stitch (Заполняющий стежок) 
диалогового окна Object Properties (Свойства объекта).

4   Выберите из выпадающего списка узор. См. также 
раздел Образцы заполнения орнаментными стежками. 
Выбранный узор показывается в панели просмотра.

5   Измените компоновки узора изменением настроек 
в диалоговом окне или на экране через кнопку Layout. 
По умолчанию, выбирается функция Grid.
•  Техника настройки компоновки узоров та же, что и 
для орнаментного заполнения. Подробнее см. в раз-
деле Компоновка узорного заполнения на экране. 
• Для поворачивающихся образцов используйте функ-
цию Sculpture. См. также раздел Создание рельефных  
заполнений.

6  Щелкните по Apply (Применить) или OK. Швы об-
новятся. 

Подсказка
Эффект волнистости (Wave Effect) позволяет направ-
лять строчки заполняющих стежков по оцифрован-
ной направляющей линии. Эффект волнистости может 
быть применим к объектам Fancy Fill.

Подсказка:
Вы можете также создавать художественные эффек-
ты, используя «рукодельные» стежки и узоры. См. 
разделы Создание заполнения рукодельными стеж-
ками и Создание узорного заполнения. 
 

Подсказка:
Функция Carving Stamp позволяет выбрать степент 
проникновения иглы с помощью шаблона ‘carving 
stamp’. См. раздел Функция “резной штамп”.

 Как создать заполнение орнаментным стежком

1   Щелкните по значку Fill и выберите из выпадаю-
щего меню Fancy.
2  Создайте и выделите замкнутый объект/ы – 
окружность или квадрат. Подробнее см. в разделе 
Методы оцифровывания. Для выделенного объекта 
будут применены текущие настройки Fancy Fill. 

Примечание:
Угол наклона стежка не влияет на расположение 
узоров.
 
3   Для изменения настроек дважды щелкните левой 
кнопкой или щелкните правой кнопкой по объекту/
ам.  

Нажмите, чтобы 
выбрать шаблон

Предвари-
тельный
просмотр

Выберите 
вариант 
макета

     Сеточная компоновка           Скульптурная компоногвка 



Текущие настройки вышивки крестом применяются к 
выбранному объекту.

Примечание:
Угол направления стежка на вид образца не влияет.

3 Для изменения настроек – щелкните на объект 
дважды на объект или правой клавишей мышиt.
Откроется диалог Object Properties > Fill Stitch.

4  Настройте параметры как считаете нужным:

Поле Описание

Fabric Count
Управляет расстояниями между кре-
стиками по размеру куска ткани или 
по реальным размерам.

Нитки
Сколько раз – 2, 4 или 6 – нитка про-
ходит один и тот же крест, чтобы 
сделать его более рельефным.

Стиль стежка Полный крест (X), диагональный или 
прямой (+).

Направление

Определяет, каким образом направ-
лено верхнее перекрестье крестика 
– т.е. полный стежок – вперед или 
назад для полных диагональных 
стежков, а также для  вертикалей и 
горизонталей прямых стежков.
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Однако вам потребуется вначале применить этот 
эффект к заполнению простегивающим стежком, а 
потом преобразовать в Fancy Fill. См. также Созда-
ние эффекта волнистости.

Создание заполнений перекрестными 
стежками

Заполнение перекрестными стежками (Cross Stitch 
fill) это особый тип заполняющих стежков, кото-
рый не заменяет приложение  BERNINA Cross Stitch, 
имеющееся на панели инструментов оцифровки 
Digitize. Эта функция несколько напоминает запол-
нение по образцам Pattern Fill, но она по друолму 
формируется и  использует прошивку под и вдоль 
перекрестных стежков.  Крестики могут быть гори-
зонтальными, чтобы соответствовать стандартной 
полной форме всей вышивки. См. также раздел Соз-
дание узорного заполнения.

Подсказка
Cross Stitch  – самостоятельный тип шва, но он не за-
меняет приложение BERNINA Cross Stitch на панели 
«Основное». См. Введение в вышивку крестом. 

Как создать заполнение перекрестными стеж-
ками 
1 Нажмите на кнопку Fill и выберите функцию Cross 
Stitch из выпадающего меню. 
2  Создайте замкнутый объект (прямоугольник или 
круг) и выберите его. Подробнее см. раздел  Методы 
оцифровки. 

Использовано 
заполнение 

простегиваю-
щим стежком

Применен 
эффект вол-

нистости
Выбрано 
узорное 

заполнение

Используйте функцию Cross Stitch Fill (панель Stitch) 
для выбора типа заполняющего стежка до или по-
сле оцифровки

Настройки 
стежков



Текущие настройки применяются к выбранному 
объекту.

3   Для изменения настроек щелкните правой кноп-
кой по значку Textured Edge при выделенном объ-
екте.  Откроется закладка Effects > Textured Edge.

4   Выберите сторону объекта, к которой вы хотите 
применить этот эффект.

5  Используйте ползунок поля Texture для установки 
степени рыхлости. Перемещайте ползунок для вы-
бора требуемой текстуры, влево для рыхлой тексту-
ры, когда  длина стежков в большей мере произ-
вольна, и вправо для гладкой текстуры. 

6   Используйте ползунок поля Span (Диапазон) для 
выбора диапазона отклонения стежков от контура.  
Перемещайте движок влево для уменьшения этого 
диапазона и вправо для его увеличения.
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5 Нажмите Apply, чтобы просмотреть полученный 
эффект, или нажмите OK, чтобы закончить работу.

Подсказка
Сетка перекрестных стежков не отображается на 
экране, но вы можете подстроить формат фоновой 
сетки под размер клеток, чтобы получить более на-
глядное представление, как используется сетка для 
создания вышивки. Используйте функцию Snap to 
Grid,  чтобы контуры объекта соответствовали сетке 
перекрестных стежков.  См. раздел Настройка оп-
ций сетки. 

Создание текстурированных краев

Используйте функцию 
Textured Edge (Текстуриро-
ванный край) для создания 
теневых эффектов или для 
имитации меха или других 
пушистых структур в ва-
шем проекте. Эффект тек-
стурированного края при-
меняется с использованием 
текущих настроек функции 
Textured Edge в диалоговом окне Effects (Эффекты). 
Отрегулируйте настройки для изменения степени 
шероховатости, стороны объекта, к которому бу-
дет применен эффект и предела текстурированного 
края. Изменяйте эти настройки до или после при-
менения эффекта. 
 
Как создать эффект текстурированного края
1  Щелкните по значку Textured Edge (Текстуриро-
ванный край). Эффект будет применен к новым или 
выбранным объектам на основе текущих настроек 
функции Textured Edge. 
2  Создайте и выделите замкнутый объект/ы – окруж-
ность или квадрат. Подробнее см. в разделе Методы 
оцифровывания. 

Используйте инструмент Textured Edge (панель 
Stitch) для создания текстурированных краев или 
имитации пушистых структур.

Стиль стежка : Upright 
Cross (Вертикальный 

крест)

   Левый край                     Оба края            Правый край 
текстурирован              текстурирован               текстурирован

Стиль стежка : Upright 
Cross (Полный крест)

Выберите 
настройки 

Настройте 
значения 

Больше вариаций длины  
стежков дает более 
рыхлую  текстуру 

Меньше вариаций дли-
ны стежков дает более 

гладкую текстуру



Эффект применяется к выбранному объекту.

2  Настройте эффекты, выберите объекты и нажмите 
Reshape Object.

3   Нажмите и тяните до получения нужной формы и 
нажмите Enter. См. Изменение формы объекта.

4   Нажмите Esc.

Подсказка
Не забывайте, что эффект волнистости можно при-
менять к объектам совместно с Fancy Fill, Pattern Fill 
и некоторыми из рукодельных типов стежков. См. 
также разделы Создание заполнения орнаментным 
стежком, Создание узорных заполнений и Создание 
заполнения рукодельными стежками.

Подсказка
После применения волнистого эффекта Wave Effect 
не меняйте углов стежков, поскольку это может при-
вести к смещению образцов заполнения Fancy Fill.

Создание эффекта Star Fill (заполнение 
звездочками)
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7  Нажмите кнопку Apply- или OK-завершить. Стеж-
ки будут регенерированы с измененными настрой-
ками. 
 

Подсказка
Чтобы лучше рассмотреть эффект Textured Edge , 
нажмите клавишу    для отображения точек укола 
или используйте режим  Artistic View.

Создание эффекта волнистости

Эффект волнистости (Wave Effect) позволяет на-
правлять строчки заполняющих стежков по оциф-
рованной направляющей линии. Стежки следуют по 
линии, но сохраняют однородную плотность и по-
рядок проколов иглой материала.

Подсказка
Используйте малую длину стежка, например, 4 мм 
или меньше.

Как создать эффект волнистости

1 Выберите закрытый объект и нажмите Wave Fill.

Нажмите Stitch > Wave Fill

Нажмите Transform > Reshape Object – просмотр 
контрольных точек.

Stitch > Star Fill - распределенные по радиусам 
стежки. Стежки направлены от контура к центру. 
Положение центра может быть изменено.

Нажмите Transform > Reshape Object – просмотр 
контрольных точек. 

Короткий
диапазон

Длинный
диапазон

Применение эффекта 
волнистости (Wave)



Для создания эффекта заполнения звездочками:
1  Выберите закрытый объект и нажмите Star Fill.
Эффект применяется к выбранному объекту.

2   Измените эффекты и нажмите Reshape Object. В 
режиме Reshape можно: 
•  Смещать центр, к которому направлены радиаль-
ные стежки.
•  Указать размер центрального отверстия.
•  Изменить форму центрального отверстия для объ-
ектов круговой/эллиптической формы. 

Подсказка:
В отличие от стежков типа Ripple, центр эффекта за-
полнения звездочками Star Fill можно вынести за 
пределы объекта или  поместить его в имеющемся 
отверстии. Это не изменит формы объекта, но даст 
своеобразный эффект заполнения. 
5 Нажмите Enter, чтобы применить настройки, и Esc, 
чтобы закончить работу. 
 

Подсказка:
Эффект заполнения звездочками  Star Fill можно ис-
пользовать вместе с эффектами Satin Fill, Step Fill и 
Fancy Fill. См. раздел Создание заполнений орнамент-
ными стежками. 

Подсказка: 
Нельзя напрямую изменять углы стежков, автомати-
чески задаваемые функцией заполнения звездочками.
Star Fill. Тем не менее, можно применить к объекту 
функцию разделения Break Apart вместе с эффектом 
Star Fill и изменить углы поворота в получившемся 
объекте. См. также раздел Разбивка объектов на ком-
поненты.

Функция Star Fill (заполнение звездочками) создает рас-
пределенные по радиусам стежки, таких типов, как гла-
дьевые или татами. Стежки создаются в направлении от 
краев к центру.

Функцию Star Fill (заполнение звездочками) можно при-
менять к разным типам объектов – замкнутым, круговым 
и прямоугольным – с дополнительными отверстиями. 
Эффект при оцифровке можно включить или выключить.
Все трансформации, исключая эффекты преобразова-
ния, сохраняют радиальный стежки функции Star Fill, 
но формы отверстий могут измениться. Операции типа 
зеркального отражения Mirror Merge или удаления пе-
рехлестов Remove Overlaps эффект Star Fill сохраняют.
Советы по применению:
Для заполнения звездочками подходят не все образ-
цы, объекты (в зависимости от размера) и варианты 
стежков. В частности, если применять этот эффект к 
объектам большего размера, используйте один или 
несколько из предлагаемых ниже приемов, чтобы 
избежать скопления ниток в центре: 
•Увеличьте размер отверстия, сместите центр в пределы 
имеющегося отверстия в объекте или переместите его за 
пределы объекта.
•Добавьте эффект Textured Edge во внутреннюю часть.
•Используйте увеличенные пробелы между стежками – 
увеличьте их примерно на 20%.
•Избегайте использовать образцы, предполагающие про-
никновение ткани иглой близко к центру объекта.
•Используйте эффект Edge Walk с объектами меньшего 
размера, чтобы сократить число стежков в центре объекта.
•Используйте острую иглу – то есть такую, у которой нет 
скругленного конца и которую обычно используют  для 
шерстяных вязаных изделий. 
Функцию Star Fill (заполнение звездочками) можно 
применять к разным типам объектов – замкнутым, 
круговым и прямоугольным – с дополнительными 
отверстиями. Эффект при оцифровке можно вклю-
чить или выключить. 
Все трансформации, исключая эффекты преобразо-
вания, сохраняют радиальный стежки функции Star 
Fill, но формы отверстий могут измениться. Опера-
ции типа зеркального отражения Mirror Merge или 
удаления перехлестов Remove Overlaps эффект Star 
Fill сохраняют. 
 

Подсказка: Используйте эффект Star Fill с кольце-
выми объектами. Ширина кольца должна составлять 
примерно 20% от внешнего диаметра.

Star Fill вместе с Satin Fill           Star Fill вместе с Fancy Fill
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6   Нажмите кнопку Apply для предварительного 
просмотра эффекта или на OK.

Подсказка
Чтобы стабилизирующие стежки не проступали че-
рез стежки заполнения, уберите флажок из окошка 
Underlay. См. также Стабилизация ткани стабилизи-
рующими стежками.. См. Создание открытых запол-
нений. 

Создание открытых заполнений 

Используйте эффект Travel on Edges (Перемещение 
по краям), чтобы подстилающие стежки сместились 
к краям объекта и не были заметны через открытую 
часть вышивки. Этот прием часто используется для 
фона.

Подсказка
Используйте эту функцию совместно с эффектом За-
полнения с плавным тоновым переходом или Сме-
шивание цветов. чтобы избежать выполнения со-
единительных стежков внутри объекта. См. также 
разделы Создание заполнения с плавным тоновым 
переходом и Создание эффекта смешивания цветов.

Как создать открытое заполнение 
1   Дважды щелкните левой кнопкой или один раз 
правой кнопкой по заполняемому объекту. 
Откроется закладка Fill Stitch (Заполняющий стежок) 
диалогового окна Object Properties (Свойства объек-
та). 

Создание заполнения с плавным тоно-
вым переходом 
Функция Gradient Fill (Запол-
нение с плавным тоновым 
переходом) изменяет плот-
ность рядов строчек запол-
нения от весьма плотного 
до весьма редкого, создавая 
теневые и цветовые эффекты, 
которые трудно было бы по-
лучить вручную. В вашем рас-
поряжении несколько типов 
эффекта Gradient Fill.  Если вы 
используете эффект Gradient Fill, текущие настройки 
интервала между строчками игнорируются. Однако 
другие эффекты вышивания сохраняются. 
 
 
Подсказка
Вы можете использовать функции Step и Gradient Fill 
with для создания интересных теневых эффектов. 

Как создавать заполнение с плавным тоновым 
переходом 
1  Выберите объект и дважды щелкните по нему. От-
кроется закладка Fill Stitch (Заполняющий стежок) ди-
алогового окна Object Properties (Свойства объекта). 
2   Нажмите кнопку Effects (Эффекты) и выберите за-
кладку > Gradient Fill. 

3   Проставьте флажок в окошке Gradient Fill и вы-
берите тип (Profile). 
4   Нажмите на Apply для предварительного просмо-
тра эффекта. 

5   Передвигайте ползунок, чтобы отрегулировать 
значение, или введите новую величину.

макс. шаг: 1 мм                    миним. шаг: 3 мм

Выберите
Gradient Fill

Выберите 
профиль
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Установите 
значение 

шага стежков



Применение эффекта смешивания цветов

Используйте функцию Color Blending для смешения 
цветов, создания эффектов перспективы и тени.

Для смешивания цветов
1  Выделите заполненный объект. Щелкните по значку 
Color Blending (Смешивание цветов). Откроется диа-
логовое окно Color Blending.

2  Выберите профиль нижнего и верхнего слоев, а 
также первый и второй цвета.

3  В нижнем слое (Bottom Layer) панели:
•  Выберите цвет первого слоя;
•  Введите, если требуется, новые макс. значения шага 
стежка для первого слоя.

2   Нажмите кнопку Effects (Эффекты) и выберите за-
кладку > Others.

3  Проставьте флажок в окошке Travel on Edges (Пе-
ремещение по краям). 
Перемещения и перекрывающиеся ряды будут уда-
лены.  Будут достигнуты стабильные зазоры между 
рядами.

4  Нажмите кнопку Apply для предварительного про-
сморта эффекта или на ОК для выхода.  Эффект Travel 
on Edges будет применен к  выбранному объекту.  
 

Подсказка
Щелкните по Save To Template (Сохранить в шабло-
не) перед закрытием диалогового окна, чтобы со-
хранить настройки. Сохраненные настройки будут 
применены ко всем новым проектам, основанным на 
текущем шаблоне. Подробнее см. в разделе Свой-
ства объекта и шаблоны.

Создание эффекта смешивания цветов 

Эффект Color Blending (Смешивание цветов) авто-
матически создает различные теневые, перспектив-
ные и трехмерные эффекты путем смешивания двух 
цветных слоев в одном объекте вышивки. Этот эф-
фект создается путем дублирования объекта, затем 
применения функций Gradient Fill и Travel on Edges к 
обоим слоям, которые потом объединяются в группу.

Имеются два разных эффекта смешивания цветов: 
•  линейное разреживание стежков;
•  искривленное разреживание стежков.

Эффект смешения цветов может быть применен к 
объектам, заполненным гладьевыми, простегиваю-
щими или орнаментными стежками, или к объектам, 
оконтуренным гладьевыми или обметочными стеж-
ками.

Нижний слой: Profile 1 
Верхний слой: Profile 1

Нижний слой: Profile 3
Верхний слой: Profile 3
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Выберите 
Travel on 

Edges 

Min шаг 
стежка

Выберите 
профиль

Max шаг 
стежка

Щелкните по значку Color Blending (панель Edit) 
для применения этого эффекта к новым или вы-
бранным объектам. 

Выберите 
первый 

цвет

Выберите 
второй 

цвет



4  В верхнем слое (Top Layer) панели:
•   Выберите цвет второго слоя;
• Введите, если требуется, новые макс. значения 
шага стежка для второго слоя.
5   Нажмите ОК.

Подсказка:
Чтобы стабилизирующие стежки не проступали че-
рез стежки заполнения, уберите флажок из окошка 
Underlay. См. также Cтабилизация ткани стабилизи-
рующими стежками.

Редактирование объектов со смешива-
нием цветов

Редактирование объекта со смешиванием цветов. 
Два объекта должны быть вначале разгруппированы, 
и отдельные объекты редактируются в соответствии 
с настройками функции Gradient Fill. Подробнее см. 
в разделе Настройка шага стежков плавного тоно-
вого перехода.

Примечание: Если вы редактируете сгруппирован-
ный объект, эффект смешивания цветов будет потерян, 
поскольку оба слоя имеют одни и те же настройки.

Как редактировать объекты со смешиванием 
цветов
1  Выберите объект со смешиванием цветов и раз-
группируйте его. Подробнее см. в разделе Группи-
ровка и разгруппировка объектов.

Подсказка
Используйте функцию Color Film для просмотра 
цветных блоков и объектов проекта. Подробнее см. 
в разделе Просмотр и выделение цветных блоков.

2    Выберите один из объектов и измените цвет, если 
требуется.
3   Дважды щелкните, чтобы открыть диалоговое 
окно Object Properties (Свойства объекта), выберите 
закладку Effects > Gradient Fill.

4   Выберите профиль.  Настройте шаг стежков. Под-
робнее см. в разделе Создание эффекта смешивания 
цветов.
5 Нажмите кнопку Apply для предварительного про-
смотра или на ОК для выхода. 
6  Повторите эти операции для второго объекта и 
разгруппируйте объекты.

Создание эффектов плавного преоб-
разования (морфинг)

Функция плавного преобразования Morphing позво-
ляет разнообразно и по новому трансформировать 
как форму объекта, так и его стежки. Эти преобразо-
вания можно использовать аддитивно – то есть, при-
менять разные эффекты к одному объекту.

Morphing является мощным средством, но не пере-
усердствуйте. Имейте в виду следующие моменты, 
когда используете функцию морфинг объектов/ 
проектов:
•  Чтобы избежать плохого качества вышивки, не 
используйте слишком больших значений Morphing. 
Меньше значит больше, когда дело доходит до 
морфинга.
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Щелкните по значку Ungroup (панель Arrange), чтобы 
разгруппировать выделенные объекты.

Щелкните по кнопке Color Film (панель General), чтобы 
просмотреть все цветные блоки и  объекты в проекте.

Для создания наброска преобразуемого объекта и его 
стежков используется пункт меню General > Morphing. 

Нижний слой: красный
Верхний слой: желтый

Нижний слой: желтый
Верхний слой: красный

Выберите 
Gradient 

Fill 

Настройте 
 шаг стежков



•  Используйте больший разброс стежка - до 20%. 
•  Избегайте пересекания гладьевых стежков. 
•  Увеличьте площадь подкладки.

Чтобы создать эффект плавного преобразова-
ния:
1  Выберите один или несколько объектов.
Эффект плавного преобразования можно применить 
к любым объектам. 

2   Нажмите кнопку Morphing на главной панели ин-
струментов General. Отобразится панель Morphing 
Effect с кнопками выбора эффектов преобразования.

3  Выберите желаемый эффект:

Pinch  - сжимает контуры объекта и стежки 
ближе к  центру преобразования. Внешние 
стежки при этом расталкиваются.

Punch - расширяет контуры объекта и стеж-
ки от центра преобразования. Контуры и 
стежки растягиваются в сторону вообража-
емой сферы.

Ripple – создает волнистые контуры, исхо-
дящие из центра преобразования как круги 
на воде от брошенного камня.

Twirl - искривляет контуры объекта и стеж-
ки вокруг центра преобразования, создавая 
эффект вихря на поверхности воды.

Skew Horizontal – наклоняет контуры объек-
та и стежки горизонтально (влево – вправо)

Skew Vertical – наклоняет контуры объекта и 
стежки вертикально (вверх – вниз)

Wave Horizontal – сдвигает контуры и стежки 
объекта по образцу горизонтальной волны

Wave Vertical – сдвигает контуры и стежки 
объекта по образцу вертикальной волны.

Выбранный эффект преобразования применяется 
к выбранным объектам. Центр преобразования по 
умолчанию помещается в центр выбранного объекта 
или группы объектов.

Программа BERNINA Embroidery Software выполняет 
также следующие действия:

•  Группирует выбранные объекты, если они ранее 
не были сгруппированы.
•  Выполняет преобразование для всей группы как 
целого,  используя выбранный по умолчанию центр 
преобразований и текущие параметры.
•  Для получившихся объектов автоматически запу-
скает инструмент редактирования Reshape Object.
•  Отображает графически управляющие точки для 
используемого преобразования.

4  Нажав кнопку Undo можно отменить выбранное 
преобразование. С помощью управляющих точек, 
которые можно “перетаскивать” мышью, можно из-
менить форму преобразования.
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Pinch Punch
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Skew
Horizontal Skew Vertical

Wave
Horizontal Wave Vertical



5   Если есть такая опция, можно переместить центр 
объекта с помощью инструмента  Reshape Object. 
(Не для всех видов преобразований такая возмож-
ность имеется).
На панели эффектов преобразований имеется кноп-
ка Center Morphing , которая активируется при пере-
мещении центра преобразования. Нажав эту кнопку 
можно вернуть центр преобразования в исходное 
положение.

6    Вы можете применить к одному объекту несколь-
ко разных преобразований.

7   Если нужно, можно отменить тот или иной эф-
фект преобразования следующим образом:
•  Если к выбранному объекту применено одно или 
несколько преобразований, активируется кнопка 
Remove. Нажатие этой кнопки отменяет последнее 
примененное преобразование. Предшествующее 
преобразование (если было) после этого тоже мож-
но отменить или изменить.

Нажатие кнопки Remove All отменяет все преоб-
разования, примененные к выбранному объекту, и 
останавливает процесс редактирования преобразо-
ваний. См. раздел Изменение формы объектов с ис-
пользованием контрольных точек.
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Центр 
перемещается 
влево
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Глава 23
Узорные штампы, оконтуривание и заполнение узорами

Узоры – это предварительно определенные элемен-
ты дизайна, такие как сердечки, листья или узоры 
бордюра, которые могут быть быстро вставлены в 
проект. Они обычно состоят из одного или несколь-
ких простых объектов и сохраняются в специальном 
комплекте узоров.
Вы можете создавать собственные узоры или ис-
пользовать узоры, входящие в программное обеспе-
чение. Узоры можно масштабировать, поворачивать 
и переводить в зеркальное отображение таким же 
образом, как и другие объекты. Вы можете исполь-
зовать узоры, расположенные вдоль оцифрованной 
линии. Можно также заполнять формы рядами по-
вторяющихся узоров и применять специальные эф-
фекты.

Вы можете также создавать образцы последовательностей хода иглы, используя в ка-
честве шаблона “резной штамп”.   В качестве “резного штампа”  можно использовать 
любой векторный рисунок и/или образец вышивки.

В этом разделе описывается, как вставлять узоры в проект и как подгонять их настрой-
ки, чтобы получать наилучшие результаты. Также объясняется, как создавать собствен-
ные узоры и комплекты узоров, а также то, как создавать образцы стежков с резными 
штампами.

Как добавить узорный штамп
1   Выберите Digitize > Pattern Stamp. Откроется ди-
алоговое окно Select Pattern (Выбор узора).

Подсказка
Выберите режим просмотра - вы сможете выбирать 
узоры по картинке, имени или по обоим признакам.

Добавление узорных штампов

Функция Pattern Stamp позволяет размещать про-
стые узоры в любом месте окна проектов.
Вы можете получить доступ к любому узору.
В том числе к специальным узорам для узорного за-
полнения, а также узорам из рукодельных стежков и 
из орнамента монограмм.

Выберите Pattern Stamp (меню Digitize), чтобы разме-
стить простые узоры в проекте.

Выберите 
комплект 

узоров

Выберите  
узор

Выберите режим просмотра



Создание цепочки узоров для контуров

Цепочка узоров - Pattern Run – это тип стежков, ко-
торые создают повторяющиеся узоры вдоль оциф-
рованной линии. Вы можете создавать декоратив-
ные контуры, используя любой узор из списка. Вы 
можете изменять угол поворота, ориентацию и раз-
меры, а также интервал между узорами.

Создание цепочки узоров

Выбирайте цепочку узоров до или после оцифровы-
вания.

Как применять цепочку узоров
1   Щелкните на символ Outline в панели  Stitch and 
Color  и затем выберите Pattern Run из списка Stitch 
Type (Тип стежка).

2   Выберите комплект узоров из выпадающего спи-
ска и выберите узор из панели просмотра. Он станет 
текущим узором. См. также раздел Примеры узор-
ного штампа, оконтуривания и заполнения.
3   Щелкните по OK. Диалоговое окно закроется, 
узор появится в привязке к указателю мыши. 
4   Перемещайте указатель мыши в требуемое по-
ложение и щелкните для отметки направляющей 
точки. Эта точка становится анкером – центром вра-
щения. Вам будет предложено назначить вторую на-
правляющую точку.
5   Перемещайте указатель мыши, пока узор не бу-
дет правильно ориентирован, и затем еще раз щел-
кните по направляющей точке.

Подсказка:
Вы можете изменить размеры узора на экране, удер-
живая клавишу Shift перед тем, как наметить вторую 
направляющую точку.
6   Нажмите клавишу Enter. Стежки будут сгенери-
рованы. 
7   Повторите эту операцию, чтобы вставить
другой узор. Вы можете вращать узоры и изменять 
их размеры после вставки.

Подсказка: 
Щелчок правой кнопкой мыши позволяет зеркально 
перевернуть узор. 

8   Нажмите Esc для завершения.
 

Примечание:
Каждый узор обрабатывается как одиночный сгруп-
пированный объект. Для правки отдельного фраг-
мента узора следует его разгруппировать. Подроб-
нее см. в разделе Группировка и разгруппировка 
объектов.
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Stitch > Pattern Run Outline - для оцифровки контура 
узорными стежками. 



Смотрите также Reshaping pattern runs (Изменение 
цепочки узора).

Примечание: Если цепочка узоров не соответству-
ет цвету, который вы выбрали в палитре цветов при 
первом оцифровывании, выберите контур после 
оцифровывания, затем выберите цвет.

Настройка размера узоров и интервала 
между узорами
Вы можете вставить цепочку узоров оригинального 
размера и ориентации и после этого изменить ин-
тервалы между узорами. Вы можете также установить 
точный размер и величину интервала до вставки це-
почки узоров. Подробнее см. в разделе Применение 
цепочек узоров.

Если цепочка узоров не точно соответствует базовой 
линии, ПО BERNINA проведет требуемые изменения 
интервала:
•  Если интервал, остающийся в конце базовой ли-
нии, меньше половины длины узора, то этот остаток 
равномерно распределяется между узорами. 
•  Если интервал больше половины длины узора, то 
ПО BERNINA вставит дополнительный узор с неболь-
шим взаимным перекрытием для равномерного рас-
пределения по базовой линии.

Подсказка: Вы можете изменить форму базовой 
линии, чтобы получить требуемый вам точный ин-
тервал. Подробнее см. в разделе Изменение формы 
цепочки узоров.

Как настроить размер узоров и интервал между 
узорами
1   Выберите цепочку узоров.
2  Щелкните дважды по объекту. Откроется диа-
логовое окно Object Properties (Свойства объекта) – 
Outline Stitch

2 Последовательно оцифруйте контур цепочкой 
узоров. Подробнее см. в разделе Методы оцифро-
вывания и Изменение формы цепочки узоров.

3    Для изменения настроек дважды щелкните левой 
кнопкой или щелкните правой кнопкой по объекту. 
Откроется закладка Outline Stitch (Оконтуривающий 
стежок) диалогового окна Object Properties (Свой-
ства объекта).

4  Если предварительно не было выбрано, выбе-
рите Pattern Run из списка Stitch Type и щелкните 
по Select. Откроется диалоговое окно Select Pattern 
(Выбор узора), в котором показываются все имею-
щиеся узоры в данном комплекте.

Подсказка
Выберите режим просмотра. Вы можете выбирать 
узоры по картинке, имени или по обоим признакам.
5  Выберите комплект узоров из списка Pattern и 
выберите узор. Подробнее см. в разделе Узорные 
штампы, контуры и заполнения.  
6   Щелкните по кнопке OK. 

7   Выберите настройки цепочки узоров. Подробнее 
см. в разделе Выбор настроек цепочки узоров.
8   Щелкните по Apply (Применить)
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Выберите режим просмотра

Выберите  
узор



Примечание:
Вы можете также создавать художественные эф-
фекты, используя заполнение «рукодельными» и 
орнаментными стежками. См. разделы Создание 
заполнения рукодельными стежками и Создание за-
полнения орнаментным стежком. 

Добавление узорного заполнения

Применяйте функцию Pattern Fill к объектам для соз-
дания декоративного заполнения с использованием 
текущих настроек узорного заполнения. Вы можете 
выбрать узор или изменить компоновку и настройки 
как до, так и после оцифровывания.

Как добавить узорное заполнение
1  Нажмите Pattern Fill. Применить к новым или вы-
бранным объектам. 
2  Создайте и выделите форму. Подробнее см. в 
разделе Методы оцифровывания.

Подсказка:
Если узорное заполнение не соответствует цвету, 
который вы выбрали в палитре цветов при первом 
оцифровывании, выберите контур после оцифровы-
вания, затем выберите цвет.
3   Для изменения настроек дважды щелкните левой 
кнопкой или щелкните правой кнопкой по объекту/ам. 
Откроется закладка Fill Stitch (Заполняющий стежок) 
диалогового окна Object Properties (Свойства объ-
екта).

Откроется диалог Object Properties > Outline Stitch.

3  В поле Size (Размер) введите размер цепочки 
узорв.

4   Если размер задан правильно, отрегулируйте ин-
тервал (Spacing).

5   Нажмите кнопку Apply.
 

Подсказка: Вы можете также изменить размеры це-
почки узоров, используя маркеры выделения. Под-
робнее см. в разделе Изменение размеров объектов. 

Создание узорного заполнения

Узорное заполнение Pattern Fill – это заполнение де-
коративными стежками, которое можно применять 
к объектам замкнутой кривой. Эта функция обеспе-
чивает заполнение формы параллельными рядами 
узоров. Вы можете компоновать узоры на экране 
или с использованием настроек в диалоговом окне 
Object Properties (Свойства объекта). 
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Stitch > Pattern Fill - для выбора типа заполняющего 
стежка до или после цифровки. 
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4   Если предварительно не было выбрано, выбери-
те Pattern Fill из списка Stitch Type и щелкните по 
Select.
Откроется диалоговое окно Select Pattern, в котором 
показываются все узоры с текущими настройками.

Подсказка: Выберите режим просмотра - вы смо-
жете выбирать узоры по картинке, имени или по 
обоим признакам.
5   Выберите комплект узоров из выпадающего спи-
ска и выберите узор из панели просмотра. См. также 
раздел Примеры узорного штампа, оконтуривания и 
заполнения.
6 Щелкните по ОК. Выбранный узор показывается в 
панели просмотра. 

7 Настройте компоновку узоров изменением настроек.

Примечание: Угол наклона стежка не влияет на 
расположение узоров.
8  Щелкните по Apply (Применить).
Оцифрованный объект будет заполнен текущим 
узорным заполнением.

Совет: Эффект волнистости (Wave Effect) позволяет 
направлять строчки заполняющих стежков по оциф-
рованной направляющей линии. Эффект волнисто-
сти может быть применим к объектам Pattern Fill.

Однако вам потребуется вначале применить этот 
эффект к заполнению простегивающим стежком, а 
потом преобразовать в Pattern Fill. См. также Созда-
ние эффекта волнистости.

Вы можете вставить узорное заполнение с ориги-
нальным размером и ориентацией и затем изменить 
настройки. Вы можете также установить точный раз-
мер и величину интервала во время вставки узор-
ного заполнения. Интервал – это расстояние между 
каждым повторением узора. См. также раздел До-
бавление узорного заполнения. 

Как настроить функцию узорного заполнения

1   Дважды щелкните левой кнопкой или один раз 
правой кнопкой по объекту узорного заполнения. От-
кроется диалоговое окно Object Properties на заклад-
ке Fill Stitch с текущим узоров в панели просмотра.

2  При необходимости выберите другой узор запол-
нения. Подробнее см. в разделе Добавление узор-
ного заполнения.
3  При необходимости измените настройки Size X 
(Размер X), Size Y (Размер Y), Column Spacing (Ин-
тервал между колонками), Row Spacing (Интервал 
между рядами).
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4  При необходимо измените настройку Row Offset 
(Смещение рядов)  от -99.99 до 99.99 мм.

5  При необходимости измените настройку  Rotation 
Angle (Угол поворота)  от -180° до  +180°. В этом 
поле устанавливается текущий угол поворота узор-
ного заполнения (по умолчанию нуль) и назначается 
ориентация всего узорного заполнения.

6   Щелкните по Apply (Применить).  Оцифрованный 
объект будет заполнен выбранным узорным запол-
нением с использованием текущих настроек.

Примечание: Если больше половины узора находит-
ся за пределами контура, он может быть подрезан 
вдоль контура.

Компоновка узорного заполнения на экране
Вы можете расположить узоры заполнения на экра-
не, используя «направляющие узоры», чтобы мас-
штабировать, трансформировать и смещать все 
узорное заполнение. Имеются три синих направля-
ющих узоров. Другие примеры узоров появляются 
желтыми. Каждый направляющий узор позволяет 
изменять различные элементы компоновки. Если вы 
изменяете направляющий узор, соответственно из-
меняются все узоры заполнения.

Подсказка: Вы можете также использовать этот ме-
тод для изменения заполнения черными узорами 
(Blackwork Fill), заполнения узелковыми строчками 
(Candlewicking Fill) и заполнения стежками кружев-
ного переплетения (Lacework). 
Используйте верхний направляющий узор для изменения 
интервала между рядами, смещения рядя и масштабиро-
вания всех  узоров.

Используйте средний направляющий узор 
для изменения интервала между колонками и  
масштабирования всех узоров.

Используйте боковой направляющий узор для перемеще-
ния, вращения, наклона  и масштабирования всех  узоров.

Подсказка:
Как правило, расположение узоров определяется до 
оцифровывания объекта. Если важно, чтобы узоры 
были выровнены по контуру объекта, то нужно оциф-
ровывать объект с использованием текущих настроек 
и после этого изменять расположение узоров.

Как компоновать узорное заполнение на экране 
1  Дважды щелкните по объекту с узорным заполне-
нием. Откроется закладка Fill Stitch (Заполняющий 
стежок) диалогового окна Object Properties (Свой-
ства объекта).   Щелкните по кнопке Layout.

2 Щелкните по кнопке Layout (Размещение). 
Диалоговое окно Object Properties закроется и в окне 
проекта появится желтый узор и синие направляю-
щие узоры.  Если вы изменяете направляющий узор, 
соответственно изменяются все узоры заполнения. 

Подсказка: Увеличьте изображение на экране, что-
бы правильно выбрать направляющий узор.

3  Настройте положение направляющих узоров, что-
бы получить нужный эффект.
•  Перемещайте узоры путем выделения среднего 
направляющего узора и перетаскивания его в новое 
положение.
•  Масштабируйте узоры путем выделения направ-
ляющего узора и изменения его размеров с исполь-
зованием маркеров выделения.

•  Вращайте узоры, дважды щелкнув по среднему 
направляющему узору, чтобы отобразить маркеры 
вращения. Щелкните по угловому маркеру и пере-
тащите его, чтобы повернуть узор. 
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• Базисные точки устанавливают стандартную ори-
ентацию узора. Перекашивайте узоры, дважды 
щелкнув по среднему направляющему узору, чтобы 
отобразить маркеры перекоса (вращение, анкер и 
наклон). 

• Изменяйте интервал между колонками, выбрав 
боковой направляющий узор и перетащив его влево 
или вправо. 
 

•  Изменяйте интервал между рядами, выбрав верх-
ний направляющий узор и перетащив его вверх или 
вниз.
•  Изменяйте смещение рядов, выбрав верхний на-
правляющий узор и перетащив его влево или впра-
во. Изменение смещения искажает ряды. 

4  Нажмите Enter для завершения.
Диалоговое окно Object Properties откроется снова, 
что позволит вам применить другие настройки. Вы-
бранные вами размер и расположение применяются 
к выделенному объекту и становятся текущими на-
стройками узорного заполнения.

Управление узорами 
BERNINA предоставляет различные возможности 
управления узорами, включая  составление комплек-
тов узоров, сохранения узоров и удаление узоров.

Сохранение собственных узоров 
Функция Create Pattern (Создание узора) позволяет 
сохранять ваши собственные узоры для использова-
ния в будущем. Сохраняйте их в собственном или 
существующем комплекте узоров. Они могут быть 
использованы в узорных заполнениях или цепочках, 
а также в узорных штампах. 

Как сохранить собственные узоры 
Выберите объект(ы), который вы хотите сохранить.

Подсказка:
Для создания объектов с отверстиями подробнее см. 
в разделе Вырезание отверстий и удаление пере-
крывающих стежков. 
2 Выберите Settings (Настройки) > Create Pattern 
(Создать узор). Откроется диалоговое окно Create 
Pattern.

3 Выберите комплект узоров из списка Pattern Set.

Примечание:
Выбирайте комплект узоров внимательно, так чтобы 
вы могли вспомнить, где вы сохранили ваш новый 
узор. Подробнее см. в разделе Создание собствен-
ных комплектов узоров.
4  Введите имя для вашего нового узора.
5  Нажмите кнопку ОК. Вам будет предложено оциф-
ровать базисные точки. 
6  Щелкните, чтобы наметить две базовые точки узора. 
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Базисные точки устанавливают также интервал меж-
ду каждым повторением узора.

7   Появится сообщение о подтверждении.
8   Нажмите кнопку ОК. 
 

Подсказка:
Проверьте ваш новый узор. Подробнее см. в разде-
ле Добавление узорных штампов, Создание узорных 
контуров и Создание узорных заполнений. 

Создание собственных комплектов 
узоров
Функция Create Pattern (Создание узора) позволяет 
создавать собственные комплекты узоров для орга-
низации и классификации ваших узоров.

Как создавать собственные комплекты узоров
1   Выберите объект, который вы хотите сохранить в 
качестве узора. Подробнее см. в разделе Сохране-
ние собственных узоров. 
2   Выберите Settings (Настройки) > Create Pattern 
(Создать узор). Откроется диалоговое окно Create 
Pattern. Щелкните по New Set для создания нового 
комплекта узоров.

3   Щелкните по кнопке New Set (Новый комплект). 
Откроется диалоговое окно New Pattern Set.

4   Введите имя нового комплекта узоров и нажмите 
OK. Комплект узоров готов для использования. 

Примечание:
Комплекты узоров хранятся в папке C:\..\Program 
Files\BERNINA\ Embroidery Software 7\Userletw 

Удаление узоров

Можно удалить любой не нужный вам узор из ком-
плекта узоров. Но вы можете удалять только соб-
ственные узоры. 

Как удалить узор 
1  Выберите Object Properties (Свойства объекта). 
2 Выберите Pattern Run Outline из списка Stitch 
Outline. 

3  Нажмите кнопку Select. Откроется диалоговое 
окно Select Pattern (Выбор узора).

Подсказка
Выберите режим просмотра - вы сможете выбирать 
узоры по картинке, имени или по обоим признакам. 
4   Выберите узор для удаления.
5  Нажмите кнопку Delete (Удалить). Появится со-
общение о подтверждении.
6  Нажмите кнопку ОК.

Функция “резной штамп” 

С помощью функции Carving Stamp (“резной штамп”) 
вы можете задать образец последовательности про-
колов иглы, используя в качестве шаблона “резной 
штамп”. В качестве “резного штампа”  можно ис-
пользовать любой векторный рисунок и/или обра-
зец вышивки. Прокол иглы помещается в точки, где 
стежок пересекается с векторной или вышивальной 
фигурой. 
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Как использовать заготовленные образцы
1 Можно выбрать, а можно и не выбирать опреде-
ленный Объект вышивки.

Примечание: 
В начале работы можно выбрать определенный Объ-
ект вышивки, а можно его и не выбирать. Если будет 
выбран один или несколько объектов – штампы бу-
дут применяться только к выбранным объектам. Если  
ничего не выбрано – штампы будут применяться к 
любым объектам. 
 
2   Нажмите кнопку Carving Stamp. Откроется диалог 
Carving Stamp. Закладка Use Pattern открывается по 
умолчанию.

3   Выберите набор образцов из списка Set  – напри-
мер, “природа”. Выпадающий список Set включает 
как заготовленные образцы, так и образцы, добав-
ленные пользователем. Подробнее см. раздел Набо-
ры образцов: резные штампы.
4 Выберите готовый образец штампа.
На панели просмотра появится свернутое изображе-
ние образца и кнопка Use Stamp будет разблокиро-
вана.

С помощью функции Carving Stamp вы можете:
•  Использовать заготовленные, или выбранные, или 
оцифрованные “резные штампы” для подходящих 
объектов.
•  Перемещать/вращать/изменять размер и форму/
удалять “резные штампы”, связанные с соответству-
ющим объектом в режиме Reshape.
•  Создавать и работать с собственными “резными 
штампами”, сохраняя их в библиотеке образцов для 
последующего использования.
•  Выбранные “резные штампы” можно использовать 
для оконтуривания объектов гладьевыми стежками, 
а для замкнутых объектов – стежками типа гладье-
вых/ шаговых/ орнаментных.. 

Использование заготовленных образ-
цов

Панель Carving Stamp содержит четыре заклад-
ки: Use Pattern (использовать образец), Use Object 
(использовать объект), Digitize (оцифровать), и 
Appearance (вид). Функция Use Pattern позволяет вы-
брать и использовать заготовленные образцы штам-
пов для только для отобранных подходящих объ-
ектов, или для любых подходящих объектов, если 
ничего не отобрано.
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задать образец последовательности проколов иглы, 
используя в качестве шаблона “резной штамп”.



Примечание: 
Если в области применения штампа находится мно-
жество перекрывающихся объектов, штамп приме-
няется ко всем подходящим объектам.
10   Повторите эту операцию столько раз, сколько 
нужно. Для продолжения работы нажмите Esc.

Примечание:
Если для работы выбран образец, добавленный 
пользователем, то кнопки Rename (переименовать) 
and Delete (удалить) будут разблокированы. Кнопка 
Rename открывает диалог переименования образца 
штампа Rename Stamp Pattern. В этом диалоге мож-
но поменять название образца, добавленного поль-
зователем. См. также раздел Добавление штампов в 
библиотеку.

Подсказка: 
На закладке Appearance имеются опции Softened 
Stamp (смягченный штамп) and Raised Stamp (ре-
льефный штамп ), с помощью которых можно смяг-
чить или подчеркнуть визуальный эффект. См. раз-
дел Изменение вида резных штампов.

Использование объектов в качестве рез-
ных штампов

Панель Carving Stamp содержит четыре заклад-
ки: Use Pattern (использовать образец), Use Object 
(использовать объект), Digitize (оцифровать), и 
Appearance (вид). Функция Use Object позволяет вы-
бирать контуры объектов из окна редактирования 
(Design Window) и либо непосредственно использо-
вать их в качестве штампов, либо сохранять в библи-
отеке для последующего использования.

Как использовать объекты в качестве резных 
штампов:
1 В начале работы можно выбрать определенный 
Объект вышивки, а можно его и не выбирать.

5 Нажмите кнопку Use Stamp и переведите курсор 
мыши на окно редактирования (Design Window). 
Подготовленный образец последует за пойнтером 
мыши. 
В строке текущего состояния (Status Bar) появится на-
поминание о том, чтобы задать анкер (точку привязки).
6 Поставьте пойнтер мыши в требуемую позицию 
над объектом (объектами).
•  С помощью правой клавиши можно отразить 
штамп зеркально.
•  Нажмите клавишу Shift , чтобы не использовать 
автоматическую прокрутку Auto Scroll.
7  Щелчком мыши зафиксируйте положение анкера.  
Теперь можно указать управляющие точки.

8   Поверните образец вокруг анкера к требуемой 
управляющей точке. Опция: можно удерживать кла-
вишу Shift нажатой. 
Программа BERNINA Embroidery Software при этом 
автоматически масштабирует образец при переме-
щении пойнтера мыши.

9   Нажмите кнопку мыши.
•  Если будет выбран один или несколько объектов 
– штампы будут применяться только к выбранным 
объектам, не зависимо от того, выходит данный об-
разец за границы объекта или нет.
•  Если  ничего не выбрано – штампы будут приме-
няться к любым подлежащим объектам.
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С помощью функции General > Carving Stamp можно 
задать образец последовательности проколов иглы, 
используя в качестве шаблона “резной штамп”.



Оцифровка резных штампов

Панель Carving Stamp содержит четыре закладки: Use 
Pattern (использовать образец), Use Object (исполь-
зовать объект), Digitize (оцифровать), и Appearance 
(вид). Функция Digitize позволяет оцифровать кон-
туры штампа и либо прямо использовать оцифро-
ванный штамп, либо применить его к подходящим 
объектам в окне редактирования (Design Window).

Как оцифровать резной штамп
1 В начале работы можно выбрать определенный 
Объект вышивки, а можно его и не выбирать. Если 
выбор сделан – оцифрованные штампы будут при-
менены только к выбранным объектам.

2 Нажмите кнопку Carving Stamp и закладку Use 
Object .
 

3 Нажмите кнопку Start Selecting (начать выбирать). 
Все объекты, которые были выбраны ранее, останут-
ся выбранными.
4 Наведите мышь на любой объект в окне редак-
тирования (Design Window). Контуры объекта будут 
выделены. 
•  Выберите контуры объекта, который вы хотите 
включить в список штампов, любым действующим 
способом выбора. Выбранный контур отобразится 
на паненли просмотра.
•  Отменить выбор можно в любой момент нажатием 
клавиши Esc.

Подсказка:  
Выбираемые объекты могут включать векторные ри-
сунки из программы Art Canvas. Это единственная 
возможность выбора векторных рисунков в режиме 
Embroidery Canvas.
5 Нажатием кнопку Use Stamp выбранный объект 
включается в список штампов. См. также раздел Ис-
пользование заготовленных образцов.

6 Дополнительно можно нажать кнопку Add to 
Library и добавить выбранный образец в  библио-
теку для будущего использования. См. также раздел 
Добавление штампов в библиотеку.

Подсказка: На закладке Appearance имеются оп-
ции Softened Stamp (смягченный штамп) and Raised 
Stamp (рельефный штамп), с помощью которых 
можно смягчить или подчеркнуть визуальный эф-
фект. См. раздел Изменение вида резных штамов.
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С помощью функции General > Carving Stamp можно 
задать образец последовательности проколов иглы, 
используя в качестве шаблона “резной штамп”.

Выберете 
вкладку Use 
Object tab



2  Нажмите кнопку Carving Stamp и откройте за-
кладку Digitize.

3  Нажмите кнопку Start Digitizing (начать оцифровку).
Программа напомнит, что нужно ввести начальную 
точку контура штампа.

4   Как оцифровать контуры штампа:
•  Нажмите один раз Enter, чтобы завершить наметку 
границы.
•  Второй раз нажмите Enter, чтобы завершить оциф-
ровку штампа.
5  Нажмите разблокированнную кнопку Stamp.
•  Нажатие кнопки Stamp применяет штамп только к 
подходящим выбранным объектам.

•  Если никакие объекты не были выбраны, кнопка 
Stamp применит штамп ко всем подходящим объ-
ектам.

•  С помощью кнопки Use Stamp поместите штамп в 
нужное место. Программа напомнит, что надо ука-
зать точку анкера. Подробнее см. раздел Использо-
вание заготовленных объектов.

6 Дополнительно можно нажать кнопку Add to 
Library и добавить выбранный образец в  библиотеку 
для будущего использования. См. также раздел До-
бавление штампов в библиотеку.

Изменение вида резных штампов

Панель Carving Stamp содержит четыре закладки: Use 
Pattern (использовать образец), Use Object (исполь-
зовать объект), Digitize (оцифровать), и Appearance 
(вид). Под закладкой Appearance имеются чекбоксы   
Softened Stamp и Raised Stamp, а также кнопка Clear 
All Stamps. Когда выбран один или несколько объ-
ектов, эти функции разблокированы.
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С помощью функции General > Carving Stamp можно 
задать образец последовательности проколов иглы, 
используя в качестве шаблона “резной штамп”.

Нажмите, 
чтобы начать 
оцифровку

Штамп применяетс к выбранным объектам/у

Применение кнопки Stamp при отсутствии выбранных объектов



Как изменить вид резного штампа
1 Выберите объект вышивки, к которому штампы уже 
применены.

2 Нажмите кнопку Carving Stamp и откройте заклад-
ку Appearance.

3 Выберите нужный вариант изменения вида штам-
па:
•  Поставив галочку в окошке Softened Stamp можно 
смягчить вид штампа (штампов).

•  Поставив галочку в окошке Raised Stamp можно 
удалить все пропуски в комбинации замкнутых кон-
туров резного штампа. Пересекающиеся и перекры-
вающиеся границы объединяются в комбинации.

Примечание: 
Кнопка Clear All Stamps удаляет все примененные 
штампы из выбранных объектов.

Изменение формы резного штампа

В режиме Reshape можно перемещать / вращать / 
изменять размер и форму / удалять “резные штам-
пы”, связанные с соответствующим объектом . При 
изменении резного штампа, точки прокола иглой в 
подлежащем объекте автоматически обновляются.

Как изменить форму резного штампа
•  В режиме Reshape выберите объект вышивки, к 
которому штампы уже применены. В центре каждо-
го штампа отобразится ромбический управляющий 
элемент.

•  Щелкните мышью по ромбическому управляюще-
му элементу. Отобразится целый набор управлющих 
элементов, позволяющих изменять размеры, растя-
гивать и поворачивать фигуру.
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Выберите 
опцию

Щелкните мышью по 
ромбическому управляю-
щему элементу



•  Потяните мышью за ромбик, чтобы переместить 
фигуру.

Подсказка: 
При удержании клавиши Ctrl, перемещение фигуры 
будет происходить строго вертикально или строго 
горизонтально.
•  Для изменения размеров фигуры потяните за 
один из угловых управляющих элементов.

           •  При нажатии и удержании клавиши Shift из-
менение размера будет происходить симметрично 
от центра.
            •  При нажатии и удержании клавиши Ctrl из-
менение размера будет пропорционально.
            •  Одновременное нажатие и удержание кла-
виш Ctrl и Shift при  перемещении углового управ-
ляющего элемента сделает изменение размеров 
пропорциональным относительно центра.

•  Потяните за один из боковых управляющих эле-
ментов, чтобы растянуть объект в нужном направ-
лении.
              •  Верхний и нижний элементы обеспечивают 
вертикальное растяжение.
         •  Левый и правый элементы обеспечивают 
горизонтальное растяжение.
         •  Если нажать и удерживать клавишу Shift,  
растяж ение будет происходить с сохранением по-
зиции центра (от центра).

•  Для поворота штампа потяните за управляющий 
элемент вращения.

•  Нажмите на синий ромбик. Он опять станет зеле-
ным и все другие управляющие элементы исчезнут 
с экрана.
•  Нажмите на контур штампа, чтобы отобразить 
управляющие точки. С их помощью, также как и для 
других объектов, можно менять форму и удалять ли-
нии штампа.

Примечание: 
При изменении формы объекта вышивки, к которо-
му применен резной штамп, форма штампа меняется 
соответственно.

Добавление штампа в библиотеку

Эта процедура запускается нажатием кнопки Add to 
Library (добавить в библиотеку) под закладками Use 
Object или Digitize на панели Carving Stamp.

Как добавить штамп в библиотеку
1 Выберите объект, который нужно добавить в би-
блиотеку в качестве заготовленного пользователем 
образца штампа.
          •  Свои собственные штампы вы можете соз-
давать с помощью функции Carving Stamp > Use 
Object. См. раздел Использование объектов в каче-
стве резных штампов.
          •  Оцифровать резной штамп можно с помо-
щью функции Carving Stamp > Digitize. См. раздел 
Оцифровка резных штампов.
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Потяните за ромбик

Перетащите ручку 
угла размеров

Потяните за боковой 
управляющий элемент

Потяните за 
управляющий элемент

С помощью функции General > Carving Stamp можно 
задать образец последовательности проколов иглы, 
используя в качестве шаблона “резной штамп”.



2  Под любой из этих закладок нажмите кнопку Add 
to Library (добавить в библиотеку). Откроется диалог 
создания образца штампа Create Stamp Pattern.

3  Выберите имя библиотеки из списка или с помо-
щью кнопки New Set создайте новую библиотеку. В 
последнем случае используйте диалог создания но-
вой библиотеки New Stamp Set. Имя новой библи-
отеки отобразится в списке библиотек Set под за-
кладкой Use Pattern.

4   Введите имя новой библиотеки и нажмите OK. Си-
стема напомнит, что надо ввести первую контроль-
ную точку в окне редактирования (Design Window).
5  Укажите первую контрольную точку:
•  При нажатии клавиши Enter контрольная точка 
создается автоматически.
•  Можно сделать это вручную, поместив пойнтер 
мыши в точку, где вы хотите поместить анкер и щел-
кнув левой клавишей мыши.

6  Укажите вторую контрольную точку:
•  При нажатии клавиши Enter контрольная точка 
создается автоматически.
•  Можно сделать это вручную, поместив пойнтер 
мыши в точку, где вы хотите поместить управляю-
щую точку и щелкнув левой клавишей мыши.

Программа BERNINA Embroidery Software:
•  Создает штамп
•  Запоминает управляющие точки, как автоматиче-
ски созданные, так и заданные вручную
•  Замещает штампы с совпадающим именем на новые
•  Выводит на экран подтверждающее сообщение.

7   Нажмите OK.
Имя нового штампа появится в списке под закладкой 
Use Pattern.

Примечание:
Если для работы выбран образец, добавленный 
пользователем, то кнопки Rename (переименовать) 
and Delete (удалить) будут разблокированы. Кноп-
ка Rename открывает диалог переименования об-
разца штампа Rename Stamp Pattern. В этом диалоге 
можно поменять название образца, добавленного 
пользователем. См. также раздел Использование за-
готовленных образцов.
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Нажмите 
добавить в 

библиотеку

Введите первую 
опорную точку

Указать вторую 
контрольную точку 

Выбрать имя
библиотеки 

Ввести имя 
нового 

Введите 
имя новой 

библиотеки
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Глава 24
Оконтуривание и заполнение рукодельными стежками

BERNINA предлагает ряд «рукодельных» стеж-
ков, которые вы можете использовать в своих 
проектах для имитации некоторых традицион-
ных ручных вышивок. Сюда входит большой вы-
бор черно-белых узоров «blackwork» и узелко-
вых узоров «candlewicking», подходящих как для 
оконтуривания, так и для заполнения объектов. 
Подробнее см. в разделе Образцы узоров руко-
дельных стежков.
Стежок «назад в иголку» (Backstitch) и стебельчатый стежок (Stemstich) являются двумя 
разными оконтуривающими стежками. Стежок «назад в иголку» образует непрерыв-
ную тонкую линию, подобную машинной строчке, в то время как стебельчатый стежок 
образует шнуроподобную строчку, толщину которой можно изменять в зависимости 
от угла наклона стежков. Оба стежка могут быть использованы для создания ровных 
рядов стежков, пригодных для оконтуривания и образования черно-белых узоров 
blackwork.
Стежки кружевного переплетения (Lacework) и пунктирные стежки (Stipple) использу-
ются для декоративного заполнения. Кружевное переплетение можно использовать 
для придания таким объектам, как цветы, вид кружева. Строчки пунктирного просте-
гивания, известные также, как «вермишель», образуют плавные произвольные линии, 
используемые для декоративных эффектов или для стежки квилтов.
В этом разделе поясняется, как выбирать типы рукодельных стежков, а также изменять 
настройки стежков для получения наилучших результатов.

Подсказка:
Вы можете также создавать декоративные эффекты 
цепочками узоров. Подробнее см. в разделе Созда-
ние узорных контуров.

Создание контуров рукодельными стежками

Создание контуров рукодельными 
стежками
BERNINA предоставляет ряд «рукодельных» стеж-
ков для оконтуривания. В их число входят стеж-
ки типа «blackwork», «backstitch», «stemstitch» и 
«candlewicking». См. также раздел Образцы узоров 
рукодельных стежков.

Используйте инструмент Blackwork Outline (панель 
Stitch) для оконтуривания в технике blackwork.

Используйте инструмент Candlewicking Outline (панель 
Stitch) для оконтуривания в технике candlewick.

Используйте инструмент Backstitch Outline (панель 
Stitch) для оконтуривания стежками назад.

Используйте инструмент Stemstitch Outline (панель 
Stitch) для оконтуривания стебельчатыми стежками.
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Различные типы стежков подходят для различных 
форм. Когда вы оцифровываете объект, использу-
ется текущий тип стежка для выбранного метода 
оцифровывания. Однако вы можете изменить тип 
стежка в любое время. Подробнее см. в разделе На-
стройка текущих свойств объекта.

Как создать контур рукодельными стежками

1   Выберите на панели Craft Stitch требуемый вам 
рукодельный стежок.
2  Используйте инструменты Open Object (Откры-
тый объект), Closed Object (Замкнутый объект), 
Circle (Окружность) или Rectangle (Прямоугольник) 
для создания направляющей линии оконтуривания. 
Подробнее см. в разделе Методы оцифровывания.

Примечание:
Контур создается с принятыми по умолчанию на-
стройками стежка. Они могут быть изменены до или 
после оцифровки через Свойства объекта.

3   Для изменения настроек дважды щелкните левой 
кнопкой или щелкните правой кнопкой по объекту.
Откроется закладка Outline Stitch (Оконтуривающий 
стежок) диалогового окна Object Properties (Свой-
ства объекта).
4    Измените при необходимости настройки:
•  Оконтуривание в технике Blackwork: Подробнее 
см. в разделе Создание контуров в технике   «чер-
ной  вышивки» («блэкуорк»).
•  Стежок «назад в иголку»: Подробнее см. в раз-
деле Создание контуров стежками «назад в иголку»  
(«бэкстич»).
•  Стебельчатый стежок: Подробнее см. в разделе 
Создание контуров стебельчатыми стежками.
•  Обрамление строчкой Candlewicking: Подробнее 
см. в разделе Создание контуров узелковым  швом.

Подсказка:
Вы можете быстро перейти от заполнения к оконту-
риванию рукодельными стежками, используя кноп-
ки на панели Craft Stitch или выпадающее меню 
Outline. См. также Создание заполнения рукодель-
ными стежками.

Создание контуров обрамления в тех-
нике Blackwork

Техника Blackwork (дословно «черная работа») полу-
чила свое название от черных шелковых ниток, ис-
пользуемых в этом виде вышивания. В более ранних 
проектах преобладали угловатые мотивы, тогда как 
теперь больше используются диагональные стежки.
В технике Blackwork используется лишь несколько 
простых стежков для создания комплексных про-
ектов. Эта техника может быть использована для 
декорирования предметов одежды или украшения, 
например, носовых платков, скатертей и салфеток.
Используйте инструменты Open Curve (Незамкну-
тая кривая), Closed Curve (Замкнутая кривая), Circle 
(Окружность) или Rectangle (Прямоугольник) для 
создания направляющей линии обрамления в тех-
нике Blackwork.

Как создать контур в технике blackwork
1   Выберите Blackwork Outline. Подробнее см. в раз-
деле Создание контуров рукодельными стежками.
2   Оцифруйте линию контура. Подробнее см. в раз-
деле Методы оцифровывания. 

3   Для изменения настроек дважды щелкните левой 
кнопкой или щелкните правой кнопкой по объекту.

4   Выберите Blackwork Outline из списка Stitch Type. 
если этот стежок еще не был выбран.
5   Щелкните по кнопке Select (Выбрать).

Используйте инструмент Blackwork Outline (панель 
Stitch) для оцифровывания обрамления в технике 
blackwork. 

Щелкните для выбора узора
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Откроется диалоговое окно Select Pattern (Выбор 
образца). 

Подсказка: 
Выберите режим просмотра - вы сможете выбирать 
узоры по картинке, имени или по обоим признакам.
6   Выберите узор на панели просмотра. Он станет 
текущим узором. См. также раздел Образцы узоров 
рукодельных стежков.
7  Щелкните по Apply (Применить) для предвари-
тельного просмотра эффекта.

8   Измените, если требуется, размер узора (Size) и 
щелкните по Apply.

9   Измените, если требуется, плотность стежков 
узора и щелкните по Apply.
•  Для увеличения плотности стежков введите мень-
шее значение.
•  Для уменьшения плотности стежков введите боль-
шее значение. уменьшенный интервал.

Подсказка:
Если к обрамлению автоматически не подобран 
нужный вам цвет, вы можете переназначить цвет, 
выбрав его по цветовой палитре.

Создание обрамления стежками «назад 
в иголку» («бэкстич»)»

Стежок «назад в иголку» (Backstitch) является старым 
легко приспосабливаемым стежком, который может 
быть использован для изысканного оконтуривания. 
Строчка этого стежка хорошо вписывается в замыс-
ловатые кривые, Эти стежки небольшие и ровные, 
так что они точно располагаются на очертании кри-
вой Стежок «назад в иголку» может быть использо-
ван для проектов «черной» и «красной» вышивки. 
Отрегулируйте настройки, чтобы получить желае-
мые точные результаты. Вы можете назначить точ-
ную длину стежка, толщину и величину перекрытия, 
а также число строчек.

Как создать контур стежком «назад в иголку»
1   Выберите Blackwork Outline. Подробнее см. в раз-
деле Создание контуров рукодельными стежками.
2   Оцифруйте линию контура. Подробнее см. в раз-
деле Методы оцифровывания. 

3  Для изменения настроек дважды щелкните левой 
кнопкой или щелкните правой кнопкой по объекту.
Откроется закладка Outline Stitch (Оконтуривающий 
стежок) диалогового окна Object Properties (Свой-
ства объекта).

Используйте инструмент Backstitch Outline (панель 
Stitch) для оцифровывания обрамления стежками «на-
зад в иголку».

Выберите режим просмотра

Выберите
узор

уменьшение 
размера

Настройка 
параметровуменьшение 

интервала
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4   Выберите Backstitch из списка Stitch Type, если 
этот стежок еще не был выбран.
5   Измените, если требуется, длину стежков
в (Stitch Length) и щелкните по Apply.

6   Измените, если требуется, толщину строчки 
(Stitch Thickness) и щелкните по Apply.

7   Измените, если требуется, величину перекрытия 
(Overlap) и щелкните по Apply.

8   Измените, если требуется, число строчек.

Создание контуров обрамления сте-
бельчатыми стежками

Стебельчатый стежок (Stemstitch) является детали-
зированным стежком, который может быть исполь-
зован для оконтуривания или заполнения форм. Он 
используется для вышивки стеблей и виноградной 
лозы вместе с другими декоративными стежками 
или в качестве оконтуривающих стежков совместно 
с гладьевыми заполняющими стежками. Отрегули-
руйте настройки, чтобы получить желаемые точ-
ные результаты. Вы можете назначить точную дли-
ну стежка, толщину и величину перекрытия, а также 
число строчек.

Как создать контур обрамления стебельчатым 
стежком

1   Выберите Stemstitch Outline. Подробнее см. в раз-
деле Создание контуров рукодельными стежками.
2   Оцифруйте линию контура. Подробнее см. в раз-
деле Методы оцифровывания. 

3   Для изменения настроек дважды щелкните левой 
кнопкой или щелкните правой кнопкой по объекту. 
Откроется закладка Outline Stitch (Оконтуривающий 
стежок) диалогового окна Object Properties (Свой-
ства объекта).

4   Выберите Stemstitch из списка Stitch Type, если 
этот стежок еще не был выбран.
5   Измените, еcли требуется, толщину линии (Line 
Thickness) и щелкните по Apply.

Используйте инструмент Stemstitch Outline (панель 
Stitch) для оцифровывания обрамления стебельчатыми 
стежками

 Длина стежка: 3.0 мм               Длина стежка: 1,5 мм 

Толщина строчки: 0,15 мм        Толщина строчки: 0,25 мм

Перекрытие: 30 %                   Перекрытие: 70 %

  Число строчек: 3           Число строчек: 5

Толщина линии: 2,0 мм       Толщина линии: 1,0 мм
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6   Измените, если требуется, шаг стежков (Spacing) и 
щелкните по Apply.

7    Измените, если требуется, величину угла (Angle) и 
щелкните по Apply.

8   Выберите одинарный или тройой тип и нажмите 
применить (Apply).

9   Только для тройного стежка (Triple Stich) в поле 
Stitch Thickness (Толщина стежка) введите нужное зна-
чение.

Настройка контуров обрамления в тех-
нике Candlewicking

Вышивание узелковыми строчками (Candlewicking) 
является традиционной техникой вышивания 
«белым-по-белому», выполняемому обычно на бе-
лой льняной или хлопчатобумажной ткани толстыми 
хлопчатобумажными нитками. Применяются в ос-
новном стежки, образующие узелки, - «колониаль-
ные» и «французские», а также стебельчатый стежок. 
Контур узелковой строчкой может быть использован 
для орнаментального обрамления. Вы можете на-
значить точные размеры каждого узора, а также ин-
тервала между узорами. См. также Создание запол-
нения строчками в технике Candlewicking.

Как создать контур в технике candlewicking

1   Выберите Candlewicking Outline. Подробнее см. в 
разделе Создание контуров рукодельными стежками.
2   Оцифруйте линию контура. Подробнее см. в раз-
деле Методы оцифровывания. 

3   Для изменения настроек дважды щелкните левой 
кнопкой или щелкните правой кнопкой по объекту.
Откроется закладка Outline Stitch (Оконтуривающий 
стежок) диалогового окна Object Properties (Свой-
ства объекта).

4   Выберите Candlewicking Outline из списка Stitch 
Type. если этот стежок еще не был выбран.
5   Щелкните по кнопке Select (Выбрать). Откроется 
диалоговое окно Select Pattern (Выбор узора).  Вы-
берите режим просмотра.

Подсказка: Выберите режим просмотра - вы сможе-
те выбирать узоры по картинке, имени или по обоим 
признакам.
6    Выберите узор на панели просмотра. Он станет 
текущим узором. См. также раздел Образцы узоров 
рукодельных стежков.

Используйте инструмент Candlewicking Outline (па-
нель Stitch) для оцифровывания обрамления в технике 
candlewicking

Шаг: 0,8 мм   Шаг: 1,5 мм

Угол: 90°          Угол: 45°

Тип: тройной             Тип: одинарный

Тройной стежок:
Толщина: 0,25 мм

Тройной стежок:
Толщина: 0,15 мм

Выбор узора

Выбор 
Узора

Выберите режим просмотра
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7  Щелкните по Apply (Применить) для предвари-
тельного просмотра эффекта.Выбранный узор будет 
применен к объекту.

8   Измените, если требуется, размер (Size) и щел-
кните по Apply.

9   Измените, если требуется, шаг узоров (Spacing) и 
щелкните по Apply.

Подсказка:
Если к обрамлению автоматически не подобран 
нужный вам цвет, вы можете переназначить цвет, 
выбрав его из цветовой палитры.

Создание заполнения рукодельными 
стежками
BERNINA предоставляет ряд «рукодельных» стеж-
ков для заполнения. В их число входят стеж-
ки типа «blackwork», «backstitch», «stemstitch» и 
«candlewicking». См. также раздел Образцы узоров 
рукодельных стежков.

Подсказка: Вы можете также создавать декоративные 
эффекты, используя орнаментные и рукодельные стеж-
ки и узоры. См. разделы Создание заполнения орна-
ментным стежком и Создание узорных заполнений.

Создание заполнения рукодельными стежками

BERNINA предоставляет четыре вида рукодельных 
стежков заполнения - Blackwork Fill, Candlewicking 
Fill, Lacework и Stipple. Различные типы стежков под-
ходят для разных форм. Вы можете выбрать эти 
стежки заполнения с помощью панели инструментов 
Stitch & Color (Стежок и Цвет) или специально вы-
деленной для них панели Craft Stitch (Рукодельный 
Стежок). Подробнее см. в разделе Образцы узоров 
рукодельных стежков.

Примечание: Пунктирные стежки (Stipple) позволяют 
заполнять объекты извилистыми линиями в преде-
лах контура. Такое заполнение слегка отличается от 
других типов рукодельных стежков. Подробнее см. в 
разделе Создание заполнения пунктирными стежками.

Как создать заполнение рукодельными стежками
1   Выберите на панели Craft Stitch требуемый вам за-
полняющий рукодельный стежок.
2   Создайте замкнутую фигуру. Подробнее см. в раз-
деле Методы оцифровывания.

 Примечание: Заполнение создается с принятыми 
по умолчанию настройками стежка. Они могут быть 
изменены до или после оцифровки через Свойства 
объекта.
3   Для изменения настроек дважды щелкните левой 
кнопкой или щелкните правой кнопкой по объекту. 
Откроется закладка Fill Stitch (Заполняющий стежок) 
диалогового окна Object Properties (Свойства объ-
екта).

Используйте инструмент Blackwork Fill (панель Stitch) 
для заполнения в технике blackwork. 

Используйте инструмент Candlewicking Fill (панель 
Stitch) для заполнения в технике candlewick.

Используйте инструмент Lacework (панель  Stitch) для 
получения специальных кружевных эффектов.

Используйте инструмент Sculpture (панель Stitch) для 
получения поворачивающихся  “кафельных” образцов 
с заданными точками прокола.
Используйте инструмент Ripple (панель  Stitch) для спи-
рального прострачивания от центра любого заполнен-
ного объекта.

Используйте инструмент Stipple Run (панель Stitch) для 
получения специальных пунктирных эффектов.
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Подсказка: Вы можете быстро перейти от запол-
нения к оконтуриванию рукодельными стежками, 
используя кнопки на панели Craft Stitch или выпа-
дающее меню Fill. См. также Создание контуров ру-
кодельными стежками.
4   Измените при необходимости настройки:
•  Заполнение стежками в технике Blackwork: Под-
робнее см. в разделе Создание заполнений в техни-
ке «черной вышивки» («блэкуорк»).
•  Заполнение строчками в технике Candlewicking: 
Подробнее см. в разделе Создание заполнений 
строчками в технике Candlewicking.
•  Кружевное переплетение (Lacework): Подробнее 
см. в разделе Создание заполнений стежками кру-
жевного переплетения.
•  Рельефное заполнение Sculptured: см. в разделе 
Creating sculptured fancy fills (Создание рельефных 
стежков)
•  Спиральные заполнения Ripple: см. в разделе 
Creating ripple fills for details (Создание спиральных 
заполнений).
•  Заполнений пунктирными стежками Stipple Run: 
см. в разделе Creating stippling fills (Заполнений 
пунктирными стежками).

Подсказка: Эффект волнистости (Wave Effect) позво-
ляет направлять строчки заполняющих стежков по 
оцифрованной направляющей линии. Эффект вол-
нистости может быть применим к некоторым руко-
дельным стежкам. Однако вам потребуется вначале 
применить этот эффект к заполнению простегиваю-
щим стежком, а потом преобразовать заполняющие 
стежки в рукодельные. См. также Создание эффекта 
волнистости.

Создание заполнений в 
технике «черной вышивки» («блэкуорк»)

Техника Blackwork (дословно «черная работа») полу-
чила свое название от черных шелковых ниток, ис-
пользуемых в этом виде вышивания. В большинстве 
случаев при таком «черно-белом» заполнении ис-
пользуются простые стежки для создания комплекс-
ных геометрических узоров. 
При использовании различных узоров заполнения 
«блэкуорк» вы можете создавать светлые и темные 
тона участков проекта. См. также Создание контуров 
в технике «черной вышивки» («блэкуорк»). 

Как создать заполнение в технике blackwork 
1    Щелкните по значку Blackwork Fill или по значку 
Fill и выберите из выпадающего меню Blackwork Fill 
(Заполнение в технике Blackwork). Подробнее см. в 
разделе Создание заполнений рукодельными стеж-
ками.
2   Создайте замкнутую фигуру. Подробнее см. в 
разделе Методы оцифровывания.

Примечание:  Угол наклона стежка не влияет на рас-
положение узоров.
3   Для изменения настроек дважды щелкните левой 
кнопкой или щелкните правой кнопкой по объекту.
Откроется закладка Fill Stitch (Заполняющий стежок) 
диалогового окна Object Properties (Свойства объекта). 

4   Если предварительно не было выбрано, выбери-
те Blackwork Fill из списка Stitch Type и щелкните по 
Select. Откроется диалоговое окно Select Pattern (Вы-
бор узора), в котором показываются все имеющиеся 
узоры.

Подсказка: Выберите режим просмотра - вы сможе-
те выбирать узоры по картинке, имени или по обоим 
признакам.
5  Выберите желаемый узор на панели просмотра. См. 
также раздел Образцы узоров рукодельных стежков.
6  Щелкните по Apply (Применить) для предвари-
тельного просмотра эффекта.

Используется
шаг стежка

Применяется 
эффект Волна

Выбраны «руко-
дельные» стежки

Используйте инструмент Blackwork Fill (панель Stitch) 
для заполнения в технике blackwork. 

Нажмите, чтобы 
изменить узор

Выберите
узор

Выберите режим просмотра
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Выбранный шаблон применяется к объекту.

7    Измените компоновки узора изменением настро-
ек в диалоговом окне или на экране через кнопку 
Layout. Техника настройки компоновки узоров та 
же, что и для заполнения узорами. Подробнее см. в 
разделе Создание узорных заполнений.
8   Щелкните по Apply (Применить) для предвари-
тельного просмотра эффекта или на ОК для завер-
шения и выхода.

Примечание:
Если больше половины узора находится за предела-
ми контура, он может быть подрезан вдоль контура.

Создание заполнений строчками в тех-
нике candlewicking

Вышивание узелковыми строчками (Candlewicking) 
является традиционной техникой вышивания 
«белым-по-белому», выполнявшейся обычно на бе-
лой льняной или хлопчатобумажной ткани толстыми 
хлопчатобумажными нитками. Сегодня более попу-
лярно использование цветных ниток. 
Применяются в основном стежки, образующие узел-
ки, - «колониальные» и «французские», а также сте-
бельчатый стежок. Эта техника может использоваться 
для вышивания на постельных покрывалах, наволоч-
ках и одежде.  См. также Настройка контуров обрам-
ления в технике Candlewicking.

Как создать заполнение в технике candlewicking 
1     Щелкните по значку Candlewicking Fill или по значку 
Fill и выберите из выпадающего меню Candlewicking 
Fill (Заполнение в технике Candlewicking). Подробнее 
см. в разделе Создание заполнений рукодельными 
стежками.

2  Создайте замкнутую фигуру. Подробнее см. в 
разделе Методы оцифровывания.

Примечание:
Угол наклона стежка не влияет на расположение 
узоров.

3   Для изменения настроек дважды щелкните левой 
кнопкой или щелкните правой кнопкой по объекту.
Откроется закладка Fill Stitch (Заполняющий стежок) 
диалогового окна Object Properties (Свойства объекта).

4   Если предварительно не было выбрано, выберите 
Candlewicking Fill из списка Stitch Type и щелкните 
по Select. Откроется диалоговое окно Select Pattern 
(Выбор узора), в котором показываются все имею-
щиеся узоры.

Подсказка:
Выберите режим просмотра - вы сможете выбирать 
узоры по картинке, имени или по обоим признакам.
5  Выберите желаемый узор на панели просмотра. 
См.также раздел Образцы узоров рукодельных 
стежков.
6   Щелкните по Apply (Применить) для предвари-
тельного просмотра эффекта.

Используйте инструмент Candlewicking Fill (панель 
Stitch) для заполнения в технике candlewick.

Нажмите, чтобы 
изменить узор

Выберите
узор

Выберите режим просмотра
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Выбранный узор будет применен к объекту. 

7  Для изменения компоновки узора измените на-
стройки в диалоговом окне или на экране через 
кнопку Layout.
Техника настройки компоновки узоров та же, что и 
для заполнения узорами. Подробнее см. в разделе 
Создание узорных заполнений.
8   Щелкните по Apply (Применить) для предвари-
тельного просмотра эффекта или на ОК для завер-
шения и выхода.

Примечание:
Если больше половины узора находится за предела-
ми контура, он может быть подрезан вдоль контура.

Создание заполнений стежками кру-
жевного переплетения

Стежки кружевного переплетения образуют похо-
жие на сетку узоры, которые придают объекту вид 
кружева. С таким заполнением вы можете подогнать 
компоновку стежков к заданным узорам.

Как создать заполнение стежками кружевного 
переплетения
1   Щелкните по значку Lacework или по значку Fill и 
выберите из выпадающего меню Lacework. Подроб-
нее см. в разделе Создание заполнений рукодель-
ными стежками.

2  Создайте замкнутую фигуру. Подробнее см. в 
разделе Методы оцифровывания.

Примечание: 
Угол наклона стежка не влияет на расположение 
узоров.
3  Для изменения настроек дважды щелкните левой 
кнопкой или щелкните правой кнопкой по объекту. 
Откроется закладка Fill Stitch (Заполняющий стежок) 
диалогового окна Object Properties (Свойства объ-
екта).  Object Properties > Fill Stitch

4   Выберите Lacework из списка Stitch Type, если 
этот стежок еще не был выбран и нажмите кнопку 
Select.  Откроется диалоговое окно Select Pattern 
(Выбор узора). 

Подсказка: 
Выберите режим просмотра - вы сможете выбирать 
узоры по картинке, имени или по обоим признакам.
5   Выберите желаемый узор на панели просмотра. 
См. также раздел Образцы узоров рукодельных 
стежков.
6   Щелкните по Apply (Применить) для предвари-
тельного просмотра эффекта.

Используйте инструмент Lacework (панель Stitch) для 
получения специальных кружевных эффектов.

Нажмите, чтобы 
изменить узор

Выберите
узор

Выберите режим просмотра
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Выбранный узор будет применен к объекту.

7   Для изменения компоновки узора измените на-
стройки в диалоговом окне или на экране через 
кнопку Layout. 
Техника настройки компоновки узоров та же, что и 
для заполнения узорами. Подробнее см. в разделе 
Создание узорных заполнений.
8  Щелкните по Apply Применить) для предвари-
тельного просмотра эффекта или на ОК для завер-
шения и выхода.

Примечание:
Если больше половины узора находится за предела-
ми контура, он может быть подрезан вдоль контура.

Создание рельефных заполнений

Рельефные стежки (Sculpture stitch) относятся к за-
полнениям орнаментного типа Fancy Fill и исполь-
зуют игольные проколы для создания рельефных 
образцов. Разница состоит в том, что рельефные 
стежки Sculpture можно применять к объектам с  
поворачивающимися стежками, создавая эффекты 
вращения и трехмерности, что  одними орнамент-
ными заполнениями  Fancy Fill не достигается. См. 
также раздел Создание заполнения орнаментными 
стежками.

Подсказка: 
Если объект, над которым вы работаете, поворачи-
вающихся стежков не содержит, вы можете добавить 
их с помощью инструмента Add Stitch Angles. См. 
раздел Подгонка углов наклона стежков.

Как создать рельефное заполнение
1 Создайте или выберите замкнутый объект с по-
ворачивающимися стежками. См. раздел Методы 
оцифровывания.

2 Нажмите кнопку Sculpture. См. раздел Создание 
заполнения рукодельными стежками.
Рельефный эффект применяется на основе имеюще-
гося образца типа Fancy Fill. См. раздел Создание 
заполнения орнаментными стежками.

Создание спиральных заполнений

Стежки типа Ripple относятся к типу контурных 
стежков (Contour stitch), создавая вышивки похоже-
го вида (с фиксированным числом линий и перемен-
ными зазорами между ними).

В этом случае, однако, стежки расходятся от центра 
заполненного объекта по спирали. Этот тип стежков 
лучше всего использовать для небольших, компакт-
ных объектов, но можно использовать и для более 
вытянутых объектов. В последнем случае некоторые 
стежки могут выходить за периметр объекта, но это 
может дать интересный визуальный эффект. См. 
раздел Создание контурного заполнения.

Как создавать спиральные стежки
1  Нажмите кнопку Ripple или кнопку Fill и выберите 
позицию Ripple из выпадающего меню. См. раздел 
Создание заполнения рукодельными стежками.

Используйте инструмент Sculpture (панель Stitch) для 
получения рельефных поворачивающихся  образцов  

Используйте инструмент Ripple (панель Stitch) для 
спирального прострачивания от центра любого за-
полненного объекта.
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2  Создайте или выберите замкнутый образец. Под-
робнее см. раздел Методы оцифровывания.

Примечание:
Угол поворота стежка не оказывает влияния на вид 
объекта.

3 Для изменения настроек надо применить двой-
ной щелчок или воспользоваться правой клавишей 
мыши. Откроется диалоговое окно Object Properties 
> Fill Stitch.

4 Настройте параметры спиральных стежков (Stitch 
Values) как считаете нужным:
•  Укажите длину стежка (Stitch Length), она влияет 
на четкость и гладкость линий.

•  Укажите нужную плотность стежков (расстоя-
ния между строчками) с помощью функции Stitch 
Spacing.

5    Нажмите Apply, чтобы просмотреть вид объекта 
на экране, или OK, чтобы закончить работу и закрыть 
диалог. Выбранные настройки будут применены к 
объекту.

Примечание: 
Если объект имеет отверстие, спиральные стеж-
ки игнорируют это обстоятельство, но другие типы 
стежков учитывают это отверстие.

Подсказка:
Можно добиться интересных визуальных эффек-
тов, перемещая центр спиральных стежков Ripple за 
пределы контура объекта.

Создание заполнений пунктирными 
стежками

Пунктирные стежки позволяют заполнять объекты 
извилистыми линиями в пределах контура. Есть три 
типа пунктирных заполнений: Stipple Run, Stipple 
Backstitch и Stipple Stemstitch. Пунктирные заполне-
ния можно применять к тем же объектам, что и за-
полнения по образцам (Pattern Fill) – то есть, к зам-
кнутым объектам с углами поворота стежков или без 
них. Их можно применять к буквам, авто аппликаци-
ям или к составным объектам.

Используйте инструмент Stipple Run панель Stitch) 
для получения специальных пунктирных эффектов

       Длина стежка: 3,0 мм                   Длина стежка: 1,0 мм

           Расстояние стежка: 3 мм        Расстояние стежка: 5 мм

Настройка 
параметров 
строчек
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Вы можете регулировать плотность стежков и рас-
стояние между строчками.
Вы можете поменять форму и масштаб контуров за-
полняемого пунктирными стежками объекта при со-
хранении настроек.

Как создавать пунктирное заполнение
1 Нажмите кнопку Stipple Run или кнопку Fill и вы-
берите позицию Stipple Run из выпадающего меню. 
См. раздел  Создание заполнения рукодельными 
стежками.
2 Создайте или выберите замкнутый образец. Под-
робнее см. раздел Методы оцифровывания.

Примечание:
Угол поворота стежка не оказывает влияния на вид 
объекта.
3 Для изменения настроек надо применить двой-
ной щелчок или воспользоваться правой клавишей 
мыши. Откроется диалоговое окно Object Properties 
> Fill Stitch.

4   Настройте параметры пунктирных стежков (Stitch 
Values) как считаете нужным:
•  Укажите длину стежка (Stitch Length), она влияет 
на четкость и гладкость линий.

•  Функция Run Count определяет число повторов 
стежков – то есть,. 1, 3, 5, 7, 9 – и тем самым массив-
ность стежков.

5 Укажите желательные параметры пунктирных 
стежков (Stipple Values):
•  Задайте интервал между петлями (Loop Spacing) . 
Он определяет плотность стежков.

•  Параметр Inset Step задает интервал между конту-
ром объекта и заполнением спиральными стежками. 
Большему значению соответствует больший зазор. 
Заметим, что заполнение пунктирными стежками за 
пределы контуров объекта выходить не может.

6 Выберите тип стежка (Stitch Type).  Стежки типа 
Stemstitch и Stipple Backstitch работают также, как и 
стежки типа Stipple Run,  но при этом имеют более 
выраженный орнаментный характер.

•  Параметры стежков типа Stipple Stemstitch на-
страиваются через функцию свойств объекта Object 
Properties. См. раздел Создание контуров обрамле-
ния стебельчатыми стежками.

Отрегулируй-
те значения 
стежка

Настройка 
параметров 
пунктиров

Длина стежка: 1,0 мм                       Длина стежка: 2,0 мм

Интервал между петлями: 1,5 мм   Интервал между петлями: 2,5 мм

 Стежки типа Stemstitch            Стежки типа Backstitch
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•  Параметры стежков типа Stipple Backstitch на-
страиваются через функцию свойств объекта Object 
Properties. См. раздел Создание обрамления стеж-
ками «назад в иголку».

7   Нажмите Apply, чтобы просмотреть вид объекта 
на экране, или OK, чтобы закончить работу и закрыть 
диалог.
После создания заполнения пунктирными стежка-
ми, можно в любое время поменять свойства объ-
екта (object properties). Можно поменять размеры и 
форму заполненного пунктирными стежками объек-
та при сохранении настроек. См. раздел Изменение 
формы объектов с использованием контрольных то-
чек.

Подсказка:
К объектам, заполненным пунктирными стежками 
можно применить операцию Break Apart. С ее по-
мощью можно напрямую изменять форму пунктир-
ной строчки. Можно применять разные типы окон-
туривающих стежков, такие, как Pattern Run, Satin и 
другие. Подробнее см. раздел Разбивка объектов на 
компоненты.

Пунктирное заполнение 
стежками Candlewicking 

Пунктирное заполнение 
стежками Blanket
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Глава 25
Оцифровывание аппликаций

Техника аппликации занимает важное место в до-
машнем рукоделии, и функция Auto Applique об-
легчает достижение высокого качества работы. 
Используйте функцию Auto Applique для получе-
ния стежков, которые требуются для объектов ап-
пликации. Генерируется до четырех слоев стежков 
– линия размещения, линия обрезки, закрепляю-
щие и покрывающие стежки. Используя инстру-
мент Partial Applique, вы можете создавать объекты 
аппликации с частичным покрытием вышивкой для 
образования эффекта нахлестки без дублирования обрамления Иногда может по-
требоваться дополнительная гибкость для расширения диапазона проектов, которые 
вы можете вышивать. Например, проекты, содержащие открытые объекты, не могут 
обрабатываться функцией Auto Applique. В таком случае специальный инструмент 
Advanced Applique позволит создавать «объект открытой аппликации» из одного или 
нескольких исходных объектов.
В этом разделе рассматривается создание замкнутого объекта аппликации, а также 
частичного покрытия объектов аппликации. Рассматривается также создание объекта 
открытой аппликации.

Подсказка: 
Вы можете также создавать объекты аппликации с 
частичным покрытием вышивкой для создания эф-
фекта нахлестки без дублирования обрамления. См. 
также Создание частичного покрытия объектов ап-
пликации.

Создание объектов аппликации

Используйте функцию Applique для получения стеж-
ков, которые требуются для объектов аппликации. 
Для каждого объекта аппликации генерируется до 
четырех слоев вышивки – линию размещения, линию 
обрезки, закрепляющие и покрывающие стежки в 
соответствии с текущими настройками.

Создание замкнутого объекта 
аппликации
Используйте функцию Applique для получения стеж-
ков, которые требуются для объектов аппликации. 
Оцифровка контура вокруг фигуры аппликации 
производится почти таким же образом, как и для 
замкнутого объекта вышивки. Вы можете выбирать 
различные настройки, включая тип покрывающе-
го стежка - гладьевый или краеобметочный, - шаг 
стежка, а также смещение. Автоматически может 
быть сгенерировано до трех типов «вторичных объ-
ектов».
• Линии размещения: Линии размещения применя-
ются опционально  для позиционирования предва-
рительно вырезанных лоскутов аппликации на ма-
териале заднего плана.
• Линии обрезки: И в этом случае опционально ли-
нии обреза образуют направляющие при обрезании 
лоскута ткани на месте.
• Закрепление: Это строчка зигзаг, прокладывае-
мая после разметки линий размещения и обрезки, 
которая используется для закрепления элементов 
аппликации к материалу фона перед покрывающим 
вышиванием.

Используйте инструмент Applique (панель Digitize) 
для оцифровывания замкнутых объектов аппликации
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Опции, определяющие одинарные или сложные 
контуры, а также положение выхода пялец, настра-
иваются в диалоговом окне Options. Подробнее см. 
в разделе Настройка опций автоаппликации.

Подсказка: 
При шитье объекта аппликации, машина останав-
ливается между слоями. Перед началом шитья ап-
пликации уложите ткань на проект и запустите ма-
шину. После прострачивания направляющей линии 
обрежьте излишек материала аппликации и снова 
запустите машину для выполнения закрепляющих и 
покрывающих стежков.

Как создавать объекты аппликации с использо-
ванием функции Applique.
1  Загрузите рисунок. См. также Загрузка изобра-
жений. 
2  Щелкните по значку Applique в режиме посмотра 
Design или Artistic View. 
3  Оцифруйте контур аппликации, наметив базис-
ные точки вокруг контура фигуры.
•   Щелкните для создания угловой точки.
•  Щелкните правой кнопкой, чтобы создать точку 
кривой.

Подсказка: 
Следуйте указаниям в строке состояния, помо-
гающим при оцифровывании. Если вы ошиблись, 
нажмите клавишу Backspace, чтобы удалить по-
следнюю базисную точку, и затем продолжайте 
оцифровывание.
4   Нажмите Enter для закрытия формы.
5  Щелкните по контуру, чтобы установить точки 
входа и выхода, или нажмите Enter, чтобы принять 
стандартные настройки. 
6    В зависимости от выбранного способа вывода 
пялец вам может быть предложено отметить пози-
цию вывода пялец. Подробнее см. в разделе На-
стройка опций автоаппликации.

•  Automatic (Автоматически): При выборе этой оп-
ции положение вывода пялец назначается автома-
тически.
•  Manual (Вручную): При активировании этой опции 
щелкните в ту точку, в которой должна быть позиция 
вывода пялец.

•  Place Under Cover Stitches (Положение под по-
крывающими стежками): Если выбрана эта опция, 
положение вывода пялец определяется местом по-
следнего прокола иглы перед тем, как произойдет 
выход пялец.
7   Нажмите клавишу Enter.
Фигура замкнута, и сгенерировано до  четырех сло-
ев вышивки - линия размещения, линия обреза, за-
крепляющие и покрывающие стежки. Подробнее см. 
в разделе Настройка параметров автоаппликации.

Примечание: 
Команда Ungroup (Разгруппировать) не действует, 
если выбран объект Auto Applique. Если вы хотите 
получить доступ к компонентам объекта, используй-
те инструмент Break Apart. Подробнее см. в разделе 
Разбивка объектов на компоненты.

Настройка параметров аппликации

Покрывающий стежок создает обрамление вокруг 
формы аппликации. Вы можете контролировать 
различные настройки, включая тип покрывающего 
стежка, шаг стежка, а также смещение по отноше-
нию к оцифрованному контуру.

Как настроить параметры функции аппликации
1  Дважды щелкните левой кнопкой или один раз 
правой кнопкой по объекту автоаппликации.

Позиция выхода пялец

Линия размещения 
(розовая)

Линия обреза
(фиолетовая)

Гладьевый 
валик

Закрепляющая 
строчка-загзаг 

(зеленая)

Используйте функцию Object Properties (панель 
General) для настройки свойств объекта.
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Откроется диалоговое окно Object Properties > 
Applique (Свойства объекта > Аппликация).

Подсказка: 
Чтобы настроить параметры до оцифровки без вы-
бранного объекта, откройте диалоговое окно Object 
Properties > Applique.
2   На панели выберите тип покрывающего стежка – 
гладьевый валик или краеобметочный стежок.

Примечание: 
Покрывающие стежки активируются по умолчанию.
Этим обеспечивается совместимость аппликаций, 
созданных в программе Explorations, где предус-
мотрена опция ‘No Border’ (Без обрамления), с ап-
пликациями, создаваемыми в BERNINA Embroidery 
Software.
3 Настройте ширину строчки и шаг покрывающего 
стежка:
•   Width (Ширина): введите ширину строчки гладье-
вого или обметочного стежка.

•   Spacing (Шаг стежка): введите шаг гладьевого или 
обметочного стежка.

4   При использовании гладьевого валика проставь-
те «галочку» в окошке Use Tackdown (Использовать 
закрепляющую строчку) и выберите ширину строчки 
и шаг стежков.

Ширина закрепляющей строчки не может быть боль-
ше ширины покрывающего стежка.

Примечание:
Закрепляющие стежки для обметочной покрываю-
щей строчки не предусмотрены. 
5   Выберите требуемые стили аппликации.
Имеются две опции – «линия размещения» (Placement 
Line) и «линия обрезки» (Cutting Line). Используй-
те линию размещения для укладки предварительно 
вырезанных лоскутов ткани. Используйте линию об-
резки для обрезки на месте лоскутов ткани. 

6   Используйте ползунок, чтобы сместить покры-
вающие стежки внутрь или наружу по отношению к 
линии размещения.

Ширина гладьевого 
валика: 2,5 мм

Закрепляющая строчка
 Ширина: уменьшена
Шаг стежка: увеличен

Закрепляющая строчка
Ширина:по умолчанию
Шаг стежка: по умол-

чанию

Закрепляющая строчка
Ширина: увеличена

Шаг стежка: уменьшен

Шаг обметочного 
стежка: 1,3 мм

Шаг обметочного 
стежка: : 2,0 мм

Ширина гладьевого 
валика: 1,0 мм

Выберите линию 
размещения и/

или обрезки

Настройте 
смещение  по-
крывающих и 

закрепляющих 
стежков
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Гладьевый стежок по умолчанию не смещен, а обме-
точный стежок смещен на 100 % внутрь.

7   Щелкните по Apply (Применить).
Текущие настройки будут применены к выбранным 
объектам.

Размещение тканей в проектах аппли-
кации

Диалоговое окно Object Properties > Applique со-
держит панель Fabric, которое позволяет выбрать 
ткань или однотонный цвет для детали вашей ап-
пликации.

Как размещать ткани в проектах автоапплика-
ции
1   Дважды щелкните левой кнопкой или один раз 
правой кнопкой по объекту автоаппликации. Откро-
ется диалоговое окно Object Properties > Applique 
(Свойства объекта > Аппликация).

2    Щелкните по Choose на панели Fabric, чтобы вы-
брать ткань или однотонный цвет для аппликации.

Откроется диалоговое окно Applique Fabric. 
Опции Fabric/Color/None позволяют вам выбрать 
ткань или однотонный цвет. По умолчанию  выбрана 
опция Fabrics (Ткани).

3  Прокрутите вниз панель, чтобы найти подходя-
щую категорию и щелкните по узлу дерева тканей 
для просмотра имеющегося диапазона, например 
‘Anniversary Florals’.
4   Щелкните по OK для применения к выбранному 
объекту аппликации.

Примечание:
Диапазон Benartex отображается как в диалоговом 
окне Patch Properties (Свойства лоскута). Подробнее 
см. в разделе Создание открытого объекта аппли-
кации.

5   Если вы предпочитаете назначить цвет детали ап-
пликации, выберите опцию Color (Цвет).

Смещение: 
внутрь

Смещение: 
отсутствует 

Смещение: 
наружу

Выберите между
тканью или

однотонным
цветом

Нажмите, чтобы 
просмотреть до-

ступные варианты

Образец показы-
вает текущую 
ткань, использу-
емую для аппли-
кации

Нажмите, чтобы 
выбрать ткань и 
цвет

Используйте функцию Show Appliqué Fabric (панель 
General), чтобы включать/отключать показ ткани/цве-
та аппликации.
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Диалоговое окно Applique Fabric преобразуется с 
отображением палитры цветов.

6   Выделите тональный диапазон – светлый (Light), 
средний (Mid) или темный (Dark) – и выберите цвет.

7    Щелкните по OK, чтобы закрыть диалоговое окно 
и вставить ткань в диалоговое окно Object Properties 
> Applique.

8    Щелкните по Apply для применения к выбранно-
му объекту аппликации.

Подсказка: 
Используйте переключатель Show Appliqué fabric 
(Показать ткань), чтобы включить или выключить 
отображение цвета / ткани аппликации.

Создание частичного покрытия объек-
тов аппликации

С помощью инструмента Remove Appliqué Overlaps 
можно создавать аппликации с частичным покры-
тием и без двойных контуров. Частичное покрытие 
применяется к нижней подложке.

Как создавать частичное покрытие объектов аппли-
кации.

1   Создайте форму аппликации функцией Applique; 
Подробнее см. в разделе Создание аппликации с 
функцией Applique.

2   Выберите объекты аппликации.

3   Щелкните по значку Remove Appliqué Overlaps.
При нахлестке объектов покрывающие стежки уда-
ляются, остаются только вторичные объекты – 
линии закрепления, размещения и обрезки.

Создание открытого объекта аппли-
кации

Техника аппликации занимает важное место в до-
машнем рукоделии, и функция Auto Applique облег-
чает достижение высокого качества работы. Однако 
иногда может потребоваться дополнительная гиб-
кость для расширения диапазона проектов, которые 
вы можете вышивать.

Щелкните по значку Remove Appliqué Overlaps (па-
нель Edit) для удажения полдожек.

Щелкните для
выбора цвета

Образец пока-
зывает текущую 
ткань или цвет

Частичное покрытие 

Непрострачиваемые 
части контура
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Например, проекты, содержащие открытые объек-
ты, не могут обрабатываться функцией Applique.

В этом проекте стебель в середине листа должен 
быть вышит после линий размещения и обрезки во-
круг контура листа, но раньше покрывающих стеж-
ков. Здесь может быть одна или две зоны ткани. 
Если имеется только один лоскут ткани, для стебля 
не требуются стежки размещения и закрепления.
Если имеются два лоскута, стебель, как и контур, 
должны быть снабжены стежками линий размеще-
ния и закрепления.
Еще одна проблема показана на проекте «Кролик». 
Вся форма состоит из открытых линий, порядок 
вышивания которых очень важен, например левое 
ухо должно быть сверху. Внутренняя часть кролика 
должна быть заполнена тканью, даже если ни одна 
из составляющих ее кривых не является замкнутой.

В обоих случаях вы захотите суметь ввести кривые в 
естественном порядке, если возможно, и правильно 
применить программу для замкнутых зон. В таком 
случае специальный инструмент Advanced Applique 
позволит создавать «объект открытой аппликации» 
из одного или нескольких «первичных» объектов. 

Контуры могут быть определены смешиванием объ-
ектов, как показано здесь.

Первичные объекты
Источник «первичных» объектов, используемых при 
создании открытого объекта аппликации, должен 
быть создан и расположен в последовательности до 
применения функции. Эти объекты не подвергаются 
каким-либо изменениям при их включении в откры-
тый объект аппликации. Могут быть использовано 
несколько типов источника объекта.
•   Любой тип оконтуривающего стежка – одинар-
ный, оконтуривающий гладьевый и др.
•   Любой замкнутый заполненный объект или
•   Любой оцифрованный блочный объект.
В комбинации с указанными выше объектами  могут 
быть использованы некоторые другие типы объек-
тов. В том числе текстовые объекты, автоаппликации 
и даже другие объекты открытой аппликации.

Примечание:
Если вышивальное ПО BERNINA Embroidery Software 
обнаруживает больше одной зоны, появляется опция 
объединения их в один лоскут. Подробнее см. в раз-
деле Соединение и разъединение лоскутов.

Вторичные объекты
Автоматически может быть сгенерировано до трех 
типов «вторичных объектов».
Линии размещения: Эти линии используются опци-
онально для обшивания первого слоя аппликации. 
Линии размещения применяются для позициониро-
вания предварительно вырезанных лоскутов аппли-
кации на материале заднего плана.
•   Линии обрезки: И в этом случае опционально ли-
нии обреза образуют направляющие при обрезании 
лоскута ткани на месте.
•   Линии размещения: Это первый уровень аппли-
кации. Используется для расположения патчей на-
резной аппликации на фоновом материале. 
•   Закрепление: Это строчка зигзаг или сметочные 
стежки, прокладываемые после разметки линий раз-
мещения и обрезки, которые используется для за-
крепления элементов аппликации к материалу фона 
перед покрывающим вышиванием.

Атласный 
контур

Block Digitizing 
(Блок оцифровки)

Blanket 
контур

Patch (лоскуток)



Каждый «граничный сегмент» генерирует линию 
размещения, линию обрезки и/или закрепляющую 
строчку в зависимости от текущих настроек.

Примечание:
Вторичные объекты шьются раньше первичных объ-
ектов и поэтому находятся ниже. Вы можете сами 
назначить цвет ниток каждого вторичного объек-
та или принять предложение программы BERNINA 
Embroidery.

Создание проекта открытого объекта 
аппликации

Для создания открытого объекта аппликации могут 
быть использованы разные типы «первичных объ-
ектов», в том числе любой тип оконтуривающего 
стежка - одинарный, оконтуривающий гладьевый и 
др. – любой объект с заполнением или любой оциф-
рованный блочный объект. Кроме того, могут быть 
использованы некоторые другие объекты, включая 
текстовые объекты, автоаппликации или даже от-
крытые объекты аппликации.

Примечание: 
По умолчанию проекты автоматически группируют-
ся при открытии или вставке в другой проект. Если 
вы открываете проект аппликации после сохране-
ния, вам потребуется вначале разгруппировать его, 
чтобы получить доступ к свойствам аппликации. 
Подробнее см. в разделе Настройка других общих 
опций.

Как создать проект открытого объекта аппликации
1   Создайте нужные вам объекты, чтобы включить 
покрывающие стежки проекта аппликации. Подроб-
нее см. в разделе Оцифровывание открытых форм.
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2   Назначьте свойства стежков и последователь-
ность шитья этих объектов.
3   Выберите все объекты, которые должны быть 
включить в открытый объект аппликации,  и щел-
кните по значку Advanced Applique. 
Вышивальное ПО BERNINA Embroidery определяет, 
содержит ли выделение по меньшей мере один объ-
ект, пригодный для оконтуривания, и правильно ли 
замкнута зона. Если эти условия соблюдены, соз-
дается открытый объект аппликации и открывается 
диалоговое окно Applique Properties.

Примечание:
Формы являются «правильными», если открытый 
объект аппликации создан первым. Это может соз-
дать эффект удаления сегментов малых деталей. 
Однако первичные объекты остаются неизменными.

4  Щелкните по опции Place Fabric and Color in 
Patches, чтобы добавить ткань или цвет. Подробнее 
см. ниже, в разделах Размещение ткани в лоскутах и 
Размещение цвета в лоскутах.

5   После завершения щелкните по Back.
6  Щелкните по кнопке Close, чтобы закрыть диа-
логовое окно.

Подсказка:
Открытые объекты аппликации можно выделять и 
обрабатывать тем же способом, что с группирован-
ные объекты, т.е. их можно перемещать, изменять 
размеры, перекашивать или поворачивать, исполь-
зуя тот же метод перетаскивания мышью, примени-
мый для всех объектов. Однако изменять форму от-
крытых объектов аппликации невозможно. 

Используйте кнопку Advanced Applique (панель 
Digitize) для создания открытого объекта аппликации 
из одного или нескольких источников объектов.

Зоны, входящие в объекты 
«приемлемого контура» мар-

кируются заштрихованным 
белым контуром



И при этом нет какого-либо способа, чтобы выбрать 
первичные или вторичные индивидуальные объек-
ты, в пределах открытого объекта аппликации, если 
объект не будет вначале обособлен Подробнее см. в 
разделе Разбивка объектов на компоненты.

Размещение ткани в лоскутах

Вы можете добавить образец ткани к открытому 
объекту аппликации, если он создан на первой или 
любой из последующих стадий.

Как разместить ткань в лоскутах
1  Если редактируется существующий открытый объ-
ект аппликации, дважды щелкните левой кнопкой 
или щелкните правой кнопкой по объекту. Откроет-
ся диалоговое окно Applique Properties (оно может 
быть открыто, если вы уже создали объект).

2 Активируйте опцию Place Fabric and Color in 
Patches. Диалоговое окно изменится, будет показа-
на панель Place Fabric in Patches (Размещение ткани 
в лоскутах).

Примечание:
На панели Used Fabrics and Colors (Используемые 
ткани и цвета) могут быть уже предварительно вы-
бранные опции.
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3  Выберите ткань из дерева тканей, – например 
‘Vintage Shirtings’,– или из панели Used Fabrics and 
Colors (Используемые ткани и цвета).
4   Переместите указатель мыши по зоне проекта. 
Вокруг любой замкнутой формы, по которой пере-
мещается указатель мыши, появится белый контур
5   Щелкните по зоне, которая в настоящее время 
заштрихована или заполнена. Зона заполнится вы-
бранной тканью, и образец будет добавлен в поле 
Used Fabrics and Colors (Используемые ткани и цве-
та).

Примечание:
Для каждого нового созданного лоскута создают-
ся вторичные вышитые объекты с использованием 
принимаемых по умолчанию типов стежка и цвета 
ниток. Подробнее см. в разделах Настройка цвета 
стежков и Настройка типа стежков.
6   Выберите другие требуемые зоны, чтобы доба-
вить больше лоскутов. 
7   После завершения щелкните по Back.
8   Щелкните по кнопке Close, чтобы закрыть диало-
говое окно. Альтернативно для активирования дру-
гих опций щелкните по Place Color in Patches (Раз-
мещение цвета в лоскутах) или Remove Fabric from 
Patches (Удаление ткани из лоскутов). Подробнее 
см. ниже, в разделах Размещение цвета в лоскутах и 
Удаление ткани или цвета из лоскутов.

Подсказка:
Используйте переключатель Show fabric (Показать 
ткань), чтобы включить или выключить отображение 
цвета / ткани аппликации.

Размещение цвета в лоскутах

Как разместить цвет в лоскутах:
1   Если редактируется существующий открытый 
объект аппликации, дважды щелкните левой кноп-
кой или щелкните правой кнопкой по объекту. От-
кроется диалоговое окно Applique Properties (оно 
может быть открыто, если вы уже создали объект).

Используйте функцию Show Appliqué Fabric (панель 
View), чтобы включать/отключать показ ткани/цвета 
аппликации

Вокруг любой замкнутой 
формы при перемещении 

указателя мыши появляется 
белый контур

Используйте функцию Show Appliqué Fabric (панель 
View), чтобы включать/отключать показ ткани/цвета 
аппликации



2 Активируйте опцию Place Fabric and Color in 
Patches. Диалоговое окно изменится, будет показа-
на панель Place Fabric in Patches (Размещение ткани 
в лоскутах).  На панели Used Fabrics and Colors (Ис-
пользуемые ткани и цвета) могут быть уже предва-
рительно выбранные опции.

Примечание: 
На панели Used Fabrics and Colors (Используемые 
ткани и цвета) могут быть уже предварительно вы-
бранные опции.
3   Выделите тональный диапазон – светлый (Light), 
средний (Mid) или темный (Dark), – используя один 
из трех переключателей в верхней части палитры.
4   Выберите цвет из цветовой палитры.
5   Переместите указатель мыши по зоне проекта. 
Вокруг любой замкнутой формы, по которой пере-
мещается указатель мыши, появится белый контур
6   Щелкните по оконтуренной зоне, которая в на-
стоящее время заштрихована или заполнена.
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Зона заполнится выбранной тканью, и образец будет 
добавлен в поле Used Fabrics and Colors (Используе-
мые ткани и цвета).

Примечание: 
Для каждого нового созданного лоскута создают-
ся вторичные вышитые объекты с использованием 
принимаемых по умолчанию типов стежка и цвета 
ниток. Подробнее см. в разделах Настройка цвета 
стежков и Настройка типа стежков.
7   Выберите другие требуемые зоны, чтобы доба-
вить больше цветов. 
8   После завершения щелкните по Back.
9  Щелкните по Close, чтобы закрыть диалоговое окно.
Альтернативно для активирования других опций 
щелкните по Place Fabric in Patches (Размещение 
ткани в лоскутах) или Remove Fabric from Patches 
(Удаление ткани из лоскутов). Подробнее см. ниже, 
в разделах Размещение цвета в лоскутах и Удаление 
ткани или цвета из лоскутов.

Подсказка:
Используйте переключатель Show Appliqué fabric 
(Показать ткань), чтобы включить или выключить 
отображение цвета / ткани аппликации.

Удаление ткани или цвета из лоскутов
Вы можете удалять цвета или ткани из открытого 
объекта аппликации на любой стадии.

Как удалить ткани или цвета из лоскутов
1   Дважды щелкните левой кнопкой или один раз 
правой кнопкой по открытому объекту аппликации.
Откроется диалоговое окно Applique Properties 
(Свойства аппликации).

2   Активируйте опцию Remove Fabric from Patches 
(Удаление ткани из лоскута).

Вокруг любой замкнутой 
формы при перемещении 

указателя мыши появляется 
белый контур



Диалоговое окно изменится, будет показана панель 
Remove Fabric from Patches.

3   Переместите указатель мыши по зоне проекта.
Вокруг любой замкнутой формы, по которой пере-
мещается указатель мыши, появится белый контур
4    Щелкните по оконтуренной зоне, которая в на-
стоящее время заштрихована или заполнена. Лоскут 
ткани или цвет заменяется с белым заштрихованием 
и все сопутствующие вторичные объекты удаляются. 

Примечание:
Ткань или цвет удаляются также из панели Used 
Fabrics and Colors, если они использовались в каче-
ство примера ткани или цвета. 
5   Выберите другие требуемые зоны, чтобы удалить 
больше лоскутов. 
6   После завершения щелкните по Back.
7  Щелкните по Close, чтобы закрыть диалоговое 
окно. Альтернативно для активирования других оп-
ций щелкните по Place Color in Patches (Размещение 
цвета в лоскутах) или Place Fabric in Patches (Раз-
мещение ткани в лоскутах). Подробнее см. ниже, в 
разделах Размещение ткани в лоскутах и Размеще-
ние цвета в лоскутах.

Соединение и разъединение лоскутов

На показанном ниже примере может быть одна или 
две зоны ткани. Если имеются два лоскута, стебель, 
как и контур, должны быть снабжены стежками ли-
ний размещения и закрепления. Если имеется только 
один лоскут ткани, для стебля не требуются стежки 
размещения и закрепления. В этом случае две зоны 
ткани требуется объединить в одну. 
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Как соединять и разъединять лоскуты
1   Дважды щелкните левой кнопкой или один раз 
правой кнопкой по объекту Advanced Applique.
Откроется диалоговое окно Applique Properties 
(Свойства аппликации).
 

2   Выберите опцию Merge Patches Together (Сое-
динение лоскутов). Откроется панель Merge Patches 
Together.

3    Выберите подлежащий присоединению лоскут.
Вокруг контура появится красная линия.
4    Наведите указатель мыши на второй лоскут. Этот 
элемент может быть заполнен или не заполнен тка-
нью или цветом. Вокруг контура появится белая ли-
ния.
5  Щелкните по лоскуту. Оба лоскута сольются в 
единый лоскут, приняв ткань или цвет первого эле-
мента. Все вторичные стежки удаляются из сегмен-
тов контура перед слиянием лоскутов.



Подсказка: 
Чтобы разъединить соединенные лоскуты, активи-
руйте на любой стадии опцию Unmerge Patches и 
щелкните по разъединемому лоскуту.

6  Нажмите Back (Назад), чтобы закончить.
7 Щелкните по Close, чтобы закрыть диалоговое 
окно.

Подсказка:
Используйте переключатель Show fabric (Показать 
ткань), чтобы включить или выключить отображение 
цвета / ткани аппликации.

Настройка цвета стежков
Вы можете установить цвета автоматически или 
вручную. Для любого создаваемого вновь открытого 
объекта аппликации вторичные объекты создаются 
с использованием автоматического выбора цвета 
стежков. Имеются две опции: Special colors for each 
layer (Специальные цвета для каждого слоя) и Match 
color of cover stitching .(Соответствие цвета покры-
вающих стежков).  См. также раздел Настройка типа 
стежков.

Как настроит цвет стежков
1 Дважды щелкните левой кнопкой или один раз 
правой кнопкой по объекту Advanced Applique.
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Откроется диалоговое окно Applique Properties 
(Свойства аппликации).

2   Выберите опцию Set Colors Automatically (Авто-
матическая установка цвета). Откроется диалоговое 
окно Automatic Stitch Colors (Автоматическая уста-
новка цвета стежков).

3   Выберите одну из цветовых схем из имеющихся 
опций:
•   Match color of cover stitching (Подбор соответству-
ющего цвета покрывающих стежков): Если выбрана 
эта опция, все вторичные объекты показываются в 
цвете сопутствующих им   первичных объектов.
•   Special colors for each layer (Специальные цвета 
для каждого слоя): Если выбрана эта опция, все вто-
ричные объекты показываются и вышиваются ото-
браженными на панели цветами (выбраны для более 
четкого отображения на экране).

Примечание:
Использование ниток показанного на экране цвета 
не обязательно, но цвет отдельных ниток для всех 
вторичных объектов должен в полной мере соче-
таться с цветом ткани основы аппликации 

4   Щелкните по OK для завершения.
5  Щелкните по Close, чтобы закрыть диалоговое 
окно.

Настройка типа стежков
У вас имеются две опции для настойки типа стежка, 
используемого для вторичных объектов: автомати-
ческий или ручной способ.. Для автоматической на-
стройки вам нужно просто активировать опцию Set 
Stitch Types Automatically (Автоматическая настойка 
типа стежков) в диалоговое окне Applique Properties. 
Типы стежков для всех закрепляющих строчек уста-
навливаются в соответствии с типом покрывающего 
стежка следующим образом:



4   Выберите вторичные объекты, которые вы хотите 
включить в открытый объект аппликации:
•   Линии размещения: Эти линии используются оп-
ционально для обшивания первого слоя апплика-
ции. Линии размещения применяются для позици-
онирования предварительно вырезанных лоскутов 
аппликации на материале плана.
•   Линии обрезки: И в этом случае опционально ли-
нии обрезки образуют направляющие при обреза-
нии лоскута ткани на месте.
•   Закрепление: Это строчка зигзаг или сметочные 
стежки, прокладываемые после разметки линий раз-
мещения и обрезки, которые используется для за-
крепления элементов аппликации к материалу фона 
перед покрывающим вышиванием.
5   Установите цвет отображения для каждого из 
вторичных объектов – линий размещения, линий об-
резки и/или закрепления, - которые вы выбираете.

Примечание: При ручном выборе цветов, любое вы-
полненное вами изменение автоматически отменя-
ет ранее выбранный цвет. Подробнее см. в разделе 
Настройка цвета стежков.
6   Если вы хотите включить закрепляющие стежки, 
выберите требуемый тип:  

Зигзаг: В этом случае имеется выбор: 
• Stitch width (Ширина строчки): устанавливается 
ширина зигзага.
•  Spacing (Шаг стежка): устанавливается шаг зигзагов.
•  Color (Цвет):  устанавливается цвет стежков.
• Offset (Смещение): устанавливается положение 
строчки по отношению к вторичному объекту, как 
показано на рисунке:

Сметочный стежок: В этом случае имеется выбор:

•  Stitch length (Длина стежка): устанавливается дли-
на стежка, подходящая для оцифрованной формы, - 
для кривых с резкими изгибами выбирается меньшая 
длина стежка, для пологих кривых можно увеличи-
вать длину стежка для сокращения общего количе-
ства стежков.

•   Если в качестве покрывающих используются окон-
туривающий гладьевый стежок, заполняющий гла-
дьевый стежок, заполняющий простегивающий сте-
жок или заполнение орнаментными стежками, для 
закрепления выбирается зигзаг.
•   Если покрывающими являются стежки другого 
типа, то для закрепления используется переходной 
стежок.
Если требуется более тщательно подбирать типы 
стежков, используемых для линий размещения, об-
резки и закрепления, используйте следующую про-
цедуру. При ручном выборе цветов, любое выпол-
ненное вами изменение автоматически отменяет 
выбранный цвет.
Как настроить тип стежков
1   Дважды щелкните левой кнопкой или один раз 
правой кнопкой по объекту Advanced Applique.
Откроется диалоговое окно Applique Properties 
(Свойства аппликации).

2   Выберите опцию Set Stitch Types Manually (На-
стройка типа стежков вручную). Откроется панель 
Set Properties Manually (Ручная настойка свойств).

3   Для активирования панели Set Properties Manually 
выберите сегмент контура следующим образом:
•   При наведении указателя мыши на индивиду-
альный сегмент контура, он подсвечивается белым. 
Если вы наведете указатель мыши на заполненный 
элемент, то подсвеченным белым будет весь контур 
лоскута. Если вы затем щелкните мышью, подсве-
ченный участок будет выделен. Контуры выделен-
ных сегментов окрасятся в пурпурный цвет.
•   Если удерживать нажатой клавишу Ctrl при под-
свеченном контуре или сегменте контура, подсве-
ченная часть добавляется к выделению, если она не 
была выделена, или удаляется из выделения, если 
она была выделена.
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Выберите 
тип закре-
пляющего 

Закрепляющие стежки
Смещение: наружу

Шаг уменьшен

Закрепляющие стежки
Смещение: нет
Шаг по умолч.

Закрепляющие стежки
Смещение: внутри

Шаг увеличен



длина стежка, для пологих кривых можно увеличи-
вать длину стежка для сокращения общего количе-
ства стежков.

•  Color (Цвет):  устанавливается цвет стежков.
7  Для возврата щелкните по Back.
8  Щелкните по Close, чтобы закрыть диалоговое окно.

Восстановление оригинальных проек-
тов вышивки
Первичные объекты могут быть восстановлены в 
любое время. Вышивальное ПО BERNINA Embroidery 
удалит все вторичные объекты, разгруппирует пер-
вичные объекты и преобразует их в индивидуаль-
ные объекты. См. также раздел Разбивка объектов на 
компоненты.

Как восстановить оригинальные проекты вы-
шивки
1  Дважды щелкните левой кнопкой или один раз 
правой кнопкой по объекту Advanced Applique. От-
кроется диалоговое окно Applique Properties (Свой-
ства аппликации).

2 Активируйте опцию Recover your original 
embroidery objects (Восстановить ваш оригинальный 
проект вышивки). Будут удалены все вторичные объ-
екты и разгруппированы все первичные объекты.

3  Щелкните по Close, чтобы закрыть диалоговое окно.

Примечание: Если весь открытый объект апплика-
ции был изменен по размеру, перемещен или пере-
кошен, первичные объекты будут восстановлены в 
трансформированном состоянии.
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Глава 26
Рельефная вышивка

BERNINA Embroidery Software предоставляет инструменты и техники для превращения 
плоской вышивки в рельефную или скульптурную. 
Stumpwork – разновидность рельефной вышивки. Созданная на опорной ткани, она 
переносится на фоновую. BERNINA Embroidery Software позволяет просмотреть все де-
тали такого проекта в одном окне. В тоже время каждый элемент может быть отредак-
тирован и отправлен на машину индивидуально. 

Quilting создает многомерные заполненные области. В BERNINA Embroidery Software 
эта функция состоит из 2х компонентов: Raised Satin – эффект мягкой гладкой вышив-
ки и Trapunto Outlines – эффект тени контура. 
Декоративная отделка ткани или «войлок» популярна при создании войлока без воды. 
В BERNINA Embroidery Software инструмент PunchWork позволяет создавать такие объ-
екты в режиме BERNINA Rotary Hook Punch. 
Данная глава описывает инструменты и техники для создания мягкой и скульптурной 
вышивки, проектов stumpwork, quilt и декоративной отделки ткани. 
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• Оцифруйте дополнительную проволоку, чтобы
укрепить форму.

Рекомендации для машины

Вот некоторые рекомендации для производства: 

• Используйте лапку 44C. Она прозрачная и доста-
точно крупная, чтобы удержать проволоку на месте 
при движении ткани. 

• При вышивке по проволоке используйте контроль
лапки – так проще начать и остановит работу. 

• Снизьте скорость работы плавным контролем.

• После прошивки проволоки можно перейти на
высокую скорость. 

• При работе с объектами в которых проволока есть
и в контуре и в заполнении, например лист с жила-
ми, сначала прошивается заполнение и только по-
том контур. Таким образом игла не будет цеплять 
внутреннюю проволоку при прошивке внешней 

• Или просто обрежьте проволоку немного короче,
чем вышивка. Таким образом все прошьется до кра-
ев без пробелов. 

Пользовательский интерфейс StumpWork

Интерфейс StumpWork имеет 3 основных компонента: 

Панель инструментов StumpWork

Stumpwork в BERNINA Embroidery Software созда-
ется средствами панели StumpWork. Здесь есть все 
необходимое для создания проекта с нуля или из 
существующей вышивки. См. Панель инструментов 
StumpWork. 

Докеры StumpWork
Докеры StumpWork Border позволяют пред-
устанавливать характеристики проекта.

Вышивка Stumpwork 

Stumpwork – разновидность рельефной вышивки. 
Созданная на опорной ткани, она переносится на 
фоновую. Вышивка становится объемной при ис-
пользовании обивки, бисера, проволоки и кружев. 

Самое сложное здесь – вывести весь проект на экран. 
BERNINA Embroidery Software позволяет просмотреть 
все компоненты в одном окне. В тоже время каждый 
элемент может быть отредактирован и отправлен на 
машину индивидуально.

Вышивка Stumpwork
Stumpwork состоит из 2х основных элементов:

Элемент Требования Примечание 

Обрезка
Обязательное, с или 
без дополнительных 
стабилизирующих 

линий

В ручную или инструмен-
том BERNINA CutWork

Заполнение Обязательное На вышитой или простой 
ткани

Проволока Опция
Состоит из размещения, 
покрывающих стежков и 

лавирования

Base design Опция Часто используется вместе 
с вышивкой stumpwork

Сценарии Stumpwork 
Вышивка Stumpwork обычно следует одному из 2х 
сценариев:

• Создание stumpwork на основе  существующего
проекта

• Оцифровка stumpwork с нуля при помощи ткани
и проволоки

Панель 
инструмен-
тов в меню 
StumpWork 



Глава 26. РЕЛьЕФНАЯ ВыШИВКА

BERNINA® Embroidery Software: Руководство по работе с программами 228

Component 
(определения) Примечания

Cutting line (линия об-
резки)

Линию обрезки можно создать 
инструментом CutWork tool или 
в ручную. Настройки Clearance 
позволяют сделать зазор между 
вышивкой и линией обрезки. 

† Mandatory (Обязательно)

Настройки проволоки 
Stumpwork чаще всего использует проволоку для 
создания заполнения и формы. Прежде всего не-
обходимо прошить направляющую для проволоки. 
Далее – вшить ее в направляющую. И наконец – сде-
лать покрывающие швы, как правило гладью. 

Свойства объекта можно регулировать с помощью 
специальной вкладки Wireline.

Если вы выбрали WireLine качестве типа вышивки, 
следующие свойства можно устанавливать:

Настройки Примечания

Tackdown stitching
Датчик определяет ширину и ход 
направляющей. Это можно учиты-
вать при обрезке или использо-
вать значения по умолчанию. 

Cover Satin (гладь)
по умолчанию. Такде может ис-
пользоваться стёжка. Ширина и 
положение настраиваются.

Также здесь можно регулировать настройки. См. Ре-
дактирование stumpwork.

Примечание:
Нажмите на иконку Object Properties – настройки 
каждого элемента.

Компоненты Stumpwork 
Stumpwork содержит некоторые или все компонен-
ты. На машине каждый отделяется остановкой. 

Component 
(определения) Примечания

Stabilizing (стабилизация)
Run 1

Только для stumpwork. Run 1 не 
нужен при применении прово-
локи, но может применяться к 
другим типам.

Embroidery (вышивка)
border

Чаще всего stumpwork использует 
проволоку, но и бругие контуры 
тоже применимы
Stop (остановка): При использо-
вании проволоки все остановки 
выключены. См. ниже.

Stabilizing (стабилизация)
Run 2

не только для stumpwork. Run 2 в 
основном используется для ста-
билизации ткани при обрезке.
Stop: обрезка в ручную или ин-
струментом stumpwork.

† Mandatory (Обязательно)

Предпросмотр текущих настроек 
границ stumpwork 

Ненужно при использовании 
проволоки, но применяется для 
других типов

Вышивка границ Stumpwork – 
обычно проволока, но может 
быть и глади или что-то еще 

Стабилизация 2 – стабилизирует 
ткань при обрезке 

Выберите обрезку в ручную или 
инструментом BERNINA CutWork

Направляющая 
для проволоки

Пришивка 
направляющей

Прокрываюшие
швы

Stumpwork
wireline
properties
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Объект будет создан в докере StumpWork Border с 
текущими настройками.

2  Выберите объекты и нажмите Create Stumpwork 
Sub-design. Выделенные объекты объединятся в 
один и станут отдельным слоем конструкции. Он 
отойдет в конец последовательности вышивки, так 
что может быть вышит отдельно. 
3 Или используйте инструмент Digitize Wireline, 
чтчобы добавить проволоку для поддержки формы. 
См. Оцифровка дополнительной проволоки. 
4 Редактируйте объекты нажатием или двойным 
щелчком по Open StumpWork. Редактируйте направ-
ление проволоки, ширину глади, смещения и т.д. 
При желании можно добавить он, соответствующий 
ткани. См. Редактирование stumpwork. 

Создание проекта stumpwork с тканью и проволокой

Оцифровка с проволокой и границей – самый про-
стой способ создать stumpwork. Он включает в себя 
создание простой границы stumpwork. Обычно это 
вышивается на отдельном куске ткани (черновом), 
затем вырезается и присоединяется к основному 
проекту. Необходимые инструменты перечислены 
ниже.

Создание проекта stumpwork с тканью 
и проволокой
1 Инструмент Digitize Open Border - создание об-
резных объектов stumpwork, так же как и других. 
Оцифруйте форму и нажмите Enter. 

Toolbox > Save Stumpwork Sub-design As – сохранить 
субпроект отдельным файлом.

Toolbox > Digitize Open StumpWork Border – оциф-
ровка открытой формы на основе существующей и с 
текущими настройками.

Toolbox > Create Stumpwork Sub – создание субпро-
ектов с выбранными объектами и границами.

StumpWork > Digitize Wireline – создание объекта с 
проволокой на основе существующего и текущих на-
строек.

StumpWork > Open StumpWork – просмотр или ре-
дактирование субпроектов.

General > StumpWork Border – открыть докер  
StumpWork Border.

Направляющая 
для проволоки

Пришивка 
направляющей

Прокрываюшие
швы

Фон ткани добавлен
в stumpwork объект
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Создание stumpwork на основе суще-
ствующего проекта
1 Откройте проект или создайте новый. Добавьте 
любые эффекты стежков. 

2  Нажмите иконку StumpWork Border – открыть до-
кер. Отрегулируйте настройки. См. Докер StumpWork 
Border. 
3  Выделите все и нажмите Create StumpWork Border 
– создать вырезной объект. Откроется окно Create 
StumpWork Border. Оно дает доступ к Свойствам 
объекта.

4   Отрегулируйте настройки типа и положения гра-
ницы. См. Свойства проволочного объекта.

5  Нажмите OK, чтобы продолжить.

Подсказка:
Изучите проект StumpWork_Sample1 в папке проек-
тов. Попробуйте его вышить. Сверьтесь с документа-
цией машины BERNINA. 

Создание stumpwork на основе суще-
ствующего проекта 

Здесь необходимо выбирать формы, из которых 
создаются вырезные объекты. Обычно используется 
проволока, но это не обязательно. Результат выши-
вается отдельно с проволокой и границей. После он 
вырезается и пришивается или прикрепляется в про-
екту. Инструменты описаны выше.

Toolbox > Create StumpWork Border – создает границу 
stumpwork из выбранного объекта

Toolbox > Create Stumpwork Sub-design – созда-
ет под-проект stumpwork из выбранных объектов, 
включающих вышивку, ограниченную границей 
stumpwork

StumpWork > Open StumpWork  - просмотр и редак-
тирование под-проекта  stumpwork

General > StumpWork Border – открывает докеры 
StumpWork Border.. 

Base embroidery from
which stumpwork will

be created

Отрегулируйте 
настройки типа 
границы

Отрегулируйте 
настройки поло-
жения границы
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Оцифровка дополнительных проволок

Так можно оцифровать дополнительные проволоки 
поверх объекта/ов. Дополнительная проволока дает 
более четкий контур.

Оцифровка дополнительных проволок

1  Создайте границу stumpwork в ручную или из 
существующей. См. Создание stumpwork на основе 
существующей вышивки.

2  Перед выбором объектов нажмите Create 
Stumpwork Sub-design, выберите инструмент 
Digitize Wireline. 
3   Оцифруйте дополнительную проволоку также, 
как любой другой открытый объект. 

Вам будет предложено отметить точки обрезки про-
волоки. Все выделенные объекты автоматически бу-
дут сгруппированы.

6  Вы берите группу объектов и нажмите Create 
Stumpwork Sub-design. Выделенные объекты объ-
единятся в один и станут отдельным слоем кон-
струкции. Его можно редактировать нажатием или 
двойным щелчком на Open StumpWork. См. Редак-
тирование stumpwork.

Подсказка:
Изучите проект StumpWork_Sample2 в папке проек-
тов. Попробуйте вышить его. Сверьтесь с докумен-
тацией машины BERNINA.

Концы 
проволоки

Объекты Stumpwork раз-
мещены в конце последова-

тельности вышивания

StumpWork > Digitize Wireline – создание объектов на 
основе существующих границ и текущих настроек. 

Созданы
границы
Stumpwork
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Редактирование  stumpwork

Как только применяется функция Create Stumpwork 
Sub-design stumpwork станет отдельным слоем кон-
струкции. Он отойдет в конец последовательности 
вышивки, так что может быть вышит отдельно. Объ-
екты Stumpwork могут редактироваться как само-
стоятельные проекты. Инструменты описаны выше. 

Редактирование  stumpwork

•    Выберите объект. 

•  Кликните на него дважды или нажмите Open 
StumpWork.  В отдельном окне редактирования от-
кроется проект stumpwork.

•  Докером  StumpWirk Border отредактируйте гра-
ницу, например, добавьте стабилизаторов или ли-
нии обрезки. См. Докер StumpWork Border.

Положение, направление и покрывающие швы соз-
даются автоматически.

4   Задайте последовательность объектов для докера 
Color Film. 
5  выделите все и нажмите Create Stumpwork Sub-
design (субпроект). Выделенные объекты объединят-
ся в один и станут отдельным слоем конструкции.

Подсказка:
Посте создания объекта дополнительная проволо-
ка может быть добавлена в режиме редактирования 
вместе с изменением последовательносмти объек-
тов, цветом, стежками и т.д. См. Редактирование 
stumpwork.

Toolbox > Save Stumpwork Sub-design As – сохранить 
под-проект отдельным файлом.

StumpWork > Open StumpWork – псмтотр или редак-
тирование под- проектов.

StumpWork > Digitize Wireline – создание объекта с 
проволокой на основе существующего и текущих на-
строек.

View > Show StumpWork – скрыть/показать под-
проекты.

Задайте 
последова-
тельность 
объектов

Готовый 
объект 
размещен 
в конце 
последова-
тельности 
вышивки

Проволока
добавлена

Редактировать свойства 
stumpwork, такие как тол-
щина проволоки, ширина 
атласного покрытия и т.д.
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•  File > Close – возврат к основному проекту. 
Если Вы не сохранили изменения, появится запрос. 

•  Переключатель Show StumpWork -  скрыть/пока-
зать объекты.

Визуализация stumpwork

•  Нажмите иконку Object Properties - свойства объ-
екта каждого компонента. Редактируйте направле-
ние проволоки, ширину глади, смещения и т.д.

•  Оцифруйте другие объекты. Инструмент Digitize 
Wireline – добавить проволоку для дополнительной 
фиксации формы. См. Оцифровка дополнительной 
проволоки.

•  В докере Color Film задайте последовательность 
объектов.

•  Design > Background – определение типа ткани 
при создании stumpwork тканью и проволокой.

•  Нажмите Save, чтобы сохранить изменения. Или 
нажмите Save Stumpwork Sub-design, если хотите 
сохранить часть как отдельный проект.

Просмотр теку-
щих настроек 
границ 

Нажмите на 
стрелку, чтобы 
увидеть свойства 
объекта каждого 
компонента

Добавьте 
фоновую 
ткань

StumpWork > Open StumpWork – просмотр или ре-
дактирование под-проектов.

Click General > Print Preview – предварительный 
просмотр на экране

View > Show StumpWork  показать или скрыть лю-
бой под-проект stumpwork , входящим в состав 
проекта
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Чтобы распечатать элементы конструкции 
stumpwork, откройте объект stumpwork в отдельном 
окне.

Подсказка:
Изучите проект StumpWork_Sample3 в папке проек-
тов. Попробуйте вышить его. Сверьтесь с докумен-
тацией машины BERNINA.  

Вышивка типа квилта 
Quilting создает многомерные заполненные обла-
сти. В BERNINA Embroidery Software эта функция со-
стоит из 2х компонентов: Raised Satin – эффект мяг-
кой гладкой вышивки и Trapunto Outlines – эффект 
тени контура.

При предварительном просмотре проекта отобра-
жаются весь проект Stumpwork, но только основная 
часть в режиме Color Film.

Окно предварительного просмотра показывает весь 
проект stumpwork в превью, но только базовые эле-
менты в цвете.

Базовые 
элементы
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Quilting в BERNINA Embroidery Software

В BERNINA Embroidery Software проект quilting осно-
вывается на 2х инструментах: 

•  Raised Satin: Позволяет создавать объемную вы-
шивку. Контуры могут использоваться для букв и 
каллиграфии. См. Создание произвольной формы 
вышивки. 

•  Trapunto Outlines: Превращает объемную вышивку 
в проект trapunto quilting. 

Объемная вышивка позволяет создавать проекты со 
многими слоями глади. Это альтернатива разным 
наполнителям. Trapunto позволяет сшивать слот 
ткани через гладь.
Функция Trapunto Outlines используется только с 
Raised Satin, и создает эффект стёганной вышивки. 
При включенной функции программа по умолчанию 
переходит к следующему неиспользованному цвету 
и заставляет машину остановиться перед прошива-
нием контура trapunto. Это дает возможность раз-
местить лицевую ткань.

Подсказка
Изучите проект quilting в папке проектов. Попро-
буйте вышить его. Сверьтесь с документацией ма-
шины BERNINA.

Техники Quilting 
Существует ряд техник, создающих проекты 
trapunto. 
 

Примечание
Отрегулируйте монитор, чтобы проект правильно 
отображался в режиме 3D, Raised Satin, Artistic View. 
См. Регулировка монитора. 

Техники Trapunto  

В ручную trapunto вышивают с 2мя слоями ткани и 
контуром мотива. Подкладку потом надрезают и за-
полняют шерстью или ватой. 
В современной технике trapunto – иногда машинное 
trapunto или надрезное trapunto – место надреза 
помечают смываемым маркером. Слой ватина при-
жимается к ткани и прошивается вместе. Ватин при-
жимается ближе ко шву, чтобы создать объем. Quilt 
затем прошивается в лицевой стороны к изнаночной 
с ватином посередине. 

Выпуклая гладь

Этот метод вместо наполнителя использует слои 
нити. Сначала конструкция прошивается на водо-
растворимом стабилизаторе Aqua Mesh. Затем ли-
цевой и подкладочный слои сшивают вместе вокруг 
проекта. См. Создание заполнения гладью. 

Примечание
Рекомендуемые настройки для глади: ручной подъ-
ем 0.3 мм в 4 слоя.

Регулировка 
глади

Edit > Create Trapunto Outlines в сочетании с 
Raised Satin – создание вышивки quilt с эффектом 
объема.
Stitch > Raised Satin Fill – создание проектов со 
многими слоями глади.

Stitch > Raised Satin Outline – создание гладевого 
контура – может использоваться с  trapunto.

Отрегулируйте 
смещение и 
толщину на-
бросков
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Фелтинг с программой BERNINA 
Embroidery Software

В BERNINA Embroidery Software инструмент 
PunchWork позволяет создавать «валяные» объекты 
и проекты при помощи BERNINA Rotary Hook Punch.

Параметры PunchWork
 
Параметры  punchwork такие же, как для апплика-
ции. Методы оцифровки тоже идентичны. См. Соз-
дание аппликации из замкнутых объектов.

Punchwork состоит из нескольких шагов, каж-
дый из которых, кроме собственно прокалывания 
(punching), является опцией. Перед выполнением 
каждого следующего  шага в последовательности 
шитья машина останавливается.

Игольный фелтинг 

Игольный фелтинг – это техника изготовление «во-
йлока» без воды. Он может быть создан промыш-
ленно, при помощи иглы для эффекта войлока, или 
с помощью приложения BERNINA, имитирующего 
иглу, или даже в ручную. 

Иглы, используемые для фелтинга имеют небольшие 
бородки с мягкими плечами. При проникновении в 
ткань-основу они протягивают волокна или «ровни-
цу». Потом бородка опускается, волокна остаются, 
а игла выходит обратно. Так можно прорабатывать 
мелкие детали, используя 1 или малую группу игл. 
Используется для работ 2D и 3D. 

Инструмент BERNINA Rotary Hook Punch 
Инструмент BERNINA ‘needle-punch’ – кластер из 
трех игл для пробивания волокон через ткань. Этот 
процесс, как правило, выполняется, как шитье сво-
бодного движения, но также может выполняться на 
пяльцах. 

Параметры 
фелтинга 

аналогичны  
аппликациям

Digitize > PunchWork – создание войлока инстру-
ментом BERNINA Rotary Hook Punch.
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В данном случае стежки оцифрованы отдельно от 
контура.

Подсказка:
Найдите проект punchwork в папке проектов. По-
пробуйте вышить его. Сверьтесь с документацией 
машины BERNINA.

Шаги Рunchwork:

Component 
(определения) Примечания

Наметка 
(placement) 

Линия стежков, намечающая размещение 
войлочного объекта  (обязательный шаг).
Остановка машины: Поместите покры-
вающую ткань (roving)  внутри  линии 
наметки и замените оборудование на 
машине, включая ротационный челнок, 
аксессуары для панчинга (прокалывания), 
иглы для панчинга и игольную пластину

Punching 
(прокалывание)

Операция состоит из равномерных и 
«прыжковых» видов прокаливаний, обе-
спечивающих равномерное распреде-
ление проколов. Настройте плотность 
проколов (обязательно)
Остановка машины: Установите выши-
вальную иглу

Cutting line
(Линия обреза) Линия по краю области войлока

Остановка машины: физически обрежьте 
по линии обреза и удалите наметочные 
стежки.

Тackdown  
Если в проекте есть контур (граница) вы 
можете, например, применить стежки по 
контуру (tackdown)
Остановка машины: проверьте качество 
стежков

Покрывающие 
стежки (Cover 
stitch)

Включите границу (по умолчании – гла-
дью). Настройте ширину границы, отсту-
пы и плотность стежков (обязательно)

† Mandatory (Обязательно)

Подсказка: Перед вышивкой проверьте настройки 
ткани. Если Вы вышиваете поверх войлока, может 
понадобиться более тяжелый тип ткани. См. На-
стройки ткани.

Техника проекта
Вы можете управлять всеми компонентами техники 
punchwork . Проекты можно реализовать разными 
способами. Например, на рисунке внизу имеются 
только наметочный контур и область фелтинга.

Поверх проколотой области можно применить по-
крывающие стежки.

Между наметочным 
контуром и областью 
проколов имеется за-
зор, соответствующий 

ширине игл. 

Покрывающие 
стежки прошиты 
линиями поверх 

области punchwork 



В дополнение к CorelDRAW®, BERNINA Embroidery Software имеет дополнительные 
и самостоятельные приложения, которые можно подключить из Embroidery Canvas. 
Приложение BERNINA Cross Stitch позволяет создавать проекты или добавлять эле-
менты вышивки крестом. BERNINA Quilter – экспериментируйте с патчами и цветами, 
создавайте уникальные квилты. 

Данная глава рассказывает о приложениях BERNINA Cross Stitch и BERNINA Quilter ПО 
BERNINA Embroidery Software.
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Глава 27
Автономные приложения

Полный список приведен ниже.

Полный 
крест

 Вертикальный 
крест

Крест 
3/4

 Двойной 
крест

Крест 
1/2

 Удлиненный 
вертикальный 

крест

Крест
 1/4

 Удлиненный 
горизонтальный 

крест

Мини 
крест

 Одинарная 
линия

Французский 
узел

Введение в вышивку крестом

Вышивка крестом удобна для заполнения больших 
пространств с малым расходом нити. Также при-
меняется для границ и контуров. Подходит для до-
машней утвари, столового текстиля, детской одеж-
ды и народных мотивов. Иногда комбинируется с 
аппликацией. 
В отличие от машинной вышивки, где конструкции 
перегружены различными типами строчек, углов и 
эффектов, в вышивке крестиком можно только доба-
вить измерение и оттенки цветов. Так что в проектах 
крестом используют больше цветов. 

Типы вышивки крестом
Такая вышивка создается на квадратной матрице по 
пиксеям. Квадрат может вышиваться о любого края 
по диагонали. 



Крест 1/2
Это просто диагональный стежок в направлении / 
или \. Обычно используются для теней и затенен-
ностей. Стежок может идти от любого угла. Можно 
из 2х крестов ½ разного цвета сделать один полный 
крест.

Стежок может идти в обоих направлениях, в зави-
симости от нужного эффекта. Например, 1/2в пере 
будет идти одновременно в обоих направлениях.

Крест 1/4
Используется для вышивки более замысловатых узо-
ров.

Мини крест
Мини крест – 2 равных по длине стежка, пересека-
ющихся в центре и образующих букву X, но не за-
полняющих ¼ квадрата. Используется для глах или 
более плотного заполнения проекта. 

Вертикальный крест
Это сочетание вертикального и горизонтального 
стежков.

Заполнение крестом
При таком заполнении можно выбирать любой его 
тип. 

Заполнение полным крестом
Этот тип состоит из двух стежков наискосок в форме 
буквы X. Общий эффект заполнения зависит от того, 
какой шов внизу, а какой вверху. Поэксперименти-
руйте, чтобы найти нужный эффект. 

Крест 3/4
Вышивается сначала четверть стежка, потом еще по-
ловина. Если вышить в обратной последовательно-
сти, общий эффект изменится.

Примечание:
Длинная часть такого стежка может выглядеть так /, 
или так \.   Крест ¼ и крест ¾ разных цветов запол-
няют 1 квадрат. Поэкспериментируйте, чтобы найти 
нужный эффект.
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Полный крест

Крест 3/4

Сочетание крестов ¼ и 3/4

Крест 1/2

Крест 1/4

Мини крест



Французский узел
Французские узды изначально использовались в руч-
ной работе для создания выпуклого вида вышивки. 
Они использовались в «белом шитье» поверх тонкой 
хлопковой ткани и с тонкими шелковыми нитками. 

Французские узлы могут сочетаться с другими типа-
ми крестов. Используются для глазков, ручек, цве-
точных пестиков или вместо бисера – например, в 
украшениях на елке или точках над ‘i’. А еще как 
контуры. хорошо смотрятся с металликом или раз-
ноцветной нитью. Лучше вышивать крупными стеж-
ками. 

Границы крестом 
Крест может использоваться для прошивания гра-
ниц или контуров. Также крестики можно сочетать с 
другими типами стежков. 
Контур можно сделать Простой линией или Полным 
крестом или их сочетанием. Контур простой линией 
программа распознает как границу, а крестом – как 
заполнение. Это важно, когда нужно удалит контур, 
т.к. линия удаляется как контур, а крестики – нет. 

Граница простой линией 
Простая линия используется только для контуров и 
добавления деталей. Может разместиться в любой 
части квадрата. Нажмите на нужную сторону. Можно 
разместить линию на 1 стороне или сразу на всех 
4х. Может применяться к квадратам, к которым уже 
применен крест. 

Граница полным крестом
Полный крест может использоваться как декоратив-
ный контур. В таком случае тип контура будет со-
впадать с типом заполнения. 

Стежки можно прошивать по холсту диагонально, 
или по горизонтальной или вертикальной линии.

Двойной крест
2 полных креста, вышитых под углом  90º друг к 
другу. Напоминает звездочку. Используется по об-
стоятельствам, например для создания контура в 
ряд. 
 

Обычно, верхняя нить нижнего креста - стежок, ко-
торый лежит в 135 ° к горизонтали; а верхняя нить 
перекрывающего креста - горизонтальная.

Удлиненный крест
удлиненный крест – 2 равных по длине стежка, об-
разующих букву X. Есть 2 типа: 

•  Удлиненный горизонтальный 

•  Удлиненный вертикальный. 

Удлиненные горизонтальные кресты в длину только 
половина обычного креста, а вертикальный – поло-
вина в ширину. 
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Вертикальный крест

Двойной крест

Удлиненный крест

Французский узел

Граница простой линией 



Мини крест

Используется для глазков или для более плотного 
вида проекта.

Удлиненный крест
Вертикально и горизонтально удлиненные крестов 
состоят из стежков в форме буквы X. Они заполняют 
либо правую или левую, либо нижнюю или верхнюю 
части квадрата.

Сочетание стежков

Кресты 1/4, 1/2 и 3/4 могут быть объединены, что-
бы сделать разноцветные кресты. Также можно со-
четать мини кресты с удлиненными и со стежками 
контура. 

Начало работы с программой BERNINA 
Cross Stitch

Проект вышивки крестом предполагает различные 
техники оцифровки. Поэтому приложение BERNINA 
Cross Stitch имеет собственное окно проекта, откры-
вающееся через  ПО BERNINA Embroidery Software.

Это можно изменить, сменив тип заполнения.

Вариации стежков крестом
Вариации дробных швов можно комбинировать для 
создания различных эффектов. Это можно делать 
попиксельно или задавая порядок заполнения. Кре-
сты также можно по-разному комбинировать. См. 
Типы крестов. 

Крест 3/4
¼ и ¾ вместе создают закругленные края. См. За-
полнение крестами. 

Крест 1/2

½ может использоваться для создания воздушного 
эффекта. Также 2 таких креста разного цвета могут 
образовывать 1 полный крест. См. Сочетание стеж-
ков. 

Крест 1/4

¼ и ¾ могут сгладить округлые края. Такде при по-
мощи креста ¼ можно создать полный крест в 1-4 
цвета. См. Сочетание стежков. 
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Граница полным крестом

2 креста 1/2

Четыре 
полных мини 
крестов

Комбинация 
4-х мини-
крестов

Примеры удлиненных крестов

Нажмите, чтобы 
начать с угла 

Сочетание крестов 1/4, 
1/2 и 3/4

Сочетание вертикально и 
горизонтально удлинен-
ных крестов

Сочетание мини креста с 
частичными крестами

Сочетание цветных кон-
туров

Сочетание контуров и 
крестов

Полный крест 
из 4х ¼ разных 
цветов

2 креста ½ 
разных цветов 
образуют 1 
полный крест 

General > Application Launcher – доступ к приложе-
ниям – Portfolio, Cross Stitch и Quilter



•  В режиме Embroidery Canvas нажмите Application 
Launcher и выберите из списка Cross Stitch.

Откроется окно проекта BERNINA Cross Stitch.

Проекты Patchwork quilt

Patchwork и quilting имеют общие техники. BERNINA 
Quilter – полностью дизайнерское приложение, по-
могающее собрать кусочки патчей, вышивок и ап-
пликаций воедино. С BERNINA Quilter планируйте и 
размещайте блоки на экране, выбирайте ткань, до-
бавляйте такие объекты как аппликации и вышивки.
 
Patchwork 
Блок patchwork – набор патчей, сшитых вместе, как 
парило в простой форме, например прямоугольника. 
Патч - кусочек ткани сшитый с другими кусочками и 
образующий блок. Техника сшивания патчей вместе 
в один блок обозначается термином «piecing». 

Для начала работы с BERNINA Cross Stitch:
•  Запустите BERNINA Embroidery Software.

•  Детали в системе помощи BERNINA Cross Stitch 
Help.

Начало работы с patchwork и quilting 

Patchwork применятся при шитье блоков. BERNINA 
Quilter может использоваться для создания патчей в 
квилт проектах, как из существующих образцов, так 
и созданных в ручную. BERNINA Quilter – экспери-
ментируйте с патчами и цветами, создавайте уни-
кальные квилты. 
Блоки на квилте могут быть заполнены патчами или 
просто тканью. BERNINA Quilter содержит множество 
патчей и тканей, но Вы также можете отсканировать 
свои и сохранить их в библиотеке. 
Когда проект готов, его можно распечатать вместе 
с блоками, их конструкцией, размерами, деталями 
вышивки и обрезки. 
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Выберите Cross Stitch 

Заглавная строка 
Меню 

Основная панель 
инструментов

Закладки

Панель инструментов 
картинки/проекты 

(зависит от режима работы) 

Панель стежков и цвета
Строка состояния 



При правильном размещении ткани, можно создать 
иллюзию трехмерности. Яркие и не очень цвета 
расположены рядом, чтобы создать контраст между 
блоками. При работе с одним цветом, используйте 
разные ткани.

С BERNINA Quilter в квилт также можно добавлять 
аппликации и вышивки.

Планируйте, определяя заранее все размеры, коли-
чество блоков, границ и саше. Решите, какие именно 
блоки использовать и как распределять цвета. По-
пробуйте разные сочетания. 

Quilting 
Квилт – как трехслойный бутерброд: 
•  Верх: набор патчей, сшитых вместе, как правило в 
простой форме, например в форме прямоугольника, 
может включать в себя границы и саше. 

Поле блоки сшиваются как в прямоугольник, так и в 
форме ромбов.

хотя некоторые квилты имеют лоскутное расшире-
ния к краю, большинство имеют одну или несколько 
границ. Некоторые из них также имеют узкие поло-
ски ткани, которые называются ‘саше’, отделяющие 
блоки. Границы и саше могут менять вид квилта. Их 
можно использовать, чтобы смягчить и закруглить 
перегруженный проект. Границы также могут уве-
личить проект так, чтобы он подходил по размерам. 
В квилте может использоваться более 1 границы.

Во многих квилтах для изнанки используют одну и 
ту же ткань. Блоки создаются на основе контраста 
между светлой, средней и темной тканями. Для не-
которых проектов решающей может стать контраст 
цветов. Сначала лучше подобрать цвет фона, а по-
том подбирать к нему другие цвета проекта.
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Патчи/
кусочки

12 патч 
блоков

Граница с 
скошенными 

углами не 
саше

Один патч 
блок с ап-
пликацией 
объекта

Один патч 
блок с вышив-
кой объекта

С границами 
и саше 

Контраст между светлой, средней и темной тканями

Создание эффекта 3D Использование  
доминирующего цвета 

           Квадрат                                    Ромб

Блок патчей 
из отдельных 
патчей 



Таблица ниже дает примерные параметры самых 
распространенных размеров. Варьируется в зависи-
мости от используемых блоков.

Quilt Дюймы Сантиметры

Baby 36-45 x 45-54 90-115 x 115-137
Cot 42-48 x 54-60 107-122 x 137-152

Single 56-64 x 84-100 142-162 x 213-254

Double 70-80 x 84-100 178-203 x 213-254
Queen 76-84 x 90-104 193-213 x 228-264
King 92-100 x 90-104 234-254 x 228-264

Jumbo 120-124 x 120-124 304-315 x 304-315

Начало работы с  BERNINA Quilter

Запустите BERNINA Quilter из BERNINA Embroidery 
Software. 

Начало работы с BERNINA Quilter:

•  Запустите BERNINA Embroidery Software. 
•  В Embroidery Canvas нажмите Application Launcher 
и выберите из списка Quilter. 

•  Или нажмите Ctrl+Q.

•  Batting: слой подкладочного материала между 
передней и задней тканью, добавляющий толщину 
и объемность. 
•  Подкладка: ткань с задней стороны квилта, нз ко-
торую крепится баттинг. 

На квилте можно вышивать декоративные элементы. 
Эти элементы используют разделительные стежки, 
дающие эффект выпуклости. Можно выполнять их 
вручную или на машине.

Подсказка:  Квилт может быть сочетанием пэчвор-
ка и квилтинга с использованием лоскутных блоков,   
собранных вместе стеганными стежками.

Изменение размера квилта
BERNINA Quilter для измерений использует дюймы. 
Чтобы перевести их с сантиметры, используйте та-
блицу ниже. При вычислении на калькуляторе, деся-
тичная система проще. 

Миллиметры Дюймы Дюймы
(десятичные)

3 1/8 0,125
6 1/4 0,25
9 3/8 0,375
12 1/2 0,5
16 5/8 0,625
19 3/4 0,75
22 7/8 0,875
25 1 1
50 2 2,0
75 3 3,0
100 4 4,0
125 5 5,0
150 6 6,0
225 9 9,0
250 10 10,0
300 12 12,0
450 16 16,0
500 20 20,0
900 36 (1 ярд) 36,0

1000 (1мetr) 40 40,0
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Верх

Баттинг (напол-
няющая ткань)
Изнанка

Выберите Quilter 

General > Application Launcher – доступ к приложе-
ниям – Portfolio, Cross Stitch и Quilter. 



Откроется окно проекта BERNINA Quilter.

•  Подробности в системе помощи в BERNINA Quilter 
Help.

Примечание
Если BERNINA Quilter не открывается через BERNINA 
Embroidery Software, проверьте, установлен ли на 
Вашем компьютере Internet Explorer V6 (минималь-
ное требование) или более новые версии. 

Управление проектом через BERNINA 
Portfolio Basics

BERNINA Portfolio дает возможность эффективно 
просматривать и редактировать проект. Этот ин-
струмент отображает миниатюры и краткую инфор-
мацию каждый раз, когда открыт проект. Исполь-
зуется для работы с проектами, хранящимися на 
жестком диске, на CD или на флешке. Он распозна-
ет все родные для ПО BERNINA Embroidery Software 
форматы. Содержимое можно фильтровать по ти-
пам файлов. BERNINA Portfolio может читать архиви-
рованные WinZip  файлы. Папки можно переимено-
вывать, удалять и добавлять, не выходя из BERNINA 
Portfolio. 

Начало работы с BERNINA Portfolio

BERNINA Portfolio не требует отдельной установ-
ки. Запустите BERNINA Portfolio через BERNINA 
Embroidery Software. 

Начало работы с BERNINA Portfolio 

•  Запустите BERNINA Embroidery Software. 
•  В Embroidery Canvas нажмите Application Launcher 
и выберите из списка Portfolio. 

Откроется окно проекта BERNINA Portfolio.
•  Используйте дерево папок BERNINA Portfolio, чтобы 
попасть в папку My Designs-Embroidery Software 7.
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Использованные блоки            Используемые цвета            Используемые цвета

General > Application Launcher – жоступ к приложе-
ниям – Portfolio, Cross Stitch и Quilter

Заглавная строка 
Меню 

Инструменты

Редактирование

Настроить панель 
инструментов

Стандартная панель инстру-
ментов

Палитра ткани

Окно дизайна

Выберите Portfolio 



Все проекты формата ART отобразятся в виде ико-
нок.

•  Подробности в системе помощи BERNINA Portfolio 
Help.

Подсказка:
Если BERNINA Embroidery Software не отображает 
программу BERNINA Portfolio, переключитесь на нее 
через функцию MS Windows®  Alt+Tab.

Глава 27. АВТОНОМНыЕ ПРИЛОжЕНИЯ
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Изменить вид проектов 

Заглавная строка 

Панель инструментов

Папки

Эскизы файлов
в папке

Разделитель между 
панелями

Строка
 состояния




